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Welcome to Axiom Strategy
Management

Axiom Strategy Management is a component of the Syntellis Axiom Healthcare Suite of financial
solutions. The Axiom Healthcare Suite products support an iterative, continuous cycle in which strategic
plans define day-to-day operational targets while operational data informs long-term strategic planning.
Axiom Strategy Management supports this process by giving you the tools needed to monitor and
manage how well your organization’s day-to-day activities align with its strategic plans, and the goals
and processes that support them. Axiom Strategy Management enables you to translate strategy to
execution in a measurable way, then feed those measurements back into the system to improve
financial outcomes and overall organizational efficiency and productivity.

What is covered in this document

This manual is written for Axiom Strategy Management Administrators. These individuals in your
organization are tasked with configuring, maintaining, and controlling other users' access to Axiom
Strategy Management-related features and data.

As an administrator, you have access to features and menus that are unavailable to regular end users
such as department managers, non-finance executives, and other stakeholders. In some cases, the same
screen or workbook might display slightly different in your interface than it would for an end user.

What’s new

Welcome to Version 2022.3 Axiom Strategy Management!

While no new functionality has been added or enhanced in Axiom Strategy Management, it does deliver
enhancement from Axiom Version 2022.3. For more information, see Axiom 2022.3 Release Notes.
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Implementing best practices for Axiom Strategy
Management

Though Axiom Axiom is highly configurable, it does make a few general assumptions about how your
organization should structure the strategy management process.

While every organization's situation is unique, it has been our experience that organizations typically get
the best results when their strategy management process:

¢ Receives full support from a well-informed management team.
e |srigorous and highly organized.

¢ Links financial planning and capital planning to the organization’s strategic plan.

¢ Encourages rational comparisons between projects and strategic initiatives throughout the entire
organization.

¢ Provides a financial context for allocation decisions.

e Accounts for the strategic, mission, and operational aspects of alternative investment decisions.

Understanding Axiom Strategy Management

Axiom Software products store your organization's data (financial data, labor data, key statistics, and so
on), in a central database, and then pull that data into the interface where you can view, enter, or
modify the data using familiar spreadsheet commands. Axiom Strategy Management also provides a
spreadsheet-based interface from the Desktop Client, but except for a few administrative tasks, you can
access features and functions through the Web Client. The majority of this guide covers using Axiom
Strategy Management in the Web Client.

Axiom Strategy Management basic components

Axiom Strategy Management picks up where your mission statement leaves off. The system consists of
three main levels: Perspectives, Objectives, and Initiatives. Each level in the strategy hierarchy is
supported by the ones below it. The following graphic is simplified to illustrate the different levels, but
in reality, Perspectives can have multiple Objectives, and Objectives can have multiple Initiatives.
Measures are applied to each element at each level in the hierarchy, and so support the entire
hierarchy.
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Perspectives — Strategic pillars that
uphold your organization’s mission. For
example, if your organization is a
hospital, one of your Perspectives might
be Clinical Performance or Community
Health Leader. Each Perspective has one Perspectives
or more associated Objectives.

Objectives — Goals that support your
organization’s Perspectives. Each
Objective belongs to only one
Perspective. Each Objective is associated
with one or more Initiatives.

Strategic pillar
Strategic pillar
Strategic pillar
Strategic pillar

Initiatives — Processes and procedures
that employees perform to support the
Objectives. Each Initiative belongs to
only one Objective.

Objectives

Supporting
Goal

Supporting Supporting Supporting

Goal Goal Goal
Measures — Data collectors used to
determine the performance status of the
items to which they are applied.

Initiatives

Supporting
Process

. . Supporting Supporting Supporting
As illustrated by the process diagram at Process Process Process

the bottom of the graphic, each measure
collects data that the system uses to
determine how well the strategy
elements are performing. Based on this @'@ - %%%ﬁ —) i]:h e o
analysis, the system applies Key

Performance Indicator icons to the Measure Data Analysis Status
elements to provide at-a-glance status

updates.
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Getting Started

This chapter covers navigating the Axiom Strategy Management interface, including logging in and out
of the system and familiarizing yourself with the Web Client and Desktop Client.

Unlike other Axiom Software products, Axiom Strategy Management is designed to be used almost
exclusively in the Web Client. However, as an administrator, you need to be familiar with the Desktop
Client because some administrative tasks currently cannot be performed in the Web Client.

Home page

All users have a home page that opens automatically when you log into Axiom Strategy Management.
Depending on your system, the Web Client home page may be one of the following:

e A product-specific home page for an installed Axiom Strategy Management product
e A custom home page created specifically for your organization
e The default Axiom Strategy Management home page

is

If you navigate away from the home page, you can return to it by using the Area menu 31 in the
Navigation bar:

1o @ i

PRODUCT AREAS
Home
Intelligence Center

System Administration

Home option on Area menu
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If you are in a system with installed products, the Area menu may contain product names instead of the
Home item. In that case, you can select a product name to return to the home page for that product.

» Default home page

If a user does not have an assigned browser-based home page, then the Web Client displays a default
home page. The default home page displays notifications, favorites, and quick links.

AXIOM| Axiom Home Favorites -+ Recent Places v Reports v Forms Explorer  Intelligence Center [N] 19 @ E_.:i

w @

Axiom System: Axiom Software Test System

2 Notifications % Quick Links * Favorites

Notifications Delete all Az Windows Client Look for the W icon to add to Favorites

Ag Excel Client _
Acct Analysis
O Expense variance alert for US West L)

Open

~ Axiom Software
Travel expense variance exceeds 8%.

Corporate Dashboard

Security Manager

system_config

Example default home page

This default home page can also be accessed (by any user) by going to the following URL:

Example Cloud https://ClientName.axiom.cloud/Home/Launchpage

URL Where ClientName is the name of your Axiom Cloud system.

Example On- http://ServerName/Axiom/Home/Launchpage

Premise URL Where ServerName is the name of the Axiom Application Server, and Axiom is

the default name of the virtual directory.

This page has the following features:

¢ Notifications: You can read and delete notifications using the same features available in the
Notifications panel.
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e Quick Links: You can use a set of global quick links that are displayed here for easy access. These
links are built-in to the page and cannot be customized.

NOTE: Quick links to client applications only display if you have security permissions to launch
the application. If you do not have permission to any quick links, then the Quick Links section
is hidden on your home page.

e Favorites: You can open and delete web favorites.

Launching Axiom Strategy Management applications

You can launch various Axiom Strategy Management applications from the Area menu in the Web
Client, including the Axiom Excel Client and Axiom Windows Client.

AXIOM| Axiom Home Reports v O a @ Ei
PRODUCT AREAS
Axiom System: Axiom Software Test System Home
Intelligence Center
4 Notifications % Quick Links % Favor [———

Notifications Delate all Am Windows Client [IGLISOIRGER  LAUNCH

A
g Bxcel Client P Windows Client =
O Expense variance alert for US West
Open Axiom Softw [SEEEIE @
Travel expense variance exceeds 8%

BUEHEERE 1S Word AddHn =

Security Mary

MS PowerPoint Add-in =

About Axiom Software @

Area menu with Launch section to launch various applications

The Launch section of the menu serves the following purposes:

e You can install the Axiom Strategy Management Desktop Client from this menu as needed. After
installing the Desktop Client (Windows Client or Excel Client), you can continue to launch the
client from this location, or you can use other options to launch the client (such as a shortcut on
your desktop).

e You can install and launch Axiom Strategy Management add-ins such as the add-ins for Microsoft
Office applications.
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¢ If your system uses SAML or OpenlID authentication, this menu is the only way to launch installed
applications. When using SAML and OpenlD authentication, you must be authenticated using the
Web Client before you can launch a desktop application.

NOTE: The specific clients and add-ins listed on the Quick Launch menu depend on your particular
security permissions (as defined on the Permissions tab of security). If you do not have permission
to a particular client or add-in, then that item does not display on the Quick Launch menu. If you do
not have security permissions to any of the applications on the Quick Launch menu, then the icon
and the menu will not be present in the navigation bar.

» Launching the Axiom Desktop Client

Using the Area menu, you can launch the Axiom Desktop Client. Click on one of the following items in
the menu:

ltem Description

Windows Client Launches the Axiom Windows Client on your desktop.

You must have the Windows Client Access security permission in order to see
this icon and launch the client. If you do not have this permission, the Windows
Client icon is hidden.

Excel Client Launches the Axiom Excel Client on your desktop. Requires Microsoft Excel.

You must have the Excel Client Access security permission in order to see this
icon and launch the client. If you do not have this permission, the Excel Client
icon is hidden.

If the client is not already installed on the current workstation, clicking the icon will initiate the install
and then launch the client. If the client is already installed, clicking the link will launch the client. Your
browser must support ClickOnce in order to install and launch the client.

The appropriate client to use depends on your organization's preferences and on your user role. Your
organization will provide instruction as to which client you should use, and grant access to the clients as
needed.

For more information on installing the Windows Client and Excel Client, including prerequisites and
configuration details, see the Installation Guide (on-premise systems) or the Axiom Cloud Technical
Guide (Axiom Cloud systems). Some software prerequisites can be downloaded and installed from the
Web Client. You can access the prerequisites download page from the Axiom Strategy Management
About box.

NOTE: The default home page also contains links to launch the Windows Client or the Excel Client.
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» Launching add-ins

Using the Area menu, you can launch Axiom Strategy Management add-ins. Click on one of the following
items in the menu:

Iltem Description

MS Word Add-In Launches the Axiom Strategy Management Add-In for Microsoft Word.

You must have the Word Add-In Access security permission in order to see this
icon and launch the add-in. If you do not have this permission, the icon is
hidden.

MS PowerPoint Launches the Axiom Strategy Management Add-In for Microsoft PowerPoint.

Add-In . . Lo
You must have the PowerPoint Add-In Access security permission in order to

see this icon and launch the add-in. If you do not have this permission, the icon
is hidden.

The Word and PowerPoint Add-ins are optional applications to support document integration between
Axiom Strategy Management and Word or PowerPoint.

Navigation menu

Using the Navigation menu across the top of the Web Client, you can navigate to various files and
locations.

AXIOM| Axiom Home Reporis ~

T ® F

Expenses Overview

Comparison Q1 to Q2

Q1
@ World Region * Variance Q1-Q2 Jan Feb
. Asia region 57615 @ 5124614 $7,730
4 Corporate departments 529,683 @ 532491 $13,694

Example custom Navigation menu

The Navigation menu is context-sensitive, and updates dynamically to show the available navigation
links for the currently active area of the Web Client. The following menus are available:
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Area Description

Custom Axiom Strategy Management provides a set of standard navigation links that
show by default for custom systems when you are in the Web Client. The
standard navigation links can be customized, so each client's system may look
different. Navigation links can only be customized by administrators using the
Desktop Client.

Product-Specific Systems with installed products have product-specific navigation links. When

you select a product name from the Area menu LI in the Navigation bar., the
product-specific links display in the Navigation menu. For more information,
see the product-specific documentation.

Common Certain common product areas are available in all systems and have a standard
Product Areas set of links in the Navigation menu. These common areas include:

* Intelligence Center: Currently this area does not have any navigation links,
but a menu may be added in a future release.

e System Administration: The system administration links show when you are
in the System Administration area, and provide access to features such as
the Table Manager, Audit Manager, and Security Manager.

Additionally, when you open a report or other browser-based document, that document may be
associated with a set of document-specific navigation links. These links are added to the Navigation
menu while you are in that document.

Viewing system information

Use the Axiom Strategy Management About box to see information about your current system, such as:
e Axiom Strategy Management version number
e Product version numbers
e System name

e Application server URL

The About box also contains a link to download software prerequisites, if necessary for installation of
the Desktop Client.

To open the About box:

1. Click the Syntellis icon EJI in the Navigation bar.

2. At the bottom of the Area menu, click About Axiom Software.
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AXIOM| Axiom Home Reports v O o @ Ei

PRODUCT AREAS
Axiom System: Axiom Software Test System Home

Intelligence Center

Jay NOUﬂCB’[\OﬂS % QU‘Ck L\nkS * FaV System Administration
A Windows Client Look for 1/ EAIIeC]
Notifications Delete all i -
A
@ Excel Client e windows Client =z
O File Processing
The job has completed processing all tasks successfully. Axiom Sof| Excel Client =
Corporate EEEVERNCIGEREER] =
Rl s PowerPoint AddHn =
About Axiom Software ®

About Axiom Software at bottom of Area menu

Web Client overview

Most Web Client features and navigation can be accessed using the two bars across the top of each
page:
¢ Navigation bar: The bar at the top of the page provides access to product areas and global
features.
e Task bar: The toolbar underneath it provides access to various features that are specific to the
current page or document.

AXIOM| Axiom Home Reports v o a @ Ei

E o & Navigation bar e
Task bar n

Select Expense Ca(egoi!
Choose a value for Category. - | %X

Select Sales Region

Choose a value for Region - | % 2 Q2
T Variance Q1-Q2 Jan Feb Mar Q1 Apr May
Clear All Cancel $7615 @ $124,614 7,730 7,730 $140,073 $15,056 $38 $
| 520,683 @ S§324941 §13,694 §13,694 §352,329 $25,008 $23,696 §2
Variance Q1-Q2 Jan Feb Mar Q1 Apr May
$-31,700 @ $322,924 $13,694 $13,604 $350,312 $25,008 $23,696 §2
$2017 @ $2,017 $0 S0 $2,017 S0 $0

Administrator's Guide Axiom Strategy Management | 15



» Navigation bar
The Web Client Navigation bar provides access to various product areas and global features. Using this
bar, you can:

¢ Navigate to home and various product areas, including common areas such as System
Administration and Intelligence Center

e Use context-sensitive navigation for the current area, including custom navigation defined for
custom systems

e Launch various client applications
¢ View alerts and notifications from various system processes and features
¢ View user information, configure session settings, and log out

e Access saved bookmarks (favorites) and recent items

Custom navigation

Current area or navigation for the User Profile
— current area Notifications | ==
AXIOM| Axiom  Home Reports v Bookmarks == A & @
A ° * PRODUCT AREAS
Area menu
Home
Expenses Overview Intelligence Center
Gomparison @110 02
System Administration
a
@ world Region * Variance Q1-Q2 Jan Feb Mar Q1 Apr LAUNCH
Asia region §7615 @ 3124614 $7,730 §7,730 $140,073 $15,056

Windows Client ey

The context-sensitive navigation displayed across the top of the page depends on the current area and
the type of system that you are using.

e Common areas such as System Administration and Intelligence Center display standardized
navigation for that area.

e Custom systems display custom navigation for the system, or the default navigation if no
customizations have been made.

e Systems with installed products display navigation for the current product area, such as Capital
Planning or Budgeting.

» Task bar
The Web Client Task bar provides access to various features that are specific to the current page or
document. Using this bar, you can perform activities such as:

¢ Filter the data shown on the current page

e Comment on the current document and review comments from others

e Access tools relating to the current page

* Save the current page or document as a favorite

e View help for Axiom Strategy Management or for the current page

e Perform other context-sensitive tasks such as managing attachments
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) 1
AXIOM]| Axiom Task icons relating to n e @ ]

the current file or page
[ S o
Favorite [~
elect Expense Categon

Help

Select Sales Region
Choose a value for Region v %

Variance 01-Q2 Jan Feb Mar a1 Apr May Jun Q2

Apply Clear All Cancel $7,615 @ $124614 $7,730

$-20683 @ $§324901m $13,604 $13,604

Panel for

current task R s Feb Mar Qi Apr May Jun a2

The left-hand side of the task bar contains a task toolbar. You can click on any icon in this toolbar to
open the panel for the associated feature. For example, clicking the filter icon opens the Filters panel.
Clicking the icon again closes the panel.

The panel can be pinned or unpinned using the pin icon in the top right of the panel. If the panel is
unpinned, the panel overlays the current page contents, and clicking on the page closes the panel. If the
panel is pinned open, then the form is pushed to the side so that the panel contents and the form can
be viewed at the same time. When pinned, clicking on the page does not close the panel—you must
unpin the panel or click the toolbar icon again to close the panel.

The contents of the task bar vary depending on the current page or document. For example, the
Message Stream and the Filters panel are only available if they have been enabled for the current
document. If a particular feature is not available for a particular document or page, then either it has
not been enabled or it does not apply.

Viewing notifications in the Web Client

If you receive a notification in Axiom Strategy Management, you can view it in the Notifications panel.
Notifications can come from the following sources:

e Alert notifications. Your system administrators and other power users may have set up alerts to
monitor certain alertable conditions and then notify specified users.

¢ Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

¢ Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

e Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Strategy Management will notify you when the process is completed or when
errors occur.

¢ Scheduler jobs. If you have run a Scheduler job manually and that job is configured to send
notifications, you will be notified when the job completes or errors (depending on the notification
configuration).
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To open the Notifications panel, click the Notifications icon [.1- in the Navigation bar.

T @ F

Expenses Overview
Comparison Q1 to Q2

a1

@ world Region * Variance Q1-Q2 Jan Feb

» Asia region $7,615 @ $124,614 $7,730
> Corporate departments $-29,683 @ §32491 §13,694
> Europe region 5163 @ $4,983 $-176
a North America region 526779 @ $838,570 §70,039
Region 1 Variance Q1-Q2 Jan Feb

US Central $7571 @ $313,755 $27,556

US East 516734 @ $310,792 $18,994

AXIOM| Axiom Home Favorites ~ Recent Places ~+ Reports ~  Forms Explorer  Intelligence Center

Mar
$7,730
$13.694
$176
$70,039
Mar
§27,556

§18,04

Q1
$140,073
$352,329

$4,631
078,647
a1
$368,866

$348,781

|
.

$1505
325,09;
s
$8301)
A
§31,58
$3337)
i

m
na @ L
Notifications Delete all

© Revenue variance alert for US Central x
Open
Revenue variance for your department is negative
Please review the variance and submit a comment using
the following report:.

© Capital Request Approval process x
notification - 3 new task(s)
You have 3 new task(s) in process ‘Capital Request
Approval
Process task for CapitallD 11 (New machinery).

Example Notifications panel

If you have new notifications when you first log in, or if you receive new notifications during a current
session, a red number displays on the Notifications icon. In the panel, new notifications are indicated by
a blue dot in the top right corner of the notification. The "new" dot is removed when the notification is

read, or when the panel is closed.

neQ L

Notifications Delete all
0 Expense variance alert for US West o X
Open

Travel expense variance exceeds 8%.

© Revenue variance alert for US Central LR
Open
| Revenue variance for your department is negative.
Please review the variance and submit a comment using
| the following report....

Administrator's Guide
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NOTES:
¢ Your notifications may also display on your home page. If so, the notifications can be read and
managed using the same features described here.

¢ All notifications displayed in the Notifications panel are also available in the Notifications task
pane of the Desktop Client. Both areas read from the same source of notifications, and edit
the same source as well. If you read a notification in one area, or delete a notification from
one area, the other area will reflect these changes.

» Reviewing notifications

Within the panel, notifications are listed in the order they were received, with the newest notifications
at the top. Notifications may display with the following icons to indicate their priority:

i Notification with "information" priority.
o Notification with "warning" priority.

A Notification with "error" priority.

When viewing notifications in the panel, you can perform the following actions:

e Some notifications may have more text than can be displayed in the panel. To view the full
notification text, click on the notification box to open it.

¢ Some notifications may contain a link to a supporting document for more information. To open
the document, click on the Open link at the top of the notification box, underneath the
notification title. Additionally, if the notification is for a process task in a plan file process, the
notification may contain one or more links to plan files. You can click on these links as needed to
open the plan files.

¢ You can remove notifications from the panel if you no longer need them. To remove a
notification, click the X icon in the top right of the notification box. Once a notification has been
removed from the panel, you cannot undo this action.

Notifications will remain in the list until you remove them, or until they are deleted by the system purge
job. By default, the system purge job deletes alerts and notifications older than 60 days.

Managing favorites in the Web Client

You can save various documents and pages as favorites in the Web Client, for quick access to commonly
used items. Your favorites list is available in the following locations:

e The Bookmarks panel

¢ The default Web Client home page
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*e

H o dey

+ [] BOOKMARK

Acct Analysis

Axiom Software
Corporate Dashboard
Security Manager

system_config

+ () RECENT

System Administration
Example favorites in the Bookmarks panel

Your favorites list displays any web-enabled favorites that you have saved in the Web Client or the
Desktop Client. Other types of favorites saved in the Desktop Client do not display in the Web Client
(including folders saved as favorites, even if the folder contains web-enabled files).

» Saving favorites

To save the current document or page as a favorite in the Web Client, click the star icon in the right side
of the Task bar. The star icon toggles from outline (not a favorite) to filled (a favorite).

noo @ b
% ®

Favorite icon in Web Client task bar

Once a favorite has been saved, it displays in your favorites list in the Web Client and in the Desktop
Client. You can use the saved favorite to quickly open the document or page.
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Web favorites are saved using the name shown in the browser tab. Axiom forms support the ability to
define a title that displays in the browser tab, which means the title may be different than the file name.
If the title is changed after the favorite is saved, the favorite does not update to show the changed title
(however, the favorite still works to open the specified document).

Currently, the Web Client does not support the ability to rename or reorder web favorites, or to
organize web favorites into folders. Web favorites display as a flat list, in alphabetical order. However, if
you rename a favorite in the Desktop Client, the Web Client updates for the new name.

NOTES:

e When favorites are saved in the Web Client, they are saved as URLs instead of as document
shortcuts. This allows you to save any page in the Web Client as a favorite, not just
documents. For example, if you have access to the Audit Manager, you can save that as a
favorite for quick access to the page. However, if the name of your Axiom Strategy
Management virtual directory ever changes (which should be a rare occurrence), the web
favorite will no longer work.

¢ |f a web favorite points to a document, and that document is later moved or renamed, the
favorite will continue to open that document (but the favorite name is not updated).

¢ |f you organize web favorites into a folder using the Desktop Client, the folder will not display
in the Web Client—the flattened list of favorites will be shown instead.

» Deleting favorites

To delete a favorite, hover your cursor over the favorite name (in either the Bookmarks panel or your
home page), then click the delete icon Lli. The favorite is deleted in the Web Client and in the Desktop
Client.

If the document or page for an existing favorite is deleted, the favorite is not automatically deleted. If
you try to use the favorite, you are informed that the document or page cannot be found. In this case
you must manually delete the favorite.

Viewing page content

All Axiom Strategy Management users have access to all main pages except the Admin pages, which are
available only to Strategy Management administrators. What you can see on each page depends on your
access rights, which are determined by your user roles and whether you are designated as an owner or
sponsor for any Initiatives. For example:

e All users can see Objective names, but only users with the Strategy Management Admin role, or
the Strategy Management Executive role can view all Objective information and Objective
measure data. Objective owners can also view information and measure data for Objectives that
they own.
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e If you are designated as the owner or sponsor of an Initiative, you can see information related to
that Initiative, but not other Initiatives.

e |If you have the Initiative Approver or Initiative Creator user role, you can view all Initiative
information.

Using the Desktop Client

Although most of the features in Axiom Strategy Management are available from the Web Client, if you
are a system administrator or are using certain reports, you may need to use the Desktop Client
occasionally; for example, when assigning security roles to users.

All Axiom Software products, including Axiom Strategy Management, share a common interface and use
many of the same features. The interface includes the following common sections.

» Display area

The main area of the Desktop Client displays open files. By default, it shows the Axiom Strategy
Management Dashboard. The display here is essentially identical with the one in the Web Client; the
only pieces missing are the side navigation panel, replaced by the Axiom Assistant pane; and the Web
Client toolbars. If you click any links in the Dashboard, they behave the same as in the Web Client—they
either open a window or open the corresponding Axiom Strategy Management Web Client page. To
work within the Desktop Client, use the task panes.
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» Task panes

A task pane provides access to commands, utilities, reports, plan files, and so on for Axiom Strategy
Management, and displays on the left side of the main display area. To switch between task panes, click
the tabs on the left side of the interface. To expand or collapse the task panes, click the arrow in the
left-hand corner above the tabs.
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» Ribbon tabs

Ribbon tabs provide access to commonly used features and shortcuts to frequently accessed files. They
display above the task pane and main display areas. The role assigned to you determines the ribbon tabs
that display. For example, the Admin ribbon tab only displays to those users assigned the Administrator

role profile.

NOTE: The role assigned to you determines the ribbon tabs that display. For example, the Admin
ribbon tab only displays to those users assigned the Administrator role profile.
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» Main

Includes commands for accomplishing most tasks in Axiom:

e QOpening, closing, and saving files
e Viewing data in spreadsheets (if you have access rights to do so)
e Printing or emailing files

e Accessing shortcuts to frequently accessed reports
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Includes standard spreadsheet commands.

MAIN ADMIN Home
e I—1 =]
0 X cut i N General - El [E Q I:‘i, Calculate Now
R Copy = = 7 Calculate Workbook
Paste X M M Insert Delete Format Print Zoom  100% | Calculation
- Format Painter — - - - Area v Options ~

Some options on the ribbon tabs display grayed out unless certain types of files such as reports or plan
files are currently open, or if you do not have the necessary security permissions to use the feature.

The Excel Client displays all of the same ribbon tabs included in a normal Excel file. The Windows Client
only includes a subset of the same ribbon tabs located in the Home ribbon tab.

TIP: When creating reports, we recommend that you use the Excel Client.
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» Windows Client or Excel Client?

The following table describes each client:
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NOTE: All Axiom Strategy Management web pages are configured for viewing in the Web Client. You
can view the Dashboard in the Windows and Excel clients, but if you click a link to another page from
a Dashboard link, you cannot navigate back.

Type Description

Windows Client ¢ Emulates a spreadsheet environment without requiring
Excel.

° Provides access to some Axiom Strategy Management
features.

© Navigation and help functions differ from the Excel
Client.
¢ Communicates with the database using http or https.

e Administrative rights not required for local installation or
updates.

e Users with appropriate permissions can open standard
Excel files from within the Windows Client.

e Provides faster processing speeds and fewer technical
requirements than the Excel Client.

e Access to features in this client depend on user access
permissions
Excel Client e Provides access to all of the Axiom Software features
within a Microsoft Excel interface.
e Communicates with the database using http or https.

e Administrative rights are not required for local installation
or updates.

e Users with appropriate permissions can open and create
any normal Excel file and perform Excel tasks without
needing to exit the Excel Client.

NOTE: The instructions in this website, including the screenshot examples, assume that your
organization is using the Windows Client. The Excel Client uses the same features, but with the
added benefit of the Excel interface, including the Excel ribbon tab.

Opening the Explorer task pane

Axiom Strategy Management provides a built-in Explorer task pane so that you can quickly access your
favorites, recent items, and all the files that you have rights to access.
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TIP: You can also access Favorites, Recent, and My Documents from the My Files and Tasks task
pane.

By default, all users are given access to this task pane. If desired, administrators can disable use of this
task pane entirely, or restrict access to certain sets of users.

To access the Explorer task pane:
¢ Inthe Main ribbon tab, click Navigation, and select Explorer.
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Accessing Axiom Strategy Management features

In Axiom Strategy Management, admins and non-admin users access main features and functionality in
the Desktop Client from the Explorer task pane. However, your user role(s) determines which features
you can access. You may not have access to all the features listed here.

To access Axiom Strategy Management File groups:
1. Inthe Explorer task pane, expand the File Groups section.

2. Scroll down to and expand Strategy Management - Requests.

To access Axiom Strategy Management Reports:
1. Inthe Explorer task pane, expand the Libraries section.

2. Expand the Reports Library.

3. Scroll down to and expand Strategy Management Reports.

To access Axiom Strategy Management utilities:
1. Inthe Explorer task pane, expand the Libraries section.

2. Expand the Reports Library.
3. Scroll down to and expand Strategy Management Utilities.

4. Expand Utilities.

NOTE: You can also access Axiom Strategy Management Home pages by expanding Home
Pages.

To access Axiom Strategy Management Scheduler Jobs:
1. Inthe Explorer task pane, expand the Libraries section.

2. Expand the Scheduler Jobs Library.

3. Expand Strategy Management.

NOTE: System administrators can access the following Scheduler jobs: SM_CreatePlanFiles,
UpdateMeasureData-SQL, and UpdateMeasureTarget-SQL

To access Axiom Strategy Management strategy hierarchy tables:

NOTE: Only administrators can access the Initiative and Objective tables.

1. Inthe Explorer task pane, expand the Libraries section.

2. Expand the Table Library.
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3. Expand !Dimensions and then do any of the following:
e To access the Initiative table, scroll down to and double-click Initiative.
e To access the Measure table, scroll down to and double-click Measure.
e To access the Objective table, scroll down to and double-click Objective.

e To access the Perspective table, scroll down to and double-click Perspective.
To access Axiom Strategy Management Data tables:

NOTE: Only administrators can access the Data tables.

1. Inthe Explorer task pane, expand the Libraries section.
Expand the Table Library.
Expand Strategy Management.

Expand Data.

LA

To open the desired table, double-click it.

Axiom Assistant task panes

The Axiom Assistant area provides quick and easy access to Axiom Strategy Management files and
features as you work in the Desktop Client. A variety of task panes are available to help you perform
general and context-sensitive tasks. Additionally, system administrators can create customized task
panes for use in this area.

The Axiom Assistant area is located in the left-hand side of the application, below the ribbon and to the
left of any opened files. By default, the area is expanded, and you can work with any of its available task
panes by clicking the side-tabs along the left-hand edge of the pane.
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Example Axiom Assistant area

» Available task panes

The task panes available to you in the Axiom Assistant area depend on your system configuration and
your security permissions. The following task panes may be available:

Task pane

Data Source

Description

Helper tool to build data sources,

Availability

This task pane is system-controlled

Assistant such as RefreshVariables, and displays if you have the
DatalLookup, and Grid. appropriate security permissions, and
the file is an Axiom file.
Explorer Open files and other items that you This task pane is included by default,

have access to, including favorites.

but may be disabled in your system or
restricted to only certain users.

File Processing

Configure and perform file processing
for an Axiom file, such as to perform
multipass processing, file collect, or
batch processing.

This task pane is system-controlled
and displays if you have the
appropriate security permissions and
the file is enabled for File Processing.

Form Assistant

Configure form settings for an Axiom
file, and preview the form.

This task pane is system-controlled
and displays if you have the
appropriate security permissions and
the file is enabled for Axiom forms.
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Task pane Description Availability

Messages View comments about the current This task pane is system-controlled
document, and add comments. and displays for all eligible documents.

Notifications View alert and system notifications This task pane is system-controlled
and open associated files. and displays if you have any active

notifications.

Process View process information and This task pane is included by default,
complete process tasks. By default but may be disabled in your system.
this task pane only displays if it is
relevant to you (for example if you
are the assigned owner of a process

task).
Sheet Assistant Configure workbook and worksheet This task pane is system-controlled
settings for an Axiom file, including and displays if you have the
Axiom queries. appropriate security permissions and
the file is an Axiom file.
Table View table details, set a filter, and This task pane is system-controlled
refresh the currently opened table. and displays when using Open Table in
Spreadsheet.
<Custom Task Your organization may have defined Custom task panes may open
Panes> one or more custom task panes for automatically when Axiom Strategy
your system. Management is launched, or you may

have access to the Task Panes Library
to open certain task panes as needed.

The order of task panes in the Axiom Assistant area cannot be manually changed. Your system
administrator has specified an order for the task panes that open when the system is started. System-
controlled task panes display after these startup task panes.

» Minimize Axiom Assistant

By default, the Axiom Assistant area is maximized when you first start Axiom Strategy Management. If
desired, you can minimize this area—for example, to gain more screen space while working on a file.
When minimized, the area displays as a thin strip along the left-hand side of the application, with one or
more side-tabs for each task pane.

You can expand the Axiom Assistant area to perform a task, and then minimize it again when you are
finished.

» To minimize the Axiom Assistant pane, click the * button in the header.

» To expand the Axiom Assistant pane, click the * button in the collapsed header, or click on one
of the task pane tabs.
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Axiom Strategy Management remembers the state of the Axiom Assistant (minimized or expanded)
when you exit the application, and will apply that state the next time you open Axiom Strategy
Management on the same machine.

It is not possible to completely hide the Axiom Assistant area when task panes are open, however, if no
task panes are open then the Axiom Assistant area is automatically hidden (and will automatically show
again when a task pane is opened).

» Opening task panes

In most cases, the task panes that you need to use will open automatically—you do not need to
manually open them.

e Certain task panes are configured to open automatically when Axiom Strategy Management is
started, such as the Explorer task pane. These task panes are considered to be "global" task panes
that you may want to use at any time while you work in the system.

e Other context-sensitive task panes only open when using certain features. For example, the File
Processing task pane only displays when you open a file that is enabled for File Processing. There
is no need to manually open the task pane because it will always be available when it is relevant
(and assuming that you have security permissions to view it).

If you have access to the Task Panes Library to open certain custom task panes as needed, then you can
open a task pane by double-clicking it in the Explorer task pane or the Axiom Explorer dialog.
Alternatively, one of your "startup" task panes might be used to open other task panes.

For example, you might have access to a Monthly Reporting task pane that details the steps you need to
do to run your monthly reports, and links to those reports. You wouldn't necessarily need this task pane
to be open at all times; instead, you would only want to see it when you are ready to process your
monthly reports. You could open the task pane as needed from the Task Panes Library or from another
custom task pane that links to it.

» Closing task panes

Most task panes cannot be manually closed. Either they are global task panes that always apply, or they
are context-sensitive task panes that close automatically when the associated file or feature is closed.
Alternatively, you can minimize the Axiom Assistant area to "hide" all task panes and gain more screen
space for your open files.

If a task pane is closeable, then you can close it by clicking the X icon on the side-tab for the task pane. If
this icon is not present, then the task pane cannot be closed. Typically, only task panes that you open
manually can be closed manually, but in some cases you may also be able to close task panes that open
on startup.
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» Using task panes in the Axiom Excel Client

When using the Axiom Excel Client, each file opens within its own window, and each window maintains
its own set of ribbon tabs and task panes. This means that as you switch windows, the set of task panes
available in each window may be different. For example:

e |If you manually opened a task pane in one window, that task pane will only be present in that
window. It will not be present in other windows.

e The currently active task pane is managed independently for each window, so the active task
pane may change as you change windows. (This can also occur when using the Axiom Windows
Client, if you switch between files that have different default task pane associations. However, in
the Axiom Excel Client it may also happen when switching between files with the same default
task pane associations.)

e The current state of task panes is managed independently for each window. For example, if you
expand the Reports Library in the Explorer task pane in one window, that expansion will not be
present if you switch to a different window.

Managing favorites
You can save Axiom files and other items as favorites, for quick access to commonly used items. In the
Desktop Client, your favorites list is available in the following locations:

e The Explorer task pane in the Axiom Assistant area

e The Axiom Explorer dialog (if you have permission to access this dialog)

<  Axiom Assistant

My Files
~ 1 Favorites
@j Incame Statement By Maonth
(3t 41000
@j Monthly Package Collect
7 Recent

Explorer

144
-

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it
to access any other commands that would be available on the item in its native area. For example, if you
have rights to the Table Library and you save a table as a favorite, you can right-click the table favorite
and perform actions such as editing the table structure.

If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it. If you attempt to open an invalid favorite, a message box informs you that the item
has been deleted, and asks whether you want to delete the favorite. If a file is moved or renamed within
the Axiom Strategy Management file system, but it retains the same document ID, then the shortcut will
not be broken.
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» Saving and deleting favorites
You can save an item as a favorite in one of the following ways:
¢ |nthe Explorer task pane and the Axiom Explorer dialog, you can right-click an item and select
Add to Favorites.
e When a file is open, you can right-click the file tab and select Add to Favorites.

The item is saved as a favorite and now displays in your Favorites list. If the file was open when you
saved it as a favorite, it displays using the file tab name. If needed, you can change the display name by
editing the shortcut properties for the favorite.

TIP: If you open a table using Open Table in Spreadsheet, and then save the open table as a favorite
(using the file tabs), the settings you used will be automatically saved as part of the favorite, in the
shortcut properties. You may want to rename the favorite to indicate the particular settings (for
example: GL2022 - Filtered for North Region).

NOTE: If a web-enabled file is saved as a favorite in the Desktop Client, that favorite will also display
in the Web Client. This includes Axiom forms and web reports. All other types of favorites do not
display in the Web Client.

To delete a favorite, right-click the item and then select Delete.

» Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites and select New Folder.

By default, favorites are displayed in the order that they were added (new favorites are added to the
bottom of the list). You can drag and drop individual favorites to change the order. Sub-folders cannot
be reordered—they will always display in alphabetical order.

To rename a favorite, right-click the item and then select Rename. The name becomes editable, and you
can type a new name.

» Shortcut properties

You can edit the shortcut properties for a favorite. Right-click the favorite and select Shortcut
Properties. In this dialog, you can edit the shortcut name, change the shortcut target, and define certain
shortcut properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.
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» Using web favorites in the Desktop Client

If you save a favorite in the Web Client, that favorite also displays in the Desktop Client favorites list. You
can double-click the web favorite to open it in the Web Client browser.

When a favorite is saved in the Web Client, it is stored as a URL instead of a document shortcut. If the
target of the favorite is later deleted, the favorite does not show as invalid in the Desktop Client. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case you
must manually delete the favorite.

Opening recent files

Axiom Strategy Management maintains a list of your recently opened files in the Desktop Client. You can
use this list for quick access to recent files.

The recent file list is located in the My Files section of the Explorer task pane and Axiom Explorer. You
can double-click files to open them, or right-click to access the context menu for the file type. Recent
files are listed using the file tab name that they were opened with, which may or may not be the same
as the file name.

The list displays the last 15 files that you recently opened. Note the following:
e If you want to clear the list, right-click Recent and select Clear History.

¢ |f you want to continue to have quick access to a recent file, you can add it to your favorites.
Right-click the file and select Add to favorites.

e If the icon next to a file name is a red arrow, this means that the file has been moved or deleted
since you accessed it, so it can no longer be opened from the recent file list.

In the Axiom Windows Client only, recent files can also be accessed from the File menu. In the Axiom
Excel Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom
Strategy Management database. Therefore, Excel's recent file list cannot be used to open Axiom files.

Viewing notifications using the Notifications task pane

If you receive an Axiom Strategy Management notification, the notification displays in the Notifications
task pane. This is a system-controlled task pane that is always available in the Desktop Client if you have
notifications. Click the Notifications tab in the Axiom Assistant area to view the task pane.
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¢ Axiom Assistant
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MNotifications

My Motifications

» I\ Expense variance
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« /1, Revenue variance alert
for US East
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Feview,

Open

» /I, Revenue variance
alert for US Central

Example Notifications task pane

If you have unread notifications when you first log in, or if you receive new notifications during a current
session, the Notifications tab will flash orange and remain that color until you click on the tab. Unread
notifications display in bold text. Once a notification has been read, the bolding is removed.

Notifications can come from the following sources:

Alert notifications. Your system administrators and other power users may have set up alerts to
monitor certain alertable conditions and then notify specified users.

Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Strategy Management will notify you when the process is completed or when
errors occur.

Scheduler jobs. If you have run a Scheduler job manually and that job is configured to send
notifications, you will be notified when the job completes or errors (depending on the notification
configuration).
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NOTES:

¢ The Notifications task pane is a system-controlled task pane; you cannot hide or show this
task pane manually. The Notifications task pane always displays on startup if you have any
active notifications (read or unread). Otherwise, it does not display. If you receive a new
notification during a session and the task pane is not already open, this will cause the task
pane to open.

¢ All notifications displayed in the Notifications task pane are also available in the Notifications
panel of the Axiom Web Client. Both areas read from the same source of notifications, and
edit the same source as well. So if you read a notification in one area, or delete a notification
from one area, the other area will reflect these changes.

» Reviewing notifications

Within the task pane, notifications are listed in the order they were created, with the newest
notifications at the top. Each notification displays a severity icon and an alert title, as well as how old the
notification is. The following severity icons are used:

- @ Info
e % Warning
. ! Error

To read the notification text, double-click the notification to expand it. The text should provide you with
more information about the notification and why you are receiving it. You can double-click the
notification again to collapse it.

If the notification is from an alert, then the alert creator may have specified a document that you can
open to see more information about the alert condition. If so, then you will see an Open link
underneath the message text when you expand the notification. Click this link to open the associated
document.

» Notification actions

You can select one or more notifications and then right-click to perform the following additional actions:
e Mark Read: Mark the selected notifications as read.
e Mark Unread: Mark the selected notifications as unread.

e GoTo Alert Definition: Open the source document for the alert, if you have permission to access
the file. You will be taken directly to the specific alert definition that generated the notification.

¢ Delete: Remove the selected notifications from the pane. Once a notification has been removed
from the pane, you cannot undo this action.

Notifications will remain in the list until you remove them, or until they are deleted by the system purge
job. By default, the system purge job deletes alerts and notifications older than 60 days.

Administrator's Guide Axiom Strategy Management | 37



Commenting on documents using the Message Stream task pane

When viewing a spreadsheet Axiom file within the Desktop Client, you can view comments that other
users have made about the document and also make comments about the document. New comments
are stored in the message stream for that document, so that all other users who access the document
can see the comment. Additionally, you can "tag" other users in the comment, so that the tagged users
are notified about the comment.

You can view comments and add comments using the Message Stream task pane. This is a system-
controlled task pane that automatically opens for eligible documents.

NOTES:
¢ The message stream is only available for documents where it has been enabled.
e The message stream is also available for Axiom forms that are open within the Desktop Client,

using the Message Stream panel. This panel is accessible from the task bar displayed across
the top of the form.

» Viewing the message stream

To view the message stream for the current document, click the Message Stream tab to display the task

pane in the Axiom Assistant sidebar. This task pane shows all comments that have been made about the
document.

< Axiom Assistant A| Home =] [BGT20] 40000
I |
+ Add Comment e 40000 Los Angeles - Store 34
g Current View: Standard view
=
i | Travel budget looks goad to me, Account
w Statistics
§ 95000 Volumes
= | @Wendy Hunter Please look at the travel budget. Total Statistics
= > Revenue
3
= 4000 Revenue
)
%Ju <o hdd a new Ravenie rogw s 2
] Total Revenue
3
S Marketing

Example message stream

Comments are displayed in the order they were made, with the most recent comment shown at the top
of the panel. Each comment shows when the comment was made and the user who made it.
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To view the full text and details of a comment, hover your cursor over the comment so that the >
symbol displays on the right-hand side of the comment. Click the symbol to open a separate Comment
Details dialog with the full comment text.

Once the message stream has been loaded for the current document, it is only updated automatically
after you add a new comment. If necessary, you can manually refresh the task pane to see if any other
users have made comments during the current file session.

Comments are stored for the life of the document, and cannot be deleted.

» Adding a comment

To add a comment, click Add Comment at the top of the Message Stream task pane. In the Add
Comment dialog, you can define an optional title for the comment, and then define the comment text.
Basic text formatting of bold, italic, and underline can be used.

A | Add Comment =

Add Comment

Title
optional
Message
B I U Tag user v

[@Wendy Hunter Please take a look at the Travel budget.

If desired, you can "tag" one or more users in the comment, so that those users are notified about the
comment. Any user tagged in the comment will receive an email that contains the content of the
comment and a link to the document. To tag a user, use the Tag user box to find a user and insert the
tag. You can type into the box to find a specific user, or select a user from the drop-down list. When you
click on a user name in the list, a tag will be inserted at the current cursor point in the comment text.
The tag displays as @FirstName LastName.
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When you click Post, the comment is saved to the message stream, and any tagged users will be
notified.

NOTES:

e All users with access to the document can see comments posted to the message stream. Any
comments made should be appropriate for the entire document audience. Do not post any
sensitive information to the message stream.

¢ Adding a comment automatically subscribes you to the document's message stream, and
tagging a user automatically subscribes that user to the document's message stream.

» Ongoing notifications (subscriptions)

If you have made a comment in a document's message stream, or if you have been tagged in a
comment, you are now subscribed to that document's message stream. Whenever a new comment is
made to that document's message stream, you will receive a notification in the Notifications task pane.

The notification details the user who made the comment and when it was made, the text of the
comment, and a link to open the file.

Currently it is not possible to unsubscribe from a document's message stream once you have been
subscribed.

Exiting Axiom Strategy Management

To exit Axiom Strategy Management, in the Main ribbon tab, click the Close Axiom Software button in
the Exit group.

MAIN  ADMIN  Home \

() -
EQ ~ [P 4] i P o ? i
- + Formula Bar N 4
Admin Task Security Locked System Scheduler Process Imports & Data File . System Recovery Help F'OSE
Panes » - ltems  Browser Management ~ Utilities ~ Protection * Headings Tools = - - Axiom SW

You can also simply close the application by clicking the X button in the top right corner of the window.
Axiom Strategy Management prompts you to save any changes to unsaved files.

About System Administration

System administration involves basic configuration and maintenance tasks, some that you perform only
once and some that you need to perform regularly. You perform most admin tasks from administrative
pages in the Web Client, but a couple are performed in the Desktop Client, as noted in this topicsection.
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» Admin pages

System administrators perform most administration functions in the Admin pages.

» Maintenance

Strategy Management

Admin — Maintenance

Perspective  Objective  Opportunities Resourcing Process Step  Import  Data Utilities  Integration
W Description Enabled Period Begin Period End lcon

+ Add New Perspective

Financial Health On . January, 2017 & December, 2020 « fa-user -
Clinical Performance On . January, 2017 - December, 2020 fa-hospital-o
Operational Performance on . January, 2017 v December, 2020 fa-cogs -4
Strategic Growth on . January, 2017 v December, 2020 w fa-line-chart |
Employee Growth and Retentior on . January, 2017« December, 2020 w fa-neart v
Community Health Education off January, 2017 - December, 2020 & fa-wrench e
Full Continuum of Care off January, 2017 December, 2020 fa-wrench rd
Patient Experience Off January, 2017 - December, 2020 fa-wrench ~
Consumer Strategies On . January, 2017 - December, 2020 fa-group £

Admin Maintenance page example

On the Maintenance page, you perform maintenance tasks on the elements that make up the strategy
hierarchy: Perspectives, Objectives, and Initiatives.

You also create new Perspectives and Objectives here. Initiatives are created elsewhere by users who
have the Initiative Creator role. However, you create and manage Opportunities and Resources from
this page, both of which are used in Initiatives.

This page also provides access to the following utilities:

Tab Utility Description
Process Initiative Resets Initiatives back to the active tracking stage after the
Step Pending Reset Initiative sponsor approves the updates made by the Initiative

owner for the current period. Resetting Initiatives enables them to
be updated during the next current period.
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Tab Utility Description

Import Process Plan Integrates imported Initiatives into active tracking.
Files
Data Update Automatically updates the MeetsTarget column entries for all
Utilities Measure measure data, based on the MeetsTargetDirection values set for
Target Status each measure.

Update Period Updates period measure data values, target values, and
Measure Data benchmark values.

Create Automatically creates measure data rows with populated target
Measure Data fields for hierarchy items when a new measure with a defined
target is added to the hierarchy item.

Delete Automatically removes all aborted Initiatives and their related
Aborted data from the Axiom Strategy Management system, including the
Initiatives Initiatives data tables.

Delete Orphan  Automatically removes measure data left over from changing a
Measure Data hierarchy measure’s time frame.

Update Automatically updates hierarchy measure data from actuals
Measure Data imported to the system. This utility runs daily but administrators
Actuals can run it on demand at any time.

Resolve Helps administrators track and identify data exceptions that need
Exceptions to be resolved when data imported to the system does not match

up with data in the system. Displays the mismatched data in the
Resolve Measure Data Exceptions form.
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» Settings

AXIOM

=

Admin — Settings

System Settings  User Preferences

Default name for Perspective Perspective
Default name for Objective QObjective

Default name for Initiative Initiative

SM Current Period January, 2019 v

Admin Settings page example

On the Settings page, you can change the default system names for Perspectives, Objectives and
Initiatives; manage user preferences; and update the Current Period for the system.

» Measures

Upcite Messure Data
Measures

Measures  Perspective Measure ~ Objective Measure  Drill Documents  Type  Clase

Class Filer | [All - Search | Typato Search x Filter Disabled on -

B Description GLAcct Class. Tyee unit Frequency Formula Description Enabled

+ Add New Measurs

Accounts Payabie Type to search v | [ CM MeticlD-Financiel v | Caloulated v | Amam - Morhly o [l
Acoounts Receivable Type o search v | | cMmeticiDFinancisl v | caculated v | Amount - Monthly |
Adsted dmissions Typato seach v | [ CunvienFnmcsl B ™ - oty Bl |
Adjusted Discharges Type to search v | |_CM MericiD-Financial v | Caloulaed v | Number - Monthly On .
disted Patient Days Type to search v | [ cMmevicipFinancil v | caculated v | Humber - Morehily Y |
Anesthesia Supply Expense per Case Atianded Typeto search v | [ M MericiD Financal v | " Caloulated v | amount - Morchly |
ANMsssurs tracking delizrs spant - Highar 1 -Salary & Hewrs Anlysis v | | ez Fnsncisl v | g v | ameum - Annally o
AN-Trecking dolars spert - igher 1 - Salary & Hours Analysis v | [ oM MericiD-Financiel v | g v | _Amount - Ancally Annual nurmber |
anificial hip suppiier costs 24~ Contract Labor Expense as % of . v | | CM MeticiD-Financial v | e v | amount - Morchly Gostpes arificil hip sveraged autper patien | | On [}
Average Length of Stay Typeto search v || CMMevieiDFinancial v | Coleulasted v | Number - Monchly |
Ausrage Rats per Hour Type s ssarch v | | ez Fnsncisl v | Ccaleulsted v | ameum - Moy 2y |
@ | Average Time o Schedule  Prmary Care Visit Type o search + | [ cMmevicio Fnancial v | caleuated v | Humber - Hanhly For Emploped Providrs,avrage imebetwes | | 00 I}
@ | BedDeht Expense Typeto search v | | cMmericiFinsncel v | “caculated v | “Amount - Borchly o Il
Bad Debt Expense as % of Gross Typeto search v | | oM MetriciD Financial v | Calculated v | Percemt - Monthly on -
Bansf Expance. Type s sarch v | | cumerienEnsncisl v | caleusted v | ameun - Moy 2y |
Bensfit Expenss a %af Wages Type to ssarch v | [ eMMetriciD-Financial v | Caleulated v | Percent - Monthly - [l
Blood Supply Expense per Adjusted Discharge Type to search v | [ M Meviald Financial v | Caoulated v | Amount - Moy o [l
Cath Lab Visits Typeto search v | | oM MetriciD Financial v | Calculated v | Number - Monthly o [l
Cathetar-azsaciatad Urinary Tact nfestion (CAUTI) Rate Type s ssarch v | [ patiom safary v | g v | Perean - Quarterly Total rumber of cbeerved heatheare sseccic | | on [
« = >
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Admin Measures page example

You maintain Perspective measures, Objective measures, and measures used by Initiatives from the
Measures page. Maintaining measures includes regularly updating measure data, and occasionally
adding, editing, enabling, disabling, or deleting measures. You can also assign drill documents to drills.

» Desktop Client Admin tasks

The following administrative tasks are currently only available from the Desktop Client or involve using
the Desktop Client.

* |nitiatives — Import Initiatives in bulk
* Measures
° Add a benchmark to a measure
° Create a measure drill

e Security — Manage user roles
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Configuring Settings

Changing default system names is a task you should perform only once, when your system is
implemented or shortly thereafter.

Instructions for the following tasks apply to working in the Admin Settings page of the Web Client.

e Change default system names — Use this setting to change the default names “Perspective,”

“Objective,” or “Initiative” if desired.
* Enable or disable the Initiative Overview tab — Use this setting to re-enable the Overview tab on
the Initiative plan file page for users who have disabled it and want it back.
e Update the current period — Use this setting to update the current month and year displayed at
the top right of most Axiom Strategy Management pages.

Change default system names

System Settings control default names for the main strategic entities in Axiom Strategy

Management: Perspective, Objective, and Initiative. You can change these to something else when your

system is initially set up and configured. For example, you could change “Perspective” to “Pillar.”

IMPORTANT: To avoid data integrity problems, do not change system names once they are being
used, and the named items have attached data in the system. You should reset names only once,
and at the time Axiom Strategy Management is first set up.

To change a default name:

1.
2.
3.

Administrator's Guide

In the Navigation panel, click Admin > Settings.
On the Settings page, click the System Settings tab if it is not already selected.
In the field for the name to change, delete the old name and then type the new one.

Click Save.
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Update the current period

Throughout Axiom Strategy Management, you and other users interact with the system during a span of
time referred to as the current period. The current period displays at the top right of the main Axiom
Strategy Management pages.

The system administrator updates the current period when it is time to roll to the next period. The
month used as the current period depends on your organization’s fiscal schedule.

( \
IMPORTANT: Axiom Strategy Management uses measure data for the current period when

calculating performance. Be aware that using an open fiscal period may cause the performance of
some items to be inaccurately represented if measure data for those items has not been entered for
the current period. We recommend using the most recent completed, closed fiscal period, if
possible, so that the KPI icons accurately reflect the performance of your Perspectives, Objectives,

and Initiatives.
\\ J

NOTE: Other Axiom software products may have their own defined current periods. As used here,
the current period applies to the Axiom Strategy Management system.

To update the Axiom Strategy Management current period:

1. Ensure that all measure data has been recorded and, if applicable, approved, for the period you
are rolling from.

2. Inthe Navigation panel, click Admin > Settings.
3. On the Settings page, click the System Settings tab if it is not already selected.

4. Below the default name settings, from the SM Current Period drop-down, select the month and
year. You can also search for the month and year by typing the month in the Type to search field.
Add a comma after typing the name of the month, to view available years.

5. Click Save.

Enable or disable the Initiative Overview tab

In Initiative plan files, the Overview tab is enabled by default. Initiative creators and other users who
have access to Initiative plan files in the Web Client can disable the Overview tab that provides
instructions on creating Initiatives. If, however, a user wants to re-enable the tab, there is currently no
way for the user to do that in Initiatives plan files. As system administrator, you can re-enable the tab
for any user.

To enable or disable the Initiative Overview tab:
1. Inthe Navigation panel, click Admin > Settings.

2. On the Settings page, click the User Preferences tab.
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When an Enable Overview tab setting is set to On, the user can see the Overview tab; when it is
set to Off, they cannot:

System Settings  User Preferences
Enabled  User

Enable Overview tab on the Initiatives page

Oon . Carl Cowgur

Off Charlie Credit

Off | Chris Sparks

On . Haolly Williams
on - Gloria Jackson
On . Howard Burns
on . Jeff Sergeant
On . Jay Spence

User Preferences tab showing which users have enabled/disabled the Initiative Overview tab

3. Click the Enabled toggle to On.

4. Click Save.

The next time the user visits the Initiatives page, the Overview tab will display. If it is not, ask the user to
refresh the page.
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Maintaining the strategy hierarchy

During initial setup of Axiom Strategy Management, your Syntellis consultant adds default data and sets
up any existing Perspectives and Objectives. Your system will require some additional configuration, and
you will need to regularly perform maintenance tasks. See the following topics for information and
instructions.

Maintaining Perspectives — Add, enable, disable, or change the active period for Perspectives.
Maintaining Objectives — Add, enable, disable, or change the active period for Objectives.

Maintaining Initiatives— Bulk import Initiatives, reset updated Initiatives to Active Tracking, and
maintain opportunities and resourcing used in creating Initiatives.

Delete aborted Initiatives — Remove aborted Initiatives from the system, including from all related
data tables.

For information on maintaining measures and related data, see About maintaining measures.

Maintaining Perspectives

Axiom Strategy Management comes with default Perspectives that you can either use as-is, edit to suit
your organization’s needs, or delete from the system. You can also add new Perspectives. After you set
up Perspectives, the only maintenance they require is enabling or disabling based on their Period Begin
and End dates. Measures applied to enabled Perspectives do require regular updating.

» Add a Perspective

Setting up a Perspective involves creating the Perspective and then adding at least one measure to it to
track its performance during its active period.

To add a new Perspective:

1.
2.
3.

In the Navigation panel, click Admin > Maintenance.
On the Maintenance page, click the Perspectives tab if it is not already displayed.
On the left side of the page under the Description column heading, click Add New Perspective.

In the Add New Perspective dialog, do the following:

a. Inthe Description field, type a name for the Perspective.
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NOTE: This field has a 150-character limit.

b. To enable the Perspective, click the Enabled toggle to On.

NOTE: Disabled Perspectives cannot be selected for Objectives, nor will they display on
the Dashboard.

c. Inthe Begin Period drop-down, select the start date.
d. Inthe End Period drop-down, select the end date.
e. Click OK.

5. (Optional) Select an icon for the Perspective: In the Icon column for the new Perspective, type or
paste the code for the new icon. For instructions on how to get more icons, see Get Perspective
icons.

NOTE: You cannot change the color of Perspective icons.

6. Click Save.
7. Add a Perspective measure.

8. Add an Objective.

» Edit or delete a Perspective

After Perspectives are set up, you probably will not need to edit them except to enable or disable them,
or change their active period.

Edit tasks can include:

e Activating a Perspective that is ready for use

e Disabling a Perspective that is no longer in use or that is not ready for use
e Changing Period Begin and End dates

e Changing the Perspective icon

¢ Changing the Perspective name

¢ Deleting a Perspective that was created in error or never used or is not being used by an
Objective

To edit a Perspective:
1. In the Navigation panel, click Admin > Maintenance.

2. Click the Perspectives tab if it is not already displayed.

3. Do any of the following as needed:
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e To activate a disabled Perspective, click the Enabled toggle to On.
e To disable a Perspective, click the Enabled toggle to Off.

¢ To change the Period Begin and Period End dates, select the desired date from the drop-
down lists.

NOTE: Be aware of how any associated Perspective measures are affected by a time
frame change, and edit those as well where needed.

e To change the icon, in the Icon column, type or paste the code for the new icon. For
instructions on how to obtain icon codes, see Get Perspective icons.

e To change the Perspective name, type the new name in the Description field.

NOTE: A name change will be reflected everywhere the Perspective name is used in
the system, including historical reports. The exception is when the name appears in
snapshots.

* To delete a Perspective that was created in error or never used and has no attached data,
Objectives, or Initiatives, click the check box to the left of the Description field. The
Perspective is deleted after you save your changes.

4. Click Save.

Maintaining Objectives
Like Perspectives, you can enable or disable Objectives and assign measures to them. Objectives are tied
to a period of activation during which the measure associated with the Objective can collect data. Each

Objective must be associated with a single Perspective. Objectives usually have associated Initiatives,
although this is not required.

Admins manage Objectives from the Objective tab on the Admin Maintenance page. In addition to
listing all Objectives in the system, this tab also lists Objectives associated with a disabled Perspective.

Add an Objective
By default, all enabled Objectives display on the Dashboard.

To add a new Objective:

1. In the Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click the Objective tab.
3. On the left side of the page under the Description column heading, click Add New Objective.

4. Inthe Add New Objective dialog, do the following:
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a. Inthe Description field, type a name for the Objective.

NOTE: The Description field has a 150-character limit.

b. To enable the Objective, click the Enabled toggle to On.

NOTE: Disabled Objectives do not display on the Dashboard and cannot be associated

with Initiatives.

c. From the Perspective drop-down, select the Perspective to associate with this Objective.

This step is required before you can save the Objective.
d. Inthe Begin Period drop-down, select the start date.

e. Inthe End Period drop-down, select the end date.

f. If the Objective owner is someone other than yourself, then from the Owner drop-down,

select the desired user.

NOTE: By default, the person creating the objective is listed as the owner.

g. Click OK. The measure is added to the end of the Objective measure list.

5. Add a measure to the Objective.

Edit or delete an Objective

Edit tasks can include:

Activating an Objective that is ready for use

Disabling an Objective that is no longer in use or that is not ready for use
Changing the Objective name

Changing the Period Begin and End dates

Changing the Objective owner

Changing the associated Perspective (not recommended)

Deleting an Objective that was created in error or never used and has no associated data

To edit or delete an Objective:

In the Navigation panel, click Admin > Maintenance.

2. On the Maintenance page, click the Objectives tab.

3. Do any of the following as needed:

Administrator's Guide

e To activate a disabled Objective, click the Enabled toggle to On.
e To disable an Objective, click the Enabled toggle to Off.
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e To change an Objective name, in the Description field, type the new name.

NOTE: A name change will be reflected everywhere the Objective name is used in the
system. This is useful if you discover a typo or if you want to distinguish the name from
another similarly-named Objective.

e To change the Period Begin and Period End dates, select the desired date from the drop-
down lists.

NOTE: Be aware of how any associated Objective measure frequency periods are
affected by a time frame change, and edit those as well where needed.

* To change the associated Perspective, select the desired Perspective from the Perspective
drop-down.

IMPORTANT: If you change the Perspective to which an Objective is associated and
that Objective has accrued historical data, all the historical data will move to the new
Perspective.

e To change the Objective owner, in the Owner field, select a different user from the drop-
down.

e To delete an Objective that was created in error or never used and has no attached data or
Initiatives, click the check box to the left of the Description field. The Objective is deleted
after you save your changes.

4. Click Save.

Maintaining Initiatives
As system administrator, you maintain some of the elements used in creating Initiatives as well as

resetting Initiatives to the active stage after their measure data has been updated and approved each
fiscal period. You may also need to import a file of Initiatives.

Maintenance tasks for Initiatives include:

e Maintaining opportunities used in creating Initiatives
e Maintaining resources used in creating Initiatives

e Resetting Initiatives to active tracking status

e Importing Initiatives in bulk

e Creating Initiatives from Capital Planning data

e Deleting aborted Initiatives

¢ Updating Initiative measure data — The Initiative owner typically updates Initiative data, but if you
ever need to, use these instructions.
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Maintaining opportunities

You can use opportunities as guides in the Initiative creation and approval process. Initiative creators
are prompted to answer the opportunity questions to show how the Initiative they are submitting aligns
with the Objective and Perspective (or other Initiatives), with which it is associated. When reviewing an
Initiative for approval, approvers can also read these questions and answers to help them evaluate the
Initiative. Currently, responding to opportunity questions is not mandatory for Initiative creators.

Add an opportunity

Keep opportunity questions broad enough to fit any Initiative because enabled opportunities are
available during the Initiative creation process for all Initiatives.

To add an opportunity:

1. In the Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click the Opportunities tab.
3. On the left side of the page under the column headings, click Add Opportunity.

4. Inthe Add Opportunity dialog, do the following:

a. Inthe Description field, type a question that you want an Initiative creator to consider
when creating an Initiative.

NOTE: The Description field has a 150-character limit. The number of characters used
displays to the right of the field. You can see how many characters you have used by
clicking on a blank area outside the field.

b. To activate the opportunity, click the Enabled toggle to On.
c. Click OK.

5. Click Save.
Edit or delete an opportunity
Editing tasks can include:

¢ Changing the opportunity text
e Enabling an opportunity
e Disabling an opportunity so it does not display in Initiative plan files

e Deleting an opportunity that was created in error or never used

To edit or delete an opportunity:

1. Inthe Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click the Opportunities tab.

3. Do any of the following as needed:
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e To activate a disabled opportunity, click the Enabled toggle to On.
e To disable an opportunity, click the Enabled toggle to Off.

NOTE: If you disable an opportunity, the opportunity no longer displays in the
Opportunities tab for any Initiative plan file.

e To change the text, in the Description field, delete the text you do not want, and type the
new text.

IMPORTANT: Be aware that the text will change for this opportunity in all Initiative
records.

e To delete an opportunity, click the check box to the left of the Description field. The
opportunity is deleted when you save your changes.

NOTE: You cannot delete an opportunity that is currently enabled or that is in use by a
record. If you cannot delete an opportunity, an error message displays with an
explanation.

4. Click Save.

Maintaining resourcing

Resourcing ensures that whenever an Initiative requires a certain resource, the need for that resource is
communicated to the right people so they can be sure it is available when needed. Enabled resources
are available for selection in all Initiatives.

Add a resource

To add a resource:

1.
2.
3.

5.
6.

In the Navigation panel, click Admin > Maintenance.
On the Maintenance page, click the Resourcing tab.
On the left side of the page under the column headings, click Add Resource.

In the Add Resource dialog, type a name for the resource in the Resource field.

NOTE: The Resource field has a 150-character limit. The number of characters entered
displays to the right of the field after you save.

To activate the resource so Initiative creators can use it, click the Enabled toggle to On.

Click OK.

Edit or delete a resource

Edit tasks can include enabling, disabling, deleting, or changing the description of a resource.
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To edit or delete a resource:
1. In the Navigation panel, click Admin > Maintenance.

2. On the Maintenance page, click the Resourcing tab.

3. Do any of the following as needed:
e To activate a disabled resource, click the Enabled toggle to On.
e To disable a resource, click the Enabled toggle to Off.
e To change the description, replace the text in the Description field.

NOTE: Changing the Description affects all the records in which the resource appears,
so unless the change is to correct a typo or improve the phrasing, do not re-purpose a
resource; instead, disable it and create a new one.

e To delete a resource, click the check box to the left of the Description field. When you save
changes on this page, the resource is deleted.

NOTE: Do not delete a resource that is currently in use by an Initiative or that is
attached to historical data. It is better to retire (disable) the resource instead.

4. Click Save.

Reset Initiatives to active tracking

The Initiative update review process requires the system administrator to reset Initiatives back to the
active tracking stage after the Initiative sponsor approves the updates made by the Initiative owner for
the current period. Resetting Initiatives enables them to be updated during the next current period.

To reset Initiatives to active tracking status:
1. In the Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click the Process Step tab.

3. Inthe Initiative Pending Reset section on the right, review the listed Initiatives to be sure they
are all ready to be reset.

4. If an Initiative does not belong in the list:
a. Inthe Navigation panel, click Initiatives.

b. On the Initiatives page, click the bookmark icon (™) to the left of the Initiative.

c. On the Initiative routing page, click Reject to reject the current step (Step 7) and send the
Initiative back to the previous step.

d. On the Process Step tab of the Maintenance page, in the Initiative Pending Reset section,
click the refresh button and verify that the Initiative that did not belong is not in the list.

5. Click Submit.
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6. Click Save.

Import Initiatives in bulk

Axiom Strategy Management can contain as many Initiatives as your organization needs. Since there is

the potential to have hundreds of Initiatives, we provided a means for system administrators to import
Initiatives in bulk. You can manually enter Initiative information to the system, where the Initiatives can
be processed into the system for immediate use.

To import Initiatives in bulk:

1.
2.
3.

10.
11.

Review the requirements in the following Requirements table.
Launch the Desktop Client.

If the Explorer task pain is not open, in the Main tab of the ribbon, click Navigation, and select
Explorer.

In the In the Libraries section of the Explorer task pain, expand the Table Library and then expand
IDimensions.

Scroll down to and double-click Initiative.
In the Open Table in Spreadsheet dialog, click OK.

In the Initiative spreadsheet, scroll down to the first blank row. Add information starting with the
Description column.

NOTE: Do not add a number in the first column; the system will add the number after you
save the spreadsheet.

In the Main ribbon tab, click Save.
In the Web Client Navigation panel, click Admin > Maintenance.
On the Maintenance page, click the Import tab.

Click the Process Plan Files button to integrate the imported Initiatives into active tracking.

Requirements

Before you begin, you need the following information for each Initiative. The fields are either required
or need to contain information to avoid data displaying incorrectly in some forms.

Data field Description Lookup location
Description Text Initiative name NA
LongDesc Text Detailed description NA

of Initiative

Administrator's Guide Axiom Strategy Management | 56



Data field

Objective

Department

Owner

OwnerName

Sponsor

SponsorName

Status

Workstream

Category

Active

Archived

Administrator's Guide

Format

Number

Number

Username
First name,
Last name
Username
First name Last

name

Number

Number

Number

TRUE/FALSE

TRUE/FALSE

Description

Objective to which
the Initiative belongs

Department the
Initiative applies to, if
applicable;
otherwise, enter “0”
for None

User who owns the
Initiative

Full name of user

User who sponsors
the Initiative

Full name of user

Enter O because at
this point, the
milestones do not
have status yet.

Workstream for
Initiative, if
applicable;
otherwise, enter “0”
for None

Select a category for
the Initiative;
otherwise, enter
”0” for None

Whether the
Initiative is currently
active

Whether the
Initiative is currently
archived

Lookup location

Table Library>
Dimensions> Objective

Table Library >
Dimensions > DEPT

Security Manager

Security Manager

Security Manager

Security Manager

Table Library >
Strategy Management
> Data > Status

Table Library >
Strategy Management
> Data > Workstream

Table Library >
Strategy Management
> Data >
InitiativeCategory

NA

NA
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Data field Format Description Lookup location

InitiativeTemplate Text Template used to File Groups > Strategy
build the Initiative; Management —
SM Main if created in Requests\Templates
Axiom Strategy
Management

InitiativeShowOnColumn TRUE/FALSE Enter “TRUE” to NA
ensure a plan file is
created for the
Initiative when the
administrator uses
the Import utility.

InitiativeRequestor Username User who created the  Security Manager
Initiative

IMPORTANT: Do not
leave the
InitiativeRequestor
field blank because
this could cause
unintended data
issues.

InitiativeRequestComment text Comment added by Optional
requestor in
Comment field of
Generate a New
Initiative Request
form

InitiativeSource SM (or other) Indicates Axiom NA
product in which
Initiative request
originated. Enter
“SM” for Strategy
Management;
otherwise, enter
code for other
integrated product,
such as Comparative
Analytics (CompA)
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Data field Format Description Lookup location

InitiativeRequestorName text Full name of the NA
person who
requested the
Initiative.

Create Initiatives from Axiom Capital Planning data

Axiom Strategy Management administrators can create Initiatives from imported Axiom Capital Planning
data for Axiom Strategy Management systems integrated with Axiom Capital Planning.

The Axiom Capital Planning integration utility on the Admin Maintenance page steps you through the
process of creating Initiatives from imported Axiom Capital Planning data.

You need the following to use this utility:

e An Axiom Strategy Management system integrated with Axiom Capital Planning, with active
licenses for both

NOTE: Currently, integration is supported only in the Web Client.

¢ SM Admin role and the Initiative Creator role

e Any Axiom Capital Planning role

NOTE: The individual CapRegs that are visible to you depend on existing Axiom Capital Planning
security.

To create Initiatives from Axiom Capital Planning projects:
1. In the Navigation panel, click Admin > Maintenance.

2. On the Maintenance page, click the Integration tab.
3. On the Integration tab, click the Capital Planning utility button.

4. From the Select Source File Group drop-down, select the desired Capital Planning year, and then
click Next.
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Capital Project Integration Utility

O Use this wtility to create Initiative pian files in Strategy Managerment based an the selected plan files in Capital Planning File Groups

Select Source File Group: Select... v
CapitalPlanning-2019 (Prior Year)
CapitalPlanning-2020 (Current Year)
CapitalPIanning-2&1 {(Mext Year)

5. From the File Group list, select the desired Capital Requisition, and then click Submit.

IMPORTANT: You need to have YRMO records for all of the OrigBudget years in which your
projects run.

Notice that there is a Project Target column. The system uses the amount in this column as the
new Initiative’s Target.
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Strategy Management

Capital Project Integration Utility

Source File Group: CapitalPlanning-2019 (Current Year)

CAPRE... En... Dept Description ProjType ProjTypeDetail Creator Project Target

Acquisition, SW MUB

12 2 21010 ) Miscellaneous Acquisition SFalkner $1,951,000
Acquisition
General Construction, Third

13 2 26440 Engineering / Facilities General Construction CYates $1,876,000
Floor NICU
General Renovation, OR

14 2 27640 Engineering / Facilities General Renovation JHudson $1,000,000

Remodel

General Construction, Sleep
Lab Expansion

Engineering / Facilities General Construction GChambers $1,125,000

General Construction, New
17 2 27400 X Engineering / Facilities General Construction Sjackson $14,250,000
Cardiac Center

Defibrillator / Pacemaker,
19 2 26140 X Cardiology Defibrillator / Pacemaker MErving $64,500
Defibrillators for ED

20 2 26140 Monitor, Vital Signs Monitors ~ Miscellaneous Monitor MErving $22,000
Monitor, Transport Monitor _ -
22 1 26310 Miscellaneous Monitor Fwilliams $20,000
for Patient Sedations -
4 »

Previous ® Submit

6. Inthe Generate a New Initiative Request dialog, enter all required information. Note that you
must select a Frequency. Click Create Initiative. (For details, see “Create an Initiative” in the
online help.)

7. Inthe new Initiative’s plan file:
a. Complete the needed information in the rest of the tabs. For details, see “Create an
Initiative” in the online help.

b. Inthe Milestone/Measures tab, add any desired milestones.

c. Forthe new Initiative measure, be sure to add a Baseline. You can rename the Initiative
measure if desired. The Measure’s Start and End dates are based on the years in which the
CapReq runs.

d. To submit the Initiative for review and approval, click Submit.

Delete aborted Initiatives

Strategy Management system administrators can purge aborted Initiatives from the system using the
Delete Aborted Initiatives data utility.

Axiom Strategy Management is designed to house hundreds of Initiatives. Once an Initiative is
submitted for Owner approval, it begins to accrue a historical record. Each time an Initiative moves to
another stage in the approval process, reviewers and approvers can add comments that also become a
part of the historical record. Initiatives and their related data are stored in several data tables in the
system.
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Some Initiatives get aborted because they are not needed, are duplicates, were created in error, etc.
Initiatives can be aborted at two steps in the Creation Approval process: Step 4 — Committee Approval,
and Step 5 — Active Tracking. Initiatives must be terminated using the abort process at one of these
steps in order to be deleted using the Delete Aborted Initiatives data utility.

NOTE: Initiatives that have been denied should not be confused with aborted Initiatives, or
completed Initiatives.

To delete aborted Initiatives from the system:

1. In the Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click the Data Utilities tab.
3. Click the Delete Aborted Initiatives button.

4. Inthe Select aborted Initiative plan file(s) to be deleted dialog, do one of the following:
¢ For each Initiative to delete, select the check box to the left of the ID number.

¢ To delete all listed Initiatives, select the check box in the header row.

Select aborted Initiative plan file(s) to be deleted x
ID Initiative Owner Sponsor Current Step
47 B Sports center staff CT-Hwilliams CT-Hwilliams Active Tracking
48 Reduce physician turnover SDrew CCredit Committee Approval
50 B Phase 3 ED Triage program SKlein jseargent Committee Approva

5. Click Yes.
A small confirmation message displays at the bottom of the page:

| Event DeletePlanFile-SOL has been scheduled.

The utility removes the selected aborted Initiatives and any related data from the following tables:

¢ Initiative table

¢ InitiativeMilestoneData
e InitiativeMeasureData
¢ InitiativeMilestone

Administrator's Guide Axiom Strategy Management | 62



¢ |nitiativeMeasure
¢ |nitiativeResource
e |nitiativeOpportunity

Convert displayed user IDs to full names

In Owner and Sponsor columns in Initiative table grids on Axiom Strategy Management dashboard
pages, user IDs were displayed instead of full user names. In version 2021.2 of Axiom Strategy
Management, when you add a user to an Initiative as sponsor or owner, the user’s full name displays
instead of their user ID. However, user names added to Initiatives before version 2021.2 still display as
user IDs. Administrators can convert these user IDs to full names using the Admin data utility Update
User ID to Full Name.

To convert user IDs to full names:

1. In the Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click Data Utilities.
3. Inthe list of utilities, click the Update User ID to Full Name button.

4. If desired, verify that users’ full names are displayed on the Dashboard, Perspectives, Objectives,
and Initiatives pages where applicable.

Administrator's Guide Axiom Strategy Management | 63



Maintaining measures

Perspectives, Objectives, and Initiatives have associated measures that require initial set up and some
maintenance. Axiom Strategy Management comes with some built-in measures, including default
measure types and classes. For more information, see About measures.

About the Measures page

The Measures page contains a library of measures available for use in Perspectives, Objectives, and
Initiatives. You perform measure maintenance tasks from the Measures page, accessed from the Admin
menu in the Navigation panel. The exception is uploading measures in bulk, currently performed in the
Desktop Client.

Measures tab — Master list of all measures currently in the system. Perspectives, Objectives, and
Initiatives get their measures from this list. Information entered in this tab is stored in the Measure
table, accessible from the Desktop Client, and located in the Table Library under Dimensions >
Measure. The measures list contains hundreds of measures, but you can filter the list.

Type tab — Lists all the measure types available to use in measures. Information entered in this tab is
stored in the MeasureType table, located in the Table Library under Strategy Management > Data.

Class tab — Lists all the measure classes currently in the system. Axiom Strategy Management comes
preloaded with a number of measure classes commonly used in the healthcare industry. For example,
we have included frequently-used groups as defined by the U.S. Centers for Medicare & Medicaid
Services (CMS) and by the Hospital Consumer Assessment of Healthcare Providers (HCAHPS). This
information is stored in the Class table located in the Table Library under Strategy Management > Class.

Perspective Measure — Lists all Perspectives and the measures associated with each, including Period
Begin and Period End dates, Baseline, Target, Department (optional), and Entity (optional).

Objective Measure — Lists all Objectives and their associated measures, including Period Begin and
Period End dates, Baseline, Target, Department (optional), and Entity (optional).

Drill Documents — Lists drill-down documents available for linking to measures, and provides function
for adding new drill documents. These documents typically contain details on the associated measure
data, and can provide supporting information and additional details about where and how the measure
data was derived.
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Update Measure Data — Launches the Measure Update web input form used for updating measure
data.

Measure maintenance tasks

By default, measures are set to require maintenance on a monthly/current period basis.
Click the following links for instructions on each task:

e Find a measure in the list (filtering measures)
e Add a measure

e Edit a measure or delete an unused measure
e Maintain measure types

e Maintain measure classes

e Update measure data

e Maintain Perspective measures

¢ Maintain Objective measures

e Create measure data rows

e Delete orphaned measure data

¢ Update measure target status

e Update period measure data

e Add a benchmark to a measure

e Managing measure drills

e Create a measure drill

e Edit or delete a measure drill

Filter the Measures list

Axiom Strategy Management can contain hundreds of measures listed under the Measures tab on the
Measures page. You can filter the list to find the measure you want.

NOTE: These instructions assume you are already on the Measures tab of the Admin Measures page.

To filter the Measures list:
1. From the Class Filter drop-down, select one of the following:
e |If you know the class the measure belongs to, select the class.

e If you do not know the class the measure belongs to, select All.

2. Do one of the following:
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e To search for enabled measures only, verify that the Filter Disabled toggle is set to On.

e To search for enabled and disabled measures, click the Filter Disabled toggle to Off.

3. Inthe Search field, click near the middle to activate it, and then type a word or two to search on,
and press Enter.

The search returns all measures that match your search terms.

NOTE: If a measure name is too long to be displayed in full, hover your cursor over the name
to see the full name in a tool tip.

4. To clear the search field for a new search, click the small x icon to the right of the Search field,
and repeat steps 1 through 3.

Add a measure

System administrators can add measures to the main measures list.

To add a measure to the main Measures list:

1. In the Navigation panel, click Admin > Measures.
2. Onthe Measures page, click the Measures tab if it is not already selected.
3. On the left under the Description column heading, click Add New Measure.

4. Inthe Add New Measure dialog, do the following:
a. Inthe Description field, type a name for the measure. This field has a 150-character limit.

b. From the Precision drop-down, select the number of data places to include after the
decimal when measure data is displayed in Measure Details windows:

e 0 - No digits display after the decimal
e 1-0One digit displays after the decimal
e 2 - Two digits display after the decimal (default setting)

c. To enable the measure after saving it, click the Active check box.

d. From the Class drop-down, select a class for the measure.

e. From the GL Acct drop-down, select an account with which to associate this measure.
f. From the Favorable drop-down, select the MeetsTargetDirection for the measure.

g. From the Unit drop-down, select the type of unit that matches the data that the measure
collects:

¢ Number — Select for numeric measure data.
¢ Amount — Select for currencies.

* Percent — Select for percentages.
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h. From the Type drop-down, select the update method used to derive the measure:

e Calculated — Axiom software automatically calculates the measure data whenever a
query is made to the field.

e Integrated — The measure data comes from integrated Syntellis Axiom products.

¢ Input — The measure data is entered directly into Axiom Strategy Management from
an external source. This data may come from a form with data entered manually or
from input utilities.

NOTE: Currently, the Type field is for recording a description of the method used; it
does not set any action for the measure.

i. From the Frequency drop-down, select how often the measure is updated and reported.

IMPORTANT: Once you set a frequency for a measure and save it, you cannot change
the frequency. If the measure is unused and has accumulated no data, you can delete
it and start over. Otherwise, retire the measure by disabling it, and then create a new
one.

j. (Optional) In the Formula Description field, type a description of how the data is derived.
For example, if the measure is “Hours paid per patient day” then the formula would be
something like “Hours paid divided by Inpatient days” or “Hours paid / Inpatient days.”

e To associate this measure with a drill document, select the desired drill document
from the User Drill drop-down.

¢ To not associate this measure with a drill document, select 0 - No Selection from
the User Drill drop-down.

NOTE: Measures that have associated drill documents display a Launch Detail button in
their Measure Detail window.

5. Click OK.
6. Click Save.

Edit or delete a measure

The system administrator can edit and delete measures but there are some caveats. After a measure is
in use by a Perspective, Objective, or an Initiative, you should not need to edit it unless there is
something wrong with the description, formula description, or other attribute that you need to change
so that the measure works correctly. You cannot change a measure’s frequency. If the measure is
unused and has accumulated no data, you can delete it and start over. Otherwise, retire the measure by
disabling it, and then create a new one.

Editing a measure can include:
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¢ Changing the Description

e Enabling or disabling the measure

e Changing the Class

e Changing the GL Account

e Changing the Type (not recommended)
e Changing the Formula Description

e Adding or changing a User Drill

e Changing the decimal display precision

e Deleting the measure

To edit or delete a measure:

1. In the Navigation panel, click Admin > Measures.
2. Inthe Measures tab on the Measures page, locate the measure. Filter the list if needed.

3. Do any of the following, as needed:
¢ To enable the measure, click the Enabled toggle to On.
e To disable the measure, click the Enabled toggle to Off.

e To edit the measure name, in the Description field, type the new name or make
corrections to the existing name.

IMPORTANT: If you change a measure’s name (description), this also changes the
name in any historical records that have not been saved in static reports.

e To change the associated GL Account, from the GL Account drop-down, select another
account, or, to remove the affiliation with an account, click 0-Default ACCT. The field will
revert to the default text “Type to Search” after you save your changes.

e To change the class, from the Class drop-down, select the new class.

IMPORTANT: If you change a measure’s class, this also changes the class in any
historical records that have not been saved in static reports.

¢ To change the type, from the Type drop-down, select the new type.

IMPORTANT: If you change a measure’s type, this also changes the type in any
historical records that have not been saved in static reports.

e To change the formula description, in the Formula Description field, type the desired
information.

e To add a user drill for the measure, in the User Drill column, select the desired drill from
the User Drill drop-down.

e To change the number of values displayed after the decimal, from the Precision drop-
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down select the desired number.
e To delete a measure:
a. Verify that the measure is not in use and has no data records attached.

b. Select the check box at the left end of the measure row. The measure will be
deleted after you save changes.

4. Click Save.

Maintaining measure types

Measure types are the methodologies used to update and report measure data. Currently, the Type field
is for recording a description of the method used; it does not set any action for the measure.

Axiom Strategy Management comes with three measure types:

Calculated — Measure data is calculated automatically by Axiom software whenever a query is
made to the field.

Input — Measure data is entered directly into the system from an external source. You may input
data manually using forms or enter data in bulk using import utilities.

Integrated — Measure data comes from integrated Syntellis/Axiom products.

Measure types you add or edit from the Admin Measures page are stored in the MeasureType data

table.

Add a measure type

You can create additional measure types, if needed.

To add a measure type:

1.
2.
3.

In the Navigation panel, click Admin > Measures.
On the Measures page, click the Type tab.
Under the Description column, click Add New Type.

In the Add New Type dialog, type a description in the Description field. This field has a 150-
character limit.

To enable this type after saving, click the Active check box.
Click OK. The new type is added to the list of types.
Click Save.

Edit or delete a measure type

You can change the name and status of a measure type.
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IMPORTANT: Do not delete measure types that are used in other data tables because this could
cause orphaned data and lead to data integrity errors. Instead, it is better to disable the type so it
does not display in the Type selection drop-down. However, if you add a type and decide not to use
it, you can delete it as long as it has no attached data.

To edit or delete a measure type:

1.
2.
3.

In the Navigation panel, click Admin > Measures.
On the Measures page, click the Type tab.

For the type to edit, do any of the following as needed:
e To enable a disabled type, click the Enabled toggle to On.
e To disable a type, click the Enabled toggle to Off.
e To change the name, edit the text in the Description field.

e To delete a type that is not in use in any data table, click the check box to the left of the
Description field. The type is deleted when you click Save.

Click Save.

Maintaining measure classes

Measure classes allow you to categorize measures that have one or more common attributes so that
you can organize and manage them, and filter them in lists, reports, and Initiative plan files. A number of
default measure classes are included in Axiom Strategy Management. These were selected from
frequently-used groups defined by the U.S. Centers for Medicare & Medicaid Services (CMS), by the
Hospital Consumer Assessment of Healthcare Providers (HCAHPS), and from a large set of standard
financial metrics. You can use any of these, disable or delete the ones you do not want, and add your
own classes.

Measure classes you access from the Admin Measures page are stored in the Class reference table.

Add a measure class

To add a measure class:

1.
2.
3.

In the Navigation panel, click Admin > Measures.

On the Measures page, click the Class tab.

Under the Description column, click Add New Class.

In the Add New Class dialog, type a name in the Description field. This field has a 150-character
limit.

To enable this class after saving, click the Active check box.
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6. Click OK.

7. Click Save.

Edit or delete a measure class

You can enable and disable a measure class, change its name, or delete it. However, you should not
change the number assigned to the class by the system because the system uses these numbers in

reports.

P
IMPORTANT: Do not delete measure classes that are used in other data tables because this could

cause orphaned data and lead to data integrity errors. Instead, it is better to disable the class so it
does not display in the Class selection drop-down. However, if you add a class and decide not to use
it, or to remove any of the default classes that came with Axiom Strategy Management, you can
delete them as long as they have no related data in other data tables. The exceptions to this are the
performance improvement measure classes, which should not be deleted or renamed.

g

To edit or delete a measure class:
1. In the Navigation panel, click Admin > Measures.

2. On the Measures page, click the Class tab.

3. For the class to edit, do any of the following:
e To disable a class, click the Enabled toggle to Off.
e To enable a class, click the Enabled toggle to On.
e To correct an error in the class name, make the change in the Description field.

IMPORTANT: Be aware that changing the class name will change the name in all
historical records that have not been saved as static records and archived somewhere.

e To delete a class that has never been used and is not attached to any data, click the check
box to the left of the Description field. The class is deleted when you click Save.

4. Click Save.

Maintaining Perspective measures

Perspective measures are measures applied from the main measure list to Perspectives. Although the
system allows you to create Perspectives without applying measures, you cannot track Perspective
performance unless you do. After creating a Perspective, the next step is assigning it one or more
measures. The measures you assign depend on how your organization defines the Perspective and
which of its aspects you want to track.
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Perspective measures you add or edit from the Admin Measures page are stored in the Axiom Strategy
Management data table PerspectiveMeasure.

Add a measure to a Perspective

Generally, Perspective measures should be broader than those used for Objectives and Initiatives
because Perspectives are at the highest level in the strategy hierarchy. The further down the hierarchy
you go, the more specific the measures can be. For example, if your organization is a hospital and you
have a Perspective named Clinical Performance, you would want to assign a measure that returns broad
measure data, such as the Composite HCAHPS-Overall Hospital Rating.

To add a measure to a Perspective:

1. In the Navigation panel, click Admin > Measures.
2. Onthe Measures page, click the Perspective Measure tab.

3. Locate the Perspective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under the main tabs so you
can see only the Perspective names.

4. If the Perspective is collapsed, click the down arrow to the left of its name.
5. On the left under the Measure column, click Add New Measure.

6. Inthe Add New Measure dialog, do the following:
a. From the Measure drop-down, select the desired measure.

b. If you are tracking this measure at the department level, then from the Dept drop-down,
select the department.

c. If you are tracking this measure at the entity level (such as a clinic, hospital location,
medical group, etc.), or if you selected a department in the previous step, from the Entity
drop-down, select the entity.

d. Inthe Period Begin drop-down, select the month and year for the measure to be active.
e. Inthe Period End drop-down, select the month and year for the measure to be inactive.

f. In the Baseline field, enter the baseline number to use as the data measurement starting
point.

g. Inthe Target field, enter the target number to use for comparing with data generated by
the measure.
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NOTE: When setting the Target, be sure you know which direction from the target
(higher or lower) is favorable and which is unfavorable for the measure. You can look
this up in the Measure table: launch the Desktop Client, open the Explorer task pane,
then expand Libraries > Table Library > !Dimensions > Measure. Locate the measure in
the table and then scroll horizontally to the last column, MeetsTargetDirection.

h. Click OK.

7. Click Save.

8.

Run the following utilities in this order:

e Create Measure Data to create the measure data rows for each period in the measure’s
lifecycle.

e Update Period Measure Data
e Update Measure Target Status

( IMPORTANT: To avoid data errors, run the utilities. The order is important: )
1. Create Measure Data

2. Update Period Measure Data

3. Update Measure Target Status

(The utilities are not listed in the correct execution order on the Admin Maintenance page.)

\

Edit or delete a Perspective measure

You can change the period dates, baseline, and target data for a Perspective measure. You cannot
delete a Perspective measure if it is in use or has data attached. If you want to disable a Perspective
measure, you must disable it in the Measures tab.

To edit or delete a Perspective measure:

1.
2.
3.

In the Navigation panel, click Admin > Measures.
On the Measures page, click the Perspective Measure tab.

Locate the Perspective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under the main tabs so you
can see only the Perspective names.

If the Perspective is collapsed, click the down arrow to the left of its name.

For the desired Perspective measure, do any of the following as needed:
e To change the Period Begin date, click the Period Begin drop-down, and select the desired
date.
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e To change the Period End date, click the Period End drop-down, and select the desired
date.

NOTE: If you shorten the measure’s time frame, after saving your changes, run the
Delete Orphan Measure Data utility to remove target data associated with unused
future time periods.

¢ To change the Baseline number, click in the Baseline field, and change the number.

e To change the Target number, click in the Target field, and change the number.

IMPORTANT: The change may be reflected everywhere the Perspective measure is
used, including any historical records that have not been preserved as static reports.

NOTE: Currently, when you change the target number, you must manually update the
target in any data rows for future periods in the measure’s active period. The Create
Measure Data utility does not update existing rows.

¢ To delete the Perspective measure:

a. Verify that it can be deleted: if there is a check box to the left of the Perspective
measure name, it can be deleted. If there is a circle with a slash through it (O)
instead of the check box, you cannot delete the Perspective measure.

b. Select the check box to the left of the measure name. The measure is deleted when
you save changes.

6. Click Save.

Maintaining Objective measures

Objective measures are measures applied from the main measure library to an Objective so that you can
track the performance of the Objective. You can apply as many measures as you like but the number
used depends on how you define the Objective and which of its aspects you want to measure. For
example, for an Objective named “Improve Patient Access,” you could add a measure that assesses the
average time it takes a patient to get scheduled for a primary care visit.

Objective measures you add or edit from the Admin Measures page are stored in the Strategy
Management data table Objective Measure.

Add a measure to an Objective

Measures applied to Objectives should be more specific than measures applied to Perspectives.
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To add a measure to an Objective:

1. In the Navigation panel, click Admin > Measures.
2. On the Measures page, click the Objective Measure tab.
3. Locate the Objective in the list.
TIP: If the list is expanded, click the Collapse All link on the left under the main tabs so you
can see only the Objective names.
4. If the Objective is collapsed, click the down arrow to the left of its name.
5. On the left under the Measure column, click Add New Measure.
6. Inthe Add New Measure dialog, do the following:
a. From the Measure drop-down, select the desired measure.
b. If you are tracking this measure at the department level, then from the Dept drop-down,
select the department.
c. If you are tracking this measure at the entity level (such as a clinic, hospital location,
medical group, etc.), or if you selected a department in the previous step, then from the
Entity drop-down, select the entity.
d. Inthe Period Begin drop-down, select the month and year for the measure to be active.
e. Inthe Period End drop-down, select the month and year for the measure to be inactive.
f. Inthe Baseline field, enter the baseline number to use as the data measurement starting
point.
g. Inthe Target field, enter the target number to use for comparing with data generated by
the measure.
NOTE: When setting the Target, be sure you know which direction from the target
(higher or lower) is favorable and which is unfavorable for the measure. You can look
this up in the Measure table: launch the Desktop Client, open the Explorer task pane,
then expand Libraries > Table Library > !Dimensions > Measure. Locate the measure in
the table and then scroll horizontally to the last column, MeetsTargetDirection.
h. Click OK.
7. Click Save.

8. Run the following utilities in this order:

¢ Create Measure Data to create the measure data rows for each period in the measure’s

lifecycle.

e Update Period Measure Data

e Update Measure Target Status
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( N\
IMPORTANT: To avoid data errors, run the utilities. The order is important:

1. Create Measure Data

2. Update Period Measure Data

3. Update Measure Target Status

(The utilities are not listed in the correct execution order on the Admin Maintenance page.)

\.

Edit or delete an Objective measure

You can change the period dates, baseline, and target data for an Objective measure. You cannot delete
an Objective measure if it is in use or has data attached. You also cannot enable or disable an Objective
measure.

To edit or delete an Objective measure:
1. In the Navigation panel, click Admin > Measures.

2. Onthe Measures page, click the Objective Measure tab.

3. Locate the Objective in the list.

TIP: If the list is expanded, click the Collapse All link on the left under the main tabs so you
can see only the Objective names.

4. |If the Objective is collapsed, click the down arrow to the left of its name.

5. For the desired Objective measure, do any of the following as needed:
e To change the Period Begin date, click the Period Begin drop-down, and select the desired
date.

¢ To change the Period End date, click the Period End drop-down, and select the desired
date.

NOTE: If you shorten the measure’s time frame, after saving your changes, run the
Delete Orphan Measure Data utility to remove target data associated with unused
future time periods.

e To change the Baseline number, click in the Baseline field, and change the number.

¢ To change the Target number, click in the Target field, and change the number.

IMPORTANT: The change may be reflected everywhere the Objective measure is used,
including any historical records that have not been preserved as static reports.
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NOTE: Currently, when you change the target number, you must manually update the
target in any data rows for future periods in the measure’s active period. The Create
Measure Data utility does not update existing rows.

e To delete the Objective measure,

a. Verify that it can be deleted: if there is a check box to the left of the Objective
measure name, it can be deleted. If there is a circle with a slash through it (O)
instead of the check box, you cannot delete the Objective measure.

b. Select the check box to the left of the measure name. The measure is deleted when
you save changes.

6. Click Save.

Add a benchmark to a measure

Axiom Strategy Management provides you the ability to add external benchmarks to Perspective,
Objective, and Initiative measure data, to help you evaluate how well these items are performing
relative to established bench-marked results from similar processes in other medical organizations that
are like yours.

System administrators can add benchmarks to Perspective measures, Objective measures, and Initiative
measures. Benchmarks are used and displayed in Measure Detail windows, such as in the following
example.
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Measure Detail X

6 - Labor Expense AWI Adjusted per Case

Current Period: JuLy 2018 Frequency: Monthly

Perspective123: Financial Health

Entity:

1 - KH Health System Dept: 10000 - EHS Balance Sheet

Methodology:

514,000
$12,000
$10,000
8,000
6,000
$4,000
2,000
50

Actual Target == Benchmark
Benchmark

Benchmark
$9,100.00

s - ke

Comment:

--- Select a chart series to see commentary ---

Measure Detail example showing monthly benchmark line (green dotted) with point marker displayed where cursor is hovered
over line

NOTE: This task is performed in the measure data tables from the Desktop Client.

To add a benchmark:

1.
2.

Launch the Desktop Client.
In the Main tab of the Ribbon, click Navigation > Explorer.

In the Libraries section, expand Table Library, then scroll down to and expand Strategy
Management > Data.

Double-click the desired MeasureData table (e.g., PerspectiveMeasureData,
ObjectiveMeasureData, InitiativeMeasureData).

In the Open Table in Spreadsheet dialog, click OK.

In the measure data table, locate the desired measure (listed by number, not name) and then
scroll to the Benchmark column titled Client-selected Benchmark value by month.
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Client-selected
Benchmark value

by month Calendar YTD Fiscal YTD Previous Period

Benchmark .| Benchmark CalYTD -  Benchmark FiscYTD .  Benchmark Prev| -
10200.00 0.00 0.00 0.00
11500.00 0.00 0.00 0.00

0.00 0.00 0.00 0.00

0.00 0.00 0.00 0.00

9500.00 0.00 0.00 0.00
10200.00 0.00 0.00 0.00
9100.00 0.00 0.00 0.00
10200.00 0.00 0.00 0.00

0.00 0.00 0.00 0.00

0.00 0.00 0.00 0.00

7. For each month that you want to provide a benchmark, enter the number in the column for that
month.

8. In the Ribbon’s Main tab, click Save.

9. Inthe Save to database completed successfully confirmation dialog, click OK.

Managing measure drills

Axiom Strategy Management provides users the ability to drill down on a measure and see supporting
documentation by clicking a link in the measure’s Measure Detail window. Supporting documentation
can be anything from a report showing where the measure was derived or calculated, to a form or
spreadsheet with additional information.

As a system administrator, you can control and customize the reports and other documents that users
can drill to from a given measure. When you add a drill to a measure, the system adds a Launch Detail
button in the upper right corner of the Measure Drill window. Clicking the button launches the drill
document. Drill documents must be stored in the Drill folder accessible from the Desktop Client at
Libraries > Reports Library > Strategy Management Utilities > Drill. If the document is an Axiom web-
enabled report or form, it opens in the browser. If the document is another type of file, such as a PDF or
Excel spreadsheet, the system opens it from the Desktop Client in a separate window.

Create a measure drill

Use these instructions to add a document drill to a measure to create a drill down in the measure’s
associated Measure Detail window. Creating a measure drill involves three main steps: 1) add the drill
document to Strategy Management, 2) create a drill for the document, and 3) associate the drill with the
desired measure.
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To create a new document drill:
1. Inthe Desktop Client, place the drill document in the Drill folder:

a. Navigate to Libraries > Reports Library > Strategy Management Utilities > Drill.

b. Right-click the Drill folder and select Import Files.

- Strategy Management Utilities
o ]

] Home Py New »

» Utilities Report Wizard
3 System Files | | rt Fil
F Table Library T
1; Eaine Add to Favorites

¥ Filter |ibrary

c. Select the desired file and click Open.

2. Expand the Drill folder, right-click the file and select Copy document path to clipboard. You will
need to paste this path into the Add Drill Document dialog in step 6c.

= | Strategy Management Utilities
| Drill
D 01_Mavigation
@_] Initiative Sum by Date w Current Year Realization
(& Praductivity Detail Hours By Dept
=] Productivity Perfarmance-Hours

o
sarnple e
¥ i Home Page
b Test Open Read Cnly
b )y Utilities Document history...
b 44 System Files Cut
L WIP
Co
bl zASD =
& blank IS
D flowtest Delete
& testfor29711 Export
[ Table Ll_brar],.r i Copy shortcut to dlipboard
Ek'g Data Diagrams Lib - |
7 Filter Library Copy document path to clipboard m
&+ Task Panes Library Add to Favorites

_| Ribbon Tabs Library

In the Web Client, in the Navigation panel, click Admin > Measures.
On the Measures page, click the Drill Documents tab.

On the left under the Description column heading, click Add New Drill.

o v~ 0w

In the Add New Drill dialog, do the following:
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a. Inthe Description field, type a name for this drill.
b. To enable this drill immediately after creation, select the Active check box.

c. Inthe Drill Filepath field, paste the file path you copied in step 2.

Add New Drill
Description
Active
Drill Filepath itegy Management Utilities\Drill\Productivity Performance-Hours_xlsx Web Enabled
Example: \Axiom\Reports Library\Strateqy Management Utilities\Drill\Productivity Detail Hours By Dept xlsx

(To see how users access a drill document, see Drill on measure details.“Drill on measure
details” in the online help.)

d. If the drill document is an Axiom report or form, click the Web Enabled check box to
enable the form to open in the browser.

NOTE: Do not select the check box if the document is another type of file, such as a
PDF or Excel spreadsheet. The system opens these types of files from the Desktop
Client in separate window.

e. Click OK.
7. Click Save.

8. Next, assign this drill to the desired measure. Do one of the following:
e |If the measure does not currently exist, follow the instructions in Add a measure.

¢ |If the measure exists, navigate to the Admin - Measures page. In the Measures tab, locate
the measure. In the User Drill column for the measure, select the desired drill from the
drop-down. Click Save.

IMPORTANT: The drill document will be accessible for all hierarchy items that use the

associated measure, so be sure that the document applies to all instances in which the
measure is used or could be used. Alternatively, you can create a copy of the measure
and give it a specific name and then associate the drill only to that version.
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Edit or delete a measure drill

The system administrator can edit and delete measure drills; however, a measure drill cannot be
deleted if it is associated with a measure.

You can edit the following for a measure drill:

e Change the drill name
e Enable or disable the drill
e Delete the drill if it is not in use

NOTE: You cannot change the document associated with a drill. Instead, create a new drill for the
new document, then remove the old drill from any measures, and then delete the old drill. Assign

the new drill to the measure(s).

To edit or delete a measure drill:
1. In the Navigation panel, click Admin > Measures.

2. On the Measures page, click the Drill Documents tab.

3. Do any of the following, as needed:
¢ To change the name, type changes in the Description field.
e To enable / disable a drill, in the Enabled column, click the toggle to the desired state.
e To delete a drill:
a. Verify that it is not in use. If the drill is in use, remove it from all associated
measures.
b. Click the checkbox to the left of the drill name. The drill will be deleted when you
save your changes.

4. Click Save.

Update measure data

The Measure Update page enables you to update data for one or more Perspective, Objective, or
Initiative measures, in a convenient web form.
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Strategy Management

= ® F T 7
Click the buttons to \
v Measure Filters

collapse / expand all r ~ v [ Editin Spreadsheet
Select Measure data to update measures N
§ T Click to view measure detail tﬂi“ ‘CHck.to edit page data I
Initiative — i in a simple spreadsheet | resuts

Select a Objective . I oo -
~ [l 871 Operating Income nvest Capital Strategically in Support of Business & Financial Goals
- Invest Capital Strategically .. v
- KH University 0- Default Jan-2019 $8,500,000.00 $8,555,945.00

~ Department Filters

Click to expand / collapse
Select an Entity . .
Choose a value for ENTITY. . individual items nvest Capital Strategically in Support of Business & Financial Goals

Selecta Department - KH University 0-Defauft Jan-2019 $5,000,000.00 $5,123983.22

Enter measure
Jan2019 ss0q  datainthe
Results field

Choose a value for DEPT. v Click the item name to

view the item page (e.g.,
Perspectives, Objectives,
Initiatives)

+ Period Filters ~ [l 873 GrossRevenue nvest Capital Strategically in Sf

Selecta Period filter
All available periods

@ Curent Period (January 2019)
Individual period

- KH University 0-Default

Apply Clear all Cancel

Measure Update page example
To update measure data:
1. Inthe Navigation panel, click Admin > Measures.
2. Onthe Measures page, in the header, click the Update Measure Data button.
The Measure Update page opens.

3. Open the Filters panel: in the header menu above the navigation panel, click the Filters icon.

Y| & F

4. Inthe Measure Filters section, from the Select Measure data to update drop-down, select the
type of measure to update.

The type of measure you select here determines the options available in the next drop-down. For
example, if you select Perspective, the next drop-down will contain a list of Perspectives.

5. To update a measure for a specific Perspective, Objective, or Initiative, in the Select a [item]
drop-down, select the desired item. Otherwise, leave this field blank to update all measures for
that item type.

6. If the measure is associated with a specific entity or a department within an entity, in the
Department Filters section, select the entity and then the department from the corresponding
drop-downs.

7. Inthe Period Filters section, select one of the following as applicable:
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8.

10.
11.
12.

e All available periods — Returns all records for all periods that have that kind of data. For
example, if you are updating Objective measure data, the system returns all Objective
measure records.

e Current Period — Returns all records that have that kind of data for the current period.

¢ Individual period — Select the desired period from the drop-down.
Click Apply.

The filtered measures display in the Measure Update page.

TIP: To see the detail for a measure, click the graph icon (! ) to the left of the measure name
at the top of the Measure column. If the measure has multiple entity or department
combinations, a pop-up dialog prompts you to select the entity/department to view.

For information on viewing related drill data (if applicable), see ”Drill on measure details” in
the online help.

To update a measure, click the Results field and type the value, then press Enter.
When finished updating values, click Save.
In the Axiom Software prompt, click OK.

To ensure that the posted values update for reports that use period measure data (such as the
Cost Reduction Status report), run the following utilities in the following order:

» Create measure data rows

e Update period measure summary data

e Update measure target status

Create measure data rows

The Create Measure Data utility allows system administrators to automatically create measure data
rows for hierarchy items.

» About the Create Measure Data utility

Users need to be able to view measure data targets in charts and reports for comparison and analysis
purposes, for each time period (frequency) set for a measure.

System administrators need to be able to set measure targets to respond to changing expectations.

To make this possible, the target needs to be set in each hierarchy item’s MeasureData table (i.e.,
PerspectiveMeasureData, ObjectiveMeasureData, InitiativeMeasureData) for each frequency period
that the hierarchy item measure is active. This means the Target field needs to be populated for future
time periods (months/quarters/half-years/years) according to the measure’s frequency.
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Instead of manually creating new rows for future frequency periods in the hierarchy item’s active period
and then entering the target data, the Create Measure Data utility automatically creates a row with the
set target for each frequency period through the end of the fiscal year for the length of the measure’s
active period (start date to end date).

For example, if an Objective measure starts on January 2018 and ends on December 2019, the utility
creates rows in the ObjectiveMeasureData table with the target column pre-populated for all YRMOs
from January 2018 to the end of the fiscal year in which December 2019 falls.

However, if a measure is quarterly, the utility creates a row for the end of each quarter for the lifespan
of the measure. So if the measure life span is one FY, the utility enters 4 rows. Likewise, for a semi-
annual frequency, a measure would have two rows for each FY, and a measure with an annual
frequency would have one row for the FY.

The following example shows a section from the ObjectiveMeasureData table for an Objective with
measure #853. The active period for that measure is outlined in red. The rows in the area outlined in
green are for future periods that have no measure data yet, but do have populated target data. Because
the measure has a monthly frequency and the measure lifespan is set at 18 months, there are 18 rows—
one for each month in the lifespan.

s

-4

4 Data Type Integer Integer Integer | Integer Integer 32 Numeric Numeric Numeric Boolean
5 String Length

Departme

6 Description Objective Measure nt Entity YRMO Value Target Score

r

8 Objectivi - Measuri v cht v Entit! v YRMC i Value ~ Tagtt - Scorn * Mntshrge hd
81 2 853 of o0 201801 1825 2500 | 0.00 TRUE
82 2 853 0 0 201802 23.50 25.00 0.00 TRUE
83 2 853 0 0 201803 21.02 25.00 0.00 TRUE
84 2 853 0 0 201804 17.65 25.00 0.00 TRUE
85 2 853 0 0 201805 19.73 25.00 0.00 TRUE
86 2 853 0 0 201806 19.85 25.00 0.00 TRUE
87 2 853 0 0 201807 24,29 20.00 0.00 FALSE
88 2 853 0 0 201808 18.40 20.00 0.00 TRUE
89 2 853 0 0 201809 20.18 20.00 0.00 FALSE
90 2 853 0 0 201810 0.00 20.00 0.00 TRUE
21 2 853 0 0 201811 0.00 20.00 0.00 TRUE
92 2 853 0 0 201812 0.00 20.00 0.00 TRUE
23 2 853 0 0 201901 0.00 20.00 0.00 TRUE
94 2 853 0 0 201902 0.00 20.00 0.00 TRUE
95 2 853 0 0 201903 0.00 20.00 0.00 TRUE
96 2 853 0 0 201904 0.00 20.00 0.00 TRUE
97 2 853 0 0 201905 0.00 20.00 0.00 TRUE
98 2 QB 0 0 21906 090 2%_ 0.00 TRUE
99 2 854 0 0 201701 198.89 210.00 0.00 TRUE
100 2 854 0 0 201702 225.45 210.00 0.00 FALSE

These prepopulated rows allow a system administrator to change the target for future time periods if
the measure’s data expectations require realignment.
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IMPORTANT: When you add a measure to an Initiative in the Initiative plan file page, data rows are
automatically created for each frequency period in the InitiativeMeasureData table when you save
the Initiative. If you want the target to be included in the data rows, you must add the target before
you save the Initiative.

When to run this utility:

e After adding a measure (with a set target) to a Perspective or an Objective

e After importing Initiatives that do not already have measure data rows for every period in their
measures’ active life cycles

NOTE: This utility only creates measure data rows with a populated target if they are missing; it does
not update a changed target.

To create measure target data rows:

1. In the Navigation panel, click Admin > Maintenance.
2. On the Maintenance page, click the Data Utilities tab.
3. Click the Create Measure Data button.

4. Click the Update Period Measure Data button to perform calculations for the CalYTD, FiscYTD,
PrevTD and Proj.TD measure columns.

5. Click the Update Measure Target Status button to update the target status in the newly created
data rows.

Update measure target status

The Update Measure Target Status utility automatically updates MeetsTarget column entries for all
measure data, based on the MeetsTargetDirection values set for each measure.

When you update measure data in the Web Client, the measure target status is automatically updated
as well. However, if you manually update measure data directly in a hierarchy data table—for example,
the PerspectiveMeasureData table—you would also need to manually update the MeetsTarget column
in that table for the updated data.

NOTE: Updating measures manually in the data tables is not the recommended best practice, but in
some cases may be unavoidable.

Run the Update Measure Target Status utility Instead of updating target status manually. You can even
use the Axiom Scheduler (job: UpdateMeasureTarget-SQL) to automatically run this utility at set times,
to ensure the measure data tables stay accurate. This is particularly useful if your organization has a
number of people manually updating measure data in the Desktop Client.
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NOTE: This utility should not be needed when you update measure data in the Web Client’s
Measure Update Form, or when Initiative owners update measure data in Initiative plan files.

» About the Update Measure Target Status utility

The utility compares the current measure data to the set measure target and determines if the measure
data meets the target. If it meets the target or surpasses it in a favorable direction, the utility enters
“TRUE” into the MeetsTarget column for that measure data. If the measure data does not meet the
target, the utility enters “False” into the MeetsTarget column.

In the following example, the data in the Value column matches the data in the Target column. This
means that the MeetsTarget column should be “TRUE” for the measure, but the entry is “FALSE.”
Running the utility will change this to “TRUE.”

A B C D E F G H | J K L M -
4 W Data Type Integer Integer Integer Integer integer 32 Numeric Numeric Numeric Boolean String |
5 | String Length 500
Clien{
Departme Bencl|
? Description Perspective Measure nt Entity YRMO Value Target Score Comment by my
8 te F Perspective . Measure| - Dept = Entity - YRMO .| Value - Target - Score - MeetsTarget - Comment - Be
69 2 866 0 0 201801 54.83 50.00 0.00 TRUE
70 2 866 0 0 201802 49.92 50.00 0.00 FALSE
i 2 866 0 0 201803 47.00 50.00 0.00 FALSE
72 2 866 0 0 201804 47.56 50.00 0.00 FALSE
73 2 866 0 0 201805 46.52 50.00 0.00 FALSE
74 2 866 0 0 201806 49.00 50.00 0.00 FALSE
75 2 866 0 0 201807 I 50.00 50.00 0.00 FALSE
76 2 866 0 0 201808 0.00 50.00 0.00 FALSE
7 2 866 0 0 201809 0.00 50.00 0.00 FALSE
78 2 866 0 0 201810 0.00 50.00 0.00 FALSE
79 2 866 0 0 201811 0.00 50.00 0.00 FALSE
80 2 866 0 0 201812 0.00 50.00 0.00 FALSE
81 2 878 0 0 201701 95.67 75.00 0.00 TRUE -
PerspectiveMeasureData + 4 [

PerspectiveMeasureData table showing incorrect entry (FALSE) in the MeetsTarget column for the example measurement.

When to run the utility:

e When anyone updates measure data directly in a hierarchy measure data table

e After running the Create Measure Data utility

To update measure target status:
1. In the Navigation panel, click Admin > Maintenance.

2. Inthe Maintenance page, click the Data Utilities tab.

3. Click the Update Measure Target Status button.

Update period measure summary data

This utility updates period measure data values, target values, and benchmark values when present.
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This utility is also for clients who create and manage a specific class of initiatives focused on cost
reduction or revenue enhancement. For these Initiatives, you enter savings achieved each period. The
period savings represent the amount of dollars saved or paid hours reduced in an individual period.
These savings appear in the Cost Reduction Status report. To make Initiative measure data that you
enter in the Update Measures page or the InitiativeMeasureData table available in the Cost Reduction
Status report, you must run the Update Period Measure Data utility after these Initiative measures are
updated.

» About the Update Period Measure Data utility

When you update cost reduction or revenue enhancement measure data in the Strategy Management
Initiative measure data table for an Initiative measure, you must also run the Update Period Measure
Data utility to update the calculated summary columns. You can even use the Axiom Scheduler (job
UpdateMeasureData-SQL) to automatically run this utility at set times to ensure the calculated data in
the summary columns in the InitiativeMeasureData table stays accurate. The job is particularly useful if
your organization has a number of people manually updating cost reduction or revenue enhancement
measure data.

This utility calculates summary columns in the data tables that sum up the rolling totals by calendar year
and by fiscal year, and also sums up the rolling total from the start of each initiative. There is also a
summary calculation that stores the prior period savings. The summary columns are reportable.

When to run the utility:

e After running the Create Measure Data utility for imported Initiatives with measures from the PI-
Dollars-Performance Improvement class

e After running the Create Measure Data utility for Initiatives with cost-saving measure data
updated from the Admin Measure Update page

e After running the Create Measure Data utility for a new Perspective measure or Objective
measure

To update period measure data:

1. Inthe Navigation panel, click Admin > Maintenance.
2. In the Maintenance page, click the Data Utilities tab.

3. Click the Update Period Measure Data button.

Delete orphaned measure data

The Delete Orphan Measure Data utility removes orphaned data records that result from changes to the
hierarchy measure tables. Axiom Strategy Management administrators can use this utility to clean up
unused data and ensure that deleted measure targets do not appear in reports.
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When a hierarchy measure is first set up, the system creates individual rows in the respective
<hierarchy>MeasureData table for each time period (frequency: month, quarter, half-year, or year) in
the measure’s active period. This active period includes future dates with set targets. If that time period
is shortened, the record would have a set target for those future periods but no Actuals, which could
result in reporting errors.

When to run the utility:

e Ad-hoc — After a hierarchy measure (Perspective, Objective, Initiative) has had its active period
shortened from the original. For example, if your organization was tracking patient falls through
the end of 2020 but now wants to change the end date to December 31, 2019.

e Scheduled — Can be set up as a Scheduler job to run at set times to ensure removal of orphaned
Initiative measure data.

To remove orphaned measure data:
1. Inthe Navigation panel, click Admin > Maintenance.

2. In the Maintenance page, click the Data Utilities tab.

3. Click the Delete Orphan Measure Data button.

Update imported measure data actuals

For clients who have configured their systems to import actuals from other sources such as other Axiom
Software products or external data feeds, Axiom Strategy Management administrators have a utility that
updates measure data from these sources.

The Update Measure Data Actuals utility runs automatically on a set basis (the default is 12:59 AM
Pacific time) to pull actuals from imported measure data stored in the staging table
(MeasureDataStaging) in the Axiom Strategy Management system. The utility updates the measure data
tables with the data and then clears the staging table. Any data that does not match measures already in
the system (matches are performed on MeasurelD, Dept, Entity, and YRMO) is moved to the
MeasureDataExceptions table, where administrators can view it using the Resolve Exceptions utility.

Administrators can also run the Update Measure Data Actuals utility on an ad hoc basis.

To run the utility:
1. Inthe Navigation pane, click Admin > Maintenance.

2. In the Maintenance page, click the Data Utilities tab.

3. On the Data Utilities page, click the Update Measure Data Actuals button.
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Update Measure Data Actuals

Update Measure Data Actuals

This utility will update Values from Actuals in the MeasureDataStaging table.

A note at the bottom of the page displays, confirming that the records have been updated from
the Staging table.

Resolve imported measure data exceptions

Use these instructions for resolving data mismatches that occur when measure actuals are imported to
the system.

Measure data imported to the Axiom Strategy Management system is matched by measurelD, Dept,
Entity, and YRMO. If one or more of these items does not match any hierarchy measure already in the
system, the incoming data is moved to the MeasureDataExceptions table. For example, if actuals for a
given Objective measure come in with an entity listed that is different from the entity listed in the
Objective measure in the system, that mismatch produces a data exception.

Administrators can run the Resolve Exceptions utility to produce a report that lists the mismatched data.

To resolve data mismatches:
1. In the Navigation panel, click Admin > Maintenance.

2. On the Maintenance page, click the Data Utilities tab.

3. Inthe list of utility buttons, click the Resolve Exceptions button.

Review and Resolve Exceptions

Resolve Exceptions

This form will display exception records from the MeasureDataExceptions table.

The Resolve Measure Data Exceptions report opens, displaying a list of exceptions found .
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Strategy Management

Save
Resolved?  Measure Dept Entity Period Value Source Date
98 26360 2 201908 5463 AcctSves 8/8/2019
45 26310 2 201308 0.045 AcctSves 8/12/2019
36 26460 2 201908 34.29 MDmercs 8/12/2019
992 26470 1 201908 1 MDmercs 8/12/2019
645 9 2 201908 2 ETLPMD 8/12/2019
223 :1:} 1 201908 2 ETLPMD 8/12/2019
7 10000 1 201812 4029.131313 AcciSves 8/18/2019

4. For each item, determine the type of error and take the appropriate action:
e If an item is missing from the system, add it to the system if it makes sense to do so.

¢ [f a data item is wrong, it will need to be corrected in the originating source or removed
from the import.

5. After resolving a listed item, to remove it from the list, in the Resolved? column, click the
corresponding check box and then click Save.

The item is removed from the list. In the MeasureDataExceptions table, corrected items are
flagged as TRUE for Resolved. The user who cleared the item from the Resolved Measure Data
Exceptions report is listed in the ResolvedBy column:

Identity Integer Integer  Integer Integer 32  Numeric String Date Boolean String
50 50
Departme Data Date of
Measure nt Entity YRMO Value Source Data Resolved Flag Resolved By
Seq ~ Measurl v Dept | Entity v YRMC ~ Value | ~ Srce Dte |~ Resolved ~ ResolvedBy | ~
1 7 10000 1 201812 4029.13 AcctSves 8/18/2019 FALSE
. 98 26360 2 201908 5463.00 AcctSvcs 8/8/2019 TRUE CT-HWilliams
3 45 26310 2 201908 0.05 AcctSves 8/12/2019) TRUE CT-HWilliams
4 36 26460 2 201908 34.29 MDmercs  8/12/2019 TRUE SKlein
5 992 26470 1 201908 1.00 MDmercs  8/12/2019 TRUE SKlein
6 645 9 2 201908 2.00 ETLPMD 8/12/2019) TRUE SKlein
7 223 88 1 201908 2.00 ETLPMD 8/12/2019 FALSE

The data in the MeasureDataExceptions table remains until the table is cleared and populated
with new data during the next import.
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6

Axiom Strategy Management reports

Axiom Strategy Management comes with two built-in standard reports, the Initiative Status Report and
the Cost Reduction Status Report. These reports are available from the Reports menu in the Navigation
panel.

Initiative Status report

The basic report displays a status icon, checkmarks that indicate whether an Initiative has measures and
milestones (or a dash if they do not), and a description of each Initiative.

Initiative status is based on milestone status. For each included Initiative, the Initiative Status report
displays the icon for the milestone with the most urgent status. For example, if all milestones are On
Track or Complete, the KPI used is the green circle with check mark. If one or more of the milestones has
the status Needs Attention, the report displays the orange circle with bar. If the status is At Risk, the
system displays the red triangle with exclamation point.

While all Initiatives are included by default, not all of the information about each Initiative is
automatically included. For example, to see Initiative sponsors and owners, you need to select those
options in the Filters panel.

The report displays Initiatives grouped under the Perspective and then the Objective to which they
belong. The report does not include any measure data.
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Initiative Status Report

System Period: September 2018 | Perspective: 2,1,3 | Sponsor: seargent’ | Owner: ‘CSparks,HBums' SDrew’ SKlein' | Workstream: 0,1,2,3,4,5,6 | Category: 0,1,23 | Initiative Status: 2,34

PEEEERD A summary of your filter
Clinical Performance selections displays here

Financial Health

Objective
Effe 1anage Controllable Supplies Expense related High-Cost Implants & Drugs
[ Initiative Status. Measures Milestones Sponsar Owner
Clicktogoto I
the Initiative's 31 Maintain decreased per unit usage v v jseargent Csparks
Routing page ) Billing for drug waste (savings added to
32 ) - N - v v seargent sklein
40B savings). !
5Y5- Supply Chain GPO contract updates v v jseargent CSparks
35 Savings from TZCP contract renegotiation v v jseargent CSparks
Effect ge Labor Cost and Productivity in-line with Industry Best Practice

D Initiative Status Measures Milestones ~ Sponsor Owner

|
Click to expand /
collapse Objective
sections 7 Nursing Labor Optimization (CM) v v jseargent CSparks
Click to open the
plan file page tion Overtime v v
T ver v v

Constant Observer - Transfer 4.18 FTEs to
cu

Workstream

Non-Labor

Non-Labor

Non-Labor

Non-Labor

Workstream

Category

Rapid Development

Quick Win

Quick Win

Rapid Development

Category

Rapid Development

Complex

Detail Description

decreased per unit

By default, executive and administrator users can view the status of all Initiatives in the report. Viewing

access for non-executive and non-admin users is as follows:

e |nitiative creators — Can view the status of all Initiatives

¢ Initiative owners — Can view the status of only Initiatives for which they are the owner

* |nitiative sponsors — Can view the status of only Initiatives for which they are the sponsor

* Initiative approvers — Can view the status of all Initiatives

» View the report
To view the Initiative status report:

1. Inthe Navigation panel, click Reports > Initiative Status.

The report page opens.

2. To view Initiatives, click the blue arrow icons ( * ) to expand the Perspectives and then the

Objectives sections.

NOTE: To view the plan file page for the Initiative, click the folder icon (

Initiative’s approval routing page, click the bookmark icon (®).

). To view the

3. Filter the report to show only the Initiatives you want to see, or the Initiative data you want to

see.

» Example filtered Initiative status report

The following general instructions are for filtering the report to display Initiatives with an At Risk status.

You can filter the report further to suit your needs.
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Initiatives with a status of At Risk

To find all Initiatives with no milestone status:

1.

2.

In the Task Bar on the left side of the page, click the filter icon (Y).

In the Filters panel Status section, in the Initiative Status filter drop-down, select 4 - At Risk and
then click OK.

Click Apply. All Initiatives that have a milestone status of At Risk are included in the report.

To see which owners the At Risk Initiatives belong to, (since owners are usually responsible for
managing Initiative milestones), in the Owner filter drop-down, click Select All, click OK, then
click Apply.

Expand the report sections to see who owns the Initiatives.

About the Cost Reduction Status report

The Cost Reduction Status report is a forms-based report that displays performance results from
Initiatives that have cost-saving measures from a specific measure class: Pl-Dollars-Performance
Improvement. Performance Improvement measures are those that involve some sort of cost reduction
or savings, or improvements to performance that result in a cost reduction, savings, or revenue
enhancement.

The report displays the actual savings and the cost savings goal of each performance-improvement
Initiative for the current period and over a set time span, which for this report is the fiscal year of the
Axiom Strategy Management Current Period year and month (YRMO).

The report includes the following:

Actual savings amount for the current period and for each period that contains data in the
current fiscal year (YRMO)

Fiscal year-to-date savings for each Initiative and cumulative savings of all Initiatives
Fiscal year-to-date savings goal for each Initiative and cumulative savings of all Initiatives
Project-to-date actual savings for each Initiative and cumulative savings of all Initiatives

Project savings goal for each Initiative and cumulative savings of all Initiatives

In addition to the Table, the report also contains bar charts that display these same savings
cumulatively. For details, see the following sections,

How the report works
Trend (By Period) chart
By Group chart
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Axiom Strategy Management executives can use this report to monitor the achievement status of cost
management initiatives at any time, on demand. This report is also available to system administrators
and users who own or sponsor Initiatives included in the report.

» How the report works

The PI-Dollars-Performance Improvement class comes with one default measure of the same name: PI-
Dollars-Performance Improvement. Axiom Strategy Management administrators can create more
measures using this class if needed. When a measure from this class is applied to an Initiative, the
Initiative becomes a cost-saving/performance-improvement Initiative.

The PI-Dollars-Performance Improvement measure acts as a filter for the Cost Reduction Status report.
Any Initiative with at least one measure of this class is included in the report, regardless of which
department the Initiative comes from or how much money is involved.

e I
IMPORTANT: All dollars captured using the Pl-Dollars-Performance Improvement measure are

included in the Cost Reduction Status report, so take care to avoid duplication of cost savings
measures. If cost savings measures are duplicated in two different initiatives, they will also be added
twice in the Cost Reduction status report. If you are using these measures in conjunction with your

budget, then you risk double-counting savings, resulting in budgets that are unachievable.
|\ J

The report has three parts:

* Afilter panel on the left that controls which performance improvement Initiatives are included in
the report

e Two bar charts that display cumulative data from those Initiatives
¢ Atable that displays the data specifics of each Initiative.

The table and the graphs both list the Initiatives that are included in the report, but other than that, the
graphs operate independently from the table. When you filter the report results, the table and graphs
both refresh to display the report's new data parameters.

NOTE: Although clicking in the table causes the graphs to appear to refresh, the graphs are not
actually changing; there is no correlation between what you click in the table and what you see in
the graphs.

By default, the report includes all Initiatives that have a measure from the PIl-Dollars-Performance
Improvement class. You can filter the report to include only Initiatives from certain Perspectives,
Objectives, sponsors, owners, etc.

The bar chart at the top of the report has three views:

e Trend (By Period)- Displays cumulative data by current period and year-to-date, and the
cumulative projected goal and cumulative actual savings (uses fiscal year of the current period)
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e By Group — Displays data by the selected group (i.e., Perspective, Objective, Sponsor, Owner,
Workstream, Category, Status)

¢ Both — Displays both charts at once

You select which chart to view from the Chart to View drop-down in the upper right of the report. The
charts and table are explained in the following sections.

» Trend (By Period) chart

The Trend chart displays by default. The selections in the Filters panel control which cost-saving
Initiatives are included in the chart.

The chart includes the entire fiscal year for the Initiatives, and displays the cumulative actual savings and
the savings goal that you expect to see by the end of the year.

e The dark blue bars show the current period cumulative actual savings, which you can see when
you hover your mouse over one of the bars.

e The light blue bars show Fiscal Year-to-Date (YTD) cumulative actual savings. They display for
every month, even future ones, but the future ones repeat the value for the last month for which
there was cumulative data; they do not change until actual data is entered for each month.

e The YTD number for a given column should equal the total of all the current period data; so if
January current period data is 5 and February is 8, then the YTD for February should be 13.

e The Goal is the YTD goal, which displays as dots along the dashed line in the graph. The goal line
extends to the end of the year to show what the goal is for each month. The dots indicate the
savings goal for each month, and the dark blue bars displays the actual savings for each month.
Hover your cursor over the dots and bars to see the values for each.

e The numbers used in the chart come from the measure(s) in the MILESTONE/MEASURES tab of
each Initiative.

NOTE: The bar chart displays a sum of the data from all included Initiatives. If the data represented
in the graph looks incorrect, targets may not be set for all Initiatives, or some of the Initiatives may
be missing other data. Ask your system administrator to run the appropriate data utilities if you have
corrected missing data and the graph still looks incorrect.

Chart to View Trend (By Period) =

Initiative by Period (Month)
52,500,000

$2,000,000

Goal
$1,518474
§1,500,000

$1,000,000

$500,000

50 ':I—-J —l |_| m |_| m [s iYTD i |_| |_| m |_|

Current Period -
392,821
$250272 3 4 5 6 7 $ 9 10 1 12

== Current Period YTD Goal
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This example displays the moused-over cumulative savings for January. For each period that contains data, the light-blue year-
to-date amount represents the sum of the current periods.

» By Group chart

The By Group chart displays cumulative Initiative data by the group selected in the Second Chart - Group
By section of the Filters panel and by either the Axiom Strategy Management Current Period or fiscal
YTD.

As in the Trend chart, the dark blue bars represent cumulative current period savings for all Initiatives in
the report, and the light blue bars indicate cumulative year-to-date savings.

For this chart, you can select to view only one block of time, either Current Period or fiscal Year-to-Date.

¢ Dots on each bar represent the savings target.

e The bar represents either the savings for the current period (dark blue) or the year-to-date
savings (light blue).

e Time periods for the data come from the Axiom Strategy Management Current Period.

On the report, you can mouse over the target dots and bars to see the associated amounts.

Chart to View By Group v

Initiative by Owner

$300,000
$250,000
$200,000
$150,000
$100,000

| ] —. .
(550,000) -

(§100,000)
BRoss DReed FWilliams GJlackson LByrd LPickens mbesta MErmving

w= YTD == Target

This example displays the year-to-date cumulative Initiative savings by Initiative owner.

» Table

The report table displays a list of all filtered Initiatives, and displays the following measure data for each
Initiative listed:

e Current period measure data value, year-to-date actual savings, year-to-date savings goal,
project-to-date actual savings, and project-to-date goal

¢ From the drop-down for each Initiative:

° Measure(s), department and entity (if specified), values for Current Period, year-to-date,
year-to-date goal, Projected savings-to-date, and projected savings goal

° Measure detail graph for each measure available from the row drop-down
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D Initiative Owner Cur Per YTD ¥YTD Goal Proj to Date Proj Goal

» 4 SDrew 5614 $1,592 $1,500 $2,583 $2,500
nsion of Medical Offices & Spol . S . S .
» 12 CSparks $35,000 570,000 5100,000 570,000 $100,000
(North Shore)

g Visit Volume - hold Admin i A . PR N PR
» 16 CSparks $11,235 $33,580 $30,000 594,780 590,000
» 17 Reduce Transcription Overtime Csparks $11,002 $33,052 $33,000 38
» 18 Market analysis - P HBums 545321 $143,042
> 19 Constant Qbserv SDrew $2,745 $8,367 $7,038 544,982

. ment of senior RNs with high- PO . R _ e -

» 20 HBurmns 517,888 553,940 553,639 5307467 $303,954

Measure data is added together and presented as a single sum only if an Initiative has more than one
cost-savings measure, as in the following example.

D Initiative Owner Cur Per YTD YTD Goal Proj to Date Proj Goal
LM 392 Test MB_Z mbesta $25,690 $46,690 $40,000 $46,600
ID Measure Entity Dept Cur Per YTD YTD Goal Proj to Date Proj Goal
Ll 1843 Pl-Dollars-Performance Improvement 0 0 $12,345 $22,345 $20,000 $22,345 $20,000
Ll 1843 Pl-Dollars-Performance Improvement 1 10000 $13,345 $24,345 $20,000 524,345 $20,000

This example shows an Initiative with two cost-saving measures. The values for the two measures are summed to create the
total values displayed in the top Initiative row.

View the Cost Reduction Status report

This report is available to system administrators, executives, and users with Initiative permissions. For
users who own or sponsor Initiatives and have no other Initiative access, the report is limited to those
Initiatives the users own or sponsor. By default, executive and administrator users can view all Initiatives
in the report. The Filters panel provides filtering and grouping options. For more information, see Filter
Initiative reports.

The report has two main parts: graphic representations of the filtered data and a table of the filtered
data.

To view the Cost Reduction Status report:

1. Inthe Navigation panel, click Reports to expand the menu.

2. Click Cost Reduction Status. The report opens on the page.

To view the charts:
In the Chart to View drop-down, select one of the following:

¢ Trend (By Period) — Displays measure performance data by month for the current year. This is the
default display.

e By Group — Displays measure data by selected group (Perspective, Objective, Sponsor, Initiative
Owner, Workstream, Category, Status)

e Both — Displays both charts at once, with the Trend chart shown above the By Group chart.
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To view table data and other information:
e To view Initiative measure data, click the blue arrow icon ( *).
* To view measure detail for the measure data, click the graph icon (1),
e To open the Initiative’s plan file page, click the folder icon (=).

e To open an Initiative’s approval routing page, click the bookmark icon (®).

ID Initiative Owner Cur Per YTD YTD Goal Proj to Date Proj Goal
4 Reduce syringe costs (CM) SDrew $614 $1,592 $1,500 $2,583 $2,500
[I] Measure Entity Dept Cur Per YTD ¥YTD Goal Proj to Date Proj Goal
866 PI-Dollars-Performance Improvement 0 26140 $614 $1,592 $1,500 $2,583 $2,500
Expansion of A - - - 0 7
> 12 CSparks 535,000 0
Medicine Facility (North Shore)
I ng Visit Volume - hold Admin . o
> 16 CSparks 511,235
» 17 Reduce Transcription Overtime CSparks 511,002 33,052 33

Filter Initiative reports

By default, the reports display all Initiatives that you have permissions to view.

For the Cost Reduction Status report, all filter options available in the Filters panel are selected by
default. Use the Filter panel to filter out what you do not want to see by selecting what you want to see.

For the Initiative Status report, all records display by default but additional information is displayed
when certain filters (e.g., Owner, Category, etc.) are applied. To view certain data, such as Initiative
owner or sponsor, select these options in the Filter panel.
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® F

v Strategic Alignment

Perspective

Choose a value for Perspective.

Objective
Choose a value for Objective.

v Responsibility
Sponsor
Choose a value for Sponsor.

Owner

Choose a value for Owner.

v Type
Workstream

Choose a value for Workstream.

Category

Choose a value for Category.

« Status
Initiative Status

Choose a value for Status.

Click the x to dear
all selections in a
drop-down

~ Second Chart - Group By
Primary Group By
Sponsor

Current or YTD?
Current Period
® YTD

This section applies
to the Cost
Reduction Status
report only

Apply Clear All

To filter a report:

1. Inthe Task Bar on the left side of the page, click the filter icon (Y).

Administrator's Guide

Click Apply after
selecting or clearing
options
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2. From the various drop-downs, select the items you want to include, click OK in the selection
dialog.

NOTE: Choosing Select All for a specific filter, such as Perspective or Type, provides the same
results as not making a selection for that filter.

e You can select more than one option from each filter group.

3. At the bottom of the Filters panel, click Apply. The report now includes only Initiatives associated
with your selections.

TIP: You can click Apply in the Filters panel at any time during selection to see what the
report looks like so far.

TIP: To quickly revert back to including all options in a selection box, click the X icon (*) to
the right of the filter option drop-down, and then click Apply. The report adds back the
Initiatives associated with the Perspectives you filtered out.

To clear filters:

e To clear all filters, at the bottom of the Filters panel, click Clear All, and then click Apply.
Remember that this adds all possible options back to the report.

e To clear a single filter selection, click the x icon (*) to the right of the filter drop-down, and then
click Apply.
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Intelligence Center

The Intelligence Center is a centralized hub where you can view any report that you have access to in
the Axiom Reports Library—including web reports, Axiom forms, visualization reports, and spreadsheet
reports.

Using the Intelligence Center, you can:
e View any report you have access to, regardless of the report type

e Create new web reports (all clients) and visualization reports (clients with certain product
licenses)

e QOpen reports for editing, in the appropriate editor for the report type

e Perform other report management activities, such as creating and deleting folders, copying
reports, and editing report names and descriptions

AXIOM| Intelligence Center 0 a @ !..:i

w
Reports Row Structures Search for a Create new
R Intelligence Center report by name I reports J

Access all of your
Reports Library | ICorporate >  Analysis Search reports Q

v O iCorporate reports in one
centralized hub

O Analysis
O Finance
O 'RepartBuilder
» [0 Archive Analy5|s
O Dashboards
ashbos Name Y Modified on Y Modified by Y Type h g
» [0 File Processing
B Acct Analysis 2/4/2022 916 AM  Clark Adams Web Report
» [0 Forms
» O MiscReports B Budget Analysis @ Info 3/2/202112:27PM  Clark Adams Axiom Forms
» (3 Monthly Reports # Edit
[@ Budget to Actuals Comparison 7/2/20217:36 AM  Clark Adams Spreadsheet Report
[ Recovered Files
«, Share »
» O Supporting Documents Corporate Dashboard 2/4/2022917 AM Clark Adams Web Report
+ Exo
» O Temp * Export »
B Quarterly Performance i 3/2/202112:53PM  Jane Doe Web Report
» [ Test Iy Copy
Perform report actions
» O Utilities . Delete
such as edit, copy, and o
» [0 Web delete .
1 50 « items per page 1-5of Sitems

» (2] My Documents

Example Intelligence Center TBD New Screenshot
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» Accessing the Intelligence Center

All users can access the Intelligence Center in the Web Client browser:
L X}

Click the Syntellis icon E-:I in the Navigation bar. From the Area menu, select Intelligence Center.

noo @ &

PRODUCT AREAS
Home
Intelligence Center

System Administration

The Intelligence Center may also be accessible from other areas of the Web Client, such as in the left-
hand Navigation panel, or from links in product-specific pages.

# Home
> W Favorites
> @ Recent Places
> E Reports

Q, Forms Explorer

il Intelligence Center

Intelligence Center in the default Navigation panel TBD New Screenshot

In the Desktop Client, you can open the Intelligence Center from the Reports menu. By default this
menu is present on the Axiom tab. If your system has installed products, it may be available to you on
the Main tab.
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“ AXIOM AXIOMDESIGNER Home

¥Z]Budget ~ ] == [
[ e: h‘
¥z Capital ~ S

Reports Tables Imports Manage

'_J All Reports
¢ Axiom Assj ¥  New Report
. % New Form
My Files -

#+ Intelligence Center
Favo .
751 Report Wizard...

Explorer

Refresh File System

’ My =~
Reports Library

| P R

Intelligence Center on the default Reports menu

» Opening reports

You can open any report that displays in the Intelligence Center. The Intelligence Center is automatically
filtered to only show the reports that you have access to.

To open a report from the Intelligence Center:

1. Inthe left-hand panel, select the Reports tab if it is not already selected.
2. Do one of the following to locate the report that you want to open:

¢ Use the folder tree in the left-hand panel to navigate to the folder where the report is
located.

OR
e Use the Search box to search for the report by name.

For more information on how to search, filter, and sort the Intelligence Center, see Intelligence
Center overview.
3. Once the report displays in the Intelligence Center grid, click on the report name to open it.
e Web reports open in the same browser tab.

e Other web-enabled reports open in a new browser tab. This applies to Axiom forms,
visualization reports, and deprecated web reports.

e [f the report is a spreadsheet report, Axiom Strategy Management attempts to launch the
Axiom Desktop Client and open the report. This works as follows:

° The launch routine uses the Axiom Windows Client by default.

° If an Axiom Strategy Management client is already open, the launch routine is
skipped and the report is opened in that client—regardless of whether the open
client is the Excel Client or the Windows Client. Therefore, if you want to open
reports in the Excel Client, you must launch the Excel Client first using the Quick
Launch menu, then you can open spreadsheet reports from the Intelligence Center.
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NOTE: You must have the appropriate security permissions to use the Axiom Strategy
Management Desktop Client in order to open a spreadsheet report. If you do not have
either the Windows Client Access permission or the Excel Client Access permission,
then spreadsheet reports are hidden in the Intelligence Center because you cannot
launch the client to view them.

If other types of files are present in the Reports Library—such as PDF, Word, or PowerPoint—these files
can also be opened from the Intelligence Center if you have a program capable of reading the file type.
Axiom Strategy Management attempts to open the file using the same routine that opens the Axiom
Desktop Client.

» Creating new reports
Using the Create button at the top right of the Intelligence Center, you can create new reports and new

fixed row structures for use in web reports. This button is context-sensitive, depending on what area
you have selected from the left-hand panel.

To create a new report, select the Reports area from the left-hand panel, then click the Create button.
Select one of the following:
* Create web report: This option opens the web Report Builder so that you can create a new web
report from scratch. For more information, see Creating new web reports.
e Create web report from template: This option creates a new web report using a template
provided by an installed product. See Creating new web reports from template.
e Create new visualization: This option creates a new visualization report. This option is only
available in systems where visualization reporting is licensed and enabled.

AXIOM| Intelligence Center A Q @ I-Ei
g
Reports Row Structures

S —— Intelligence Center
v (O ICorporate
Reports Library | !Corporate > Analysis Search reports Q
O Analysis
Create web report from template

O Finance

[0 'ReportBuilder Create web report

O Archive AnalySls Create new folder

(3 Dashboards

aslbos Name Y Modified on Y Modified by Y Type h 4
» [0 File Processing
B Acct Analysis 2/4/2022 9116 AM  Clark Adams Web Report

» [0 Forms

Example Create button

To create a new fixed row structure, select the Row Structures area from the left-hand panel and then
click Create. For more information, see Creating fixed row structures.
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» Other Intelligence Center actions

In the Intelligence Center, you can use the Actions menu to perform other report and folder
management activities. To view the available actions, navigate to the item that you want to work with,
then hover your cursor over the three dots icon in the right-hand side of the Name column. Actions are
available for report files, report folders, and fixed row structures.

TBD Screenshot

The following actions are available:

Action Description More Information

Info Opens an information panel for the e Changing folder names and
current item, displaying the item name descriptions
and description. * Changing report names and

descriptions

¢ Changing fixed row structure
names and descriptions

Edit Opens the current item in the appropriate e Editing reports
editor. * Editing fixed row structures

Copy Generates a copy of the current item. Only e Copying web reports
available for fixed row structures and web e Copying fixed row structures
reports.

Delete Deletes the current item. e Deleting reports

e Deleting folders

¢ Deleting fixed row structures

You can also create new folders by clicking the folder icon at the top right of the Intelligence Center.

Intelligence Center overview

The Intelligence Center is organized into two main areas. To view an area, select the area name from the
left-hand panel:

e The Reports area, which contains the Reports Library folder tree and your My Documents folder
(if you have access to it). You can click on folders in this section to navigate through the folder
tree. Once a folder is selected, the contents of that folder display in the report grid. You can click
on a subfolder name to open that subfolder, or you can click on a report name to open that
report.

e The Row Structures section, which contains fixed row structures for use in web reports. This
section does not have subfolders. You can click on the parent Fixed Row Structures folder to view
the available fixed row structures, and click on a name to open that structure.
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As you navigate, a breadcrumb displays at the top of the report grid. You can click on a folder name in
the breadcrumb to move to that folder location.

AXIOM| Intelligence Center 0 a @ L:i

w ®
Click a folder in the
Reports Row Structures breadcrumb to return

& Revorts Ly Intelligence Center | tothat folder

Search fora
report by hame
a— View reports or
fixed row structures Reports Library | ICorporate >  Analysis Search reports Q
O Analysis

O Finance

Click a column

[ tReportBuilder header to sort by tCIﬁtk thbe filter :con
H 0O Tiiter a column
P O Achive Analysis that column o tterby a
£ Dashboards Name Y Modified on Y Modified by Y Type b d
» [0 File Processing
Acct Analysis 2/4/2022 916 AM  Clark Adams Web Report
» O Forms
» O MiscReports B Budget Analysis 3/2/202112:27PM  Clark Adams Axiom Forms
» O Monthly Reports
[@ Budget to Actuals Comparison 7/2/2021 7:36 AM Clark Adams Spreadsheet Report
[ Recovere
» O Supg Browse_your available B Corporate Dashboard 2/4/2022 917 AM  Clark Adams Web Report
folders in the Reports
> D Temi Library
B Quarterly Performance 3/2/202112:53PM  Jane Doe Web Report
» [0 Test
» O Utilities
» O Web .
1 50 w items per page 1-5of Sitems

» ] My Documents

Navigating the Intelligence Center

» Searching the Intelligence Center

You can use the Search box at the top right of the Intelligence Center to find a report or a fixed row
structure. The search matches on name only. The search box is context-sensitive as follows:

e If the currently selected area is Reports, then the search can be used to find reports in the
Reports Library and your My Documents folder.

e |f the currently selected area is Row Structures, then the search can be used to find fixed row
structures.

To search for an item by name:

e Type your search text into the Search box, and then click the magnifying glass or hit the Enter key
to search.

The grid updates to show a list of all reports or fixed row structures that match your search text. You can
open an item or perform other actions using this list. You can also filter and sort this list as described in
the following sections.

To clear a search:
e Click the X icon in the right side of the Search box.
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Your search text is cleared, and you are returned to the folder location that you were viewing when you
started the search.

» Filtering the grid
When you are viewing a folder in the Intelligence Center (or when viewing search results), you can filter

the contents by any column in the grid. For example, you can filter to show all reports of a certain type,
or to show all reports created after a certain date.

To filter the grid based on a column:
1. Click the filter icon in the column header to show the filter options.

2. Set the filter options as desired. You can set up to two filter options, combined with either
AND or OR.

3. Click Filter.

The grid updates to only show items that meet the filter. Additionally, a green dot displays by the filter
icon in the column header to indicate that the grid is filtered by this column.

Analysis
Name Y. M
Jm
B Corporate Dashboard Ntontains 0
dashboard
And
Contains

Example Intelligence Center column with a defined filter

If multiple columns are filtered, the filters are combined using AND—meaning the grid only shows items
that match all of the filters.

The column filter is retained until you clear it, or until you navigate to a new folder location. If you have
filtered the search results, clearing the search results also clears the filter.
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To clear a filter:

1. Click the filter icon in the column header to show the filter options.

2. Click Clear.

The grid updates to clear the filter.

» Sorting the grid

When you are viewing a folder in the Intelligence Center (or when viewing search results), you can sort
the list by any column in the grid.

To sort the grid by a column, click on the column header. Each click toggles between ascending sort,
descending sort, and no sort. If the grid is currently sorted by a column, the sort direction is indicated by
an arrow on the column header (up for ascending, down for descending).

The sort is reset when you move to a new folder location. If you have sorted the search results, clearing
the search results also clears the sort.

NOTE: The grid can only be sorted by one column at a time. If you have sorted by a column and then
you click the column header of a different column, the sort on the original column is cleared and
replaced by the new column sort.

Managing report files in the Intelligence Center

Using the Intelligence Center, you can create, edit, copy, and delete reports in the Reports Library. You
can also edit report names and descriptions.

» Creating new reports

Using the Create button at the top right of the Intelligence Center, you can create new reports and new
fixed row structures for use in web reports. This button is context-sensitive, depending on what area
you have selected from the left-hand panel.

To create a new report, select the Reports area from the left-hand panel, then click the Create button.
Select one of the following:

e Create web report: This option opens the web Report Builder so that you can create a new web
report from scratch. For more information, see Creating new web reports.

» Create web report from template: This option creates a new web report using a template
provided by an installed product. See Creating new web reports from template.

e Create new visualization: This option creates a new visualization report. This option is only
available in systems where visualization reporting is licensed and enabled.
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Example Create button

To create a new fixed row structure, select the Row Structures area from the left-hand panel and then
click Create. For more information, see Creating fixed row structures.

Different security permissions are required to create new web reports versus visualization reports.
These security requirements are noted in the relevant topics.

» Copying reports

In the Intelligence Center, you can copy existing reports to create new reports. Currently, this
functionality is only available for web reports, and only web reports that were created in the Report
Builder. Web reports created from template cannot be copied.

In order to copy a web report, you must be an administrator or have the Create Web Reports security
permission. You must also have read/write access to the current folder, because the copy is created in
the current folder.

To copy a report from the Intelligence Center:

1. Inthe Intelligence Center, locate the web report that you want to copy. You can use folder
navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Copy from the menu.
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[y Copy

B Quarterly Performance 8 Delste

If the Copy action is present but disabled, then you cannot copy this report because you do not
have the appropriate security permissions.

3. Inthe Copy Report dialog, enter a name for the copy. By default, the name is Copy of
OriginalReportName.

4. Click OK.

The copy is created in the current folder, with the specified name.

» Editing reports
You can open a report for editing from the Intelligence Center if the report is eligible to be edited, and
you have read/write permissions to the report.

To edit a report from the Intelligence Center:
1. Inthe Intelligence Center, locate the report that you want to edit. You can use folder navigation
to find the report, or use the Search box at the top of the page.
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2. Once the report displays in the Intelligence Center grid, hover your cursor over the Name column
to make the three-dots icon visible. Click the icon then select Edit from the menu.

Name Y

B Acct Analysis B

Budget Analysis @ Info
& Edit

[@) Budget to Actuals Comparison < shae >
+

B Corporate Dashboard 3 Export »
[ Copy

B Quarterly Performance -

3. Thereport is opened for editing as follows, depending on its file type:

* Web reports are opened in the Report Builder, in the current browser tab.

¢ Visualization reports are opened in the Visualization Report Editor, in a new browser tab.

¢ Spreadsheet reports and Axiom forms are opened in the Axiom Desktop Client, as

spreadsheet report files. This works as follows:
° The launch routine uses the Axiom Windows Client by default.

° If an Axiom Strategy Management client is already open, the launch routine is
skipped and the report is opened in that client—regardless of whether the open
client is the Excel Client or the Windows Client. Therefore, if you want to open
reports in the Excel Client, you must launch the Excel Client first using the Quick
Launch menu, then you can open spreadsheet reports from the Intelligence Center.

NOTE: You must have the appropriate security permissions to use the Axiom Strategy
Management Desktop Client in order to open a spreadsheet report. If you do not have
either the Windows Client Access permission or the Excel Client Access permission,
then spreadsheet reports are hidden in the Intelligence Center because you cannot
launch the client to view them.

Why is the Edit action missing for some reports?

The following report types cannot be opened for editing from the Intelligence Center. The Edit action
does not display for these files:

¢ Web reports built from template: If a web report is built from a template, the report is tied to
that template and cannot be separately edited. For more information, see Creating new web
reports from template.
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e Deprecated web reports: The prior implementation of web reporting is deprecated. To edit a
deprecated web report, click the file name to open the report, then click the wrench icon in the
toolbar to open the legacy web report editor.

e Other non-report file types: The Reports Library can be used to store other non-report, non-
Axiom file types, such as PDF, DOC, PPT, JPG, and others. These file types cannot be edited in
Axiom Strategy Management.

Why is the Edit action disabled for some reports?

If the Edit action is present but disabled, this means that although the report type is eligible to be
edited, it is not possible for you to edit this particular report. One of the following reasons may apply:

* You do not have edit permissions (Read/Write access) to the file.
e The file is product-controlled and therefore cannot be edited.
e The file is configured to prevent editing (applies to certain visualization reports).

» Changing report names and descriptions

If you have read/write access to a report, then you can rename the report or change its description.

NOTES:

¢ In systems with installed products, the names and descriptions of product-controlled reports
cannot be edited.

 If you have read/write access to a report file, but read-only access to its folder, then you
cannot edit the report name.

To change a report name and/or description:

1. Inthe Intelligence Center, locate the report that you want to edit. You can use folder navigation
to find the report, or use the Search box at the top of the page.
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2. Once the report displays in the Intelligence Center grid, hover your cursor over the Name column
to make the three-dots icon visible. Click the icon then select Info from the menu.

Name

Acct Analysis

B Budget Analysis

[@ Budget to Actuals Comparison

Corporate Dashboard

Quarterly Performance

h e

)

@ Info
/ Edit

«% Share »

|+

Export »

[y Copy

=

Delete

The Settings panel opens along the right-hand side of the page.

3. In the Settings panel, edit the report Name or Description as needed, then click Save.

The name can be up to 250 characters, and the description can be up to 2000 characters.
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If the report name and description cannot be edited, then the Apply button is not available. This
may occur because you do not have the necessary permissions, or because the report belongs to

an installed product.
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» Deleting reports

If a report is no longer needed, you can delete it using the Intelligence Center. In order to delete a
report (or any other file that resides in the Reports Library), you must have read-write access to the file
and to the folder it resides in.

NOTE: In systems with installed products, product-controlled reports cannot be deleted.

To delete a report:

1. Inthe Intelligence Center, locate the report that you want to delete. You can use folder
navigation to find the report, or use the Search box at the top of the page.

2. Hover your cursor over the row with the report, hover your cursor over the Name column to
make the three-dots icon visible. Click the icon then select Delete from the menu.
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Delete

If the report cannot be deleted, the Delete action is disabled. This may occur because you do not
have the necessary permissions to delete the report, or because the report belongs to an
installed product.

3. When you are prompted to confirm that you want to delete the report, click OK.

The report is deleted from the system and no longer displays in the Intelligence Center. If the report was
deleted in error, an administrator may be able to restore the report using the Restore Deleted Files
feature in the Desktop Client.

Managing folders in the Intelligence Center

Using the Intelligence Center, you can create, rename, and delete folders in the Reports Library.
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» Creating new folders

You can create new folders as needed in the Intelligence Center. In order to create a folder, you must
have read-write access to the parent folder.

To create a folder:

1. Inthe Intelligence Center, navigate to the folder location where you want to create a new folder.

For example, if you want to create a new top-level folder in the Reports Library, select the
Reports Library. If you want to create a new subfolder within a folder, then select that folder.

2. Click Create > Create new folder.

3. Inthe Create new folder dialog, enter a name for the new folder, then click OK.

The new folder is created in the current location.

» Changing folder names and descriptions

If you have read/write access to a folder, then you can rename the folder or change its description.

NOTE: In systems with installed products, the names and descriptions of product-controlled folders
cannot be edited.

To change a folder name and/or description:

1. Inthe Intelligence Center, navigate to the parent folder of the folder that you want to rename, so
that the folder you want to rename displays in the Intelligence Center grid.

2. Hover your cursor over the row with the folder, so that the three dots icon is visible the Name
column. Click the icon then select Info from the menu.

Name Y

O My Folder B

B Acct Analysis @ Info
i1 Delete

B Budget Analysis

The Settings panel opens along the right-hand side of the page.
3. In the Settings panel, edit the folder Name or Description as needed, then click Apply.
The name can be up to 250 characters, and the description can be up to 2000 characters.

If the folder name and description cannot be edited, then the Apply button is not available. This
may occur because you do not have the necessary permissions, or because the folder belongs to
an installed product.

Administrator's Guide Axiom Strategy Management | 116



» Deleting folders

If a folder is no longer needed, you can delete it using the Intelligence Center. In order to delete a folder,
the folder must be empty and you must have read-write access to the folder.

NOTE: In systems with installed products, product-controlled folders cannot be deleted.

To delete a folder:
1. Inthe Intelligence Center, navigate to the parent folder of the folder that you want to delete, so
that the folder you want to delete displays in the Intelligence Center grid.

2. Hover your cursor over the row with the folder, so that the three dots icon is visible the Name
column. Click the icon then select Delete from the menu.

Name Y

O My Folder E]

B Acct Analysis @ Info

® Delete

Budget Analysis

If the folder cannot be deleted, the Delete action is disabled. This may occur because you do not
have the necessary permissions to delete the folder, or because the folder belongs to an installed

product.

The folder is deleted from the system and no longer displays in the Intelligence Center. There is no
confirmation dialog before deleting an empty folder. If the empty folder was deleted in error, you can

create a new folder with the same name.

Administrator's Guide Axiom Strategy Management | 117



Web Reports

Axiom web reports provide a fully browser-based reporting option for Axiom Strategy Management
data. You can create, edit, and view web reports all within the Axiom Strategy Management Web Client.

Web reports are designed to be intuitive for report designers to build, and easy for report viewers to
use. The Intelligence Center provides a centralized hub to create new web reports and to view any
report that you have access to.

Web reports support two different ways to display reporting data in a grid:
¢ Dynamic rows: Dynamically display data rows based on a specified dimension or grouping.

» Fixed rows: Use predefined fixed row structures to organize data rows into sections with headers,
totals, and subtotals.

Web reports can be created from scratch using the Report Builder, or you can create them from
templates provided by installed Axiom Strategy Management products.

Managing Web Reports

Using the Intelligence Center in the Axiom Strategy Management Web Client, you can create, edit, copy,
and delete web reports as needed. Web reports are designed to be intuitive for report builders to
create, and easy for report viewers to use.

» Creating new web reports
To create a new web report, select the Reports area from the left-hand panel of the Intelligence Center,
then click Create. From the Create menu, select one of the following:

e New web report: This option opens the Report Builder so that you can create a new web report
from scratch.

e New web report from template: This option creates a new web report based on a template
provided by an installed product.

If you want to create a web report that uses a fixed row structure, the fixed row structure must be
defined separately and then assigned to the report. Using the Intelligence Center, you can create, edit,
and delete fixed row structures. For more information, see Managing Fixed Row Structures.
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In order to create a web report, you must be an administrator or have the Create Web Reports security
permission. You must also have read/write access to at least one folder in the Reports Library or My
Documents.

» Copying web reports

In the Intelligence Center, you can copy existing web reports to create new reports. In order to copy a
web report, you must be an administrator or have the Create Web Reports security permission. You
must also have read/write access to the current folder, because the copy is created in the current folder.

NOTE: Only web reports created in the Report Builder can be copied. Web reports created from
template cannot be copied.

To copy a web report from the Intelligence Center:

1. Inthe Intelligence Center, locate the web report that you want to copy. You can use folder
navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Copy from the menu.

Name Y
B Acct Analysis B
B Budget Analysis ® Info
# Edit
[@ Budget to Actuals Comparison e >

.

+
B Corporate Dashboard = Export ¥
[y Copy

B Quarterly Performance # Delete

If the Copy action is present but disabled, then you cannot copy this report because you do not
have the appropriate security permissions.

3. Inthe Copy Report dialog, enter a name for the copy. By default, the name is Copy of
OriginalReportName.

4. Click OK.

The copy is created in the current folder, with the specified name. If you want to save a copy in a
different folder, then you can Edit the report instead and use Save As within the Report Builder.
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» Editing web reports

You can open a web report for editing from the Intelligence Center if the report is eligible to be edited,
and you have read/write permission to the report.

NOTE: Only web reports created in the Report Builder can be edited. Web reports created from
template cannot be edited.

Only one user at a time can open a web report for editing in the Report Builder. However, other users
can continue to view the report as normal.

To edit a web report from the Intelligence Center:

1. Inthe Intelligence Center, locate the web report that you want to edit. You can use folder
navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Edit from the menu.
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If the Edit action is present but disabled, then you cannot edit this report. This may be because
the report belongs to an installed product and cannot be edited, or because you do not have
read/write access to the report, or because the report was created from template.

The report opens in the Report Builder, in the current browser tab. You can now edit it as needed. For
more information, see Using the Report Builder.

Alternatively, when viewing a web report, an Edit button is present in the top right-hand corner if the
report is eligible to be edited, and you have read/write permission to the report. You can click the Edit
button to open the report in the Report Builder, make and save your changes, then click the Back button
on your browser to return to the report.
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Example Edit button to open the current report in the Report Builder

» Changing web report names and descriptions

If you have read/write access to a web report, then you can rename the report or change its description.

NOTES:
¢ |n systems with installed products, the names and descriptions of product-controlled reports

cannot be edited.
 If you have read/write access to a report file, but read-only access to its folder, then you

cannot edit the name or description.

To change a web report name and/or description:
1. Inthe Intelligence Center, locate the web report that you want to edit. You can use folder
navigation to find the report, or use the Search box at the top of the page.
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2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Info from the menu.
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The Settings panel opens along the right-hand side of the page.

3. In the Settings panel, edit the web report Name or Description as needed, then click Save.

The name can be up to 250 characters, and the description can be up to 2000 characters.
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If the web report name and description cannot be edited, then the Save button is not available.
This may occur because you do not have the necessary permissions, or because the report
belongs to an installed product.
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» Deleting web reports

You can delete a client-created web report if it is no longer needed. You must have read/write access to
the report and its folder in order to delete a report. Product-controlled web reports cannot be deleted.

TIP: If a report is deleted in error, an administrator may be able to restore the report using the
Restore Deleted Files feature in the Axiom Strategy Management Desktop Client.

To delete a web report from the Intelligence Center:

1. Inthe Intelligence Center, locate the web report that you want to delete. You can use folder
navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Delete from the menu.
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If the report cannot be deleted, the Delete action is disabled. This may occur because you do not
have the necessary permissions to delete the report, or because the report belongs to an
installed product.

3. When you are prompted to confirm that you want to delete the report, click OK.

The report is deleted from the system and no longer displays in the Intelligence Center.

TIP: You can also delete a web report in the Desktop Client, using Axiom Explorer or the Explorer
task pane.

Creating new web reports

Using the Intelligence Center, you can create new web reports from scratch so that you can build the
report as needed.
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In order to create a web report, you must be an administrator or have the Create Web Reports security
permission. In order to save the new report you must have read/write access to at least one folder in
the Reports Library or access to the My Documents folder. If you do not have permission to create web
reports, then the option to create a new web report will not be available from the Create button in the
Intelligence Center.

To create a new web report:

1. Inthe Intelligence Center, click Create > Create web report.
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NOTE: The Reports area must be selected in the left-hand panel of the Intelligence Center in
order to create a new web report.

The Report Builder opens in the current browser tab, displaying a new blank report.

2. Inthe Select Table dialog, select a primary table to determine the data context for the report,
then click OK.

The data context determines the overall pool of data that is eligible to be included in the report.
The selected primary table determines which other tables are eligible for inclusion in the report,
based on lookup relationships and shared dimensions. All table columns and filters used in the
report must be compatible in the context of the primary table.

You can select a table from the drop-down list directly, or type into the box to search for a table
name. The search uses "contains" matching to return any tables that contain the search text
within the table name. Tables that start with the search text are listed first, followed by tables
that contain the search text anywhere in the table name. In the following screenshot, the text
2022 has been used to search for tables with the year 2022 in the name.
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Selecting a primary table for the data context

Once a table is selected for the data context, you can work with the report in the Report Builder.
The Build tab of the Report Builder is where most of the report creation occurs. The Build tab is
organized into three main areas as follows:

¢ The Data Panel on the left side is where you select the data to include in your report.
¢ The Report Canvas in the middle is where you build the report. Columns can be dragged

and dropped from the Data Panel to the Report Canvas. You can also create calculations to
display in the report columns, and define column groups.

¢ The Configuration Panel on the right side is where you define properties for the report,
the data grid, and the individual columns. You can configure properties such as report
titles, drilling options, and column formatting.

For more information on using the Report Builder, see Using the Report Builder.

3. At the top of the Report Canvas, click inside the title boxes and define the title text as desired.
You can also optionally edit the title text within the Report Configuration panel. For more
information, see Defining report titles and other web report properties.
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Defining titles for the report

4. Define the rows of the report by doing one of the following, depending on whether you want to
generate the rows dynamically or use a fixed row structure:

¢ Dynamic rows: In the Data Panel, locate the table column that you want to use as the row
dimension. Drag and drop the column to the Row Dimensions box in the Report Canvas.
For more information, see Specifying the row dimension for a web report.
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WorldRegion
v [ DbePT
0t Column widin
@ Description
0 Tempiate Aignment
» | [ WoridRegion Please add at least one column to the Column Definitions box Default (Lefty v
D Country
0-0orotems @D covener
» | O Region
) Hide column
M Gurrency -
. D @D show description
@ Employees Description display format
@D Manager Value (Description) v

T Consolidated
» | M owner
@ emaiiz
(@0 FestDept
M BotCombineDuringQuery

@ showonList

Dragging and dropping a column to use as the row dimension
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* Fixed rows: Select the grid placeholder text in the Report Canvas so that the Grid
Configuration properties load into the Configuration Panel. On the General tab, enable
Use fixed rows then select an existing Fixed row structure. For more information, see
Specifying the fixed row structure for a web report.

AXIOM| Intelligence Center

< Intelligence Center

Data Context

6L2022

v o0z
» [0 AccT
v [ bEPT
0 Dept

@ Description

@ Tempiate

@ worldRegion

@ Gountry

@ Region
@ Currency
> o
[ Employees
D Manager
D Consolidated
> | @ Owner
@ Emaiiz
@ Festoept
D BotCombineDuringQuery

@ showonList

Build  Parameters  Filters

Budget to Actuals Corporate

Through June 2022

+v

1M Fixed Row Header Column

& previe (g

Grid Configuration

General Advanced

Column Properties ~

@D Enable reorcering columns

Grid Properties ~

@D veeearons

Please add at least one column to the Column Definitions box

Fixed row structure

RevEXp v

Specifying a fixed row structure to define the rows

Fe )
() Enable ariling

5. Use the Data Panel to locate the data columns that you want to display in the report, then drag
and drop those columns out to the Column Definitions box in the Report Canvas. Once the
columns are added to the grid, you can configure data and display properties for each column.

For more information, see Adding data columns and calculated columns to a web report and
Configuring column properties for a web report.
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AXIOM| Intelligence Center n a @ L:i

e
< Intelligence Center Buld  Parameters  Filters # RefreshData  Preview
Data Context . P
Budget to Actuals Corporate Column Configuration
GL2022 7
. General Advanced
Click on a column
liceabiuncaizz name to configure it Column
—_— 4 BGT2022.02
» BB 8GT2021 - +v + ¥
Header
v Beetn 0 worldRegion == MQlActuals = [MQ2Actuals = [DQ1 Budget =
= Q2 Budget
» [0 Accl
» [ DePT
Column width
@ pETAIL
D WorldRegion Q1 Actuals Q2 Actuals Q1 Budget Q2 Budget ‘ Alignment
D m2 Asia (Asia region) $59,065,030 $58,174,791 $33,016,385 $34,789,159 Default (Right) v
m m3
D Corporate (Gorporate departments) $11,786,889 7,370,832 $6,102973 $6,200,837 | Number format
Tws Default (Currency) v
. Europe (Europe region) $30,716,504 $30,422,551 $1,202,834 $1,223,440
@ Mo ‘Aggregation
owr North America (North America region) 760,989,716 $750,407,151 $153,881,599 139,551,224
Default (Sum) v
M me 1-4.0f 4 ftems
@ m9 Data filter Edit
M mi0

Drag columns from the
DT Data Panel to the
@ M2 Column Definitions box @D cravienver
[ saveTagloclD e

() Hide column
[0 saveTag

Adding and configuring data columns

NOTE: To populate the grid with data after adding columns to the Column Definitions box,
click the Refresh Data button. By default, the Report Builder uses live data, but you must
manually refresh in order to see the result of any data changes. For more information, see
Changing data display options for the Report Builder.

6. Select the grid in the report canvas so that the configuration panel changes to show the Grid
Configuration settings. Define the grid settings as needed, such as to enable the total row or
enable drilling options. For more information, see Configuring grid properties in a web report.

In the following example, the total row was enabled for the grid.
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AXIOM)| Intelligence Center n o @ tji

e
< Intelligence Center Buld  Parameters  Filters # RefreshData  Preview
Data Context d configurati
Budget to Actuals Corporate Grid Configuration
GL2022 7
General Advanced
Through June 2022
Column Properties A
» B8 oL2022 2 2V
@D Eravie columntitters
» [ Dimension Tables [ worldRegion = Ml Actuals = Q2 Actuals = [DQ1Budget =~ 002 Budget = -
(1) Mutti-column sorting
» % Related Tables —
@D Enabvie reordering columns
WorldRegion Q1 Actuals Q2 Actuals Q1 Budget Q2 Budget rid Properties R
Asia (Asia region) $50,065,030 $58,174,791 33,016,385 $34,780,150 (T use tedrows
Carporate (Corporate departments) $11,786,889 §7,370,832 $6,102.973 6,200,837 @D inciude totat row
Europe (Europe region) $30,716,504 $30,422,551 $1,202,834 1,223,440 Total row header label
North America (North America region) 760,989,716 $750,407,151 $153,881599 139,551,224
() suppress zero rows
$862,558,229 $846,375,326 | $194,203,791 181,854,660 -
- ) "
1 aofditems Click the grid area () Enable drilling
to |D$d lherg”d Grid sort order
configuration
gura @® Defautt
properties
QO custom

Configuring grid properties

7. Click the Filters tab along the top of the page to define report-level filters as needed, to limit the
data shown in the report. For more information, see Filtering data in web reports.

In the following example, a general filter was added to exclude the Corporate world region value
from the report and to only show data for revenue accounts.
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AXIOM| Intelligence Center

< Intelligence Center Build

AllFilters + Add v

Revenue for Sales Regions
Revenue for Sales Regions

General filter @D cenabled

Name

Revenue for Sales Regions

Description

Filter Criteria

ACCT.Category = Revenue’ AND DEPT.WarldRegion <= ‘Corporate’

Defining a report-level filter to limit data in the report

noo @

Q@

Preview (VIR

Filters

8. Return to the Build tab, then use the plus icon at the top right of the Column Definitions box to
add calculated columns to the grid as needed. For more information, see Adding data columns

and calculated columns to a web report.

Build  Parameters  Filters

Corporate

1o @ i

w @
& Refresh Data Preview
Report Configuration
General Advanced
Title

+ v Budget to Actuals

Q2 Actuals = [DQ1Budget = [0 Q2Budget - Add Calculated Column @
Add Column Group
Subtitle
Q1 Actuals Q2 Actuals Q1 Budget Q2 Budget Through June 2022
56,089,316 $5,939,730 55,416,397 55,334,331 -
Report description

Click the plus icon to add a calculated column
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In the following example, two calculated columns have been added to calculate the difference
between actuals and budget for each quarter.

AXIOM| Intelligence Center

< Intelligence Center

Data Context

GL2022

> 8 6L2022
» [ Dimension Tables

» % Related Tables

Budget to Actuals

Through June 2022

Buld  Parameters  Filters

Corporate

oo >0
T WorldRegion MQ1 Actuals ~ [ Q1Budget = [MDifference = | MQ2Actuals = [Q2Budget ~ M Difference -
,
WorldRegion 01 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference
Asta (asia region) $6989,316 $5416,307 20.08% $5939,730 $5334331 11.35%
Europe (Europe region) $473,158 $340,531 38.95% 3369618 5335371 16.16%
North America (North 32,766,656 35,600,235 7.08% $26,180,604 35,068,189 -25.34%
America region)
$40,229,130 41,366,163 -2.75% 32,509,952 $40,737,891 -20.20%

1-30f3items

Adding and configuring calculated columns

% | | Refiesh Data | Preview

Column Configuration

General Advanced

Calculation

({Q1 Actuals}- {Q1 Budget)) / {Q1 Bud.. J°

Header

Difference

Column width

Alignment

Default (Right) v

Number format

Percent v
Data filter Edt
@D cnavieitter

() Hidecolumn

Include in total row

Default (true) v

Use the plus icon at the top right of the Column Definitions box to add column groups to the grid
as needed. Using column groups, you can display multiple columns grouped underneath a
header. For more information, see Defining column groups for a web report.
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v @

Build  Parameters  Filters % RefreshData  Preview

Corporate Report Configuration

General Advanced

Title

Budget to Actuals

s = [DQ2Actuals = [ Difference == [DQ1Budget =~ [MQ2Budget = [ Add Calculated Column

Add Column Group

_________________________________________________________________________________________________________________________ » | Subtitle
Q2 Actuals Difference Q1 Budget 02 Budget Difference Through June 2022
$5,939,730 29.04% $5416,397 $5,334,331 11.35% -
Report description

Click the plus icon to add a column group

In the following example, two column groups have been added for Q1 and Q2.

AXIOM| Intelligence Center [n] a @ 5;
w @
< Intelligence Center Bulld  Parameters Filters #+  RefreshData Preview
Data Context H i .
' Budget to Actuals . | Corporate i Column Group Configuration
6L2022 i : B
General
. : Through June 2022 H—
v 1
» E oL N © a
» [ Dimension Tables T WorldRegion mal - | maz (1) Hide column
> % Related Tables [MQ1 Actuals == [DQ1Budget = [0 Difference = Q2 Actuals -~ [MQ2Budget ~~ M () Autowrap header text
Header Alignment
« >
) @ Default v
WorldRegion
Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference | p. Fiter Bt

Asia (Asia region) $6,980,316 45,416,397 20.04% $5939,730 85,334,331 11.35% No filters defined

Europe (Europe region) $473,158 $340,531 38.95% $389,618 $335,371 16.18%

North America (North 432,766,656 $35,609,235 -7.08% $26,180,604 435,068,189 25.34%

America region)

$40,229,130 $41,366,163 -2.75% $32,509,952 $40,737,891 -20.20%
1-30f 3items.

Adding and configuring column groups
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10. Optional. If you want the report to dynamically change data based on user selections, then click
the Parameters tab to add report parameters to the report. For more information, see Using
report parameters in web reports.

11. Click Save to save the report.

12. Inthe Save Report As dialog, complete the following fields and then click Save:

Item Description

File name The name of the report file. This is the name that users will see in the
Intelligence Center.

Description Optional. A description of the report. Currently, descriptions do not
display in the Intelligence Center, but they can be viewed in the
Axiom Strategy Management Desktop Client using Axiom Explorer.

Save to folder The folder in the Axiom repository where you want to save the
report.

¢ C(Click the folder icon [= to the right of the field.

¢ In the Choose output folder dialog, select a folder in the Reports
Library. You can only select folders where you have read/write
access to the folder. If a folder name displays with a lock icon, this
means you have read-only access to that folder and therefore
cannot save a new report there.

NOTE: If you have access to the My Documents folder, then you
can also save reports to that location for your personal use.

¢ Click OK to choose the folder and return to the save dialog.

The path to your selected folder now displays in the field.

If you use a file name that already exists in the target folder, you will be prompted to choose
whether or not to overwrite the existing file. If you choose not to overwrite, the save operation is
canceled and you are returned to the Report Builder.

Keep in mind that many of these steps can be done in any order. You can configure the grid settings
before defining report titles, and so on. The main dependency is that you must select a primary table for
the data context before you can begin adding columns to the report.

Creating new web reports from template

Using the Intelligence Center, you can create new web reports from a template. Currently, templates
are only provided by installed Axiom Strategy Management products. For more information about any
templates provided by your installed products, see the separate product documentation.
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Some report templates require a fixed row structure to define the row dimensions and sections of the
report. If you want to create a new web report from a template that requires a fixed row structure, this
row structure must already exist so that you can assign it to the report when you create it. For more
information, see Managing Fixed Row Structures.

Web reports created from template remain linked to that template. If a template changes, that change
is automatically available in all reports created from that template.

In order to create a web report, you must be an administrator or have the Create Web Reports security
permission. In order to save the new report you must have read/write access to at least one folder in
the Reports Library or access to the My Documents folder. If you do not have permission to create web
reports, then the option to create a new web report from template will not be available from the Create
button in the Intelligence Center.

To create a new web report from template:

1. Inthe Intelligence Center, click Create > Create web report from template.

AXIOM| Intelligence Center o a @ 1
Q@
Reports Row Structures
v & Reports Library Intelligence Center
v O Corporate
Reports Library | Corporate Q
O Analysis
O3 Finanee Create web report from template
O ReportBuilder Create web report
> 3 Archive !Corporate Create new folder
£ Besthoards Name Y Modified on Y Modified by Y Type T

[}

File Processing
0O Analysis 3/2/202112:27 PM Clark Adams File Folder

0

Forms

Jpaimero O Finance 3/2/202112:27PM  Clark Adams File Folder

f

NOTE: If your system does not have any product-delivered templates available, then this
option will not be present on the Create menu.

The Create New Web Report from Template dialog opens to walk you through the report
creation process.

2. On the template screen, select the template that you want to use to create the report, and then
click Next.
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Create New Web Report from Template X

Select a template

Template name Created on
Balance Sheet Validation Report

Budget Balance Sheet Trend

Budget Comparative Income Statement

Budget Consolidating Balance Sheet

Budget Income Statement Trend

Budget Yield Trend

Cash Flow Forecaster Log Report

Cash Flow Forecaster Log Report Instrument Detail
Comparative Balance Sheet

Comparative Income Statement

Consolidating Balance Sheet

Consolidating Income Statement -

m ‘ CANCEL |

Example template screen showing product-delivered templates

3. On the fixed row structure screen, select the fixed row structure to use in the report, and then
click Next. If the template you selected does not use a fixed row structure, then this screen does
not display and you can skip to step 4.
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Create New Web Report from Template X

Select a fixed row structure

Fixed row structure name Created on

PM Test Yield with NIM V2 =
Contribution Statement

Statement of Earnings

Balance Sheet V1

Summary Balance Sheet

Operating Expenses

Student

Balance Sheet Trend Validation

= Lo [

Example screen showing fixed row structures

NOTE: If no fixed row structures are listed, then your system does not have any available
fixed row structures. You must create one before you can create a web report using the
selected template. You can click Back to select a different template, or you can click Cancel to
exit the dialog and return to the Intelligence Center. For more information, see Managing
Fixed Row Structures.

4. On the final screen, complete the following fields to save the new report, and then click Create.

Iltem Description

Name The name of the report file.

Description Optional. A description for the report.
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Iltem Description

Save report in The folder in the Axiom repository where you want to save the
report.
¢ Click the folder icon [= to the right of the field.

¢ Inthe Choose output folder dialog, select a folder in the Reports
Library. You can only select folders where you have read/write
access to the folder. If a folder name displays with a lock icon, this
means you have read-only access to that folder and therefore
cannot save a new report there.

NOTE: If you have access to the My Documents folder, then you
can also save reports to that location for your personal use.

¢ Click OK to choose the folder and return to the save dialog.

The path to your selected folder now displays in the field.

The report is opened in the current browser tab. You can now review the data using a variety of tools
available to web reports, such as sorting, filtering, and drilling. For more information, see Viewing and
exploring data in web reports.

Once a report is created from template, it cannot be edited—for example, to choose a different fixed
row structure. If you want to use a different fixed row structure, create a new report from template
again. Remember that any changes to the template or to the fixed row structure will automatically flow
through to all reports that use the template or the fixed row structure.

Using the Report Builder

Using the Report Builder, you can create and edit web reports using a drag-and-drop interface. Web
reports are intended to be intuitive for report builders to create and easy for report viewers to use.

Web reports support two different ways to display reporting data in a grid:
e Dynamic rows: Dynamically display data rows based on a specified dimension or grouping.

» Fixed rows: Use predefined fixed row structures to organize data rows into sections with headers,
totals, and subtotals.

The Report Builder opens when you do either of the following:
e Create a new web report from the Intelligence Center.
e Edit an existing web report from the Intelligence Center or from the report viewer.
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» Overview of the Report Builder
The Report Builder is organized into three tabs:

e Build: Use this tab to design the report data and configure report properties. This is the default
tab.

e Parameters: Use this tab to enable and configure interactivity for the report. Report users can
dynamically change the data that displays in the report using report parameters.

¢ Filters: Use this tab to define report-level filters, to limit the data shown in the report.

In the Build tab, the Report Builder has three main areas:

e The Data Panel on the left side is where you select the data to include in your report.

e The Report Canvas in the middle is where you build the report. Columns can be dragged and
dropped from the Data Panel to the Report Canvas. You can also create calculations to display in
the report columns, and define column groups.

e The Configuration Panel on the right side is where you define properties for the report, the data
grid, and the individual columns. You can configure properties such as report titles, drilling
options, and column formatting.

AXIOM| Intelligence Center Separate tabs for building n oo @ i
the report, defining report
parameters, and defining b
report filters
< Intelligence Center Bulld  Parameters  Filters '3 Preview
Data Context .
Budget to Actuals Corporate Report Configuration
612022 e Report Canvas: |- General Advanced
Through June 2022 Dl’ag and dl’OP
columns to design Title
» BB 6L2022 +v the report o Budget to Ac
v B omenson Tases — Configuration Panel:
¢ = [MworldRegion == oo = [@ma2 *  Secondary Configu re grid, column,
> % Related Tables Q1 Actuals =~ Q1 Budget - [Difference = M2 Actuals = [0Q2Budget - [ Difference == corpora. ~ and report properties
> Subtitle
a Qz Through June 2022
WorldRegion

Data Panel: Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference
SEIEC[ IEbIES End Report description
N Asia (Asia region) $6,980,316 $5,416,307 20.04% $5,039,730 $5,334,331 11.35%
columns to include
in report ) .
Europe (Europe region) $473,158 $340,531 38.95% $389,618 $335371 16.18%

File group context Edit
North America (North America

region) $32,766,656 $35,600235 7.98% $26,180,604 $35,068,189 2534%

40,229,130 $41,366,163 2.75% $32,500,952 $40,737,891 -20.20%
Report data
|-3ofsitems (® Live data with manual refresh

(O ive data with auto refresh

(O Mock data

Overview of the Report Builder

As you build and configure the report, a preview of the grid displays in the Report Canvas area. Several
options are available to control how data is shown in this grid. For more information, see Changing data
display options for the Report Builder.
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» Building a report in the Report Builder

The following is an overview of how to build a report in the Report Builder:

Define a data context: Each report must have a specified primary table to determine the data
context for the report. Once the data context is defined, you can build the report using columns
from the primary table and from related tables.

Define report titles: You can define report title text and an optional report description.

Define the grid rows: Web reports can use dynamically generated rows based on a dimension, or
they can use a fixed row structure. Do one of the following depending on the type of report that
you want to make:
° For dynamic rows, add a row dimension to the grid by dragging and dropping a table
column.

° For fixed rows, specify a fixed row structure by modifying the grid properties.

Add data columns and calculated columns: Drag and drop table columns out to the grid to define
the data columns for the report, and define calculated columns as needed. You can also define
column groups to create grouped headers in the report.

Configure grid properties: Configure grid properties such as the total row and user interaction
options, including enabling and configuring drilling options as needed. You can also adjust the
default formats for various column types.

Configure column properties: Configure properties for each column such as alignment, width,
number format, and column filters.

Define report filters: You can define general and table-specific filters to limit the data shown in
the report grid.

Define report parameters: You can optionally create and configure report parameters to allow
end users to dynamically change the data shown in the report.

» Changing data display options for the Report Builder

As you build and configure the report, a sample of the grid data displays in the Report Canvas area. You
can choose how data displays in the sample grid as you build the report.

NOTE: The sample grid is intended to give you an idea of how the report data will display to report
viewers, but it is not intended to be an exact representation of the final report. To see the report as
it will appear to report viewers, use the Preview feature.

To change how data displays in the Report Builder:

1.

On the Build tab of the Report Builder, click the gear button at the top of the page to load the
Report Configuration properties.
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n o @ i

w @

& Refresh Data Preview

2. Select one of the following options for Report data:

e Live data with manual refresh (default): Live data is shown in the grid, however, you must
manually refresh the data after making configuration changes that affect the data shown.
This is for performance reasons, so that you do not have to wait for data queries to
complete in order to continue working on your report. When using this option, data
updates are handled as follows:

° |If you add a new column, or make a configuration change that would affect the data
shown in the column, the column will be blank. To populate the grid for data in this
column, click the Refresh Data button.

° If you make a configuration change that would affect the data shown in the entire
grid, the grid will be blank. To populate the grid with the current data, click the
Refresh Data button.

The Refresh Data button is only available when using this option.

¢ Live data with automatic refresh: Live data is shown in the grid, and the data
automatically updates after you make any configuration changes. Generally speaking, this
option should only be used when the report queries a small set of data so that updates will
be quick, or when you do not expect to be making many configuration changes that affect
data.

¢ Mock data: Mock data is shown in the grid. When using this option, you can get a basic
idea of how the report columns and format will display to the user, without viewing actual
data. This is a good option if you do not need to made configuration changes that affect
the data, or if you do not need to view the data while you are making these changes.
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AXIOM| Intelligence Center

< Intelligence Center

Data Context

612022

> 6Lz
» & Dimension Tables

» % Related Tables

Budget to Actuals

Through June 2022

D worldRegion

WorldRegion

Asia (Asia region)

Europe (Europe region)

North America (North America
region)

1-3of 3items

Data display options for the Report Builder

mal

a1l Actuals ==

Q1 Actuals

$6,980,316

$473158

$32,766,656

$40,229,130

Build  Parameters  Filters

Q1 Budget =

Q1

Q1 Budget

$5,416,307

$340,531

$35,609,235

$41,366,163

Corporate

@ Difference ==

Difference

20.04%

38.95%

7.98%

2.75%

- a2

M Q2 Actuals =

Q2 Actuals

$5030,730

$389,618

$26,180,604

$32,509,952

[0 Q2 Budget =

Q2

Q2 Budget

$5334,331

$335371

$35,068,189

$40,737,891

(@ Difference ==

Difference

11.35%

16.18%

25.34%

-20.20%

n oo @

w @

& [RefreshData | Preview

Report Configuration

General Advanced

Title

Budget to Actuals

< Secondary title

Corporate

Subtitle

Through June 2022

Report description

File group context Edit

Report data
(®) Live data with manual refresh

(O Live data with auto refresh

(O Mock data

Even if you are viewing live data, keep in mind that the grid shown in the Report Canvas is simply meant
as a guide to help you build the report—it is not intended to be a fully functional representation of the
report. If you want to see how the report will display to report viewers, click the Preview button.

NOTE: The Report data option is not saved in the report, and your selection is not saved for future
Report Builder sessions. Every Report Builder session defaults to using live data with manual refresh.

» Previewing a report

The sample grid in the Report Canvas accurately reflects some report configuration details such as
column headers and number format. However, other configuration details are not reflected in the
sample grid. For example:

e Column width may not be accurately reflected in the sample grid. Initially, the grid will expand to
fit the available space. Once there are enough columns to fill the space, the column width will be

honored.

e The sample grid only shows up to ten rows of data (when using dynamic rows) and does not
display paging options.

¢ Drilling options are not available in the sample grid.

e Report viewer options to sort and filter column data are not available in the sample grid

e Report parameters cannot be used on the sample grid.
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If you want to see how the report will display to end users in the report viewer, including all user
interaction options for the report, click the Preview button at the top of the Report Builder.

n o @ i

w @

& Refresh Data Preview

The report preview opens in a separate dialog that overlays the Report Builder. Using this preview, you
can view the report data and try out end-user features like sorting, filtering, and drilling the report.
When you are done viewing the preview, click Close at the bottom of the dialog to return to the Report
Builder (or click the X in the top right corner).

The report preview does have a few limitations. Export and share options are not available in the report
preview. Additionally, if hyperlinks are used in the report, the hyperlinks will always open in a new tab,
even if they are configured to open in the same tab—this is done so that clicking a hyperlink will not
close the Report Builder.

» Saving a report

Use the Save button at the top of the Report Builder to save the report. If the report is a brand new
report, you will be prompted to define a name and folder location for the report. Otherwise, the existing
report is saved.

If you have opened an existing report for editing and you want to save a copy of it with a new name,
click the down arrow to the right of the Save button and select Save As.

n o @ &

w @

el Refresh Data Preview m

Save As

Column Configuration

Save button with Save As option
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NOTE: The Create Web Reports security permission is required in order to use Save As.

If you have made changes to the report but have not yet saved, you will be prompted to save when you
attempt to close the browser tab or navigate to a new location.

Defining the data context for a web report

The data context for a web report determines the overall pool of data that is eligible to be included in
the report. To define the data context, you select a primary table as the "base" table for the report. This
primary table then determines which other tables are eligible for inclusion in the report, based on
lookup relationships. All table columns used in the report must be compatible in the context of the
primary table.

In the Report Builder, the primary table for the data context is specified on the Build tab, in the left-
hand Data Panel. You must select the primary table before you can drag and drop any table columns out
to the grid.

To select a primary table for the data context:

There are two ways to select a primary table for the data context.
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¢ When you create a brand new report, you are automatically prompted to select a primary table
for the data context.

You can select a table from the drop-down list directly, or type into the box to search for a table
name. The search uses "contains" matching to return any tables that contain the search text
within the table name. Tables that start with the search text are listed first, followed by tables
that contain the search text anywhere in the table name. In the following screenshot, the text
2022 has been used to search for tables with the year 2022 in the name.

Select Table

Select a Data Context for the report

2022

BGT2022

6L2022

Example Select Table prompt when creating a new report
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e If you are already in the Report Builder, then you can define or change the primary table using
the Data Context box at the top of the Data Panel. Click the Edit icon ¢ to open the Select Table

dialog (as shown in the previous screenshot).

< Intelligence Center

Data Context

GL2022 &

» HBH GL2022
» & Dimension Tables

» S Related Tables

Once you have selected a table, that table name is shown in the Data Context box, and the Data Panel
populates to show a table tree in three expandable/collapsible sections:

e TableName: The selected table and its columns. This table is the primary table.

e Dimension Tables: Reference tables that the primary table looks up to. If the reference tables
have lookups to other reference tables, these multi-level reference tables are accessible through

the first-level reference tables.

e Related Tables: The contents of this section depend on the type of table selected as the primary
table.
o If the primary table is a data table, then this section contains other tables that look up to
one or more of the same reference tables as the primary table.

o If the primary table is a reference table, then this section contains tables that look up to
the reference table.

You can expand these tables to view the columns, and then drag and drop columns out to the Report
Canvas area so that they can be used as row dimensions or data columns.

Administrator's Guide Axiom Strategy Management | 145



< Intelligence Center

Data Context

GL2022 7

b

F

F

BB GL2022
M AccT
@ DEPT
M m
M m2
M M3
M m4
M M5
M Mms
@ m7
M s
M m9

Expanded table tree

In this example, we have selected GL2022 as the primary table. GL2022 is a data table that looks up to
reference tables Dept and Acct. The table tree is populated as follows:

GL2022: This node contains all columns in GL2022, as well as columns in the lookup tables Dept
and Acct.

Dimension Tables: This node contains the lookup reference tables Dept and Acct. If the reference
tables look up to other downstream reference tables (multi-level lookups), those downstream
reference tables can be used through these tables.

Related Tables: This node contains other tables that also look up to Dept or Acct (or to a multi-

level lookup through Dept or Acct). This may include tables such as GL2021, BGT2021, and
BGT2022.
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When you save the report, the data context is saved for that report and will be reloaded into the Data
Panel whenever the report is opened in the Report Builder.

NOTES:

¢ When choosing the data context, the list of tables is automatically filtered to only show tables
that you have access to. If you have the Administer Tables security permission, all tables will
be shown. This means it can be possible to select a primary table where you do not have
access to any of the data in the table. You can build the report but it will not populate with
data.

e Certain tables can be restricted from showing the in the Report Builder using the system
configuration setting TablesRestrictedFromReportWriter. If a table that you have access to is
not available, it has likely been restricted using this setting.

» Changing the data context

You can change the data context freely until you have done either of the following:
e Dragged and dropped columns out to the grid setup boxes in the Report Canvas

e Selected a fixed row structure for use with the report (when using the Use fixed rows option in
the Grid Configuration properties)

You can still change the data context if needed, but any newly selected primary table must be
compatible with the table columns you have already added to the grid, and with the fixed row structure
you have selected (if applicable). If the newly selected primary table is not compatible, an error will
occur when the Report Builder tries to refresh the grid in the Report Canvas. At this point you have the
choice of selecting a different primary table that is compatible (which may mean returning to the
original primary table), or removing the incompatible columns from the grid, or choosing a different
fixed row structure.

Other settings that must be compatible with the primary table include columns selected as drilling
columns for a Directed drilling configuration. If you change the primary table and any of these settings
are incompatible with the new primary table, an error will occur.

If you change the data context and save the report, the new primary table is now saved for the report
and will be reloaded into the Data Panel whenever the report is opened in the Report Builder.

Specifying the row dimension for a web report

The row dimension for a web report defines the summation level for the row data. For example, you
may want the rows in your grid to show data by department, region, entity, account, or some
combination of dimensions. You specify a table column to use as the row dimension, and then the rows
in the grid are dynamically generated based on the unique values in that column.
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NOTE: If you want your report to use a static row structure with multiple sections instead of
dynamically generating the rows, then use a fixed row structure instead of a row dimension.

The row dimension for the report is placed in the left-hand box at the top of the Report Canvas, known
as the Row Dimensions box. The report grid cannot render until you specify either a row dimension or a
fixed row structure.

New Report + Add Secondary Title

+ Add Subt Drag and drop data
columns to define the |
rows of the report

Row Dimensions box at the top of the Report Canvas

Web reports can have multiple row dimensions. If two or more row dimensions are specified, then each
row in the report represents a unique combination of the dimensions. For example, if the row
dimension is just Dept, then each row shows data for a department. If the row dimension is Dept and
Acct, then each row shows data by the unique combinations of department and account.

To specify a row dimension for a web report:

1. On the Build tab of the Report Builder, in the Data Panel, expand the table tree until you locate
the column that you want to use as a row dimension.
If the Data Panel is empty, this means you must select a primary table first.

2. Drag and drop the column to the Row Dimensions box at the top of the Report Canvas.

3. Select the column name in the Row Dimensions box, and then use the Column Configuration
panel to configure display properties such as column width, alignment, header text, and
formatting. For more information, see Configuring column properties for a web report.

4. If multiple columns are present in the Row Dimensions box, you can drag and drop them within
the box so that they display in the desired order within the grid.

Once a row dimension is specified, the Data Panel updates to remove any tables that are incompatible
with the specified row dimension. You can now build out the data columns of the report by dragging and
dropping columns from the Data Panel, and by creating calculated columns. For more information, see
Adding data columns and calculated columns to a web report.
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< Intelligence Center
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[0 Dept

[ Description
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@ country
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@ currency
» mvp
[ Employees
[0 Manager
@ Consolidated
» [0 owner
@ emaiz
[0 FesiDept
M BgtCombineDuringQuery

[ showonList

Budget to Actuals

Through June 2022

[0 WorldRegion ==

0-0of 0 items

Defining a row dimension for a web report

NOTES:

Build

Parameters  Filters

Corporate

Please add at least one column to the Column Definitions box

n a @ i

w @

£ HEUCTA Save v

Column Configuration

General Advanced

Column
DEPT.WorldRegion

Header

WorldRegion

Column width

Alignment
Default (Left) v

@D Eenave iiter

T Hi
() Hide column

@D show description
Description display format

Value (Description v

e If you drag and drop a validated column from a data table to use as the row dimension, such
as GL2022.Dept, this column reference is automatically "elevated" to point to the lookup
table instead, meaning Dept.Dept. This is done so that the column reference is compatible
with other data tables that reference the same lookup table. This elevation only occurs if the

validated column looks up to a shared dimension table.

¢ Calculated fields from the database cannot be added as row dimensions.

» Using a dynamic column for the row dimension

You may want to design a report where the row dimension is dynamic based on user input. Users can
choose the grouping level that they want to see the rows summarized by.

To configure a report to use a dynamic row dimension, you must:
e Create a Column List report parameter, and configure the parameter to use the columns that you
want users to be able to choose as the row dimension.

¢ Add a Dynamic column to the Row Dimensions box, and configure that column to use the Column
List report parameter.
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When a report user opens the report, they can use the Report Parameters panel to choose the column
that they want to use as the row dimension. The report then refreshes to show the data grouped by that
column. For more information, see Using report parameters in web reports and Using Column List
report parameters.

» Displaying descriptions for the row dimension

In many cases your row dimension will be a code, such as a department code or an account code, and
you want to display the description for the code next to it. By default, any column with an associated
description is automatically enabled to show the descriptions appended to the column value. If desired,
you can specify a different display format for the descriptions, or you can disable showing descriptions.

This behavior applies to any column with descriptions used in the report, but the most common use
case is for the row dimension columns.
To configure the description display formats for row dimensions:

1. On the Build tab of the Report Builder, select the row dimension column in the Row Dimensions
box.

2. Inthe Column Configuration settings, on the General tab, enable or disable Show description as
needed.

3. If descriptions are enabled, then select the desired display format from the Description display
format list.

In the following example, the Dept column has been configured to show descriptions using the Value -
Description format. If you select a format that shows descriptions first, such as Description (Value),
then the rows will be sorted by the descriptions instead of the underlying values.

AXIOM| Intelligence Center o a @ ’_:3
w Q@
< Intelligence Center Build  Parameters  Filters 4  RefreshData  Preview
Data Context . " fqurati
New Report + Add Secondary Title Column Configuration
L2022 7
General Advanced
+ Add Subtitle cotumn
DEPTDept
v BB ol PV +~
Header
» [ AceT O DEPT == MM = M2 = TM3 =
DEPT
» [ oerT
e Column widin
m m2
m M3 =T (30 M2 M3 Alignment
e 11000 - Balance Sheet $1.200,867 $2,060,668 $567,027 Default (Left) v
@ ms
Twe 20000 - Corporate $338371 $348818 $512,223 Number format
T Defautt (Dimension) v
21000~ Corporate Administration $109,424 $142424 $113,341
mwms @D cravleditter
@ mo 22000 - Information Technologies $446,802 $463814 $466,517 _
() Hide column
@ m10 T
23000 - Purchasing & Materials Mgt $129,671 $160499 $144,200 T
D (o] v
@ Mz 24000 - Business Development §29,110 $28736 $32,280 B I
» [ integer Value - Description v
25000 - Finance $169,733 $167,145 $187,505
m ot

m yTo1

@ vo2

1-100f 124 items

M vz

Example row dimension column configured to show descriptions
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» Filtering the row dimension

In some cases you want the report to display a subset of values from the row dimension column, instead
of all values. To filter the row dimension values, use the Filters tab to define a general filter for the
report.

For example, if the row dimension is Dept but you want the report to only display departments that
belong to a specific entity, define a general filter such as Dept.Entity="Entity 1'. This will filter
the grid so that it only shows data that belongs to Entity 1, including the row dimension values.
Department codes that do not belong to Entity 1 will not be included in the data query.

» Changing the row dimension

You can change the row dimension at any time by dragging and dropping additional columns to the Row
Dimensions box, or by removing existing row dimensions.

To remove a row dimension, click the three-dots icon to the right side of the column name and then
select Delete Column. If you remove the only row dimension, the grid in the Report Canvas cannot be
rendered until you specify a new one.

If you change the row dimension after adding data columns and calculated columns, or if you change
the primary table after specifying a row dimension, it is possible that some of the selections may be
incompatible with each other. In this case, an error will display when the Report Builder attempts to
refresh the data in the Report Canvas. You may have to remove incompatible columns, change the row
dimension, or change the primary table in order to restore a valid grid configuration.

If you decide that you want to change the report to use a fixed row structure instead of a row
dimension, use the Grid Configuration properties to enable fixed rows and then choose a fixed row
structure. For more information, see Specifying the fixed row structure for a web report. Any columns
currently placed in the Row Dimensions box will be ignored while fixed rows are enabled for the report.

Using upstream grouping columns as row dimensions in web reports

Under normal circumstances, row dimension columns can be columns on the primary table for the data

context, or columns on lookup dimension tables. However, when the primary table for the web report is
a reference table, you can also optionally use columns from related tables as row dimensions. This type

of configuration is referred to as upstream grouping columns.

Upstream grouping columns can be useful for reporting in certain Axiom Strategy Management products
that hold important data in reference tables. For example, the Enterprise Decision Support (EDS)
product needs to report on data in the Encounter table, which is a reference table. For some reports,
they want to group this data using a related table such as the EncounterPayor table, yet still bring in
columns from other related tables that look up to the Encounter table (such as CostDetail). Columns
from the EncounterPayor table are considered upstream grouping columns because EncounterPayor
looks up to Encounter instead of the other way around.
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» Identifying upstream grouping columns
A row dimension column is considered an upstream grouping column if both of the following are true:

e The primary table for the data context is a reference table. Reference tables are a particular type
of table classification in Axiom Strategy Management that can only have one key column, and can
serve as the lookup source for a validated column. Reference tables are also often referred to as
dimension tables, as many reference tables are used to define dimensional data such as
department, account, or entity.

¢ The row dimension column is from a related table instead of from a dimension table or the
primary table.

» Design considerations and limitations when using upstream grouping columns

When upstream grouping columns are used in a report, the data query uses different syntax than when
using standard row dimensions. This special syntax causes the following design considerations and
limitations:

e Aggregations: Average and Distinct Count aggregation types cannot be used in the report.

e Data impact: When rendering the report, any data from the primary table that is not referenced
by the upstream grouping column is omitted from the report. For example, imagine that the
primary table is Encounter, and you are grouping by a column in the upstream EncounterPayor
table. If there are records in the Encounter table that the EncounterPayor table does not
reference, those records are omitted from the report.

e Total row: When the current row dimension is an upstream grouping column, the totals shown in
the total row may not match the sum of all the displayed rows. This is because multiple values in
the upstream grouping column may reference the same record in the primary table, causing that
record to be included multiple times. The total row displays the total as if each record from the
primary table is only included once. When this situation occurs, a warning icon displays on the
total row, with an explanation of this effect in the tooltip.

For example, imagine that the primary table is Encounter, and you are grouping by a column in
the upstream EncounterPayor table. Payor A and Payor B both reference Encounter 100, so
values associated with Encounter 100 are included in both payor rows in the report. Rather than
double-count the values from Encounter 100, the total row only counts the values once.

Specifying the fixed row structure for a web report

Web reports can optionally use fixed row structures to define the data sections in the report. Instead of
dynamically generating the rows based on a table column, fixed row structures individually define each
row of data, including section headers, subtotals, and totals.
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Fixed row structures are defined separately so that you can reuse them in different web reports, and so
that you can update the row structure in one place and have the changes propagate to all reports that
reference the fixed row structure. The fixed row structure that you want to use in the web report must
already exist—they cannot be created or edited in the Web Report Builder. For more information, see
Managing Fixed Row Structures.

The fixed row structure is specified in the Configuration Panel, using the Grid Configuration properties.
The grid in the Report Canvas cannot render until you specify either a fixed row structure or a row
dimension.

To specify a fixed row structure for a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click the grid area below the column
setup boxes. This area displays with placeholder text until either a row dimension or a fixed row
structure is specified.

AXIOM| Intelligence Center o a @ I_Ei
w @

< Intelligence Center Buld  Parameters  Filters ® Preview m

pata conext New Report + Add Secondary Title Grid Configuration

612022 2
22 7 General Advanced

+ Add Subtitle

Column Properties
+v +v

> B ez
@D Enable column fiters
» [ Dimension Tables
() Mutticolumn sorting
» % Related Tables —
@D eravie reordering columns

Click here to load the Grid Properties
Please select at least one Row Dimension column g”dp(,:—g:g?(l\lgzuon ( :) Use fixed rows

) Include total row

0-00f Oitems

A O N

) Suppress zerorows

2. Inthe Grid Configuration properties, enable Use fixed rows.

3. From the Fixed row structure drop-down list, select an existing fixed row structure. You can type
into the box to filter the list by name.
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Grid Configuration

General Advanced

Column Properties v

D Enable reordering columns

Grid Properties v

‘) Use fixed rows

Fixed row structure

[ rey| v

RevEXp

RevExp1

After selecting a fixed row structure, the Report Canvas area updates as follows:

e The Row Dimensions box updates to show a placeholder column named Fixed Row Header
Column. This column is the column that holds the section titles and data row labels as defined in
the fixed row structure. You can select this placeholder column in order to configure certain
display details about this column within the web report.

¢ Once you have dragged and dropped at least one data column to the Column Definitions box, you

can use Refresh Data to update the grid and show the sections and rows as defined in the fixed
row structure.
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Example web report using a fixed row structure
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¢ |f you want to make changes to the fixed row structure, you must edit the structure in the
separate fixed row structure editor. Any changes made to the row structure will automatically

apply to any web report that uses the fixed row structure.

e The option to Add Dynamic Column above the Row Dimensions box is not available when
using a fixed row structure. Dynamic columns are only available for use when using row

dimensions to generate the rows of the report.

* |f you decide that you want to use dynamically generated rows instead of a fixed row
structure, you can simply disable Use fixed rows and then drag a column to the Row
Dimension setup box. For more information see Specifying the row dimension for a web

report.

» Impact on Grid Configuration options

When Use fixed rows is enabled for the grid, multiple grid configuration options become unavailable
because they do not apply to web reports that use fixed row structures. If these options were
configured before fixed rows were enabled for the grid, the configuration will be ignored.

e Enable column filters: Report viewers cannot filter columns when using fixed rows.

e Multi-column sorting: Report viewers cannot sort columns when using fixed rows.
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¢ Include total row (and related settings): This option does not apply because fixed row structures
have their own defined subtotal and total rows.

e Suppress zero rows: This option does not apply to fixed row structures; all configured rows will
display regardless of whether they return all zero data.

e Grid sort order: This option does not apply to fixed row structures.

» Configuring the Fixed Row Header Column

Most of the display details for the Fixed Row Header Column are configured within the fixed row
structure and therefore cannot be changed within the web report. However, if you select the Fixed Row
Header Column item in the Row Dimension setup box, you can configure the following:

Iltem Description

Column width The column width of the column in the grid, in pixels. Enter the desired
column width as a whole integer between 30 and 600.

The default width of the Fixed Row Header Column is 400.

Adding data columns and calculated columns to a web report

When creating a web report, you can add as many columns as needed to define the data that you want
to display in the report. You can also define calculated columns, such as to show the difference between
two columns.

The data columns and calculated columns for the grid are placed in the right-hand box at the top of the
Report Canvas, known as the Column Definitions box. This box defines the columns to display in the
report. Although it is possible to add columns and calculated columns to the Column Definitions box
before specifying a row dimension or a fixed row structure, the grid in the Report Canvas will not
populate until the rows are defined.

New Report + Add Secondary Title
+ Add Subtitle Drag and drop the Click here to add a
data columns to | calculated column
P display in the report J— v

Column Definitions box at the top of the Report Canvas
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» Adding data columns

To display data in the report, you can drag and drop table columns from the Data Panel to the Column
Definitions box in the Report Canvas. The Data Panel displays the tables and columns that are eligible to
be included in the report, based on the selected data context (primary table) and the specified row
dimension.

To add a data column to a web report:
1. On the Build tab of the Report Builder, in the Data Panel, expand the table tree until you locate
the column that you want to add to your report. You can also use the search boxes at the top of
the panel to find a particular table or column by name.

2. Drag and drop the column to the Column Definitions box at the top of the Report Canvas.

NOTE: When using the default behavior, the new column will render as blank in the report
until you click Refresh Data.

3. If the column is not in the desired location within the grid, drag and drop it within the Column
Definitions box to reorder the columns.

4. Use the Column Settings in the Configuration Panel to configure display properties for the
column, such as column width, alignment, header text, and formatting. For more information, see
Configuring column properties for a web report.

By default, when you drag and drop a column to the grid, that column is selected and its column
properties display in the Configuration Panel. You can return to the column properties at any time
by clicking the column name in the Column Definitions box.
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Example web report after adding data columns

NOTE: If Use fixed rows is enabled for the grid, currently the Report Builder does not dynamically
update the tables listed in the Data Panel based on the specified fixed row structure. If you drag and
drop a column from a table that is not valid in the context of the fixed row structure, a generic error
will occur when the Report Builder attempts to populate the grid.

» Adding calculated columns

Calculated columns can be used to display totals, differences, percentages, and other calculations within
a column of the report. Calculations can be based on columns from related tables that are eligible to be
included in the report.

To add a calculated column to a web report:

1. On the Build tab of the Report Builder, in the Report Canvas, click the plus sign in the top right
corner of the Column Definitions box, and then click Add Calculated Column.
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Corporate Report Configuration
General Advanced
Title
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Add Column Group

Subtitle
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56,089,316 $5,939,730 55,416,397 55,334,331 -
Report description

2. At the top of the Add Calculated Column dialog, define the following properties:
e Header: Enter the column header text for the calculated column. This is effectively the
name of the calculated column. By default, the header text is "Calculation".

e Numeric type: Select the desired numeric type for the calculated column. If this is left at
Default, the default numeric type for calculated columns is Currency.

Add Calculated Column X

Header Difference Numeric type  Percent ~
» EBGL2020
» % Related Tables

» i Grid Columns

You can change these properties later using the Column Configuration properties in the
Configuration Panel.

3. To create the calculation, drag and drop columns from the table tree on the left to the calculation
canvas. See Defining calculations for more information.

4. When you are finished creating the calculated column, click OK.

The calculated column is added to the Column Definition box. By default, the new column is blank
until you click Refresh Data.
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5. If the calculated column is not in the desired location within the grid, drag and drop it within the
Column Definition box to reorder the columns.

6. Use the Column Configuration properties in the Configuration Panel to configure display
properties for the column, such as column width and alighnment. For more information, see
Configuring column properties for a web report.

By default, when you define a calculated column, that column is selected and its column
properties display in the Configuration Panel. You can return to the column properties at any time
by clicking the column name in the Column Definitions box.
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Example web report after creating a calculated column

» Defining calculations

Using the Add Calculated Column dialog, you can build a calculation based on columns from related
tables that are eligible to be included in the report. The column does not have to be present in the grid
in order to be used in a calculation. Numeric values can also be used in the calculation.

The left-hand side of the dialog lists a table tree of available columns, while the right-hand side of the
dialog—the calculation "canvas"—is where you build the calculation. To start the calculation:

e Drag and drop two columns out to the canvas. The two columns are separated by an operator
selector.

e Select the desired operator.
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You can continue building the calculation by dragging and dropping additional columns and selecting the
operator. You can also do the following:

e Numeric values: To add a numeric value to the calculation, click the plus icon at the top right of
the dialog. You can then move, reorder, or delete the numeric value just like columns.

e Reorder items: To change the order of columns in the calculation, drag and drop them on the
canvas.

e Parentheses: To add parentheses to a part of the calculation, select Add Parentheses from the
operator selector. The two columns affected by the operator will become enclosed in
parentheses.

e Delete items: To delete an item, hover your cursor over the column and then click the trash can

icon.
Add Calculated Column X
Header Difference Percent Numeric type  Percent v
» EBGL2020
: +e
» % Related Tables Add numeric
values to the
v i Grid Columns calculation
[0 Jan Actuals
Build the
(D Jan Budget calculation on the
canvas area
Drag and dro R ,
co\un%ns from lll?le ( Jan Actuals - Jan Budget ) /- Jan Budget

tree to the canvas

Select calculation
operators and add
parentheses

Cancel

Example calculation in the calculation editor

Calculations can use the following operators: addition (+), subtraction (-), multiplication (*), and division
(/). Use parentheses to determine calculation order, such as: (GL2022.Q1-
BGT2022.Q1) /BGT2022.0Q1.

Calculations can use the following columns:
e Numeric columns from the primary table, whether or not those columns are also in the grid.

e Numeric columns from related tables, whether or not those columns are also in the grid.
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e Numeric columns from the grid, including other calculated columns. Grid columns display using
the header text defined for the column.

If you use a table column from the grid instead of from the table itself, then the calculation will
use the column as it is configured to display in the grid. For example, if the grid column has a
column filter or uses an alternate aggregation, the calculation will be based on that modified
version of the column.

NOTES:

¢ |f you drag and drop a column from the primary table or a related table, it displays on the
canvas using the column name only—such as M1. You can hover your cursor over the column
box to see a tooltip with the full table.column name—such as GL2022.M1. If you drag and
drop the column from the Grid Columns node, then it will display using the defined header
text for the column.

¢ |f you use a grid column in the calculation, then the grid column cannot be deleted from the
grid because deleting it would cause the calculation to become invalid. An error message will
display if you attempt to delete a referenced column from the grid. To resolve the issue, you
can do one of the following: edit the calculation to remove the reference, delete the
calculated column, or configure the grid column as hidden so that it can still be referenced in
the calculation but not display in the report.

» Editing calculated columns

You can edit an existing calculated column to change the calculation.

To edit a calculated column in a web report:

1. On the Build tab of the Report Builder, in the Report Canvas, click the calculated column in the
Column Definitions box.

2. On the General tab of the Column Configuration properties, click the Edit icon #*to the right of
the Calculation box.

Column Configuration

General Advanced i

Calculation

({Q1 Actuals} - {Q1 Budget}) / {Q.. &

3. Inthe Edit Calculated Column dialog, edit the calculation as needed, then click OK.
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» Pre-aggregation in calculated columns

You can pre-aggregate calculations in a calculated column. A pre-aggregate calculation is applied to data

rows in the query before those rows are aggregated by the row dimension.

In this example, the sum of columns Q1 through Q4 have been summed up and presented in a new
calculated column, Total Yearly Budget and the Pre-Aggregation Calculation button is selected.

< Intelligence Center Build  Parameters  Filters % RefreshData  Preview
Data Context )
Budget for 2020 + Add Secondary Title Column Configuration
BGT2020 7
General Advanced
+ Add Subtitle
Search tables Search columns Galculation
+v +v  Q1+04+03+Q2

» BB BGT2020

» [l imension Tables M Dept - [ Description -+ @Q1 -~ @MQ2 -~ MQ3 - Q4 - |MTotal Yearly Budget - @D FreAvuregation Calculation

» @ Related Tables
Display Properties

Header

Dept Description Q1 Q2 Q3 Q4 | Total Yearly Budget Total vearly Budget
20000 (Corporate: Corporate) Telephone $80,657 $80,495 $78977 $79,735 $319,864
Column width | [120px
21000 (Carperate Administration) Travel §79,077 $78,536 $77,648 $78,089 $313350
Alignment
s 75 75 738,90 747 2,906,8
22000 (Information Technologies) Telephone 755343 755343 $738,004 $747,161 2,096,841 Defaut (Right)
rchas saterials
23000 (Purehasing & iate il Utilities $22013 $21815 $21,650 $21,723 $87,201
Mgmt) Hide column
24000 (Business Development) Telephone $11,050 $10882 $10882 $10883 343,607
Formatting Properties
25000 (Finance) Telephone 54,646 $4,627 54,553 54,595 $18421
26000 (Portfolio Management) Supplies $26915 $26,796 $26,383 $26,503 $106,687 | DataProperties
27000 (Human Resources) Telephone $4,551 $4452 $4304 $28,645 $42,042
28000 (Facilities) Utilities $228,515 $227,814 $227,743 $227,778 $911,850
29000 (Legal) Telephone $286,236 $307,796 $301,139 $304,462 51,199,633
$1,607,027 $1,625,001 51,598,730 $1,636,190 6,466,948

se of pre-aggregation calculations impacts the total row, if it is enabled. Behavior is as follows:

e Post-aggregation calculations: The calculation is performed on the total row values of the source

columns.

e Pre-aggregation calculations: The values in the calculated column are summed for presentation

on the total row.

e Pre-aggregation calculations can use alternate aggregations if desired. The field is unhidden for

the calculated column when pre-aggregation is enabled. If an alternate aggregation is set and
then pre-aggregation is disabled, the alternate aggregation field is re-hidden and ignored.

» Additional column actions

Once data columns and calculated columns have been added to the grid, you can further adjust them as

follows:

e Reorder columns: To reorder a column in the grid, drag and drop it to any location in the Column
Definitions box. Note that you cannot drag and drop a column from the Column Definitions box to

the Row Definitions box. If you accidentally dragged a column to the wrong box, you must
remove the column and then drag and drop it again from the Data Panel.
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¢ Remove columns: To remove a column from the grid, click the three-dots icon to the right of the
column name and then select Delete Column. Use caution before removing a calculated
column—if you later decide you want to re-add the column, you will need to re-create the
calculation from scratch.

¢ Copy columns: To copy a column in the grid, click the three-dots icon to the right of the column
name and then select Clone Column. A copy of the column is created to the right of the original
column. The new column has the same properties as the original column, except that the text
(Copy) is appended to the header text. You can modify the new column as needed in order to
differentiate it from the original, such as to define a filter for the column, or to modify the
calculation.

NOTE: If you copy a table column in the grid (as opposed to a calculated column), it is not
possible to point the column to a different table column. The purpose of copying a table
column is to display multiple instances of the same table column, but using different filters or
different aggregation types.

e Group columns: If you want a set of columns to display under a group header, you can define a
column group and then add the columns to that group. For more information, see Defining
column groups for a web report.

» Configure columns: To configure display properties for a column, select the column name in the
Column Definitions box, then use the Column Configuration properties in the Configuration
Panel. For more information, see Configuring column properties for a web report.

Defining column groups for a web report

You can define column groups in web reports so that certain columns can display together under a
group header. For example, your report might have several actuals columns followed by several budget
columns, and you want these columns to display under the group headers "Actuals" and "Budget".

To define a column group, first you add the group "container" to the Column Definitions box of the grid,
then you add table columns to the group container.

To define a column group:

1. On the Build tab of the Report Builder, in the Report Canvas, click the plus sign in the top right
corner of the Column Definitions box, and then click Add Column Group.
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noo @ i

v @

B“_”d Parameters  Filters ¢ RefreshData  Preview m
Corporate Report Configuration
General Advanced
Title
+ v Budget to Actuals
Is = [DQ2Actuals = [ Difference == [DQ1Budget =~ [MQ2Budget =~ [ Add Calculated Column
Add Column Group
Subtitle
Q2 Actuals Difference Q1 Budget Q2 Budget Difference Through June 2022
55,039,730 29.04% 55416,397 55,334,331 11.35%

Report description

A new empty column group is added to the Column Definitions box.

71 Q2 Budget =+ [0 Difference == [ New Column Group **

Drop Columns Here

2. Drag and drop the desired columns into the column group. You can drag and drop columns that
are already in the Column Definitions box, or you can drag and drop columns from the Data Panel
directly to the group.

New Column Group =

M Q2 Actuals == [0 Q2 Budget *+ [T Difference *

3. Select the column group box, and use the Column Group Configuration panel to define the
header text and other properties. See the following section for more information on the available
properties.

The column group displays in the grid with its child columns underneath.
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AXIOM| Intelligence Center o a @ I.:i

w @
< Intelligence Center Buld  Parameters  Filters % RefreshData  Preview
Data Context .

Budget to Actuals Corporate Column Group Cenfiguration
gLz 4 General

Through June 2022 Header text

v v 1
> B8 6Lao22 w = “
» I Dimension Tables [0 WorldRegion = mal - | ma2 () Hide column
> % Related Tables MQ1Actuals = [DQ1Budget = [ Difference = a2 Actuals =  MQ2Budget = M () Autowrap header text
, | Header Algnment
Q1 Q2 Default v
WorldRegion
Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference Data Filter Edit

Asia (Asia region) $6,989,316 $5416,397 29.04% $5,939,730 $5,334,331 11.35%

Europe (Europe region) $473,158 $340,531 38.95% $389,618 $335,371 16.18%

T‘\lonh Ame”Fa (North $32,766,656 $35,609,235 -7.98% $26,180,604 $35,068,189 -25.34%

America region)

$40,229,130 $41,366,163 -2.75% $32,509,952 $40,737,891 -20.20%
1-30f 3items

Example web report with column groups

Once a column group has been created, you can work with it as follows:

* Reordering groups: To reorder a column group, drag and drop the group to another location

within the Column Definitions box.

* Deleting groups: To delete a column group, click the three-dots icon in the top right corner of the
group box and then select Delete Group. However, if you still want to use the columns in the
group, you should drag and drop the columns out of the group before deleting the group. If you

delete the group with columns in it, all of the columns will be deleted as well.

e Copying groups: To copy a column group, click the three-dots icon in the top right corner of the

group box and then select Clone Group. A copy of the group is created to the right of the original
group, including copies of the child columns within the group. The new group has the same
properties as the original group, except that the text (Copy) is appended to the header text. You
can modify the new group as needed in order to differentiate it from the original, such as to
define a filter for the group, or to populate the group with different child columns.

NOTE: If a calculation in the column group references another column in the group, then
when the group is cloned the calculation in the new group is updated to point to the
corresponding column in the new group.
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e Configuring groups: To configure display properties for a column group, select the group in the
Column Definitions box, then use the Column Group Configuration properties in the
Configuration Panel.

¢ Nested groups: Currently, nested groups are not allowed. You cannot drag and drop a group
within another group.

You can work with columns within the group as follows:
¢ Adding columns: You can continue to add columns by dragging and dropping them into the group
box. You can also copy columns within the group.

e Removing columns: You can drag and drop columns out of the column group box to remove
them from the group. If you don't want the column to be in the report at all, you can delete the
column as normal.

e Reordering columns: You can reorder columns in the group by dragging and dropping them
within the group box.

e Configuring columns: Columns in a column group can be configured as normal. Select the column
box within the group box to bring up the Column Configuration properties in the Configuration
Panel.

» Column group properties

The following column group properties are available for web reports on the General tab of the Column
Group Configuration panel:

Item Description

Header The header text to display on the group header. Enter the desired header
text.
Hide column Specifies whether the column group is hidden in the report:

¢ [f enabled, then the group is hidden in the report. The group remains
visible in the Column Definitions box so that you can continue to
configure the group as needed.

e |f disabled (default), then the group is visible.
Autowrap header text Specifies whether header text wraps:
e |f enabled, then header text that exceeds the group width will wrap.

e |f disabled (default), then header text that exceeds the group width is
truncated. The user can resize the group wider to view the full header
text.

Header alignment The alignment of the header text over the columns in the group. Select
one of the following: Default, Left, Right, Center. Group headers use
center alighnment by default.
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Item Description

Data filter Optional. Defines a filter to limit the data shown in the columns within this
group. This is equivalent to defining the same data filter at the column
level for each column in the group. For more information, see Using group
filters.

» Using group filters

The Data filter property can be used to filter the data coming into the columns within a particular group.
This filter only impacts the data in the group columns; it has no impact on the rest of the report.

To filter the data in a group:
1. On the Build tab of the Report Builder, in the Report Canvas, select the group that you want to
filter.

2. In the Column Group Configuration panel, click the Edit link over the Data filter box to open the
Filter Wizard.

3. In the Filter Wizard, create the filter as needed. For more information on how to use the Filter
Wizard to create a filter, see Using the Filter Wizard in the Report Builder.

The tables available in the Filter Wizard depend on whether the current group consists of
columns from a single table or multiple tables, and the primary table specified as the Data
Context of the report:
 If the group consists of columns from a single table, the Filter Wizard shows that table and
its dimension tables.
e If the group consists of columns from multiple tables, the Filter Wizard shows the following
tables:
° If the group uses columns from multiple tables, and the primary table is a data
table, the Filter Wizard shows the common dimension tables for the tables involved
in the calculation.

EXCEPTION: If the group includes a column from a dimension table, then the Filter
Wizard shows the common dimension tables for all related tables used in the
report, regardless of whether the related table is used in this particular group.

° If the group uses columns from multiple tables, and the primary table is a reference
table, the Filter Wizard shows the primary table and its dimension tables.

EXCEPTION: If the group only consists of columns from related tables (no columns
from the primary table or its dimension tables), then the Filter Wizard shows the
common dimension tables for all related tables used in the group.

If the group contains a calculated column, the columns used in the calculation are considered as
part of the group.
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You can create a filter using any column on the available tables. If you choose to use a predefined
global filter from the Filter Library, the global filter must be based on the same eligible table
columns.

4. Once the filter statement is complete, click OK to close the Filter Wizard and add the filter to the
Data filter box.

Once a filter has been defined for a group, you can modify it as follows:

e To edit the filter, click the Edit link over the Data filter box again and change the filter within the
Filter Wizard.

e To delete the filter, click the Clear link over the Data filter box.

Data filters defined at the group level are combined with any filters defined at the column level. If the
group contains calculated columns, the group filter is applied to all columns referenced in the
calculation. If the calculated column references grid columns, the group filter is combined with any
other filters applied to the grid columns (either at the column level or at the group level, if the column
belongs to a different group). Additionally, if a data filter is defined at the report level, it is also applied.
All relevant filters are combined using AND to determine the data that can display in a particular
column.

If a group has a defined filter, then a filter icon displays next to the group name in the sample grid of the
Report Canvas. This icon is intended to let report builders know about the group filter at-a-glance. The
icon does not display in the report viewer.

Defining report titles and other web report properties

Using the Report Configuration panel in the Report Builder, you can define titles for web reports and
configure other web report properties.
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AXIOM| Intelligence Center

< Intelligence Center

Data Context

GL2022

» BB 6L2022
+ [ Dimension Tables

» % Related Tables

Budget to Actuals

Through June 2022

@ worldRegion ==

WorldRegion

Asia (Asia region)

Europe (Europe region)

North America (North
America region)

1-30f3items

Example Report Configuration panel

» Defining report titles

Build  Parameters

mar
[MQ1 Actuals = [MQ1 Budget =
Q1
Q1 Actuals Q1 Budget
$6,989,316 45,416,397
$473,158 $340,531
$32,766,656 $35,600235
$40,229,130 $41,366,163

Filters

Corporate

M Difference ==

Difference

29.04%

38.95%

-7.98%

-2.75%

Da2

@D Q2 Actuals ==

Q2 Actuals

$5,939,730

$389,618

26,180,604

$32,509,952

Q2
Q2 Budget
$5334,331

335371

435,068,180

$40,737,891

M Q2 Budget =

Difference

11.35%

16.18%

-25.34%

-20.20%

@ piffere

n oo @ ui
o

(€]

E] RefreshData  Preview

Report Configuration
General Advanced
Title

Budget to Actuals

secondary title
Corporate
Subtitie

Through June 2022

Report description

File group context Edit

Report data
(®) Live data with manualrsfresh

(O Live data with auto refresn

(O Mock data

Each web report can have a defined title, subtitle, and secondary title. You can also define an optional

report description.
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AXIOM| Intelligence Center

Title I Secondary title I

Budget to Actuals | Corporate
Through June 2022
. Q1 Q2

WorldRegion Subtitle I

Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference
Asia (Asia region) $6,089,316 $5416,397 20.04% $5,039,730 $5,334,331 11.35%
Europe (Europe region) $473,158 $340,531 38.05% $380,618 $335,371 16.18%
North America (North $32,766,656 $35,600,235 -7.98% $26,180,604 $35,068,189 25.34%
America region)

$40,229,130 $41,366,163 -2.75% $32,509,952 $40,737,891 -20.20%

Example titles as they display in a rendered report

To configure report titles for a web report:
e On the Builder tab of the Report Builder, in the Report Canvas, click on the box for the title text
that you want to edit, then type the desired title text. Once you are finished, you can press Enter
to exit the box (or press Tab, or click outside of the box).

The Title, Secondary Title, and Subtitle are all defined in separate boxes that roughly correspond
to where the titles display in the rendered report.

New report < + Add Secondary Title

+ Add Subtitle

Click on the title boxes to edit the report titles

When you click on a report title box to make it active, the Report Configuration properties load in the
right-hand Configuration Panel. The titles defined for the report also display in this panel, and can also
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be edited here. Any edits made in the title boxes are reflected in the Report Configuration properties,
and vice versa. An optional Report description can be defined in this panel, or you can define it when

saving the report.

NOTE: Currently, it is not possible to use variables in web report titles.

AXIOM| Intelligence Center

< Intelligence Center

Data Context

GL2022

» BB GL2022
» & Dimension Tables

r % Related Tables

Budget to Actuals

Through June 2022

@ worldRegion ==

WorldRegion

Asia (Asia region)

Europe (Europe region)

North America (North
America region)

1-30f3items

ma1

MaQ1 Actuals =

Q1 Actuals

$6,989,316

$473,158

$32,766,656

$40,229,130

» Report Configuration properties

Build

a1 Budget -

al

Q1 Budget

$5,416,397

$340,531

$35,609,235

541,366,163

Parameters

Filters

Corporate

@M Difference =

Difference

29.04%

38.95%

-7.98%

-2.75%

- MaQ2
[MQ2Actuals - [0Q2Budget -
Q2

Q2 Actuals Q2 Budget
$5,939,730 $5,334,331
$380,618 8335371
$26,180,604 $35068,189
$32,509,952 $40,737,891

+v

Difference

11.35%

16.18%

-25.34%

-20.20%

@D Differe

3

noa @

W@

(] reresnoata erevew

Report Configuration

General Advanced

Title

Budget to Actuals

Secondary title

Corporate

Subtitie

Through June 2022

Report description

File group context Edit

Report data
(®) Live data with manual refresh

(O Uive data with auto refresh

O Mock data

Using the Report Configuration panel, you can define a variety of properties for the web report, such as
to associate the report with a file group or to configure database properties for the report. The following
table provides a reference for each property in the panel.

To access the Report Configuration panel, select the Build tab in the Report Builder and then click the
gear button in the top right. The panel is organized into two tabs, General and Advanced.

General report configuration properties

Item Description

The main title for the report. This text displays at the top of the report,
over the grid.

Title
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Item Description

Secondary title Optional. The secondary title for the report. If defined, this text displays in
the same line as the main title, separated by a horizontal pipe character.
For example:

Title | Secondary Title

Subtitle Optional. The subtitle for the report. This text displays in smaller font
underneath the main title.

Description Optional. A description for the report.

File group context Optional. The file group associated with the report. The file group context

can be used to report on process management information, or to
generate hyperlinks to plan files in the file group.

Report data Specifies the data display behavior for the Report Builder. This option only
applies to the current Report Builder session, and is not saved in the
report.

NOTE: If you created a web report using the Report Builder in version 2021.2 or 2021.3, that report
may have had one or more Report Filters defined in the Report Configuration properties. These
filters are now defined on the Filters tab. Your existing filters have been migrated to this new
location.

Advanced report configuration properties

The Advanced tab is only visible to administrators and support users.

Iltem Description

Current Data This setting is for a pre-release feature that is not yet generally available.
Required

Filtering data in web reports

You can define report-level filters to limit the data shown in a web report. There are three different
types of report filters:

e General filters: General filters are based on reference tables, and impact all tables in the report
that look up to the reference tables used in the filter.

* Table-specific filters: Table-specific filters only impact a single specific table used in the report.
For example, if a report has data from GL2022 and BGT2022, you can define a table-specific filter
that only filters one of those tables.
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e Column value filters: Column-specific filters only impact a single specific table used in the report.
A Filter field displays in the Column Value Configuration area. This filter only works for columns

with a static source type. Column filters are ignored if the column source type is changed to
dynamic.

Report-level filters are defined on the Filters tab of the Report Builder. Any existing filters are displayed
in the left-hand pane. You can select a filter to view and edit its properties in the right-hand pane.

AXIOM Intelligence Center -+~ | a ® [5;

w ®
< Intelligence Center Build  Parameters  Filters — M
All Filters + Add ~

Revenue Filter
Revenue Filter

General filter () Enabled

. N;
Budget Filter ame

Table specific filter (BGT2022) Revenue Filter

Description

Filter Criteria

DEPT.WorldRegion = ‘Europe” AND (ACCT.Category = ‘Revenue’ OR
ACCT FestAcet = Program Revenue')

Filters tab of Report Builder

NOTE: Filters cannot be reordered in the Filters tab. Filters are listed in the order they are created.
The order has no impact in how the filters are applied.

Filters can also be defined at the individual column level and group level. In this case, the filter only

applies to the data in the affected column or group. For more information, see Using column filters and
Using group filters.

» Creating report filters for a web report

You can create as many filters as needed for your web report.
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To create a report filter:

1. On the Filters tab of the Report Builder, click the Add button and then select the type of filter
that you want to create:

¢ General Filter: Define a filter that is based on one or more dimension tables, to filter all
tables in the report that look up to the dimension tables.

¢ Table-Specific Filter: Define a filter that only impacts a specific table used in the report.
Select the table from the fly-out menu. This menu only lists non-dimension tables that are
used in the report. The primary table is only listed if it is a data table.

< Intelligence Center Build  Parameters  Filters

All Filters + Add ~
1e Filter
Revenue Filter General Filter
General filter
Table-Specific Filter » L2022
BGT2022
Revenu
Description

Creating a report-level filter

The Filter Wizard opens automatically after you make your selection.

2. In the Filter Wizard, create the filter as needed. For more information on how to use the Filter
Wizard to create a filter, see Using the Filter Wizard in the Report Builder.

The tables available in the Filter Wizard depend on the type of filter you are creating, and the
primary table specified as the Data Context of the report:
e If you are defining a general filter, the Filter Wizard shows the following tables:
° If the primary table is a data table, the Filter Wizard only shows the dimension

tables for the report.

° |f the primary table is a reference table, the Filter Wizard shows the primary table of
the report and the dimension tables for the report.

e If you are defining a table-specific filter, the Filter Wizard shows the table that you selected
from the menu and its dimension tables.

Additionally, if the report is configured to report on Process Management columns, then these
columns are also available to define general or table-specific filters. For more information, see
Reporting on process information in web reports.
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You can create a filter using any column on the available tables or on the Process Management
columns (if present). If you choose to use a predefined global filter from the Filter Library, the
global filter must be based on the same eligible table columns.

3. Once the filter statement is complete, click OK to close the Filter Wizard and add the filter to the
Filters tab.

4. Optional. Edit the filter properties as desired. You can give the filter a specific name, define an
optional filter description, and toggle the filter as enabled or disabled. By default, the newly
created filter is enabled and will filter the report data. See the following section for more
information on editing the filter properties.

P Editing existing filters
You can edit all filter properties except for the filter type. It is not possible to convert a general filter to a

table-specific filter or vice versa.

To edit an existing filter:

1. On the Filters tab of the Report Builder, in the left-hand pane, select the filter box for the filter
that you want to edit.

The properties for the selected filter display in the right-hand pane.

2. Edit the filter properties as needed.

Filter properties

Iltem Description

Name The name of the filter. By default, the name is set as follows:
e General filters use the name General Report Filter.
e Table-specific filters use the name TableName Filter.

You can change this name to something more descriptive as needed. Filter
names only display in the Report Builder.

Description Optional. If desired, you can define a description to document the
purpose and scope of the filter.
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Item Description

Enabled Specifies whether the filter is enabled. By default, filters are enabled and
will impact the data shown in the report.

If desired, you can toggle the filter to disabled in order to keep the filter in
the report properties for future use, but temporarily disable it. When you
are ready to use the filter again, you can toggle it back to enabled.

While the filter is disabled, the filter box in the left-hand pane is grayed
out. The filter will not be applied to the data queries in the report.
However, you can continue to edit the other filter properties while the
filter is disabled.

Filter Criteria The filter criteria statement for the filter. Click Edit to edit the filter within
the Filter Wizard.

If you only want to edit the filter criteria statement, you can hover your cursor over the top right corner
of the box, and click the Edit icon to open the Filter Wizard directly.

All Filters + Add ~
Revenue Filter & %
General filter

» Deleting existing filters
You can delete a report filter if it is no longer needed. Remember that you can disable the filter instead,
if you want to temporarily remove the filter without deleting it from the report.

To delete an existing filter:
1. Onthe Filters tab of the Report Builder, in the left-hand pane, locate the filter that you want to
delete.

2. Hover your cursor over the top right corner of the box, then click the Delete icon to delete the

filter.

All Filters + Add v
Revenue Filter s x
General filter @

The filter is deleted from the report.
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» Filter notes

General filters and table-specific filters have certain setup and behavior differences.

General filters
General filters are based on reference tables:

e [f the primary table is a data table, you can define a general filter using any reference table that
the primary table looks up to. Basically, this means the tables listed in the Dimension Tables node
of the report.

e [f the primary table is a reference table, you can define a general filter using the primary table
itself, or using any reference table that the primary table looks up to.

When creating the filter, you can use any column on the reference table, including multi-level lookups
through the reference table. For example, if the primary table looks up to Dept, the filter could be
Dept.Dept=24000 or Dept.Region="West' or Dept.Region.RegionType=1.

The general filter applies to all tables in the report that look up to the reference table (as well as the
reference table itself). For example, imagine that you have a report that compares GL2022 to BGT2022.
You want to define a filter so that the report only shows data for the West Region. In this case you can
define a general filter on the Dept table of Dept.Region="West"'. Since both tables look up to the
Dept table, the general filter will apply to both tables and limit the data in the report.

NOTES:

e |f the primary data table looks up to multiple reference tables, the general filter can be a
compound filter that uses multiple reference tables. In this case, the filter will only apply to
data tables that look up to both reference tables. For example, imagine you define a general
filter of Dept.Region="West' and Acct.Category='Revenue'. If the report contains a
table that only looks up to the Acct table but not the Dept table, then the filter will not apply
to that table and no error will occur.

¢ If you define a general filter and then change the primary table of the report to a table that
has different dimension tables, the filter will not cause an error. If the existing filter does not
apply to any tables in the report, it will simply be ignored.

* |f the report uses process management columns, you can create a general filter with these
columns.

Table-specific filters

Table-specific filters apply only to the selected table for the filter. All other tables are unaffected by the
filter.

The table-specific filter can use any column in the table or its dimension tables. For example, if the
selected table is BGT2020, the filter could be BGT2020.m1<>0 or
BGT2020.Acct.Category="Revenue' or Dept.Region="West"'.
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Table-specific filters can be defined on any table used in the report, except for the following tables.
General filters can be defined for these tables instead.

* Reference tables that are Dimension Tables for the report.

e The primary table, if the primary table is a reference table.

NOTE: If you define a table-specific filter and then later edit the report configuration so that the
table no longer has any columns in the report, the filter will not cause an error. It will simply be
ignored.

Create limit filters

You can use the new limit filter to broaden your ability to view data from any table in your organization.
This powerful new filter lets you generate data sets in a single filter that wasn't possible before.

Axiom has two types of tables:

e Data tables contain transactional or budget data, such general ledger or budget tables.

e Reference tables (also called lookup or dimension tables) are single-key tables with values that
point to other values.

An example of a reference table is the DEPT table, which contains keys for department-related data,
such as department name, department description, and locations, such as WorldRegion and Country.
Data tables contain data that is linked to a key.

A key in a dimension table can point to many data tables.

When you create a report, the tables you can use in the report are listed on the left side:
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AXIOM Intelligence Center ~

< Intelligence Center

Data Context

DEPT

search tables

» BB DEPT

- Dimensicn Tables
» BB Owner

» BB Region

BB TempBud

BB TestGroup

» BVF

BB worldRagion

v (@ Related Tables

BB AltKeyTest

B8 8672014

B8 BGT2015

B8 BGT2016

B8 BGT2017

B8 BGT2018

B3 BGT2019

B8 BGT2020

B8 BGT2020_V1

B8 BGT2021

B8 BGT2022

Limit fiters must use a dimension Bulld  Parameters - Fllters
table for the data context. Here we're
using DEPT. R
" New Report i i + Add Secondary Title
4 :
+ Add Subtitle
Search columns i
+ v
These additional dimension tables are all
associated with DEPT, the data context for S
this filter. We've used Country and Region HRegion 0D (o) ooz s &3 i
for this report.
Country Region YTD Q1
US West (United States Western Sales $36.463 $22013 21
Region)
China china (China Sales Region) $0 $0
France France (France Sales Region) S0 50
India India (India Sales Region) s0 $0
Italy Italy (italy Sales Region) S0 S0
Singapore Singapore (Singapore Sales Region) $0 $0
Related tables are those tables that have Dept as one UK (United Kingdom Sales Region) 84,442 52,671 52
of its fields. We can use one or more of these tables in
the report. For example, we could view data for several US West (United States Western Sales
years of the budget to analyze budgeting trends by Region) $2,643,900 §1,582,343 $1.60
sales regions or for a specific budget item type, such as
Faciliies or IT.

You can create a

report based on the EDS Encounter table, but without any filters.

AXIOM| Inteliigence Center -

< Intelligence Center

Data Context

Search tables
+ BB Encourter
= IS Dimension Tables
» Boer
> B Encounerpazen
* ey

@ entry
» [ PrEm

» | [ FLocasond

Encounter 4

entity e

Buld  Parameters

New Report

+ Add Subtitle

+v
enTITY | DcaseCount =~ [ TotalActualPayments
L
| ety CaseCount
0 (DEFAULT) 200
2000 (PORTLAND WILLAMETTE MEMORIAL HOSPITAL) 296320200
3000 (WILLAMETTE OUTPATIENT SERVICES) 144917.00
4000 (EORTU-\N()NEAL'N OREGON MEMORIAL 41121000
HOSPITAL)
6200 (FORTLAND HEALTH MEDICAL GROUF) 622114800
7000 (PORTLAND HEALTH HOME CARE) 35250.00

1-60f 6nems

Fitters

+ Add Secondary Title

M TotsiCost *  MRevenve ™
TotalActualPayments
327726

313030794144

18169,865.04

633683153 86

780,725966.76

8214081039

TotalCost

300260

267335008475

2398340525

628975,868.55

1104813871 87

9302591788

Revenue

s273

$456,943857

(85,813,540)

54707285

Column Configuration
General  Advanced

Goluma
ENTITVENTITY

Display Properties -
Formatting Properties -

Data Properties ~

@D eabie firering

Report without filters

For this report, you can view information about a specific population group, such as patients who have
had a total hip replacement.

For a limit report, select the General Filter option, which lets you limit data from any table.
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Select type of filter x

(@) General Filter (O Table Filter
Limits all data coming into the report Applies only to data from the selected
from any table table

Cancel

Filter selection dialog

Here we define the population group of patients who've had total hip replacements:

Select values for PopulationMame X

Search available values Contains Selected Values =

= Total Hip Replacement
available values =

Aetna Inpatients

End Stage Renal Disease

Foreign object after surgery
Percutaneous Coronary Interverttion {PCI)
Robotic Procedures

Sepsis

Stage 3 or 4 Pressure Ulcers

Total Knee Replacamment

8 values available 1 value selected

Cancel [Ewd

Selecting value for PopulationName
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After you finish creating the filter, review how the results have changed:

AXIOM| Intelligence Center

< Intelligence Center

Data Context

New Report

+ Add Subtitle

DENTITY - McaseCount =

ENTITY

d  Paramet

D TotalactuslPayments

Casecount

202,00

1.545.00

ters  Fiters

+ Add Secondary Title

MTotalCost -~ MRevenve =

TotalActualPayments TotalCost

857846435 23415264

2701420856 2184129118

35,592.667.91 2807544378

oo @
o @

Grid Configuration

General Advanced

Column Properties

@D v colom e

Mutkcslumn soring

@D e reorssnng ke

Grid Properties

4312 | Use fired rows

s5172912 | QD) el mrow

Total tow header lael

Total

@ s

Enable drilling

Completed limit filter report

The previous example uses a simple limit filter; however, filters can be as complex and detailed

required.

Notes to remember about filters:

¢ You cannot directly edit the SQL statement; instead use the filter and selection tools.

e Make sure the data context for your report is a dimension table, so that your report can pull data
from multiple tables. If you use data table as context, the report can only contain data from that

data table.

e Always use the General Filter option when creating a limit filter.

Using report parameters in web reports

Using report parameters, you can enable end users to dynamically change the data showing in the
report. The advantages of using report parameters include:

e You can more efficiently cover your reporting needs using fewer reports, which means less time
needed to develop and maintain reports.

e Report users are more in control over the data they want to see in the report.
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» What can report parameters impact in the report?

Report parameters can be used to dynamically impact the following items in the report:

e The row dimensions used in the report can change dynamically by using Column List report

parameters. For example, the user can dynamically change the row dimension to show data by
different groupings such as department, account, region, entity, and so on.

e The data in the report can be dynamically filtered by using Column Value report parameters. For

example, the user can select one or more values in a column—such as departments, accounts, or
entities—and the report is dynamically filtered to show only the data for the selected values.

Reports can use either or both types of parameters as needed to provide the desired level of
interactivity.

» How are report parameters defined?

Report parameters are defined in the Report Builder using the Parameters tab. Using this tab, you can
create, configure, and delete parameters as needed. When configuring parameters, you define
properties such as:

The type of parameter, Column List or Column Value

The name of the parameter and the display text to use when presenting parameters to report
users

Whether the parameter is optional or required—if required, then the report does not display
data until the user makes a selection

For Column List parameters, the list of table columns to associate with the parameter, and an
optional default column selection

For Column Value parameters, the column to associate with the parameter:

° You can select a specific column or you can tie the Column Value parameter to a Column
List parameter, so that Column Value parameter dynamically uses the selected column

° You can specify whether users can select a single value in the column or multiple values
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AXIOM)| Intelligence Center

< Intelligence Center

All Parameters + Add v
Category
Dept x
Column List Name
Grouping for analysis
Category
Category x
Column Value Display prompt

Account category to analyze

Account category to analyze

() Required

Column Value Configuration

Source column type

(®) static column

O Dynamic column

Selected Column

ACCT.Category Edit

T
() Allow mulii-select

Description display format

Value - Description

Build

Parameters

oo @i

w @

Filters Preview [SENCERS

Example Parameters tab to define report parameters in the Report Builder

» How do users interact with report parameters?

When users view a report with report parameters, the parameters display in a panel along the left-hand
side of the report. Users can make selections and apply them to dynamically refresh the report with

data that meets their selections. If a parameter is required, then the user must interact with the report
parameter panel before the report shows any data.

AXIOM)| Intelligence Center

Report Parameters
Grouping for analysis

Vice President v

Budget to Actuals

Account category to analyze [hcuchpunez022

Revenue v
Vice President ]
Bree Sigman
Evan Simpson

Frank Martinez

Javier Grant

Example web report using report parameters
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Q1 Actuals

$6,015,031

12,810,352

$161,693

$5,018,848

Q12022

Q1 Budget

$6,054,348

$13,105,690

$331,567

54,165,304

oo @ L
&

Edit  Export  Share

Q22022
Difference Q2 Actuals Q2 Budget Difference
13.51% $6,437,818 $6,848,078 -6.00%
-2.02% $5208,342 $12,005,756 -59.23%
-51.23% 5262,089 $326,543 -19.74%
20.49% 54,119,925 $4,102,194 0.43%
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Managing report parameters

Using the Parameters tab in the Report Builder, you can add, edit, reorder, and delete report

parameters. Report parameters enable reports to update dynamically based on selections made by
report users.

When you select the Parameters tab in a report, any existing parameters display in the All Parameters

panel along the left-hand side. You can select a parameter box to view the properties for that
parameter.

AXIOM| Intelligence Center Parameters tab to o a @ 13
manage report
parameters & ®
< Intelligence Center Build  Parameters  Filters Preview
All Parameters + Add v
Category
Dept x
Column List Name
Grouping for analysis General
Category parameter
B 9 . Pproperties
Column Value Display prompt
Account category to analyze
Account category to analyze
() Required

Add new parameters
and work with existing . i
parameters Column Value Configuration Configuration for the J
e

specific parameter typ

Source column type

(®) static column

O Dynamic column

Selected Column

ACCT.Category Edit

T
() Allow mulii-select

Description display format

Value - Description v

Example Parameters tab in the Report Builder

This topic describes the basic features available to manage report parameters in a report. For more
information on how to configure and use specific parameter types, see the following topics:

e Using Column List report parameters

e Using Column Value report parameters

» Adding report parameters

You can add as many report parameters as needed to provide the desired interactivity for the report.
Keep in mind that all report parameters in the report are active and will display to end users.
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To add a report parameter:

e On the Parameters tab of the Report Builder, click Add, then select the type of parameter to
create.

© Column List: Define a list of columns that report users can select from. The selected
column can be used as dynamic row dimension in the report, or as the column for a
Column Value parameter.

° Column Value: Select a column that report users can select values from. The selected
values are then applied to the report as a report filter.

< Intelligence Center

All Parameters + Add

Column List

Column Value

The new parameter is added to the All Parameters panel along the left-hand side. You can now
configure the properties for the parameter, which display in the main area to the right.

General parameter properties

Item Description

Name The name of the parameter. By default, this is set to Report Parameter
(Type). You can edit this name as needed.

The parameter name does not display to report users; it is solely for use in
the Report Builder. You should give the parameter a name that indicates
its purpose.

Display prompt The prompt text to display to report users in the Report Parameters panel.
By default, this is set to Report Parameter (Type). You can edit this name
as needed.

You should define display prompt text that helps users understand the
purpose of the parameter. For example, "Select a department".
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Item Description

Required Specifies whether the parameter is required.

e |f enabled, then the report does not refresh with data until this
parameter has a value. The message "Waiting for input" displays in the
report grid until all required parameters have a value.

In the Report Parameters panel, the Apply button does not become
available until all required parameters have a value. Additionally,
required parameters cannot be cleared.

e |f disabled (default), then users can optionally leave this parameter
blank (unset) when applying parameter values. The report can refresh
data without this parameter.

Parameter-specific properties
The remaining parameter properties depend on the parameter type. For more information, see:

e Using Column Value report parameters

e Using Column List report parameters

» Editing report parameters

You can edit existing report parameters as needed.

To edit a report parameter:
e On the Parameters tab of the Report Builder, select the parameter that you want to edit in the
All Parameters panel.

The current configuration for the parameter displays in the main area. You can edit the parameter
properties as needed.

» Reordering report parameters

When users view a report with parameters, the parameters are listed in the Report Parameters panel in
the order that they display in the Report Builder. You can reorder the parameters as needed to change
how they display to report users.

To reorder report parameters:

e On the Parameters tab of the Report Builder, select the parameter box that you want to move,
then drag and drop the box to a new location in the list.

NOTE: If you have a Column Value parameter that is dependent on a Column List parameter, the
Column List parameter should be located before (above) the Column Value parameter.
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» Deleting report parameters

You can delete existing report parameters if they are no longer needed. Remember that all parameters
are active and will display to report users, so if a parameter is not needed the only option to hide it from
report users is to delete it.

To delete a report parameter:

e On the Parameters tab of the Report Builder, in the All Parameters panel, click the X icon in the
right-hand corner of the parameter that you want to delete.

Using Column List report parameters

When you use a Column List report parameter, you define a list of table columns to allow the report
user to select a column. The user's selected column can then be applied to the report in one of the
following ways:

e The selected column can be applied to the report as a row dimension. This allows the report user
to dynamically change the row dimension for the report, so that the same report can be used to
view data by different dimensional groupings such as department, region, or entity. In order to do
this, you must configure the report with a dynamic column for the row dimension, and then link
the dynamic column to the Column List report parameter.

e The selected column can be applied to a Column Value parameter. This allows the report user to
select a value or values from the column to be dynamically applied as a report filter and change
the data shown in the report. In order to do this, you must configure the report with a Column
Value parameter, then link the Column Value parameter to the Column List parameter.

When a user views the report with a Column List report parameter, the list of columns is displayed in a
drop-down list, using the header text as defined for the column.

Select a Grouping

|VP| v

WorldRegion

Dept

vp ]

Example Column List parameter in the Report Parameters panel

» Defining a Column List report parameter

Column List report parameters are defined on the Parameters tab of the Report Builder. You can define
as many Column List parameters as needed for the report.

To create a Column List parameter:
1. Inthe Report Builder, select the Parameters tab.
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2. Click Add > Column List.

The new parameter is added to the All Parameters panel along the left-hand side. The properties
for the parameter now display in the main area.

3. Complete the following general properties for the parameter:

Iltem Description

Name The name of the parameter. By default, this is set to Report
Parameter (Type). You can edit this name as needed.

The parameter name does not display to report users; it is solely for
use in the Report Builder. You should give the parameter a name that
indicates its purpose.

Display prompt The prompt text to display to report users in the Report Parameters
panel. By default, this is set to Report Parameter (Type). You can edit
this name as needed.

You should define display prompt text that helps users understand
the purpose of the parameter. For example, "Select a department".

Required Specifies whether the parameter is required.

¢ If enabled, then the report does not refresh with data until this
parameter has a value. The message "Waiting for input" displays
in the report grid until all required parameters have a value.
In the Report Parameters panel, the Apply button does not
become available until all required parameters have a value.
Additionally, required parameters cannot be cleared.

¢ |f disabled (default), then users can optionally leave this
parameter blank (unset) when applying parameter values. The
report can refresh data without this parameter.

NOTE: If the Column List parameter is linked to a dynamic column, the parameter must have
a value in order to refresh data, regardless of whether the parameter is configured as

required.

4. Inthe Column List Configuration section, complete the following parameter-specific properties:
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Iltem Description

Selected columns

Default value

Administrator's Guide

The selected columns for the parameter. Click Edit to select columns
in the Select Columns dialog.

¢ Use the table treeview in the left-hand panel of the dialog to
locate the columns that you want to use. You can select any
column from the primary table, a dimension table, or a related
table. You can use the search boxes at the top of the panel to
search by table names or by column names.

¢ Once you locate a column that you want to use, drag the column
to the middle Selected Columns panel.

¢ For each selected column, define Header text in the right-hand
Column Properties panel. This header text is displayed in the
Column List drop-down when users select a column from the list.
If the Column List parameter is linked to a dynamic column, this
text is also used as the header text for the dynamic column within
the report grid.

e When the columns are presented to report users in a drop-down
list, they will be displayed in the order listed here (top to bottom).
To reorder columns, click on the drag handle in the left-hand side
of the column box, and then drag and drop the column to a new
location within the list.

e After selecting and configuring the columns, click OK to return to
the Report Builder. The selected columns now display in the
Selected columns box.

NOTE: If the primary table is a data table, and a selected column
looks up to a dimension table for the primary table, the column
reference is automatically "elevated" so that it uses the lookup
dimension table instead of the source table. For example, if the
primary table is GL2021, and you select either GL2021.Acct or
BGT2021.Acct, the column reference is elevated to Acct.Acct. This
elevation is done so that the column is valid for use as a row
dimension, and so that any filter resulting from the column is applied
as a general filter affecting all tables that look up to the dimension
table.

Optional. The default value for the parameter. When a report user
opens the report, the parameter will use this value by default.

You can select any of the columns in the Selected columns list to use
as the default value, or you can leave it blank to have no default
value.
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IMPORTANT: The columns selected for the Column List parameter must be valid within the
context of how you intend to use the parameter. If the parameter will be used with a dynamic
column, then all of the selected columns must be valid as row dimensions within the report
configuration. If the parameter will be used with a Column Value parameter, then all of the
selected columns must be valid to be used as filters within the report configuration. If a
column in the list is not valid for use as a row dimension or a filter, an error message will
display when the user attempts to apply that parameter selection to the report. As the report
designer, you should test your parameters to verify that they work as intended within the

report.
g
AXIOM| Intelligence Center o o @ I':i
1A
< Intelligence Center Build  Parameters  Filters Preview
All Parameters + Add v
DeptGroup
DeptGroup x
Column List Name
Grouping for analysis
DeptGroup
Category x

Column Value Display prompt
Account categery to analyze
Grouping for analysis

() Required

Column List Configuration
Selected columns Edit

WorldRegion (DEPT.WorldRegion)
Country (DEPT.Country)

Region (DEPT.Region)

Vice President (DEPT.VP)
Manager (DEPT. Manager)

Dept (DEPT.Dept)

Default value

Dept X w
Example Column List parameter with a list of columns and a specified default value

» Using a Column List parameter with a dynamic column

In order to use a Column List parameter to dynamically change the row dimension of the report, you
must:

e Add a dynamic column as a row dimension for the report
¢ Link the Column List parameter to the dynamic column

This configuration is only possible when using row dimensions, meaning the report rows are dynamically
generated based on the row dimension columns. If you are using a fixed row structure in the report,
then the option to add a dynamic column is not available.
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Web reports can use one or more row dimension columns. When using dynamic columns, all of the row
dimensions can be dynamic, or you can have a mix of dynamic and fixed row dimensions.

To define a dynamic column:
1. Inthe Report Builder, select the Build tab.

2. Click the plus icon over the Row Dimensions box, then select Add Dynamic Column.
New Report
- + Add Subtitle
+v
Add Dynamic Column o —

A column box labeled Dynamic is added to the Row Dimensions box.

New Report

+ Add Subtitle

0 Dynamic ** |

3. Inthe right-hand Column Configuration panel, from the Dynamic column parameter list, select
the Column List parameter to use with the dynamic column. Parameters are listed by name as
defined on the Parameters tab.
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Column Configuration

General

Dynamic column parameter

DeptGroup v

Default column

DEPT.Dept

By default, Axiom Strategy Management automatically selects the first available Column List
parameter and uses the default value defined for that parameter. If the parameter does not have
a defined default value, the Report Builder uses the first column in the list of columns defined for
the parameter. This is because the Report Builder must be able to associate the dynamic column
with an actual table column in order to refresh data.

If no Column List parameters are defined, or if the Column List parameter does not have a
defined list of columns, then the report cannot be refreshed with data until this issue is resolved.

4. Complete the remaining Column Configuration properties as needed. Note the following:

e The Header property and the related header properties on the Advanced tab are not
available for dynamic columns. The column header text for each column in the column list
is defined when configuring the Column List parameter.

* You can optionally enable Show description and select a Description display format for
the dynamic column. These options will apply if the selected column for the Column List
parameter has an associated description column.

The following example shows a web report configured with a dynamic row dimension column, linked to
a Column List report parameter. The grid is refreshed with data using the default column specified for
the report parameter.
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AXIOM| Intelligence Center n a @ I..Ei

w
< Intelligence Genter Build  Parameters  Filters &  RefreshData  Preview m
Data Context .
Budget to Actuals + Add Secondary Title Column Configuration
G0z 4 General
lrouaiuneoy Dynamic column parameter
- - DeptGroup
» BB GLao22 v = i e
> I Dimension Tables ma1 2022 -~ Moz22022 Default column
» % Related Tables Q1 Actuals ~ [DQlBudget - [ Difference == [DQ2Actuals -~ [D0Q2Budget — [T DEPT Dept
Column width 250
»
Q12022 Q22022 Alignment
Dynamic
Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Di Default (Left) ~
Arizona Distribution $17.271 So 0.00% $17,318 $o ()
Enable fiiter
Arizona Warehouse $82,285 59,421,017 -09.13% 582,201 $5,143,359 ‘(:)‘ Hide column
@D show description
Asia Distribution $154,044 $320,721 -51.97% $151,086 $320,781
Description display format
Asia Warehouse $211,502 $316,257 -33.12% $207.622 $314,567 Description only
scription only v
Atlanta - Store 52 $9,875417 514,256,548 -30.73% $9,429,706 518,749,209
»
Total $857,770,545  $214,751,120 299.43% $846,341,814  $202,328,130
1-100f 119 items

Example Report Builder with dynamic row dimension

NOTE: In the Report Canvas, the dynamic column displays in the grid using the header text Dynamic.
This only occurs in the Report Builder, so that you know which column is the dynamic column. When
previewing or viewing the report, the dynamic column uses the header text defined for the currently
selected column, as defined in the Column List parameter configuration.

In this example the Column List report parameter lets the user select from three different grouping
levels—Dept.Dept, Dept.WorldRegion, or Dept.VP. The report will refresh with data and use the
selected column as the row dimension.
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AXIOM| Intelligence Center

< Intelligence Center Build  Parameters  Filters
All Parameters + Add v
DeptGroup
DeptGroup x
‘Column List Name

Select a Grouping
DeptGroup

Display prompt

Select a Grouping
@D required

Column List Configuration
Selected columns Edit

World Region (DEPT.WorldRegion)
Vice President (DEPT.VP)

Department (DEPT.Dept)

Default value

Department X v

oo @ ki

w @

ECUETEE Save v

Example Column List parameter providing column options for the dynamic row dimension

AXIOM| Intelligence Center

Report Parameters

Select a Grouping

World Region v

Budget to Actuals

Through June 2022

Q12022
World Region s
Q1 Actuals Q1 Budget Difference
Asia region 56,089,316 55,416,397 20.04%
Europe region $473,158 $340,531 38.95%
North America region $32,766,656 $35,835,060 -8.56%
Total $40,229,130 $41,591,988 -3.28%

Q2 Actuals

55,939,730

$389,618

$26,180,604

$32,509,952

A

Edit

Q2 2022

Q2 Budget

55,334,331

$335371

§35,292,107

540,961,809

o @ L
% ®

Export  Share

Difference

11.35%
16.18%

-25.82%

-20.63%

Example end user experience to select and change the row dimension
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Design considerations for the report user experience
When using a dynamic column with a Column List parameter, you must decide whether you want the
report to refresh using a default column selection, or if you want to require the user to make a selection
before the report refreshes with data.
¢ [f the Column List parameter does not have a specified default column, then when a user opens
the report, it will not refresh with data and instead displays the message "Waiting for input". The
user must select a value for the Column List parameter and apply before the report is refreshed
with data.

e |f the Column List parameter has a specified default column, then when a user opens the report,
it refreshes with data using the default column. The user can then optionally change the selected
column in order to refresh the report using a different row dimension.

NOTE: If the Column List parameter that drives the dynamic column does not have a default value,
then the report cannot be exported or shared because it does not have a column to use as the row
dimension. Although report parameter selections made by users are not honored when exporting or
sharing web reports, the default value is honored for the dynamic column when exporting or sharing
the report.

Design considerations for drilling

If you want to use a dynamic column and also enable directed drilling for the report, you must be careful
to ensure that all of the drill columns are compatible with the Column List columns. If the user can select
a column for the Column List parameter that is not compatible with the drill columns, an error will occur
when the user attempts to drill the report.

Alternatively, you can enable drilling and use key column drilling, which will continue to work as long as
all of the columns defined the Column List parameter are valid as row dimension columns.

» Using DateParts in a Column List parameter

You can use DateParts when setting parameters for a ColumnList. Click Parameters from your report
and click Add to add a Column List.

In the Column List Configuration section, click Edit to select a column and then drag the column name to
the Selected columns section. Then use the Date part to retrieve menu to select a date part and click
OK.

» Using a Column List parameter with a Column Value parameter

In order to use a Column List parameter to populate the source column for a Column Value parameter,
you must:

¢ Define a Column Value parameter

¢ Configure the parameter as dynamic and select the Column List parameter as the source
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In the following example, the Column Value parameter is configured to use the FilterCols Column List
parameter. First the user will select a column from the Column List parameter, then the user will select a

value or values in that column from the Column Value parameter.

AXIOM| Intelligence Center

< Intelligence Center Build  Parameters  Filters

All Parameters + Add
FilterValue

FilterCols x

Column List Name

Filter by

Filtervalue
FilterValue x
Column Value Display prompt

Select filter values
Select filter values

() Required

Column Value Configuration

Source column type

(O static column

(® Dynamic column

Selected parameter (dynamic column source)

FilterCols v

@D Atow multi-select

Description display format

Value - Description v

Example Column Value parameter using a Column List parameter to provide the source column

n o @ i

w @

Frevien m

Axiom Strategy Management | 197



AXIOM| Intelligence Center o o @ HH
¥ Q@

Report Parameters Edit  Export = Share

Filter by
AccT x i
- e Account Analysis
Select filter values .
Region * Jan Feb Mar
tray
China 7,600,520 7,436,078 $9,008,480
5000 - Travel
£000 - Ciner Trave Corporate $3,632,055 $5,474,832 $3121,313
France $4,140,101 $4282217 $4,136,503
india $4472,830 $4,595,180 $5100,535
Italy $1,104,481 $1259,156 $1,047,663
Singapore $6,004,279 $6,772,344 $6985,727
UK $4,727,841 $4,794,366 $4,780,809
US Central $73,601,052 73,525,863 73,021,619
US East 54003715 $49,227,795 48,112,441
US West $128700258  §129,931,118  $129,827.850

$289,166,229 $287,298,948 $286,043,029

Example end user experience to choose the filter column and values

For more information on how to configure Column Value parameters and how the selected values are
applied as report filters, see Using Column Value report parameters.

Design considerations for the report user experience

When a Column Value parameter is linked to a Column List parameter, the Column Value parameter is
automatically dependent on the other parameter. This means that the Column Value parameter will not
become active in the Report Parameters panel until a value has been selected for the Column List
parameter. The Column Value parameter will then become active and allow the user to select a value or
values from the column selected for the Column List parameter.

NOTE: Because of this automatic dependency, you should make sure that the Column List parameter
is ordered before (above) the Column Value parameter.

Additionally, you must decide whether you want the Column Value parameter to start with a default
column or not:

e |f the Column List parameter does not have a specified default column, then the Column Value
parameter will be disabled until a value is selected for the Column List parameter.

e If the Column List parameter has a specified default column, the Column Value parameter is
enabled and uses the default column. The user can optionally select a different value for the
Column List parameter to change the column used by the Column Value parameter.
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Using Column Value report parameters

When you use a Column Value report parameter, you specify a column from which the user can select
one or more values. The user's selected values for the column are then applied to the report as a report
filter. This allows the user to dynamically change the data shown in the report.

For example, you may design a report that is intended to display financial results for a selected
department or entity. You can create a Column Value report parameter that uses the department or
entity column. The user can select the departments or entities that they want to view, and then apply
the parameter values to refresh the report with the selected data.

When users view the report with a Column Value report parameter, the column values are displayed in a
drop-down list:

e Column values are displayed with descriptions if applicable.
e Users can type text into the drop-down list to filter the list and find a specific value.

e Users can select one value from the list, or multiple values, depending on the parameter
configuration.

Select filter values

trd

5000 - Travel

6000 - Other Travel
7400 - Tuition and Tr...
7700 - Maintenance ...

9300 - Expense Trans...

Example Column Value parameter in the Report Parameters panel

» Defining a Column Value report parameter

Column Value report parameters are defined on the Parameters tab of the Report Builder. You can
define as many Column Value parameters as needed for the report.

To create a Column List parameter:

1. Inthe Report Builder, select the Parameters tab.
2. Click Add > Column Value.

The new parameter is added to the All Parameters panel along the left-hand side. The properties
for the parameter now display in the main area.

3. Complete the following general properties for the parameter:

Administrator's Guide Axiom Strategy Management | 199



Item Description

Name The name of the parameter. By default, this is set to Report
Parameter (Type). You can edit this name as needed.

The parameter name does not display to report users; it is solely for
use in the Report Builder. You should give the parameter a name that
indicates its purpose.

Display prompt The prompt text to display to report users in the Report Parameters
panel. By default, this is set to Report Parameter (Type). You can edit
this name as needed.

You should define display prompt text that helps users understand
the purpose of the parameter. For example, "Select a department".

Required Specifies whether the parameter is required.
¢ If enabled, then the report does not refresh with data until this

parameter has a value. The message "Waiting for input" displays
in the report grid until all required parameters have a value.

In the Report Parameters panel, the Apply button does not
become available until all required parameters have a value.
Additionally, required parameters cannot be cleared.

¢ |f disabled (default), then users can optionally leave this

parameter blank (unset) when applying parameter values. The
report can refresh data without this parameter.

4. Inthe Column List Configuration section, complete the following parameter-specific properties:

Iltem Description

Source column type Select one of the following to determine the source of the column for
the Column Value parameter:
¢ Static column: Select this option if you want to select a specific
column to use as the source column.
¢ Dynamic column: Select this option if you want to dynamically
use the selected column for a Column List parameter as the
source column.
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Iltem Description

Selected column

Selected parameter
(dynamic column
source)

Allow multi-select

Description display
format

Administrator's Guide

If the specified Source column type is Static column, click the Edit
link to select a column from the Select Column dialog.

¢ Use the table treeview in the left-hand panel to locate the column
that you want to use. You can select any column from the primary
table, a dimension table, or a related table. You can use the
search boxes at the top of the panel to search by table names or
by column names.

¢ Once you locate a column that you want to use, select it and then
click OK. The selected column name now displays under the
Selected column header.

NOTE: If the primary table is a data table and the selected column
looks up to a dimension table for the primary table, the column
reference is automatically "elevated" so that it uses the lookup
dimension table instead of the source table. For example, if the
primary table is GL2021, and you select either GL2021.Acct or
BGT2021.Acct, the column reference is elevated to Acct.Acct. This
elevation is done so that the column is applied as a general filter
affecting all tables that look up to the dimension table.

If the specified Source column type is Dynamic column, then select
the desired Column List parameter to use as the source.

This means that the user will first select a column from the
designated Column List parameter, then the user can select one or
more values from that column using the Column Value parameter.
The Column Value parameter will not be active until the Column List
parameter has a selected value. If the Column List parameter has an
assigned default value, this value will be used as the initial source
column for the Column Value parameter when the report is opened.

Specifies whether the parameter allows selecting multiple values
from the column. By default, this is disabled, which means users can
only select a single value at a time.

The display format to use for the column values in the drop-down
list. By default, this is set to Description only.

This setting applies when the column used by the Column Value
parameter has an associated description column. If the column used
by the parameter does not have an associated description column,
then this setting is ignored and the column values will display as is.
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IMPORTANT: The column used by the Column Value parameter must be valid as a filter
column for the current report configuration. If a column in the list is not valid for use as a
filter column, then an error message will display when the user attempts to apply the
parameter selection to the report. As the report designer, you should test your parameters to
verify that they work as intended within the report.

\ J
AXIOM)| Intelligence Center Il A @ Ei
wr @
< Intelligence Center Build  Parameters  Filters Preview m
All Parameters + Add ¥
Category
Dept x
Column List Name
Grouping for analysis
Category
Category x
Column Value Display prompt

Account category to analyze
Account category to analyze

() Required

Column Value Configuration

Source column type

@ Static column

(O pynamic column

Selected Column
ACCT.Category Edit

T q
() Allow multi-select

Description display format

Value - Description v

Example Column Value parameter allowing report users to filter the report by the source column

» Using DateParts with ColumnValue parameters

You can use DateParts when setting parameters for a ColumnValue. Click Parameters from your report
and click Add to add a Column Value.
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< Intelligence Center Builld  Parameters  Filters Preview

All Parameters + Add ~
Report Parameter (Column Value)

Report Parameter (Column
Value) L=

Column Value

Report Parameter (Column Value
Report Parameter (Column Value) P ( )

Display prompt

Report Parameter (Column Value)

Required

Column Value Configuration
Source column type
© Static column

O Dynamic column

Selected Column
no column selected> Edit

Allow multi-select

Parameter filter behavior for Related Table columns

Parameters view

In the Column Value Configuration section, select Static column. In the Selected Column section, click
Edit and the select the column you want to use. Then, select which date part to use, such as Full Date.
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Select Column X
Search tables Search columns Column properties
- Column name
O status
DEPT.Dept_Date
@ Dept_Date
M Biglumeric Date part o retrieve
M BudCat FullDate
M Active
M RegionZ
@ DateTime
0 Percent
@ integerDim
M Integervalue h
Selected column: DEPT.Depi_Date Cancel el
Specifying column and date part
When you view the report, you can select a date to apply to the results of the report.
Report Preview X
Report Parameters
Report Parameter (Column Valug) New Report
WorldRegion 4 Country Dept Description YTD
1/1/2018 -
122018 Asia (Asia region) Singapare 78500 (Test/Dept) Test/Dept $97,557,11
V/alne gmp‘)'ate (Corporate UsA 29000 (Strat Plan) Strat Plan §17,466,64
1/4/2018 epartments)
1/5/2018 Europe (Europe region) UK 80500 (Paris - Store 89) Paris - Store 89 $50,497,68
1/6/2018 .
North America (North Usa 95001 (West Coast West Coast Distribution $1,262,544,80

1/7/2018

America region)

Distribution)

3

Report with column value drop-down list
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» Using a Column List parameter with a Column Value parameter
In order to use a Column List parameter as the source for a Column Value parameter, you must:
e Create and configure a Column List parameter

e Configure the Column Value parameter as dynamic and select the Column List parameter as the
source

In the following example, the Column Value parameter is configured to use the FilterCols Column List
parameter. First the user will select a column from the Column List parameter, then the user will select a
value or values in that column from the Column Value parameter.

AXIOM| Intelligence Center [n] a @ :.EE
w
< Intelligence Center Build  Parameters  Filters Preview m
All Parameters + Add
FilterValue
FilterCols x
Golumn List Name
Filter by
Filtervalue
Filtervalue x

Column Value Display prompt
Select filter values
Select filter values

() Required

Column Value Configuration

Source column type

(O static column

(®) Dynamic column

Selected parameter (dynamic column source)

FilterCols v

@D Alow multi-select

Description display format

Value - Description v

Example Column Value parameter using a Column List parameter to provide the source column
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AXIOM| Intelligence Center o o @ HH
¥ Q@

Report Parameters Edit  Export = Share

Filter by
AccT x i
- e Account Analysis
Select filter values .
Region * Jan Feb Mar
tray
China 7,600,520 7,436,078 $9,008,480
5000 - Travel
£000 - Ciner Trave Corporate $3,632,055 $5,474,832 $3121,313
France $4,140,101 $4282217 $4,136,503
india $4472,830 $4,595,180 $5100,535
Italy $1,104,481 $1259,156 $1,047,663
Singapore $6,004,279 $6,772,344 $6985,727
UK $4,727,841 $4,794,366 $4,780,809
US Central $73,601,052 73,525,863 73,021,619
US East 54003715 $49,227,795 48,112,441
US West $128700258  §129,931,118  $129,827.850

$289,166,229 $287,298,948 $286,043,029

Example end user experience to choose the filter column and values

For more information on how to configure Column List parameters, see Using Column List report
parameters.

Design considerations for the report user experience

When a Column Value parameter is linked to a Column List parameter, the Column Value parameter is
automatically dependent on the other parameter. This means that the Column Value parameter will not
become active in the Report Parameters panel until a value has been selected for the Column List
parameter. The Column Value parameter will then become active and allow the user to select a value or
values from the column selected for the Column List parameter.

NOTE: Because of this automatic dependency, you should make sure that the Column List parameter
is ordered before (above) the Column Value parameter.

Additionally, you must decide whether you want the Column Value parameter to start with a default
column or not:

e |f the Column List parameter does not have a specified default column, then the Column Value
parameter will be disabled until a value is selected for the Column List parameter.

e If the Column List parameter has a specified default column, the Column Value parameter is
enabled and uses the default column. The user can optionally select a different value for the
Column List parameter to change the column used by the Column Value parameter.
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» How Column Value parameter selections are applied as filters
When a Column Value parameter selection is applied to the report, the filter is applied as follows:

e [f the source column is from a related table, or if the source column is from the primary table
when the primary table is a data table, then the filter is applied as a table-specific filter.

e Otherwise, the filter is applied as a general report filter.

NOTE: Because columns that look up to dimension tables are automatically "elevated" to the
dimension table when the primary table is a data table, it is not possible to apply table-specific filters
with these columns when using a Column Value parameter. For example, it's not possible to use
BGT2021.Acct in a Column Value parameter, because the column reference is always elevated to
Acct.Acct and therefore applied as a general filter. In the majority of use cases involving columns
that look up to dimension tables, the general filter is the intended filter.

The filters resulting from Column Value parameter selections are applied in the same way as report-level
filters defined in the Report Configuration panel. For more information on the difference between table-
specific filters and general report filters, see Filtering data in web reports.

The syntax used for filters depends on whether the parameter allows single selection or multiple
selection. For example, if the source column is Dept.Dept, filters are created as follows:

¢ Single selection: A filter will be created such as Dept .Dept=20000.

e Multiple selection: A filter will be created such as Dept .Dept IN (20000,21000,45000).

To make your variable narrow the list displayed to only the departments used in a single table (for
example, GL 2020), enter GL.2020 . Dept . Dept.

This filter statement is not visible to report users—the users only see their selected value(s) for the
column.

Keep in mind the following:

e |tis possible that the source column used by the Column Value parameter is not valid as a filter
column for the report, depending on the report configuration. In this case an error will occur
when the user attempts to apply the parameter.

e |tis possible that the Column Value parameter uses a source column that is valid as a filter
column for the report, however, the filter has no effect. For example, if the column is applied as a
table-specific filter but the report does not use any columns from that table, then the table-
specific filter will have no effect and no error will occur.

All report parameters should be tested by the report designer to ensure that they are working as
intended, before rolling out the report to end users.

Administrator's Guide Axiom Strategy Management | 207



Configuring grid properties in a web report
The grid properties define the available features and the overall presentation of data in a web report.
Using the grid properties, you can configure:
e User interaction properties such as whether users can filter columns, sort columns, and reorder
columns
e Display properties such as whether the grid has a total row and whether rows with all zero values
display
¢ Drilling properties such as what type of drilling is enabled and configuration for directed drilling

In the Report Builder, the grid properties are defined in the right-hand Configuration Panel.

To configure grid properties for a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click the grid that displays below the
column setup boxes.

2. Inthe right-hand Configuration Panel, complete the Grid Configuration properties as needed.

AXIOM/| Intelligence Center [n] Ja @ Ei
w
< Intelligence Center Build  Parameters  Filters %  RefreshData  Preview
Data Context d f N
Budget to Actuals Corporate Grid Configuration
GL2022 7
General Advanced
Through June 2022
Column Properties ~
» BB Gl2oz2 PV =V
@D cravle coumn fiters
» [2] Dimension Tables @ WorldRegion - Q1 Actuals == [DQ2Actuals -~ [DQ1Budget -~ [DQ2Budget - —
() Multi-column sorting
> % Related Tables -
@D enavie reorcering columns
WorldRegion 1 Actuals 2 Actuals 1 Budget 2 Budget
9 @ aQ a 9 a g Grid Properties ~
Asia (Asia region) $59,065,030 $58,174,791 $33,016,385 34,789,159 () uss ixedrows
Corporate (Corporate departments) 411,786,889 $7,370832 $6,102,073 $6,290,837 @D include total row
Europe (Europe region) $30,716,504 $30,422,551 1,202,834 $1,223,440 Total row header label
North America (North America region) $760,989,716 $750,407,151 $153,881,599 $139,551,224
( 7) Suppress zero rows
$862,558,229 $846,375,326 | $194,203791 $181,854,660 *
) . e .
S Click the grid area () Enable drilling
to load the grid

Grid sort order

configuration
properties

(@) Defaut
Q) custom

Example Grid Configuration properties

The grid configuration properties are separated into two tabs:
e General: Basic grid properties that should be reviewed and configured for all web reports.

e Advanced: Advanced grid properties such as default column formats for the grid.
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» General grid properties

The following grid properties are available for web reports on the General tab of the Grid Configuration
panel:

Column Properties

Iltem Description

Enable column filters Specifies whether users can filter columns in the grid. Only applies to grids
with dynamic rows; users cannot filter columns in grids where Use fixed
rows is enabled.

e |f enabled (default), then filter icons display on columns where Enable
filter is enabled in the column configuration properties. Report users
can use these icons to filter the data shown in the column. If Enable
filter is disabled on a column, the filter icon is not available for that
column.

 |f disabled, then filter icons do not display on any columns, regardless
of whether Enable filter is enabled for the column.

Multi column sorting Specifies whether users can sort by multiple columns in the grid. Only
applies to grids with dynamic rows; users cannot filter columns in grids
where Use fixed rows is enabled.

e |f enabled, then users can sort the grid by multiple columns. If the grid
is already sorted by a column and a user clicks another column to sort,
then the grid is first sorted by the most recent column and then sorted
by the original column. Columns will remain sorted until the user
toggles the sort disabled for that column.

e |f disabled (default), then users can sort the grid by a single column. If
the grid is already sorted by a column and a user clicks another column
to sort, then the sort is disabled on the original column and the grid
becomes sorted by the most recent column.

Users can sort columns by clicking on the column header. Each click
toggles through sort ascending, sort descending, and no sort.

NOTE: The ability to clear the sort is only available if multi-column sorting
is enabled. Otherwise, clicking a column header will toggle between sort
ascending and sort descending. You can click a different column header to
sort by that column, but you cannot clear the sort.

Enable reordering Specifies whether users can reorder columns in the grid.

columns * If enabled (default), then users can drag and drop columns within the
grid to temporarily reorder them.

¢ [f disabled, then users cannot reorder columns in the grid.
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Grid Properties

Item Description

Use fixed rows Specifies whether the grid uses dynamic rows or a fixed row structure.

e |f enabled, then the grid uses a fixed row structure to define the rows.
Select the structure using the Fixed row structure field. For more
information, see Specifying the fixed row structure for a web report.

e |f disabled (default), then the grid dynamically generates rows based
on a table column specified as the row dimension. The row dimension
is specified by dragging and dropping the desired table column into the
Row Dimensions box at the top of the Report Canvas. For more
information, see Specifying the row dimension for a web report.

Fixed row structure Specifies the fixed row structure to use in the grid. Only applies when Use
fixed rows is enabled.

Select an existing fixed row structure to define the rows of the grid. You
can type into the box to filter the list of fixed row structures by name.

Fixed row structures can be created from the Intelligence Center. For
more information on creating fixed row structures, see Managing Fixed
Row Structures.

Include total row Specifies whether a total row is present on the grid. Only applies to grids
with dynamic rows; if Use fixed rows is enabled then the grid uses
subtotal and total rows as defined in the fixed row structure.

e |f enabled, then a total row displays at the bottom of the grid. If the
grid data is paged, the total row shows the total of all rows across all
pages.

Use the Total row header label field to define label text for the total
row, such as "Total". This text displays in the last row dimension
column.

Columns displaying numeric, non-dimensional data are included in the
total row by default. If desired, you can exclude a numeric column
from the total row using the column configuration properties.

e |f disabled (default), then the grid does not have a total row.
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Item Description

Suppress zero rows Optional. Specifies whether data rows with all zeros are suppressed from
showing in the grid. Only applies to grids with dynamic rows; all zero rows
cannot be suppressed in grids where Use fixed rows is enabled.

Non-key columns that meet both of the following criteria are evaluated to
determine whether a row should be hidden:

e The column data type is Integer (all types) or Numeric.

e The column is from the primary table or an additional data table.

If the primary table is a data table, Integer and Numeric columns on
lookup reference tables are ignored—meaning these columns may have
values, but the row is still suppressed if all applicable data table columns
have zero values. There is one exception: reference table columns are
considered if the column classification is Values and the numeric type is
Currency.

Calculated columns defined in the grid are not evaluated for this purpose
and do not prevent a row from being suppressed.

Enable drilling Specifies whether users can drill down rows in the grid to view the
underlying data.

e |f enabled, then users can drill rows in the grid. Use the Drilling type
property to specify what type of drilling options are present:

° Key columns (default): Users can drill down to the key column level
of the data. These drilling options are automatically generated
based on the validated key columns of the primary table. No
additional setup is required.

° Directed: Users can drill down predefined drilling paths. Use the
View/Edit Configuration link underneath the Directed option to
configure the drilling paths.

For more information, see Configuring drilling for web reports.

e |f disabled (default), then users cannot drill rows in the grid.
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Item Description

Grid sort order Specifies the sort order for data in the grid.

e Default: Data is sorted by the row dimension columns specified for the
grid, in ascending order. If multiple row dimension columns are
present, the first row dimension column is the primary sort column,
followed by the second row dimension column, and so on.

e Custom: Specify one or more columns to sort the grid data, in either
ascending or descending order. Use the View/Edit Configuration link
underneath the Custom option to select the drill columns.

° The Edit Sorting Configuration dialog lists all columns in the grid. It
is not currently possible to sort by a column that is not present in
the grid. If necessary, you can add a column to the grid in order to
sort by that column, then configure the column as hidden so that it
does not show in the grid.

° To add a column to the sorting configuration, drag the column from
the left-hand panel to the right-hand panel, and then select Asc
(default) or Desc for the sort order. To remove a column from the
sorting configuration, click the X icon on the right-hand side of the
column box.

° If multiple columns are added to the sorting configuration, the top-
most column is the primary sort column, followed by the next
column, and so on. You can reorder the columns in the list by
clicking the drag handle on the left-hand side of the column box
and then dragging and dropping it to a new location.

If a custom sort is specified but no columns are added to the sorting
configuration, the grid will revert to using the default sort order.

NOTES:

e |f Multi column sorting is not enabled for the grid, the grid will still
honor a multi-column sort configuration when the report is initially
rendered. However, if a user sorts by any column, the grid reverts to
single-column sorting with no way to return to the previous sort
configuration other than by reloading the report.

¢ Process columns cannot be added as custom sort columns.

e If a dynamic column is added to the sort configuration, it displays in
the list with its assigned Column List report parameter name in
parenthesis. If you hover your cursor over the column name in the sort
configuration, the current column used by the dynamic column is
shown in the tooltip.
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NOTE: If you created a web report using the Report Builder in version 2021.1, that report may have
had a defined Data Filter in the Grid Configuration properties. These filters are now defined at the
report level, on the Filters tab. Any existing grid filter will be automatically converted to a general
report filter. In rare cases, this conversion may result in report errors if the grid-level filter is not
valid as a general report filter. If this occurs, you can delete the converted filter and re-create it as a
table-specific filter.

» Advanced grid properties

Using the properties on the Advanced tab of the Grid Configuration panel, you can view and edit
Default column formats for columns in the current report. Select a column Data type that you want to
configure, and this section will populate with the properties for the selected data type.

All columns added to the report will inherit the settings defined here. By default, columns will continue
to inherit any changes made to the default column formats unless the format has been overridden at
the column level.

For example, the default alignment for String columns is Left. When String columns are added to the
grid, they are configured to use the Default alignment, meaning Left. If desired, you can change the
default alignment for String columns to Center, and all String columns in the grid that are using the
Default alignment will now update to use Center alignment. However, if you have manually configured a
particular String column to use Right alignment instead of the Default alignment, that column will
continue to use its configured alignment of Right.
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Item Description

Data type Select a column data type to view and edit the default column formats for
that type. The following data types are available:

e String: Columns containing text or alphanumeric values. Includes table
columns using the String data type.

¢ Date: Columns containing dates. Includes table columns using the Date
data type.

e DateTime: Columns containing date-time values. Includes table
columns using the DateTime data type.

e Boolean: Columns containing True or False values. Includes table
columns using the Boolean data type.

e Dimension: Columns containing numeric dimension codes. Includes
table columns using Numeric, Integer, or Identity data types, where
the Column Classification is Dimension.

e Decimal: Columns containing decimal numeric values. Includes table
columns using the Numeric data type, where the column has a
Numeric Type of Number.

¢ Number: Columns containing whole integer numeric values. Includes
table columns using Integer or Identity data types, where the Column
Classification is Value.

e Currency: Columns containing currency numeric values. Includes table
columns using the Numeric or Integer data types, where the column
has a Numeric Type of Currency.

¢ Percent: Columns containing percent numeric values. Includes table
columns using the Numeric or Integer data types, where the column
has a Numeric Type of Percent.

Additionally, when you create a calculated column, you can specify its
data type as one of the numeric data types. The column will then use the
default column formats for that data type. The default data type for
calculated columns is Currency.

NOTE: Columns that would normally be treated as Number data type are
treated as Dimension data type if they are used as row dimension columns
or drill columns.
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Item Description

Column width The default column width for the selected Data Type, in pixels. Enter the
desired column width as a whole integer between 30 and 600.

The default width for each data type is as follows:
e Currency, Decimal, Percent, Date, Boolean: 120
e Number: 150
e DateTime, String, Dimension: 200
Alignment The default alignment of the column values for the selected Data Type. If

you want to change the default alignment for a data type, select one of
the following: Left, Right, Center.

The default alignment for each data type is as follows:
e String, Date, DateTime, Boolean, Dimension: Left

e Decimal, Number, Currency, Percent: Right

Numeric default properties

The following default properties only display if the selected Data type is a numeric data type. These
properties can be used to define the default numeric format by column data type.

For example, the default number format for the Currency data type uses 0 decimal places, with a
thousands separator, and a negative number format of red parentheses. When a Currency column is
added to the grid, the contents automatically display using this number format. If desired, you can
change the default number format for Currency so that it uses 2 decimal places, and all Currency
columns in the grid will now update to show 2 decimal places. This applies to columns that use the
Currency number format by default, as well as columns that you have manually configured to use the
Currency format. However, if you have manually configured a particular Currency column so that it now
uses a Custom number format instead of the Currency number format, then it will continue to use its
custom configuration.

Iltem Description

Decimal places The number of decimal places used by the selected Data Type. Enter any
whole number from 0 to 10. You can also use the arrow keys to move the
number up or down.

The default number of decimal places for each numeric data type is as
follows:

e Currency: 0
e Decimal, Percent: 2

The Number data type does not use decimals.
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Item Description

Use 1000's separator Specifies whether the selected Data Type uses a thousands separator:

e If enabled (default), numbers show with a thousands separator, such
as 1,000.

e |f disabled, numbers do not use a thousands separator, such as 1000.

Negative number The format used by the selected Data Type to display negative numbers.

format Select the desired format from the drop-down list. Available formats use
the minus sign, or parentheses, or red text (or a combination of these
formats).

The default negative number format for each numeric data type is as
follows:

e Decimal, Number, Percent: Minus sign

e Currency: Red text in parentheses

Date and Date Time default properties

The following default properties only display if the selected Data type is a date data type. These
properties can be used to define the default date format by column data type.

For example, the default format for Date columns is Month/Day/Year (such as "10/152022"). When a
Date column is added to the grid, the contents automatically display using this format. If desired, you
can change the default format for Date so that it displays as "October 15, 2022" instead, and all Date
columns in the grid will now update to use this format. However, if you have manually configured a
particular Date column so that it uses a different date format instead of the default format, then it will
continue to use its custom configuration.

Item Description

Date format The format used by the selected Data Type to display date or date-time
values. You can select any of the "full date" formats supported by Date
and DateTime columns, including custom formats. By default, the formats

Date Time format are:

e Date: 10/15/2020
e Date Time: 10/15/2020 13:25

or

NOTE: Only "full date" formats are supported as the default format. If you
configure an individual Date or DateTime column to use a different date
part, such as Year or Quarter, then the default date format no longer
applies, and the column is treated as a Dimension data type.

Custom Date format Use this field to define the custom date or date-time format, if Custom is
specified as the Date format or Date Time format. For more information

or
on the syntax to define custom date and date-time formats, see Custom

Custom Date Time formats.

format
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» Frequently asked questions
Can | disable paging for a dynamic row grid?

Currently, if the grid uses dynamic rows then the grid is automatically paged if it exceeds 25 rows. This
paging cannot be disabled.

How do | define a grid-level filter to limit the data in the report?

If you want to filter the data in the grid, you can define a report-level filter. Select the Filters tab of the
Report Builder to define one or more report-level filters.

Configuring column properties for a web report
The column properties define the presentation of each column in the grid. Using the column properties,
you can configure:

e Display properties such as header text, column width, alignment, and number formatting

e Data properties such as column filters, alternate aggregation, and display formats for data

e Grid behavior properties such as inclusion in the total row, and whether end users can sort and
filter using the column

In the Report Builder, the column properties are defined in the right-hand Configuration Panel. The
column properties can be defined for both table columns and calculated columns.

To configure column properties for a column in a web report:

1. On the Build tab of the Report Builder, in the Report Canvas, click a column name in either the
Row Dimensions box or the Column Definitions box to select that column.

2. Complete the Column Configuration properties that display in the Configuration Panel.
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e General: Basic column properties that should be reviewed and configured for all columns in the

grid.

e Advanced: Advanced column properties to be configured as needed.

» General column properties

The following column properties are available for web reports on the General tab of the Column
Configuration panel. These properties apply to table columns, calculated columns, and dynamic

columns.
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Item Description

Column The following information displays at the top of the panel to identify the
column:
or
. e Column: If the column is a table column, the full Table.Column path
Calculation displays for your reference.
or

Column Configuration
Default Column

General Advanced

Column

BGT2020.Q1

e Calculation: If the column is a calculated column, a text representation
of the calculation displays for your reference. You can click the Edit
icon to the right of the box to open the Edit Calculated Column dialog
and edit the calculation as needed.

Column Configuration

General Advanced

Calculation

({Q1 Actuals} - {Q1 Budget}) / {Q.. &

e Default column: If the column is a dynamic column, the currently used
Table.Column path displays for your reference. This column is
determined by the configuration for the Column List parameter that is
associated with the dynamic column.

Column Configuration

General

Dynamic column parameter

DeptGroup v

Default column

DEPT.Dept
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Item Description

Dynamic column The Column List report parameter to associate with the dynamic column.
parameter Only applies when the current column is a dynamic column.

For more information, see Using Column List report parameters.

Header The header text to display on the column header. Enter the desired
header text.

e |If the column is a table column, the column name is used as the header
text by default.

e |f the column is a calculated column, the text "Calculation" is used as
the header text by default.

If the column is a dynamic column, the header text is defined in the
Column List parameter settings, for each column that is available to be
selected. Within the Report Canvas only, the dynamic column displays
using the header Dynamic.

Column width The width of the column in the grid, in pixels. Enter the desired column
width as a whole integer between 30 and 600.

The default width depends on the column data type, and is configured at
the grid level. If you do not enter a custom width, then the default width
displays in the Column width box in gray text. If you leave this default
width and the grid-level defaults are changed, then column will update to
use the new default width. For more information, see Configuring grid
properties in a web report.

Alignment The alignment of the column values. Select one of the following: Default,
Left, Right, Center.

The default alignment depends on the column data type, and is configured
at the grid level. If a column is set to use Default and the grid-level
defaults are changed, the column will update to use the new default
alignment. For more information, see Configuring grid properties in a web
report.
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Item Description

Select Formatting Properties to work with number formats. The number
format used by the column. Only applies to columns that hold numeric
data. Select one of the following:

Number Format

Aggregation

Data filter

Administrator's Guide

Default: The column uses the default number format as defined for the
column's data type at the grid level. If a column is set to use Default
and the grid-level defaults are changed, the column will update to use
the new default number format. For more information, see Numeric
default properties.

Currency, Decimal, Number, Percent, or Dimension: The column uses
the default number format as defined for the selected data type. For
example, you may have a column that is natively a Decimal column,
but you want it to display using Currency format in a particular report.

If a column is assigned to a different number format, it will also inherit
the default column width and alignment set for the associated data
type, if the column is using the default column with and alignment.

Custom: The column uses a custom number format as defined in the
column properties. Click Override default formatting to work with
custom number formats.

When Custom is selected, then several additional properties become
available to configure the number format. In this case, the column is
no longer tied to any particular default number format.

° Decimal places: Specify the number of decimal places to display,
from 0 to 10.

© Use 1000's separator: Specify whether the number uses a
thousands separator or not.

° Negative number format: Specify the format to use for negative
numbers.

This option is not available for use with dynamic columns.

Select Data Properties to configure Aggregation. The aggregation type
used to aggregate data queried from the database column. Does not apply
to calculated columns or to columns used as row dimensions.

If you want to override the default aggregation type for a database
column, select an aggregation type.

Select Data Properties to configure the optional Data filter. Defines a filter
to limit the data shown in this column. The column-level data filter should
be used instead of a grid-level data filter when you want the filter to
impact just this column. For more information, see Using column filters.
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Item Description

Enable filter Specifies whether report viewers can filter the report based on the
column contents.

e |f enabled (default), and if Enable Column Filters is enabled in the Grid
Configuration properties, then a filter icon is available on the column in
the rendered report. Report viewers can use this column to filter the
grid based on the column contents.

e |f disabled, then the filter icon is not available on the column.

This property does not apply to any column in the grid if Use fixed rows is
enabled in the Grid Configuration properties. Fixed row reports do not
support end-user column filtering.

Hide column Specifies whether the column is hidden in the report. Does not apply to
columns used as row dimensions.

¢ If enabled, then the column is hidden. The column remains visible in
the Report Builder so that you can continue to configure the column as
needed.

¢ [f disabled (default), then the column is visible.

Show description Select Display Properties to work with configure the description text.

Specifies whether you want descriptions to display for dimension values.
This option only applies to key columns, alternate key columns, and
validated columns that have an associated description column.

e |f enabled (default), then descriptions display alongside the dimension
values or instead of the dimension values. For example, if the column
is Acct then you likely want the account descriptions to display along
with the account codes.

When this option is enabled, the Description display format field
becomes available. Select the desired display format from this list. By
default, the format Description (Value) is used.

e |f disabled, then only the dimension values display. For example, if the
column is Acct then only the account codes will display.

NOTE: If the dimension table has multiple description columns (meaning
columns where Describes Key is True), then the first description column is
used.

If the column is a dynamic column, then this option will be applied when
the currently selected column has a description column, and ignored
when it does not.
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Item Description

Include in total row Specifies whether the column is included in the total row, if a total row is
enabled in the Grid Configuration properties. Does not apply to columns
used as row dimensions.

Select one of the following:

e Default: The column is included or not based on its data type. All
numeric columns are included by default unless they are the
Dimension data type. All other non-numeric columns are not included
by default, unless you change the aggregation so that the column
returns a number (such as using Count aggregation on a String
column).

¢ Include: Override the default behavior and include the column in the
total row.

¢ Exclude: Override the default behavior and exclude the column from
the total row.

If a column is included in the total row, it is treated as follows:

e Table columns use their default or configured aggregation in the total
row. For example, if a numeric column uses the default aggregation of
sum, the column will be summed in the total row.

e Calculated columns apply their calculation to the total row.

This option does not apply if Use fixed rows is enabled in the Grid
Configuration properties. Columns will be included or excluded in subtotal
or total rows using the default behavior.

Date part to retrieve Specifies the date or date-time part to retrieve, if the column is a Date or
Date Time column. For example, you can return the full date value, or just
the year or month, or the fiscal year or month. For more information, see
Date part and format options.

Date format Specifies the format to display the date values, if the column is a Date or
Date Time column. The available format options depend on the specified
Date part to retrieve. For more information, see Date part and format
options.

The label and visibility of this setting varies depending on the selected
date part. For example, if you select Month as the date part, then the
label for this setting is Month format. If you select a date part that does
not have any formatting options, such as Year, then this setting is hidden.
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» Advanced column properties

The following column configuration properties are available for web reports on the Advanced tab of the
Column Configuration panel. These properties apply to table columns and calculated columns. Dynamic
columns do not use these properties.

Header Properties

Item Description

Header text (row 1) The header text to display on the column header. Enter the desired
header text.

NOTES:

e This is the same property that displays on the General tab as Header.
The header text can be edited from either tab.

e The (row 1) label only displays if Multi-row header has been enabled.
In this case, the property defines the header text for the top row of the
multi-row header.

Header text (row 2) The header text to display on the second row of the column header. Enter
the desired header text.

This property is only available if Multi-row header has been enabled.

Multi-row header Specifies whether the column header has multiple rows:

e |f enabled, then the header text property updates so that there are
two properties: Header text (row 1) and Header text (row 2). The
default header text populates row 1. You can define additional text to
display on row 2.

e |f disabled (default), then only one row of header text can be defined.
Keep in mind that enabling a multi-row header is different than wrapping
header text. If you enable multi-row headers, then you can define two

separate rows of header text. A line break separates each row. If
autowrap is enabled, then each row of header text wraps individually.

If you just want a single row of header text that wraps, you can leave this
option disabled and then enable Autowrap header text.

Autowrap header text  Specifies whether header text wraps:

¢ |f enabled, then header text that exceeds the column width will wrap.
If Multi-row header is enabled, both rows of header text will wrap
individually.

e If disabled (default), then header text that exceeds the column width is
truncated. The user can resize the column wider to view the full
header text.
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Item Description

Header alignment The alignment of the header text. Select one of the following: Default,
Left, Right, Center. All column headers use Default alighment by default.

By default, the header text uses the same alignment as the column
contents (as determined by the Alignment property on the General tab).
If you leave the header alignment set to Default, then the header
alignment will adjust to match the column alignment. If, however, you
want the header alignment to be different than the column alignment,
you can configure this property.

Link Properties

For more information on using hyperlink columns in web reports, see Displaying hyperlinks in web
reports.

Item Description

Enable Specifies whether the column displays hyperlinks. Select this option if you want each
link row of this column to contain a hyperlink that dynamically incorporates the current
column value.
If this option is enabled, then the additional link properties in this section become
available; otherwise they are hidden.

Link Specifies the type of link to display in the column:
type e Custom: You specify the relative URL for the hyperlink, including using variables to
dynamically incorporate the current column value in the URL.
¢ Plan file: Axiom Strategy Management dynamically generates a hyperlink to the plan
file associated with each row. In order to use this option, the report must have a
specified File group context in the Report Configuration properties, and the row
dimension must be the key column of the plan code table for that file group.

NOTE: This option only displays if the report meets the requirements to support plan
file links. Otherwise, all links are custom links by default, and this option does not
display.
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Item Description

URL Specifies the URL to use in the hyperlink column. Enter a relative location in the Axiom
Strategy Management system. The URL can use variables as needed so that the URL
value is dynamic per row of the report.

For example, imagine that the report contains the key column of a plan code table (such
as Dept), and you want each plan code to link to the Process Routing page for a
particular plan file process. The full URL to the Process Routing page uses the following
syntax:

https://mycompany.axiom.cloud/process/
processdefinitionID/planfile?planvalue=plancode

The process definition ID will be constant for the URL, but the plan code value needs to
be the current row's department value. The {value} variable can be used for this
purpose. The following relative URL with a variable would be entered into the URL field:

/process/16682/planfile?planvalue={value}

NOTE: The relative URL can be entered with or without the beginning forward
slash.

When the report is viewed, the column will resolve to use the full URL with the current
column value. For example, the row showing Dept 22000 will have the following URL:

https://mycompany.axiom.cloud/process/16682/planfile?planval
ue=22000

When the user clicks on the hyperlink in this row, they will be taken to the Process
Routing page for Dept 22000, for the plan file process associated with process definition
ID 16682.

NOTE: The URL property only displays if the specified link type is custom, or if the Link
type option is not present because all links in the report are custom. When using the
plan file link type, the URL to the plan file is automatically generated by Axiom Strategy
Management.
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Item Description

Link text  Specifies the display text for the hyperlink column. Enter the desired text, using
variables as needed. Keep in mind the following:

¢ |If you want the link text to be the column value—meaning the same value that
would display in the column if the column was not enabled as a link column—then
you can leave this field blank. The current column value is automatically used as the
link text.

e The variable {value} displays the raw column value from the database. For
example, if the column is a numeric column, the value will not have numeric
formatting and will show all decimal places.

e The variable {formattedvalue} displays the column value with formatting—such
as default formatting based on the column type, or applied formatting in the Column
Configuration properties. It is only necessary to use the { formattedvalue}
variable if you want to display the formatted column value along with other link
text. If you just want to display the formatted value by itself, you can leave the field
blank as previously noted.

Link Specifies the tooltip to show when a user hovers the cursor over the hyperlink. Enter
tooltip the desired text, using variables as needed. The same variable behavior noted
previously for the Link text property also applies to this property.

Open Specifies whether the hyperlink opens in the same tab (replacing the report) or in a new
link in tab. By default, the hyperlink opens in the same tab. Enable this option if you want the
new tab hyperlink to open in a new tab.

» Using column filters

The Data filter property can be used to filter the data coming into a particular column. This filter only
impacts the data in the current column; it has no impact on the rest of the report.

To filter the data in the current column:
1. Click the Edit link over the Data filter box to open the Filter Wizard.

2. In the Filter Wizard, create the filter as needed. For more information on how to use the Filter
Wizard to create a filter, see Using the Filter Wizard in the Report Builder.

The tables available in the Filter Wizard depend on whether the current column is a table column
or a calculation, and the primary table specified as the Data Context of the report:

e If the current column is a table column, the Filter Wizard shows that table and its
dimension tables.

e If the current column is a calculated column, the Filter Wizard shows the following tables:

° If the calculated column only uses columns from a single table, the Filter Wizard
shows that table and its dimension tables.
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° If the calculated column uses columns from multiple tables, and the primary table is
a data table, the Filter Wizard shows the common dimension tables for the tables
involved in the calculation.

EXCEPTION: If the calculation includes a column from a dimension table, then the
Filter Wizard shows the common dimension tables for all related tables used in the
report, regardless of whether the related table is used in this particular calculation.

° |f the calculated column uses columns from multiple tables, and the primary table is
a reference, the Filter Wizard shows the primary table and its dimension tables.

EXCEPTION: If the calculation only consists of columns from related tables (no
columns from the primary table or dimension tables), then the Filter Wizard shows
the common dimension tables for all related tables used in the calculation.

You can create a filter using any column on the available tables. If you choose to use a predefined
global filter from the Filter Library, the global filter must be based on the same eligible table
columns.

3. Once the filter statement is complete, click OK to close the Filter Wizard and add the filter to the
Data filter box.

Once a filter has been defined for a column, you can modify it as follows:

e To edit the filter, click the Edit link over the Data filter box again and change the filter within the
Filter Wizard.

¢ To delete the filter, click the Clear link over the Data filter box.

Data filters defined at the column level are combined with any filters defined at the column group level
and at the grid level. All relevant filters are combined using AND to determine the data that can display
in a particular column.

If a column has a defined filter, then a filter icon displays next to the column name in the sample grid of
the Report Canvas. This icon is intended to let report builders know about the column filter at-a-glance.
The icon does not display in the report viewer.

NOTES:
¢ |f a data filter is defined for a calculation, the filter is applied to the columns referenced in the
calculation, then the calculation occurs.

e Column-level data filters cannot be defined for columns used as row dimensions. To limit the
rows shown in the grid, use a report-level filter in the Report Configuration properties.
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» Frequently asked questions

| defined a column filter but it isn't impacting the grid data as | expected—why do I still see rows that
don't match the column filter?

A column filter only filters the data coming into that specific column. If you want to define a filter that
impacts the entire report, including the row data, then you should define a filter at the report level.
Select the report title and then use the Report Configuration properties to define one or more Report
filters.

To illustrate the difference, imagine the following uses of a filter to only show data from the West
region:

e Report: When the general filter Dept .Region="West"' is defined for the report, the entire grid
is filtered to only show data from the West region. Row dimension values (such as departments)
will only display if they belong to the West region, and column data is limited to only show data
for the West region.

¢ Column: When the filter Dept .Region="West ' is defined on a column, that single column is
filtered to only show data from the West region. Other columns and row dimension values are
not limited by this filter. You might do this if you want to create a report that shows the different
region data in different columns, such as to compare data from the West, East, North, and South
regions side-by-side.

Configuring drilling for web reports

You can enable two types of drilling for web reports:

e Key columns: Users can drill to view the underlying data based on the key columns of the table
specified as the Data Context. This option provides limited "out-of-the-box" drilling functionality
that does not require any further setup.

e Directed: Users can drill to view the underlying data based on predefined drilling paths. The
report designer defines the available drilling paths and can configure certain display attributes for
the drill.

To enable either drilling option:

1. On the Build tab of the Report Builder, in the Report Canvas, select the grid so that the Grid
Configuration properties display in the Configuration Panel.

2. On the General tab of the Grid Configuration properties, enable Enable Drilling.
3. For Drilling type, select either Key columns or Directed.

4. If you selected Directed, click the View/Edit Configuration link to define the directed drilling
paths.
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» Configuring directed drilling paths
Use the Edit Drilling Configuration dialog to define the drilling paths for directed drilling.

To define drilling paths:

1. Inthe Grid Configuration properties, click the View/Edit Configuration link under the Directed
drilling option.

2. Drag and drop columns from the table tree to the Drill Columns area in the middle of the dialog.
The available columns for drilling depend on the table specified as the primary table for the data
context:

e If the primary table is a data table, then you can use any column on the primary table or on
a lookup reference table (the Dimension Tables).
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e If the primary table is a reference table, then you can use either of the following:

° Any column on the primary table, including multiple-level lookup references to the
dimension tables.

° Any column on a table that looks up to the primary table (the Related Tables). This
option is not available if the report uses a fixed row structure.

NOTE: If you use a column from a related table, you are effectively using
upstream grouping columns in your drilling path. This means that any special
considerations and limitations that apply to upstream grouping columns also
apply to the drill results. For more information, see Using upstream grouping
columns as row dimensions in web reports.

3. Place the drill columns in the desired order for the directed drilling. Users can drill from the
column at the top of the list down to the column at the bottom of the list. Generally speaking, the
lowest level of detail should be at the bottom—for example: VP > Director > Manager > Dept.

e To reorder columns, click the handle on the left side of the column box to drag and drop
the column to a new position.

e To remove a column, hover your cursor over the column and then click the X on the right
side of the column box.

4. Select each drill column and configure the drill properties in the right side of the dialog. See the
following table for information on these properties.

5. Click OK to complete the drill configuration and return to the Report Builder.
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Edit Drilling Configuration

» EHGL2020

v [& Dimension Tables
» EBACCT
v EBDEPT

[ Dept
[0 Description
[ Template

» [0 WorldRegion
D Country

» [0 Region
[0 Currency

» VP

M Employees

s

Drill columns

1 - DEPT.Country

2 - DEPT.Region

3- DEPT.Dept

Order the drill
columns from
highest level to
lowest level

Drag and drop
columns that you
want to use as the
drill levels

Column properties

Drill Column Configure display
properties for the
DEPT.Dept drill columns
Header
Department
Column width
300
Alignment

Default (Left) ~

~
( ) Show description
A

Description display format

Description (Value) ¥

Cancel

Example drilling configuration dialog

Drill Column Properties

Iltem Description

Drill column The full Table.Column path of the drill column displays for your reference,
so that you know which column you are configuring.
Header Header text for the column in the drill results. Enter the desired text. The

column name is used by default.

Column width The width of the column in the drill results, in pixels. Enter the desired

column width as a whole integer between 30 and 600.

By default, the width is 300 for all drill columns, regardless of data type.

Alignment The alignment of the column values. Select one of the following: Default,

Left, Right, Center.

The default alignment depends on the column data type. If a column is set
to use Default and the grid-level defaults are changed, the column will
update to use the new default alignment. For more information, see
Configuring grid properties in a web report.
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Item Description

Show description Specifies whether you want descriptions to display for dimension values.
This option only applies to key columns, alternate key columns, and
validated columns that have an associated description column.

e |f enabled (default), then descriptions display alongside the dimension
values or instead of the dimension values. For example, if the column
is Acct then you likely want the account descriptions to display along
with the account codes.

When this option is enabled, the Description display format field
becomes available. Select the desired display format from this list. By
default, the format Description (Value) is used.

e |f disabled, then only the dimension values display. For example, if the
column is Acct then only the account codes will display.

NOTE: If the dimension table has multiple description columns (meaning
columns where Describes Key is True), then the first description column is
used.

» Using directed drilling
If directed drilling is enabled and configured, you can drill down the predefined drilling paths to view the
underlying data. Directed drilling works as follows:

e When you view the report, you can hover your cursor over a row to show the magnifying glass
icon on the left side of the row.

Q1 2020
WorldRegion T
Q1 Actuals Q1 Budget
$6,989,316 $5,416,397
s camy
aTopE $473,158 $340,531
North America $32,766,656 $35,609,235

e Click the magnifying glass to drill to the first level of the drill. This is the column positioned at the
top of the Drill Columns list in the Edit Drilling Configuration dialog. The drill results openin a
new browser tab.

e From here, you can continue to drill by hovering over a row and clicking the magnifying glass to
go to the next level of the drill. All subsequent drills are performed in the same browser tab.

¢ Once you reach the final level of the drill, no more drilling options are available and the
magnifying glass no longer displays.
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NOTE: If a particular drill level has data that cannot be associated with any grouping values, then the
drill results contain a row labeled <No value>. This row cannot be further drilled. This situation may
occur if the drill level contains records with a blank or empty string value, or if some of the
underlying data in the row being drilled does not have a reference to the current drill level.

» UsingDateParts in drill column configurations
Use directed drilling to configure a datepart in a drill column configuration.
In Grid Properties in the right sidebar, enable drilling and select the Directed drilling type to configure.

Choose the Directed option and click View/Edit Configurationto open the Edit Drilling Configuration
dialog box. This example shows how DEPT.Dept_Date was configured to retrieve by YearMo.

Edit Drilling Configuration X
Search tables search columns Drill columns Column properties
" Drill column
» BB BET2020 1- DEPT.Dept_Date
DEPT.Dept_Date
» [®] Dimension Tables
2 - DEPT.Country Header
Dept_Date

3 - DEPT.Region
Column width 3

4- DEPT.Dept
Alignment

Default (Left) v

Date part to retrieve

YearMo v

Cancel ﬂ

Once configured, the values are shown by the year and month.
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Report Preview

New Report
WorldRegion = Europe (Europe regi...
Drill Path - -
By Dept_Date
Dept_Date < YTD TOT
201901 54,442 510,595
201906 50 50
Total 54,442 510,595

» Using key column drilling

If key column drilling is enabled, you can automatically drill to the key column level to view the
underlying data. The available key columns are determined as follows:

e |f the primary table used as the data context is a data table, you can drill to the validated key
columns on the table. However, any key column used as a row dimension will not be available for
drilling, since the report already shows data at that level.

e |f the primary table used as the data context is a reference table, you can drill to the key of the
reference table, unless the key is used as the row dimension.

When you view the report, you can hover your cursor over a row to show the magnifying glass icon on
the left side of the row. From here you can drill as follows:

e |f there is only one available key for drilling, click the magnifying glass to drill.
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e If multiple keys are available for drilling, click the magnifying glass to show a list of the available
keys, then click on the key you want to drill.

WorldRegion 1
Q1 Actuals
Asia $6,989,316
)
~— Drill by ACCT
$473,158
Drill by Dept
NOFUN AMerica $32,766,656

The drill results open in a new browser tab. If multiple keys were available for drilling, you can optionally
drill the drill results to view the other key(s).

If no keys are available for drilling, then the magnifying glass does not display when you hover your
cursor over the row.

» Presentation of drill results

When you drill, the drill results display in the same browser tab, replacing the original report grid. The
data contents of the drill results are as follows:

e The row dimension(s) of the original report are removed from the grid and replaced with the
current drill column. The drill column is either the current column of a directed drilling path, or
the selected key column.

e All other columns of the report are included in the drill results and show data for the current drill
level.

e |f the drill results contain multiple rows of data, the grid includes a total row. If the drill results
contain a single row of data, the total row is omitted.

e Drill results are paged if the results contain many rows.

The current drill path displays along the top of the page. The drill path identifies the row that was drilled
and the current drill level. If you have drilled the drill results, the previous drill levels also display in the
drill path. You can click a previous drill level to return to that level, or you can click the X icon to clear
the drill and return to the original report grid.

The drill column displays as follows:

¢ For key column drilling, the column alignment and width are determined by the column data

type. The header text is the key column name. Key column values are presented as Description
(Value).

e For directed drilling, the column alignment, width, and header text are as configured in the Edit
Drilling Configuration dialog.
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AXIOM| Intelligence Center

Budget to Actuals | Corporate
Through June 2022

WorldRegion = Europe Country = UK

Drill Path x TR o By Region
a1 Q2
Region ¢
Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference
United Kingdom Sales Region (UK) $161,771 $5247,830 -34.73% $237,089 5244075 -2.86%

Example drill results with drilling path displayed at the top

Reporting on process information in web reports
You can include process columns in a web report in order to display status information for plan files in a
plan file process. You can display information such as:

e Current process status for a plan file, including the current step name and number

¢ Process step history per plan file, including the name and number of each step the plan file has
been active in, the plan file's step status, and the time spent in the step

e Step statistics, such as average time spent in each step and number of workbooks in each step

In order to report on process information, the web report must be associated with a file group. The
process columns are then available to be added to the report, and will return information on the
designated plan file process for the file group.

» Configuring a web report to use process columns

Process columns are not available for use in the Report Builder unless the report is associated with a file
group. This association is made in the Report Configuration properties.

Primary table prerequisite

Process reporting will only work if the primary table selected as the Data Context for the report is
compatible with the plan code table for the file group. In the majority of cases you should select the
plan code table itself. For example, if the plan code table is Dept, then you should select Dept as the
primary table for the report. However, if needed you can use a table with a lookup to the plan code
table instead.
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To associate a web report with a file group:
1. On the Build tab of the Report Builder, click the gear button at the top of the page to load the
Report Configuration properties.

oo @ ki

w @

Fa ) Refresh Data Preview m

2. Inthe Report Configuration properties, click the Edit link above the File group context box.

File group context Edit

3. Inthe Choose File Group Context dialog, select a file group or a file group alias, then click OK.

Use the radio buttons at the top of the list to toggle between viewing file group aliases or file
groups. When viewing file group aliases, the name of the file group that is currently assigned to
the alias displays in parentheses after the alias name.
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Choose File Group Context X

@ File group alias O File group

Name Y

Current Budget (Budget 2021)

Current Capital (Capital Requests)

Cancel

Selecting a file group alias means the report will be dynamically associated with the file group
that is currently assigned to the alias. For example, if the Current Budget alias is updated so that it
points to the Budget 2023 file group instead of the Budget 2022 file group, the report will update
to show the process information for the Budget 2023 file group.

NOTE: The selected file group must have a designated Plan File Process in the file group
properties.

Once a file group context has been selected, a new node appears in the Data Panel named Process
Management. The process columns are listed under this node, organized into Process Status Columns
and Process Step Columns. To use a process column in the report, drag and drop it to the setup boxes at
the top of the Report Canvas just like any other column.
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Data Context

CapitalRequest 7

» BB CapitalRequest

» [&E] Dimension Tables

L
m

Process Management
¥« Process Status Columns
M Process Status

M Current Step

M Process Initiator

4
ln

Process Step Columns
M Process Step

M step Status

M Time in Step

M Workbook Count

Process columns available in the Data Panel

» Using process columns

The following tables detail what each process column returns, as well as usage and configuration
guidance for each column. Additionally, note the following:

e When a process column is used in a report, the plan code values are automatically filtered to only
return codes that have any activity in the plan file process. It is not necessary to filter the report
by a ShowOnlList column in order to suppress plan code values that are not active in the file
group.

e Process columns can be used as row dimensions or as column definitions, however, only certain
process columns make sense to use as row dimensions. See the column details for more
information.
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Process status columns

The process status columns can be used to display current process status information for plan codes in
the file group. These columns are best used if you want to create a report that shows the current step
and status for each plan file.

When using the process status columns, the row dimension for the report should be just the key column
of the plan code table for the file group. For example, if the plan code table is Dept, the row dimension
should be the Dept key column of that table. This means that each row of the report will be a plan code
in the file group, showing the process status for that plan code. Note the following:

Column Name Description

Process Status Returns the current process status for each plan code. For example:
Active, Stalled, Completed, or Aborted.

Current Step Returns the name and/or number of the current step of the plan file.

e By default, the column is configured to show as Value (Description),
where Value is the step number and Description is the step name.

¢ You can use the Description display format option in the Column
Configuration panel to change the display format—for example, to
display as Description Only or as Value - Description.

e |f you want to display just the step number, disable the Show
description option in the Column Configuration panel.

Process Initiator Returns the name of the user who initiated the process for the plan file.
This column is only available if the associated file group is an on-demand
file group.

NOTE: Reports created prior to version 2022.1 may have a column named Current Step Number—
this column has been deprecated but it will continue to work in existing reports.

Process step columns
The process step columns can be used to return process information for each step that a plan file has
been active in. When using process step columns, you should set the row dimension as follows,
depending on the goal of the report:
e If the goal of the report is to see step detail by plan code, then the row dimension should be set
to both the key column of the plan code table and the Process Step column. This means that the
report will contain a separate row for each combination of plan code and step.

e [f the goal of the report is to see grouped information about the step, then the sum level for the
query should be set to just the Process Step column. This is useful to see information such as
average time in step, and the count of workbooks that have been active in the step.
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Column Name Description

Process Step Returns the name and/or number of the step. When using process step
columns, this column should be a row dimension for the report.

e By default, the column is configured to show as Value (Description),
where Value is the step number and Description is the step name.

* You can use the Description display format option in the Column
Configuration panel to change the display format—for example, to
display as Description Only or as Value - Description.

e |f you want to display just the step number, disable the Show
description option in the Column Configuration panel.

Sub-steps are returned using decimals, such as 2.1 and 2.2. Even though
this column is a string column, if the report is sorted by the Step Number
column the numbers will be sorted in the correct order.

Step Status Returns the status of the step per plan file. This column is only useful
when the row dimension is set to both the key column of the plan code
table and the Process Step column.

Time In Step Returns the time spent in each step per plan file. Although the raw value
for this column is seconds, the total seconds are translated into the
highest useful time value for display in the report—whether that is
seconds, minutes, hours, or days. Therefore, one plan file may list the time
in step as "25 minutes" while another plan file may list the time in step as
"2 days".

If the row dimension for the report is set to just the Process Step column,
then the Aggregation for the Time In Step column should be changed to
Average so that the column returns the average time spent in the step
(for all plan codes that were ever active in the step). Otherwise the
column will return the total time spent by all plan codes in the step, which
is likely not a useful value.

NOTE: If you use this column in a calculation, the calculation will be based
on the raw seconds value. Therefore if you want to return the time in step
using the same time unit for all plan codes, regardless of how long they
have been in the step, you can use a calculation to do so. For example,
divide the time in step by 86400 to convert the seconds to days.
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Column Name Description

Workbook Count Returns the count of workbooks that have been active in the step. This
column is only useful when the row dimension is set to just the Process
Step column, so that you can see the count for all plan codes that have
been active in the step. If the key column of the plan code table is
included as the row dimension, then the Workbook Count will always
return 1 for each plan code / step combination, which is likely not a useful
value.

This column always uses Count aggregation and cannot be changed.

NOTE: Reports created prior to version 2022.1 may have columns named Step Number and Step
Name—these columns have been deprecated but will continue to work in existing reports.

» Filtering based on process columns
When a report uses process columns, the report can be filtered based on these columns.

e End user filtering: If a process column is enabled for end user filtering (Enable filter is enabled for
the column), then users viewing the report can filter it on the fly. For example, a user may want
to filter the Process Status column to only see plan files that are currently stalled in the process.

Process Status Report

Dept ¢ Process Status Current Step Currg
21000 - Corporate Administration Active D Jr—
22000 - Infermation Technologies Active [ Active
) ) D Completed

23000 - Purchasing & Materials Mgmt Stalled

D Pending
24000 - Business Development Active

[] statiea
25000 - Finance Active

Clear

26000 - Portfolio Management Active g o e
27000 - Human Pesnlirres Artive Burnat Nevelnnment 1

Example end user filtering on process columns
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e Report filtering: Process columns can be used to define a general report filter or a table-specific
report filter, to limit the data shown in the report. For example, you may want to filter the report
to only show plan files in a certain step or with a certain status. The Process Management
columns are only available in the Filter Wizard dialog when the report is configured to enable use
of process columns.

Example filter using process columns

Process Management columns cannot be used as column filters on columns or calculations, or on
groups. The Process Management columns node is hidden when the Filter Wizard is opened in
these contexts.

NOTES:

° When filtering by process columns, you should base the filter on the same set of
columns that you are using in the report (Process Status Columns or Process Step
Columns). Although it is possible to cross-filter, the results may not be as expected
since these two sets of columns are looking at the process information from two
different angles.

° If you are filtering by Time in Step, input the number as seconds. The Filter Wizard will
then convert that number to the largest relevant time unit for display in the dialog.

» Example process reports

The following screenshots show some of the reports that can be created using process columns. These
examples only use process columns, but the reports could contain additional columns from the plan
code table or from related data tables, in cases where it makes sense to show this additional
information.

The first example shows a report using process status columns, for the purpose of viewing the current
status of each plan code. The row dimension is the key column of the plan code table (CapitallD).

Process Status

Capital Request ¢ Process Status Current Step Process Initiator

11 - New machinery Active 1 - Initial Request Wendy Hunter

13 - Equipment maintenance Active 2 - Manager Inputs Wendy Hunter

14 - Warehouse remode Active 1 - Initial Request Rufus Xavier Sasparilla
16 - Computer upgrades Active 4 - Executive Approval Wendy Hunter

Web report with process status columns
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The second example shows a report using process step columns, for the purpose of viewing process
history for each plan code. The row dimension is set to the step name and the key column of the plan
code table (Dept). The end user could filter the Dept column to view the history for a specific plan code.

Step History per Plan File

Dept ¢ Process Step $ Step Status Time in Step

21000 - Corporate Administration 1 - Budget Development Active 6 days
22000 - Information Technologies 1 - Budget Development Completed 32 minutes
22000 - Information Technologies 2 - Management Approval Skipped 0 seconds
22000 - Information Technologies 3 - Management Edits Active 6 days
23000 - Purchasing & Materials Mgmt 1 - Budget Development Completed 32 minutes
23000 - Purchasing & Materials Mgmt 2 - Management Approval Skipped 0 seconds

Web report with process step columns, grouped by key column and step

The third example shows a report using process step columns, for the purpose of viewing process
statistics. The row dimension is set to the step number only, so that the process data is aggregated at
the step level. The columns show the count of workbooks that have been active in each step, as well as
the average time in step per workbook.

Average Time in Step

Process Step = Time in Step Workbook Count
1 - Budget Development 6 days 50
2 - Management Approval 2 days 16
3 - Management Edits 6 days 12
4 - Finance Approval 8 days 3

Web report with process step columns, grouped by step
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Displaying date and date-time values in web reports

When using Date or DateTime columns in web reports, you can display the values in a variety of
different ways:

e You can choose to report on the full date or date-time value, or you can choose to report on just
a part of the value by selecting a date part. When you use a date part you are extracting a specific
portion of the date, such as Year, Month, Quarter, and so on.

¢ You can choose various formatting options for the date or date-time value. For example, you can
display the full date as 10/10/2022 or as October 10, 2022. Many of the date part options also
support various formats. For example, you can display the Month date part as 10 or Oct or
October.

» Using date formatting versus date parts

There is a significant difference between defining a display format for a date or date-time value, versus
using a date part. When you choose a date part, then for the purposes of this report you are effectively
changing the column data type and contents to match the selected date part. For example, if you specify
the date part as Month, the column is now treated as if it contains values from 1 to 12 representing
each month. All of the other information about the date or date-time value is ignored. This means that
you can use the column as a row dimension, and the values will be grouped by month instead of by the
underlying date or date-time value.

Date formatting, on the other hand, is primarily for display only. The display format does not
fundamentally change the way the values are treated. For example, you can choose to format a full date
value as simply October 2022, but in this case the column values in the report are still the full date. If
you use this column as a row dimension, you will likely see multiple instances of October 2022 as rows,
because the underlying column values are different dates in October 2022 such as 10/102022,
10/11/2022, and so on. You are really grouping the report by the full date values and not by the display
format. If instead you want to group the report by month and year (or "yearmo"), then you can select
the YearMo date part. Now the column values are effectively transformed to integer yearmo values for
purposes of the report, enabling the report data to be grouped by unique yearmo combinations.

Other benefits of using date parts include:

¢ Column values are sorted by the date part and its chosen display format. For example, if the date
part is Month, the column will be sorted as expected whether you choose to display the month as
1-12 or as January-December. Full date or date-time values are always sorted by the full date or
date-time regardless of display format.

e |If end-user filtering is enabled for the column, the filtering options match the configured date
part. For example, if the date part is Quarter, the user can filter by selecting from the list of Q1-
Q4 values.
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e Date parts can also be used when defining filters for the report data, such as general filters or
column filters. This makes it easier to construct filters based on a portion of the date or date-time
value. For more information, see Using date part filtering.

e Date parts support the concept of a fiscal year calendar. For example, you can choose to return
the calendar month or the fiscal month, if they are different for your organization.

» Configuring date parts and display formats for Date and DateTime columns

Use the Column Configuration properties to specify the date part and display format for any Date or
DateTime columns in your report.

To configure the date part and display format for a Date or DateTime column:

1. On the Build tab of the Report Builder, in the Report Canvas, click a column name in either the
Row Dimensions box or the Column Definitions box to select that column.

2. Complete the following Column Configuration properties in the Configuration Panel, on the
General tab:

Item Description

Date part to retrieve  Specifies the date or date-time part to retrieve for this column. For
example, you can return the full date value, or just the year or
month, or the fiscal year or month.

By default, this property is set to Full Date or Full DateTime, which
means the column will return the full date or date-time value. You
can then use the Date format property to specify how this value
should display in the report.

You can optionally chose a different date part in order to extract and
retrieve a specific aspect of the date or date-time value. When a date
part is selected, the column data is effectively transformed into the
date part values for purposes of this report. For more information on
the available date part options, see Date part and format options.

Date format Specifies the display format for the date or date-time values. The
available formatting options depend on the specified Date part to
retrieve. Some date parts, such as Year, do not have additional
formatting options, in which case this property does not display.

The label of this property varies depending on the selected date part.
For example, if you select Month as the date part, then the label for
this setting is Month format.

For more information on the available formats for each date part, see
Date part and format options.
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Item Description

Custom Date Specifies the custom format to use for the full date or date-time

Format value, if the Date format property is set to Custom. For more details
on the available options to define default custom formats, see
Custom formats.

NOTE: The labels for these properties vary depending on whether the column is a Date or
DateTime column. For example, if the column is DateTime, then the properties are labeled
DateTime part to retrieve, DateTime format, and Custom DateTime Format.

Data filter Edit

DateTime part to retriave

Fiscal month v
Month format

1-January W

Example date part and format properties in the Column Configuration panel

» Date part and format options

You can configure Date and DateTime columns to display in various ways using the date part and format
options:

e Date part: Specify the part of the date or date-time value that you want to display—such as the
full date or date-time, the year or fiscal year of the date, the month or fiscal month of the date, or
the hour or minute from the time.

e Format: Specify the format to display the selected date part. For example, if you select full date,
you can display it as 10/15/2022 or October 2022 or Thursday, October 15, 2022. If you select
Month, you can display it as 10 (the month number), Oct, or October.

The following tables detail the date part and format options. Where multiple formats are available, the
default format is shown in bold. If only one format is available for a particular date part, then the Date
format property does not display.
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Standard date and time options

Date Part Description Format
Full Date Use the full date stored in ¢ Default
the column. Only applies to e Custom
Date columns. * ShortMonth Year (Oct 2022)
This option is the default ¢ Month Year (October 2022)
date part for Date e Month/Date/Year as Date (10/15/2022)
columns. ¢ Day, Month Date, Year (Thursday, October
15,2022)

¢ YearMonth as Number (202210)
¢ YearMonthDay as Number (20221015)

Date data types have a configured default that
is set at the grid level. If a column is set to use
Default and the grid-level defaults are changed,
the column will update to use the new default
format. For more information, see Configuring
grid properties in a web report.

Full DateTime Use the full date-time Same as Full Date, plus the following additional
stored in the column. Only options:
applies to DateTime e Month/Date/Year Hour:Minute as DateTime
columns. (10/15/2022 13:25)
This option is the default ¢ Month/Date/Year Hour:Minute:Second
date part for DateTime DayPeriod as DateTime (10/15/2022 1:25:00
columns. PM)

¢ Day, Month Date, Year Hour:Minute:Second
DayPeriod (Thursday, October 15, 2022
1:25:00 PM)

¢ YearMonthDate Hour:Minute as Number
(20221015 13:25)

Date Time data types have a configured default
that is set at the grid level. If a column is set to
use Default and the grid-level defaults are
changed, the column will update to use the new
format. For more information, see Configuring
grid properties in a web report.

Date Only Use the date part of the Same formats that are available for Full Date.
date-time. Only applies to
DateTime columns.
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Date Part Description Format

YearMo Use the combined year and  Year and Month combined (202210)
month of the date.
Year Use the year part of the Full year (2022)
date.
Quarter Use the quarter for the ¢ Number of the Quarter (1-4)
date. e Number of the Quarter with Prefix (Q1)
¢ Text Description (1st quarter)
Month Use the month part of the ¢ Number of the Month (1-12)
date. e Number of the Month with 2-Digits (01)

¢ Short Name of the Month (Jan)
¢ Name of the Month (January)

Week Use the number of the Number of the Week (1-52)
week for the date, within
the year.
Day of Year Use the day of the year for Number of the Day (1-365)
the date.
Day of Month Use the day of the month Number of the Date (1-31)
for the date.
Day of Week Use the day of the week ¢ Number of the Day (1-7)
for the date. The first day o 2-Letter Abbreviation for the Day (Su)
of the week is Sunday. * Short Name of the Day (Sun)
¢ Name of the Day (Sunday)
Hour Use the hour of the date- ¢ 24-Hour Clock Number (0-23)
time. Only applies to  12-Hour Clock with Day Period (1 AM)
DateTime columns. e 24-Hour Clock as Hundreds (100)
Minute Use the minute of the Number of the minute (0-59)

date-time. Only applies to
DateTime columns.
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NOTES:

¢ If a column is configured to display the full date or date-time, but the selected format only
shows a part of it, the column sorting and filtering remains based on the full date or date-time
value.

 |f a DateTime column is configured to display the hour, the column filtering is always based on
0-23, regardless of the display format. For example, if the display format is a 12-hour clock
with day period, filtering by 13 displays values of 1 PM.

¢ |f a Date or DateTime column is configured to use a date part that is not the full date part—
such as Year, Quarter, or Month—the column becomes a Dimension date type for purposes of
inheriting the default alignment and column width.

Fiscal year options

The fiscal year for your system is determined by the system configuration setting
ClientFiscalYearEndMonth. By default, this is set to 12, which means the fiscal year is the same as the
calendar year. If your organization uses a different fiscal year end, your implementation consultant
should adjust this setting accordingly.

For example, if your organization's fiscal year ends in June, the ClientFiscalYearEndMonth setting should
be changed to 6. This means:

e Adate of 6/1/2022 is in fiscal year 2022 and represents month 12 of the 2022 fiscal year.
* Adate of 7/12022 is in fiscal year 2023 and represents month 1 of the 2023 fiscal year.

When the fiscal year is different than the calendar year, the fiscal year options will return different date
information than the corresponding standard date options. Continuing the example where the fiscal
year end is June, the following return values apply to a date of 7/1/2022:

e The Year part will return 2022, whereas the Fiscal Year part will return 2023.
e The Quarter part will return Q3, whereas the Fiscal Quarter part will return Q1.

e The Month part will return 7, whereas the Fiscal Month part will return 1.

Date Part Description Format

Fiscal YearMo Use the combined fiscal Year and Month combined (202310)
year and month that the
date belongs to.

Fiscal Year Use the fiscal year that the Full year (2023)
date belongs to.
Fiscal Quarter Use the fiscal quarter that ¢ Number of the Quarter (1-4)
the date belongs to. * Number of the Quarter with Prefix (Q1)

¢ Text Description (1st quarter)
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Date Part
Fiscal Month

Description

Format

Use the fiscal month that ¢ Number of the Month (1-12)

the date belongs to. e Number of the Month with 2-Digits (01)

¢ Number And Short Name of the Month (1 -
Jan)

¢ Number And Name of the Month (1-
January)

» Custom formats

When using the Full Date or Full DateTime parts, you can optionally specify a custom format to display
the date or date-time value. When you select Custom as the format, a Custom Date Format box

becomes available so that you can enter the custom format syntax. The following case-sensitive syntax
can be used in the custom format:

Desired

Date/Time Part

Syntax

Day Period

Returns the day period AM or PM.

Day of Month

For the day number (1), use one or two letters (d or dd). dd
enforces 2 digits.

Day of Week

Eore

For the abbreviated day name (Sun), use one upper-case
letter (E).

For the full name (Sunday), use four upper-case letters
(EEEE).

For the numerical day of the week (1), use one lower-case
letter (e). Sunday is the first day.

Hour

Horh

For the hour in the 12-hour clock (1-12), use one or two
lower-case letters (h or hh). hh enforces two digits.

For the hour in the 24 hour clock (0-23), use one or two
upper-case letters (H or HH). HH enforces two digits.

NOTE: Use k if you want to display the 24 hour clock as 1-24
instead of 0-23.

Minutes

For the minutes number (1), use one or two letters (m or mm).
mm enforces 2 digits.

Month

For the numerical month (1), use one or two letters (M or
MM). MM enforces 2 digits.

For the short name (Jan), use three letters (MMM).
For the wide name (January), use four letters (MMMM).
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Desired Syntax

Date/Time Part

Seconds S For the seconds number (1), use one or two letters (s or ss). ss
enforces 2 digits.

Quarter Q e For the numerical quarter (1), use one or two letters (Q or
QQ). QQ enforces 2 digits.

¢ For the abbreviation (Q1), use three letters (QQ).
e For the text description (1st quarter), use four letters

(QQQQ).
Year y e To render the full year (2022), use one letter (y).
¢ To render a two-digit year (20), use two letters (yy).

For example, to render a date as 2022 Oct 10, you would enter the following into the Custom Date
Format box: y MMM d.

Date part to retrieve

Full Date v

Date format

Custom v

Custom Date Format

y MMM d

Example custom date format

Displaying hyperlinks in web reports

Web reports can display hyperlinks within a column, so that each row can link to a designated page or
plan file relating to the current row of the report. You can define two different types of links:

e Custom: Link to any page in the Axiom Strategy Management system by entering a relative URL.
Variables can be used in the URL so that it is unique per row of the report.

e Plan File: Link to any set of plan files in the Axiom Strategy Management system. When using this
option, Axiom Strategy Management dynamically generates the URL to each plan file on a per
row basis, given a file group context. The row dimension of the report must be the key column of
the plan code table in order to generate the links.
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Process Status

By Department

Dept

21000

22000 -

23000 -

24000

25000 -
26000 -
27000 -
28000 -
29000 -

40000 -

Example report with a hyperlink column

To configure a column in a web report to show hyperlinks:
1.

- Corporate Administration

Information Technologies

Business Development

Finance

Portfolio Management

Human Resources

Facilities

Legal

Los Angeles - Store 3400

Purchasing & Materials Mgmt

Process Status

Active

Active

Active

Active

Active

Active

Active

Active

Active

Active

Current Step

X

@

Current Step Name

Management Approval

Management Approval

Management Edits

Management Edits

Management Approval

Management Edits

Management Approval

Management Edits

Management Approval

Management Edits

Total

$106,424

5446802

$129,671

§20,110

$169,733

$105.420

8113366

$851,278

$137,963

$17,490,615

§118,326,278

Meore Information

Open routing page for 23000

25 » itemsperpage 1-250f 59 tems

On the Build tab of the Report Builder, in the Report Canvas, click a column name in either the
Row Dimensions box or the Column Definitions box to select that column.

You must select the column name in the setup boxes and not the column name in the grid below.
Selecting a column name in the preview grid causes the Grid Configuration to display instead of

the Column Configuration.

NOTE: The ability to display hyperlinks within a column is not available if the report uses fixed
rows. Additionally, the following column types cannot be enabled to display hyperlinks:
dynamic columns and process columns.

In the Column Configuration panel, select the Advanced tab.

In the Link properties section, select Enable links.

Complete the Link properties as needed.

Administrator's Guide

Axiom Strategy Management | 254



Link Properties ~

@D enavietink

Link type
T w
URL nsert variable -
/process/ 16682/ planfile?planvalue={value}
Link text nsert variable -
Open routing page for {value}
Link tooltip nsert variable «

Click to view full routing details

Q Open link in new tab

Example hyperlink properties

Once a column is enabled to show links, the column will display the contents of the Link text property. If
the Link text property is left blank, the normal column contents display. Column contents are styled as
hyperlinks with blue underlined text when the report is viewed in Preview mode or in the report viewer.

NOTES:

¢ Hyperlinks do not show on the column within the Report Canvas grid. You must view the
report in Preview mode or the report viewer in order to see and interact with the hyperlinks.

¢ If you click a hyperlink while viewing the report in Preview mode, the link always opens in a
new tab, regardless of the link property configuration. This is done so that clicking the
hyperlink does not cause you to exit the Report Builder.

¢ Hyperlinks are not preserved when exporting a report. If you export to PDF, the column
displays the link text without an active hyperlink. If you export to Excel or a delimited file, the
link configuration is ignored, and the regular column value is exported (as if the column were
not enabled to show links).

» Link properties

The following properties are available in the Advanced tab of the Column Configuration panel when
Enable links is enabled.
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Item Description

Link Specifies the type of link to display in the column:

type e Custom: You specify the relative URL for the hyperlink, including using variables to
dynamically incorporate the current column value in the URL.

¢ Plan file: Axiom Strategy Management dynamically generates a hyperlink to the plan
file associated with each row. In order to use this option, the report must have a
specified File group context in the Report Configuration properties, and the row
dimension must be the key column of the plan code table for that file group. For
more information, see Setting up a report for plan file links.

NOTE: This option only displays if the report meets the requirements to support plan
file links. Otherwise, all links are custom links by default, and this option does not
display.
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Item Description

URL The URL to link on each row. The URL must be to a relative location within the Axiom
Strategy Management system. When the report is viewed, the full URL will be
generated by appending the relative URL to the current Axiom Strategy Management
system address.

To make the link dynamic, use the Insert Variable menu above the box to insert a
variable for use within the URL. For more information, see Using variables in the link
properties.

For example, imagine that the report contains the key column of a plan code table (such
as Dept or CapReq), and you want each plan code to link to the Process Routing page
for a particular plan file process. The full URL to the Process Routing page uses the
following syntax:

https://mycompany.axiom.cloud/process/
processdefinitionID/planfile?planvalue=plancode

The process definition ID will be constant for the URL, but the plan code value needs to
be the current row's department value. The {value} variable can be used for this
purpose. The following relative URL with a variable would be entered into the URL field:

/process/16682/planfile?planvalue={value}

NOTE: The relative URL can be entered with or without the beginning forward
slash.

When the report is viewed, the column will resolve to use the full URL with the current
column value. For example, the row showing Dept 22000 will have the following URL:

https://mycompany.axiom.cloud/process/16682/planfile?planval
ue=22000

When the user clicks on the hyperlink in this row, they will be taken to the Process
Routing page for Dept 22000, for the plan file process associated with process definition
ID 16682.

NOTE: The URL property only displays if the specified link type is custom, or if the Link
type option is not present because all links in the report are custom. When using the
plan file link type, the URL to the plan file is automatically generated by Axiom Strategy
Management.
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Item Description

Link text ~ Optional. Specifies the display text for the hyperlink column. Enter the desired text,
using variables as needed. For more information, see Using variables in the link
properties.

If you want the link text to be the regular column value—meaning the same value that

would display in the report if the column was not enabled as a link column—then you
can leave this field blank. The regular column value is automatically used as the link

text.
Link Optional. Specifies the tooltip to show when a user hovers the cursor over the
tooltip hyperlink. Enter the desired text, using variables as needed. For more information, see

Using variables in the link properties.

Open Specifies whether the hyperlink opens in the same tab (replacing the report) or in a new
link in tab. By default, the hyperlink opens in the same tab. Enable this option if you want the
new tab hyperlink to open in a new tab.

NOTE: If the link type is Plan file and the plan files are spreadsheets that will open in
the Axiom Strategy Management Desktop Client, then you should not enable this option
because it does not apply. The links will work either way, but if you enable the option to
open in a new tab, then Axiom Strategy Management will first open an empty browser
tab and then launch the Desktop Client.

» Using variables in the link properties

The following variables can be used in the URL, Link text, and Link tooltip properties, so that these
values can be unique per row of the report. To insert a variable, use the Insert Variable menu above
each field. Once the variable has been inserted into the field, you can enter any additional text as
needed.

Iltem Description

{value} Resolves as the raw column value for the current row. For
example, if the column is a numeric column, the value will not
have numeric formatting and will show all decimal places.

This variable is most appropriate for use in the URL property,
when the URL contains the column value. For example, the URL to
the Process Routing page contains the plan code value.

{formattedvalue} Resolves as the formatted column value for the current row,
honoring any default formats for the column type and applied
formatting in the Column Configuration properties.
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Item Description

{column: Resolves as the raw value in the specified table column, for the

TableName.ColumnName} current row. This can be used if you need to reference a value
from a different column than the current column in any of the
URL properties.

Edit the variable to replace the TableName.ColumnName text
with the desired table column name. For example:
{column:Dept.Description}

{column: Resolves as a formatted value in the specified table column, for
TableName.ColumnName the current row. This can be used if you need to reference a
:format}

numeric value from a different column than the current column in
any of the URL properties, and you need to apply formatting to
that numeric value.

Edit the variable as follows:

¢ Replace the TableName.ColumnName text with the desired
table column name.

e Replace the format text with syntax that indicates the desired
numeric format. See the following table for details on this
syntax.

For example: {column:BGT2022.m1:S$#, #}

NOTE: If you use a variable to display values from a different column as the Link text, the total row
will continue to display the total of the actual column values. It is recommended to omit the column
from the total row in this case.

Number format syntax

Number format syntax is case-sensitive. All examples assume the raw value is 1234.5678

Syntax Description Examples

0 (zero) The zero placeholder replaces the zero with the Oreturns 1234
corresponding digit if such is present.

. . . 00000 returns 01234
Otherwise, zero appears in the result string.

# (pound) The digit placeholder replaces the pound sign #returns 1234
with the corresponding digit if one is present.

. . . . H#i#HH returns 1234
Otherwise, no digit appears in the result string.

. (period) The decimal placeholder determines the 0.00 returns 1234.57
location of the decimal separator in the result
string.

#.4## returns 1234.57
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Syntax Description Examples

, (comma) The group separator placeholder inserts a 0,0 returns 1,234

localized group separator between each group. # # returns 1.234

% (percent) The percentage placeholder multiplies a #% returns 123456%
number by 100 and inserts a localized
percentage symbol in the result string.

S (dollar) The currency placeholder specifies that the S#,#.00 returns $1234.57
number will be formatted by using the currency
culture settings. The $ symbol is replaced with
the localized currency symbol. $ is interpreted
as a format specifier in the format string.

» Setting up a report for plan file links

You can enable a column to link to plan files in a file group, without needing to manually create the
necessary URLs to the plan files. The application will automatically generate the correct URL syntax to
each plan file.

In order to do this, the report must be set up as follows:

e A file group must be specified as the File group context for the report. The plan file hyperlinks
will open the plan files in the designated file group.

© Click the gear icon to view the Report Configuration panel.
© Click Edit over the File group context field.

° Select a file group or file group alias, then click OK. Selecting a file group alias means the
report will be dynamically associated with the file group that is currently assigned to the
alias. For example, if the Current Budget alias is updated so that it points to the Budget
2023 file group instead of the Budget 2022 file group, the report will update to link to plan
files in the Budget 2023 file group.

e The row dimension for the report must be the key column of the plan code table. For example, if
the plan code table of the file group is Dept, the row dimension for the report must be Dept.Dept.
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@

Report Configuration

Title

Budget Status

Secondary ftitle
Subtitle

By Department

Report description

File group context Edit

Current Budget (Budget 2021) X

Example Report Configuration panel with a designated file group context

Once the report is configured so that plan file links are possible, then the Plan file link type becomes
available as an option in the Link properties. Once this option is selected, the URL field becomes hidden
because Axiom Strategy Management will automatically generate the necessary URL to the plan files.

In the following example, the Dept column has been enabled to contain hyperlinks to plan files. The Link
text field has been left blank to use the column values in the Dept column, which have been configured
to show descriptions.
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Budget Status .+ Add Secondary Title Column Configuration
R e b A B SR — eneral advanced

By Department
Header Properties -

+ v 2w, Header text

[0 Dept == D Process Status -~ [0 Cumrent Step -~ [ Current Step Number Dept
D Multi-row header

("7 Autowrap header text
Dept Process Status Current Step Current Step Number Header alignment
21000 - Corporate Administration Active Management Approval 2 Default (Left) w
22000 - Information Technologies Active Management Approval 2 . )

Link Properties ~

23000 - Purchasing & Materials Mgmt Active Management Edits 3

@D Enavie tink
24000 - Business Development Aclive Management Edits 3 Link type
25000 - Finance Active Management Approval 2 Plan File e
26000 - Portfolio Management Active Management Edits 3 Link text Insert variable v
27000 - Human Resources Active Management Approval 2
28000 - Facilities Active Management Edits 3 Link tooltip Insert variable «

Click to open plan file

29000 - Legal Active Management Approval 2

D Open link in new tab
40000 - Los Angeles - Store 3400 Active Management Edits 3

1- 10 of 60 iterns

Example link properties to use plan file links

When the report is viewed, the column enabled for plan file links will contain hyperlinks to the plan files
in the designated file group. If the plan files are web-enabled, the hyperlinks open the plan files in the
browser. If the plan files are spreadsheet-based, the hyperlinks open the plan files in the Axiom Strategy
Management Desktop Client.
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Budget Status

By Department

Dept

25000 - Financ

Click to open plan file

1 2 R S

Example report with a column enabled for plan file links

NOTES:

Process Status

Active

Active

Current Step

Management

Management

Management

Management

Management

Management

Management

Management

Approval

Approval

Edits

Edits

Approval

Edits

Approval

Edits

Current Step Number

v itemsperpage  1-250f 60 tems

¢ |f the designated file group has a Show On List column, the row dimension is not
automatically filtered to only show plan codes where the Show On List column is true (1). You
should define a general filter for the report to exclude plan codes where the Show On List
column is false (0). The row dimension will only be filtered automatically if you have also
chosen to include process management columns in the report.

¢ |f a plan file has not been created for a plan code, the row will still contain a hyperlink but the
hyperlink will fail with a "plan file has not been created" error.

¢ You can select the Plan file link type for any column in the report that you want to link to the
plan files. The column with the hyperlinks does not have to be the key column of the plan

code table.

Using the Filter Wizard in the Report Builder

The Filter Wizard displays when you create or edit a filter in the Report Builder. The same dialog is used
for report filters, column filters, and column group filters. The dialog provides a user-friendly way to
build data filters using your current system's data structures.
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Edit filter X

Columns Filter Library

WorldRegion | <= |+ Europe
AND ~

. Description CONTAINS |= store
A EDln‘ensonTaoes
AND =
» BB ACCT
= Category | = |+ Revenue
v BB DEPT
OR ~

D Dept = FestAcet | = |»  Program Revenue
@ Description @
M Template

» @D worldRegion
@ country

» [ Region

@ curency
DEPT.WorldRegion <= "Europe’ AND DEPT.Description LIKE '%store% AND (ACCT.Category = 'Revenue’ OR ACCT.FcstAcct = 'Program

» MvP 5

@ Employees

Save as Global Filter Cancel m

Example Filter Wizard in the Report Builder

Using the Filter Wizard, you can:
¢ Browse and search table columns to create a new filter, or, use a global filter from the Filter
Library.
e Select the operator for the filter such as equals, not equals, greater than, less than, and so on.
e Select existing column values to filter by, or manually enter values.

e Easily combine and group multiple filter statements using AND and OR.

» Creating a filter

Each filter that you create in the Filter Wizard can consist of one or more filter statements. Multiple
filter statements are combined using OR or AND to create compound filters. Each filter statement
consists of a Table.Column name, an operator, and one or more values. For example, the following are
all filter statements:

Dept.Region='US West'
Acct.Acct IN (1250, 1300, 1400)
Encounter.AdmitDate BETWEEN 1/1/2020 and 12/31/2021

GL2022.M1 > O
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The following steps describe the general process of creating a new filter from scratch. For more
information on specific aspects of the Filter Wizard, see the other sections in this topic.

To create a filter in the Filter Wizard:

1. In the Filter Wizard dialog, on the Columns tab, use the table tree to find the column that you
want to use for the first column filter statement. Note the following:

e The table tree is automatically filtered to only show tables that are relevant to the current
context. For example, if you are creating a table-specific report-level filter, the table tree is
filtered to only show the selected table.

¢ You can use the search boxes over the table tree to search for a particular table or column
by name.

2. Select the column and drag it over to the right-hand area of the dialog. This area is known as the
filter canvas. Once you drop the column to the filter canvas, it creates a filter statement "box"
that is structured as follows:

ColumnName Operator Values

3. If the column is a Date or DateTime column, select the date part that you want to use for the
filter. For more information on this choice, see Using date part filtering.

By default, when you drag over a Date or DateTime column, the date part menu automatically
opens. If you press the Escape key or otherwise close the date part menu without making a
selection, the default is Full Date or Full DateTime. If you select a date part from the menu, the
operator menu automatically opens next.

4. From the operator menu, select the operator that you want to use for the filter statement. By
default, when you drag over the column, the operator menu automatically opens. The data type
of the column determines the default operator and the list of available operators. For more
information, see Using operators.

5. Select or input one or more values for the column filter statement. If you selected an operator
from the operator menu, the following occurs:

¢ [f the operator is equals or not equals, the Select Values dialog automatically opens so that
you can select one or more values. If you select multiple values, the operator will
automatically adjust to IN or NOT IN to accommodate the multiple values. For more
information on using this dialog, see Using the Select Values dialog.

e If the operator is anything else, an input box becomes focused so that you can input or
select one or more values. In most cases, this will be a single input box where you can type
the desired value. Note the following:
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° If the column is a String column and you are manually typing in text instead of
selecting values in the column, do not type quotation marks or wildcard characters.
The Filter Wizard will automatically add quotation marks or wildcard characters as
needed.

° |f the operator is BETWEEN or NOT BETWEEN, two input boxes become available so
that you can input or select both values.

° If the column is a Boolean column, the input becomes a drop-down menu for
selecting True or False.

° |f the column is a Date or Date time column, the input becomes a calendar control
to select a date or date/time from a calendar.

If instead you closed the operator menu without making an explicit selection, then the default
operator is used and the column filter statement is set to <no values>. You can manually click
on the <no values> text to specify one or more values using the same behavior described
previously.

6. Repeat the previous steps as needed to create more filter statements.

NOTE: You can use preexisting global filters instead of creating filter statements, or use global
filters in combination with filter statements. Select the Filter Library tab, locate the desired
filter, and drag and drop it to the filter canvas. For more information, see Using global filters
in the Report Builder.

7. If your filter consists of multiple filter statements and/or global filters, these are combined using
AND or OR. By default, all statements in the filter are combined using AND. You can group
multiple statements together and change the compound operator as needed. For more
information, see Creating compound filters.

8. Review the complete filter as shown at the bottom of the Filter Wizard.
9. Click OK to complete the filter and apply it to the current context.

When building a filter, or when editing an existing filter, you can:

e Change the operator: Click on the operator to open the operator menu and select a different
operator. In most cases your current value or values are preserved and will apply to the new
operator if applicable.

¢ Change the value(s): Click on the value to select or input a different value or values. You can also
hover your cursor to the right of the filter statement and click the pencil icon to edit the value.

¢ Add more statements: Drag additional columns or global filters to the canvas, then specify how
these statements are combined. You can group and reorder statements by selecting and dragging
them.
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e Remove statements: Hover your cursor over an existing filter statement or global filter, then click
the trash can icon to remove it from the filter. Note that if you want to clear a filter, this is not
achieved by deleting all the filter statements within the filter. Instead you should delete the filter
from the current context. For example, if the filter is a column filter, click the Clear option for the
filter in the Column Properties.

Edit filter Click to choose the Click to specify values *
operator for the

for the statement

statement
columns Filter Library S — —
= WorldRegion | <= |+ Europe Change how
AND = multiple statements
~ X
. = Description | CONTAINS |+ store are combined
v & Dimension Tables
AND -
» BB ACCT
= Category | = |+ Revenue
v B DEPT
= OR =
[0 Dept = FcstAcct | = |~ Program Revenue
@ Description
.
M Templap Edit or
delete a
Drag a column to statement
the canvas to filter —
by that column
[ Currency
DEPT WorldRegion <= "Europe’ AND DEPT Description LIKE '%store%' AND (ACCT Category = 'Revenue’ OR ACCT FcstAcct = 'Program
» Mve
Revenue')
@ Employees
e > Display of full

filter for review

Save as Global Filter Cancel ﬂ

e Add values manually: You can type values manually or paste from other sources, such as
spreadsheets. For pasted content, the filter wizard will recognize most filter delimiters (such as
spaces and semi-colons) and correctly create the SQL statement. However, if you are typing
values manually, use commas. When you enter simple string values, you do not have to place the
guotes around the string because they are added automatically. In this example, the string
contains several countries (France, Italy, US, UK) without quotes. In the case of Costa Rica, you
must add quotes because that country has two words.
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Create new filter X

Columns Filter Library
Dept | In |« (10011322,11083234)

Search tables Search columns AND w
v 1 Dimension Tables = Country | In |+ (Franceand 4 more)
» BB accT
v B3 DEPT
M Dept
@ Description

» @ worldRegion

M country
° + [0 Region
@ currency
» Mve
D Employees Typed quotes were only needed for
- Costa Rica. The other countries did not
@ Manager need us to type quotes. The results in the
SQL statement are correct for all
[ consolidated countries.
» [0 Email
» | (O TempBud DEPT.Dept IN (10011322, 11083234) AND DEPT.Country IN (France’, Ttaly, US, UK, ‘Costa Rica’)
@ FecstDept

@ BgtCombineDuringQuery

[ showonList

Save as Global Filter Cancel m

Filter wizard with manually entered strings

Notes about manual entries:

° If your string has leading or trailing spaces, use quotes that include those spaces (for
example, 'a').

° If you search for a value in a large table (such as the EDS Encounters table), you can type
the first few characters or numbers in the search field to retrieve those results more
quickly.

° You cannot directly edit the SQL statement for your filter. If you need to make changes or
additions, use the filter options to select or manually enter the values needed.

» Using operators

When you initially drag and drop a column to the filter canvas, it is assigned a default operator based on
the column data type. For example, Integer and String columns default to equals, while Date, DateTime,
and Numeric columns default to greater than. You can accept the default or choose any valid operator
from the operator menu. At any time, you can click the operator to open the operator menu.

The available operators depend on the column data type. Most columns can use the following
operators:

e Equals (=) and not equals (<>)
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IN and NOT IN
e Greater than (>) and greater than or equals to (>=)

e Less than (<) and less than or equals to (<=)

BETWEEN and NOT BETWEEN (both inclusive of the specified values)
In addition, Numeric columns has this operator:
e |SNULL AND IS NOT NULL
Additionally, String columns have the following options—all of which generate LIKE or NOT LIKE filter

statements with the appropriate wildcard syntax:
e STARTS WITH and DOES NOT START WITH

e ENDS WITH and DOES NOT END WITH
e CONTAINS and DOES NOT CONTAIN
e ISEMPTY and IS NOT EMPTY

For example, if you select CONTAINS and then specify a value of store, the filter will be created such as
Description LIKE '$store%'.You can see the created filter at the bottom of the Filter Wizard
dialog.

NOTES:

e CONTAINS and ENDS WITH (and the DOES NOT versions) are not available for tables that use
the Large Data index scheme, for performance reasons.

e The operator menu displays equals/not equals or IN/ NOT IN depending on whether multiple
values are currently selected. The operator will be automatically adjusted for single or
multiple values depending on your selections. It is not necessary to manually select the
appropriate operator.

» Using the Select Values dialog

When creating an equals or not equals filter statement, the Select Values dialog is available to select
one or more values in the column. This dialog opens automatically when you initially select the equals or
not equals operator. You can manually open the dialog by clicking the currently selected values (or the
<no values> placeholder text), or by hovering your cursor to the right of the filter statement and
clicking the pencil icon.
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The available values in the column display in the left-hand side of the Select Values dialog, and the
currently selected values for the filter statement display in the right-hand side of the dialog. You can:

e Search for a particular value using the search box over the Available Values list. Only the first 100
column values show in the dialog for performance reasons, but you can find any value in the
column using the search box.

° You can use the filter icon to the right of the search box to change how the search matches
values. The default matching behavior depends on the column type. String columns and
validated columns with descriptions default to "contains" matching, while numeric
columns default to "equals" matching.

° To clear the search text, use the Clear icon to the right of the filter icon. This icon only
displays when search text is present. You can also manually select and delete the search
text.

e Select values by moving them from the Available Values list to the Selected Values list. You can
double-click values to move them between lists, or you can use the arrow keys in the middle to
move values. You can select multiple values in either list using the SHIFT or ALT keys, and then
move those values using the arrow keys.

When you click OK, all values in the Selected Values list are included in the filter statement. The
operator automatically adjusts as needed for single or multiple values—for example, if you selected the
equals operator but then chose multiple values, the operator automatically changes to IN (and vice
versa).

Select values for Dept b3

Available Values + Selected Values +

store Yy ¥ 40000 (Los Angeles - Store 3400)

41000 (New York - Store 30)
42000 (Boston - Store 82)

43000 (Dallas - Store 78)
45000 (Phoenix - Store 33) i
45500 (San Francisco - Store 87)

46000 (Chicago - Store 45)

ATOAAA FMnetlom A Cdeen oA

59 values available 2 values selected

Cancel m

Example Select Values dialog for the Filter Wizard
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NOTES:
¢ |f you want to use an equals operator but the value does not currently exist in the column,
then you must first switch the operator to greater than or less than, manually type the value,
then switch back to equals. It is not currently possible to manually type multiple values for
use with the IN operator.

¢ |f the column is a validated column with descriptions, the descriptions display next to the
column values in parentheses. You can search for values using the actual column values or the
descriptions. However, when you select values, keep in mind that you are selecting the actual
column values and not the descriptions. If you want to create a filter that is based on the
description values, you must base this filter on the actual Description column.

e The Select Values dialog is not available for calculated fields from the database. When the
equals operator is used with a calculated field, you can type the desired value for the filter.
Currently, it is not possible to create an IN filter for multiple values in a calculated field. If
necessary, you can create multiple filter statements and combine them with OR as a
workaround.

» Creating compound filters

You can drag any number of columns over to the filter canvas and create filter statements for each one.
When multiple filter statements are present, they are combined using either AND or OR to create a
compound filter.

¢ AND means that records must match both filter statements to be included or excluded by the
filter.

¢ OR means that records must match one of the filter statements to be included or excluded by the
filter.

By default, filter statements are combined using AND. You can change this to OR as needed by using the
drop-down menu on the AND/OR operator to the left of the filter statements.

If the operator change could create an ambiguity in how the statements are combined, you will be
prompted to choose whether to group or split the statements when changing the operator. For
example, if you choose to group the statements, the two statements associated with the operator will
become grouped. If you choose to split the statements, one statement will be separated while the other
statement is grouped with the statement next to it. Grouped statements are the equivalent of using
parentheses in SQL.

Multiple filter statements can be grouped, combined, and reordered by dragging and dropping the
statements, and by changing the AND/OR operator.

NOTE: The Filter Wizard will automatically place parentheses as needed in filters that use multiple
filter statements. There is no way to manually add or remove parentheses.
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» Using date part filtering

When the column used in the filter is a Date or DateTime column, you can filter based on the full date or
date-time as saved in the column, or you can filter based on a date part such as the year or quarter. For
example, you can create a filter statement such as StartDate > 2019, when the StartDate column
contains full date or date-time values. Using date parts makes it easier to construct filters that restrict
data based on a particular aspect of the date or date-time value.

By default, the filter is based on the full date or date-time.

You can click the name of the column to open the date part menu and select a specific date part
for filter. The same date part options that are available in the Column Configuration properties
for Date and DateTime columns are available for use in filter statements.

If you select a date part other than the Full Date or Full DateTime, the selected date part displays
in parentheses next to the column name. For example: StartDate(Year) when Year is the selected
date part.

If you select a date part with a finite set of available values—such as Quarter or Month—then the
Select Values dialog displays those values.

If you select a date part with an open-ended set of available values—such as Year or YearMo—
then the Select Values dialog converts the actual dates or date-times in the column into the
selected date part and displays those values. This means that if you want to create an equals or
not equals filter which uses a value that is not currently present in the column, you must first
change the operator to greater than, type the desired value using the correct format for the date
part, and then change the operator back to equals or not equals.

When using the following date parts, only the equals/not equals and IN/NOT IN operators are
available: Quarter, Fiscal Quarter, Month, and Day of Week. For example, it is not possible to
create a filter such as StartDate(Quarter)>Q2. Instead you would select the specific values of Q3
and Q4, which would create the filter StartDate(Quarter) IN (Q3,Q4). For all other date parts, the
normal set of operators can be used.
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Edit filter

Columns Filter Library
= AdmitDate (Quarter)~ | = |+ 02
Full DateTime
» EH EncounterEDS
Date Only

» [&E] Dimension Tables

Fiscal YearMo
YearMo
Fiscal year
Year
Fiscal quarter
Quarter
Encount  Figcal month =2

Month

Example date part menu for Date and DateTime columns

» Limitations and known issues
The following limitations and known issues currently apply to the Filter Wizard:

e |f a String column has a blank entry (empty string), this displays in the Select Values dialog as a
blank entry. This blank entry cannot be selected, and it is not currently possible to create a filter
statement that includes or excludes empty strings. However, if a report with an empty string filter
statement was created in a previous version, this filter statement will be preserved and will
continue to work.
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e If a column contains null values, this displays in the Select Values dialog as <no wvalue>. This no-
value entry cannot be selected, and it is not currently possible to create a filter statement that
includes or excludes null values. However, if a report with a null value filter statement was
created in a previous version (using operators IS NULL or IS NOT NULL), this filter statement will
be preserved and will continue to work.

» If you want to create a filter statement using equals/not equals or IN/ NOT IN, it is not currently
possible to manually type the desired value or values. You must use the Select Values dialog. For
single values, a workaround is available as follows: you can change the operator to greater than,
type the desired value, then change the operator back to equals or not equals. There is no
equivalent workaround for multiple values.

e Filter statements that directly compare two columns, such as Columnl > Column2, are not
currently supported in the Filter Wizard. However, if a report with a column comparison
statement was created in a previous version, this filter statement will be preserved and will
continue to work.

When viewing reports that were created in previous versions, you may find other filter statements that
use syntax which is not currently supported in the Filter Wizard. Generally speaking, if the report does
not error and the filter statement is not flagged as invalid, these filter statements will continue to work
as they did in previous versions, although you may not be able to edit the filter statement or newly
create it in exactly the same way.

Using global filters in the Report Builder

A global filter is a report filter that is stored in the Filter Library. These filters can be referenced in
various reports as needed. Storing the filters separate from the reports has the following advantages:

e Afilter that is commonly used can be defined once and then used in all reports that need it.

e |If the filter needs to be modified, you can edit the global filter once, instead of needing to modify
all of the reports that use the filter.

When you are defining filters for a web report, you can use an existing global filter, or you can build a
filter in the report and then save it as a global filter so that it is available for others to use. If a web
report references a global filter, and that filter is modified, the report automatically uses the current
version of the global filter.

Global filters can also be used as starting points to create a local report-level filter. For example, there
may be an existing global filter that is almost exactly what you need to filter the current report. In this
case you can do either of the following:

e Add the global filter to the report, then convert the filter to a local filter. This conversion breaks
the reference with the global filter and copies the filter statement into the current report. You
can then edit the filter as needed for use in the current report.

OR
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e Add the global filter to the report, then combine that filter with additional filter statements in the
report to arrive at the overall desired filter. In this case the global part of the filter will continue
to be linked to the Filter Library and will update as needed, while the rest of the filter provides
the additional context needed in the report. This approach only works if you need to extend the
global filter, not fundamentally change the global filter to use a different operator or values.

All of these global filter actions can be done in the Filter Wizard dialog in web reports. The Filter Wizard
is available when defining report-level filters on the Filters tab, or when defining filters for individual
columns or column groups on the Build tab.

Global filter features in the Filter Wizard

» Using a global filter in a web report
When you are creating or editing a filter in a web report using the Filter Wizard, you can add a global
filter to the filter statement. You can add any of the following filter types that are stored in the Filter
Library:

e Report filters: Filters created in web reports using the new Filter Wizard.

e Legacy standard filters: Filters created using the legacy Filter Wizard (in any location of the
application). Basically, a "standard filter" means any regular Axiom Strategy Management filter
that is not a limit filter and not a visualization filter.

Limit filters and visualization filters cannot be used as global filters in web reports. Visualization filters
do not display in the Filter Wizard. Limit filter statements display in the Filter Wizard, however, if you
attempt to use one as a global filter, an error will occur regarding the unsupported filter format.

You can use a global filter on its own, or in combination with locally defined filter statements and other
global filters. In order to use a global filter, you must have read-only access to at least one filter in the
Filter Library, as determined by your security permissions.

To add a global filter to a filter statement:
1. Inthe Filter Wizard, in the left-hand pane, select the Filter Library tab.

2. Locate the global filter that you want to use in the Filter Library. You can use the search box
above the folder tree to search for a specific filter by name.

This area shows all folders and filters that you have permission to access in the Filter Library. If
you do not have access to the Filter Library, then the tab is still present in the dialog but it will be
empty.

3. Drag the desired filter over to the right-hand pane (the filter canvas).
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Before the global filter is added to the filter canvas, it is validated to make sure the contents of
the global filter are valid in the current context.

e If the filter is valid, then the filter is added to the filter canvas. The filter box displays the
filter name with a globe icon. You can see the actual underlying filter statement in the
tooltip, or by viewing the filter shown at the bottom of the dialog.

= @ Store Revenue

((ACCT.Category = 'Revenue' AND DEPT.Description LIKE “#%5tore®5)

NOTE: When displaying the filter statement for a global filter in the Filter Wizard, the
statement is always wrapped in parentheses, even if it is the only statement used in
the filter. If the global filter itself is a compound filter statement that is wrapped in
parentheses, you may see double parentheses displayed in the Filter Wizard. These
"extra" parentheses do not cause an issue and only serve to identify the global filter
statement within the overall filter.

e |If the filter is not valid, an error message will display and the global filter will not be added
to the canvas. Generally speaking, the global filter must use columns from the same tables
that display on the Columns tab of the Filter Wizard.

Invalid Filter X

Filter ‘Certification’ references table ‘Certification’ which is invalid in the current context

Once the global filter is added to the filter canvas, it becomes a filter statement that can be combined
and rearranged just like the locally defined filter statements. The only difference is that you cannot
modify the contents of the global filter, unless you want to break the association with the global filter in
the Filter Library and convert it to a local filter (see the next section).

Although security permissions to the Filter Library are required in order to add a global filter to a report,
once the filter is present in the report it is treated like part of the report and governed by the report's
permissions. It is not necessary to grant filter permissions to users who only need to view or edit the
report.
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» Converting a global filter to a local report filter

Once a global filter has been added to the Filter Wizard, you can optionally convert the filter to a "local"
filter. This will break the association with the global filter and copy the filter statement into the report.
You can then edit the filter statement as needed.

To convert a global filter to a local filter:
1. Inthe Filter Wizard, locate the global filter that you want to convert.

2. Hover your cursor to the right of the global filter, then click the Convert icon.

g Convert filter reference to local filker

3. At the confirmation prompt, click Yes to convert the filter.

= @ Store Revenue

The filter statement for the global filter is copied into the report, and now displays like a regular filter
statement created in the Filter Wizard. The filter statement is no longer associated with the global filter,
and will not update if the global filter is changed. You can now edit the filter statement as needed for
use in the report.

» Saving a global filter to the Filter Library

After creating a filter in the Filter Wizard, you can optionally save that filter to the Filter Library. Saving
the filter to the Filter Library allows the filter to be used by other web reports, so that all of the reports
reference the same global filter.

Currently, filters created in the Report Builder's Filter Wizard and saved to the Filter Library can only be
used in web reports. Future releases may expand the use of this Filter Wizard, so that its filters can be
used in other places.

Any filter that can be created in the Filter Wizard can be saved as a global filter. The filter can contain
multiple filter statements, and can even contain references to other global filters. The context where the
filter was created does not matter for purposes of saving it as a global filter. For example, you can create
a filter for use as a General report-level filter, save the filter as a global filter, then later use the global
filter as a column filter in a different report. As long as the filter statement is valid in both contexts, it
does not matter where the global filter was initially created.

In order to save a global filter to the Filter Library, you must have read/write access to at least one
folder in the Filter Library. If you do not have this permission, then the Save as Global Filter option is
not present in the Filter Wizard.

To save a global filter:
1. In the Filter Wizard, create the filter that you want to save to the Filter Library.
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2. Click Save As Global Filter in the bottom left of the dialog.

3. Inthe Save As Global Filter dialog, complete the following fields and then click Save:

Iltem Description

File name The name of the filter. This is the name that users will see when
finding filters in the Filter Library, and when editing web reports that
use the global filter.

Keep in mind that when users add the global filter to a report, they
cannot see the actual filter statement—they can only see the filter
name. Because of this, it is recommended to include the table name
used by the filter statement in the filter name, so that users can
understand whether the filter will be valid in the current context.

Description Optional. A description of the filter. Currently, filter descriptions do
not display in Filter Wizard, but they can be viewed in the Axiom
Strategy Management Desktop Client using Axiom Explorer.

Save to folder The folder in the Filter Library where you want to save the filter.
¢ Click the folder icon [= to the right of the field.

¢ Inthe Choose output folder dialog, select a folder in the Filter
Library. You can only select folders where you have read/write
access to the folder. If a folder name displays with a lock icon, this
means you have read-only access to that folder and therefore
cannot save a new report there.

¢ Click OK to choose the folder and return to the save dialog.

The path to your selected folder now displays in the field.

If you use a name that already exists in the target folder, you will be prompted to choose whether
or not to overwrite the existing filter. If you choose not to overwrite, the save operation is
canceled and you are returned to the Filter Wizard.

4. After the filter is saved to the Filter Library, you are prompted to copy the global filter into the
report to replace the current filter. Click Yes if you want to reference the newly created global
filter in the current report. If you do not want to reference the global filter in this report, click No.

The global filter is saved to the Filter Library and is now available for use in other web reports.
Additionally, if you chose Yes at the prompt after saving, the current filter in the Filter Wizard is replaced
with a reference to this newly created global filter.

» Editing an existing global filter

If a global filter is edited, all web reports that reference this global filter will now use the updated filter
statement. For example, a healthcare organization may have a filter that limits the report to codes
associated with COVID-19. If later a new code is added, you can edit the filter to include the new code,
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and this new code will now be applied to all reports that reference the global filter.

Currently, there is no user interface to edit a global filter directly. Instead, global filters can be edited as
follows:

e QOpen the Filter Wizard and add the global filter to the filter canvas.
e Convert the global filter to a local filter.
e Edit the local filter as needed.

e Save the local filter as a global filter, using the same name as the existing global filter.

This process will overwrite the existing global filter with the newly saved version of the filter. All reports
that reference the global filter will now use the updated version of the filter statement.

NOTE: If a web report is being viewed or edited when the global filter is changed, the report will not
reflect the changed filter until the report is closed and reopened (or until it is reloaded by refreshing
the browser).

» Deleting a global filter

If a global filter is no longer needed within a particular report, you can delete it from the filter. Hover
your cursor to the right of the global filter and then click the Delete icon. This action simply removes the
reference to the global filter from the current filter. It has no impact on the global filter in the Filter
Library.

If a global filter is no longer needed at all, you can delete it from the Filter Library. Currently, this can
only be done from the Desktop Client. In order to delete a global filter, you must have permission to use
the Windows Client or the Excel Client, and read/write permission to the folder that the global filter
resides in.

To delete a global filter from the Filter Library:

1. From the Area menu ;-: I, click Windows Client or Excel Client to launch the Desktop Client.

2. Onthe Axiom tab, in the Administration group, click Manage > Axiom Explorer.
NOTE: In systems with installed products, this feature may be accessible from the Admin tab.

Click System Browser to open Axiom Explorer.

TIP: You can also use the Explorer task pane to delete a global filter.

3. Navigate to the Filter Library, and then locate the filter that you want to delete.

4. Right-click the filter and then select Delete.

If any web reports reference the deleted filter, these reports will display an error about the missing
global filter. You must edit the reports to remove the reference in order to refresh the reports again.
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Managing Fixed Row Structures

Fixed row structures can be used to define data sections for a web report, including section headers,
data rows, subtotals, and totals. Fixed row structures are defined separately so that you can reuse them
with different web reports, and so that you can update the row structure in one place and have the
changes propagate to all reports that reference the structure.

Fixed row structures can be used with "custom" web reports created in the Report Builder, and with
web report templates provided by installed Axiom Strategy Management products. The fixed row
structure defines the data sections in the report, while the web report defines other report properties
such as the data columns, filters, and drilling options.

Balance Sheet Trend Validation Report
EOM Balances Consolidated

= e e e T S e

Balance Sheet Section headers
Cash & Due From Banks - 1287,642 13,674,884 17,682,301 16,638,829 17,288,809 21,812,477 16,860,101 1

Investment Securities

Short-Term Investments 32,652,374 35,456,410 38,652,968 19,951,862 14,683,400 24,062,652 47,028,544 4
Securities 174,154,704 176,278,507 192,696,470 189,637,415 191,114,031 193,452,280 195,857,851 18
Total Investment Securities 206,807,078 211,734,918 231,349,438 209,589,277 205,797,431 217,514,932 242,886,395 22

Subtotal and Gross Loans
total rows
Commercial & Industrial . . 00 298,031,372 309,747,920 310,310,313 321,055,239 322,858,899 32
Multiple sections
SBA Of data rows 33 37,012,714 34,275,310 33,473,263 35,274,655 34,582,617 3
Direct Financing Leases, Net T 2860 32,724,149 31,807,951 31,224,850 30,364,972 30,047,827 2

Censtruction 159,889,124 161,869,392 168,633,930 174,411,587 179,643,970 185,180,992 186,652,279 18
Land Development 45,896,984 46,463,558 45,353,409 44,767,641 46,373,614 47,242,952 49,057,555 4
Other Real Estate Loans 50,549,879 50,904,924 49,659,194 47,957,289 46,352,283 46,814,478 46,753,701 4
Multifamily 171,648,223 184,298,060 184,489,660 199,277,875 201,266,516 195,362,715 193,902,221 19

Example report using a fixed row structure

You can define as many different fixed row structures as you need. A row structure can be used with any
web report where the structure's row dimensions are compatible with the report's columns, filters,
drilling options, and any other report property that impacts queried data. Row structures can be
created, edited, and deleted using the Intelligence Center.
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To access the Intelligence Center:

® Click the Syntellis icon E;I in the Navigation bar. From the Area menu, select Intelligence Center.

noo @

PRODUCT AREAS
Home
Intelligence Center

System Administration

Fixed row structures are not file-based—they are stored directly in the database. There is no file type or
library folder for fixed row structures, and you cannot see them in Axiom Explorer. The only place to
view and manage fixed row structures is using the Intelligence Center.

» Creating fixed row structures

You can create new fixed row structures as needed for use in web reports.

In order to create a fixed row structure, you must be an administrator or have the Create Web Reports
security permission. If you do not have permission to create web reports, then the option to create a
new fixed row structure will not be available in the Intelligence Center.

To create a new fixed row structure:

1. In the Intelligence Center, select the Row Structures area from the left-hand panel, then click

Create.

AXIOM| Intelligence Center

Reports Row Structures

Intelligence Center

[ Fixed Row Structures

Fixed Row Structures

Fixed Row Structures

Name

= RevExp

Administrator's Guide

a

Y Modified by Y Type g

2/2/202210:23 AM Jane Doe Fixed Row Structure
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The row structure editor opens in the current browser tab, showing a new blank row structure.
The row structure starts with just a top-level section header and a grand total row.

AXIOM| Intelligence Center o a @ i
w @
Row Editor () snow Higden tems

Root Section + 15 Row Structure

| Grand Total ROW STRUGTURE PROPERTIES

Row Structure Name (required) New Fixed Row Structure

Dimension Table (required) v

(1) use Dimension Mapping

= Section Properties

SECTION HEADER PROPERTIES
@D snow section Header

Header Text Roct Section

Header Category Default v

Example new blank row structure

2. Inthe top of the right-hand panel, complete the following required properties for the row

structure:

Item Description

Row Structure Enter the name of the row structure. The name identifies the row

Name structure so that users can select it when creating a new fixed report.

Dimension Table Specify the dimension table to use for the Filter Wizard when
defining row data. For example, if rows will be defined using
accounts or account groupings, select the ACCT table.

Use Dimension Enable this toggle switch if you want to map specific items in the

Mapping dimension table to specific rows in the structure. When using

dimension mapping, all row data is defined at the key column level of
the dimension table, and each dimension item can only be assigned
to a single row. The toggle switch shows as green when enabled and
as gray when disabled.

If this option is not enabled, then row data is determined by defining
filter criteria statements at the row and section level. For more
information, see Using dimension mapping versus row filters in a
fixed row structure.
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Row Structure

ROW STRUCTURE PROPERTIES
Row Structure Name (required) MyStructure

Dimension Table (required) ACCT v

@) Use Dimension Mapping

Example required properties with dimension mapping enabled

Once these items are completed, you can use the Save button to save the row structure.

3. Inthe left-hand row editor, add sections and data rows as desired to create the overall row
structure. Think of the Root Section as the overall "wrapper" in which all row sections are placed.
To create the first row section, click the plus icon on the Root Section header and then select Add

New Section.
Row Editor
Grand Total

= Add Data Row

= Add New Section

Your row structure will now look like this:

Row Editor

Root Section

Section

New Data Row 1

New Data Row 2

New Data Row 3
Section Total

Grand Total

You can then continue to add data rows or additional sections:
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e To add a section, select the section header where you want to add the section, then click

the plus icon > Add New Section. The new section is added as a subsection to the current
section. By default, all new sections contain a section header row, three data rows, and a
total row. You can add or remove data rows as needed.

¢ To add a data row within a section, select the section header where you want to add the

data row, then click the plus icon > Add Data Row. The new data row is added to the
current section.

When you add a new data row or section, it is always added at the bottom of the current section.
You can drag and drop the row or section to a different location within the section as needed (but
not to a different section).

If a data row or a section is not needed, select the row or section header and then click the trash
can icon. The row or section is deleted from the row structure.

NOTE: Header rows and total rows cannot be deleted from a section. The trash can icon on a
section header row is used to delete the entire section, not the header row. If you do not
want a particular section to display a header row or a total row, you can hide these rows on a
per section basis using the Section Properties.

4. For each section in the report—including the Root Section—configure the properties for that
section. To configure a section, select the section header and then complete the Section
Properties in the right-hand panel. The section properties control the following:

Visibility, text, and style of the section header row

Visibility, text, placement, and style of the section total row

Whether data rows are indented from the parent section

Whether section data is added or subtracted when calculating the parent total

An optional data filter to apply to all data rows in the section (only available if the structure
does not use dimension mapping)

For more information on all of the section properties, see Section properties.
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Row Editor Dimension Mapping Show Hidden Items

MyReport Row Structure

Revenue

ROW STRUCTURE PROPERTIES

Revenue Line 1 Row Structure Name (required) MyStructure

Revenue Line 2 Dimension Table (required) ACCT v

Revenue Line 3 @) use Dimension Mapping

Revenue Total

= Section Properties

Expenses
P SECTION HEADER PROPERTIES
Expenses Line 1 @) show Section Header
Expenses Line 2 Header Text Revenue
Expenses Line 3 Header Category Default L/
Expenses Total
SECTION TOTAL PROPERTIES.
Grand Total
@) show Section Total Row
Total Row Placement Below %
Total Row Text Revenue Total
Total Row Category SubTotal3 v

SECTION PROPERTIES

@) indent Child Rows

In most cases, the row structure immediately updates to reflect section properties that affect the
display. For example, if you define header text, that text is immediately shown on the row
structure. However, if you hide the section header row, the row will continue to display in the
row structure unless you disable the option Show Hidden Items. This option is located at the top
right of the row editor, under the Save button. By default, the row editor continues to show
hidden section headers so that you can use the Add Data Row and Add New Section actions on
the header row.

For each data row in the report, configure the properties for that row. To configure a row, select
the row and then complete the Row Properties in the right-hand panel.

At minimum, the row properties define the label text for the row. If the structure does not use
dimension mapping, then the row properties also define a data filter to determine the data to be
shown on the row. For more information on defining the row properties, see Row properties.

Row Editor Dimension Mapping Show Hidden tems
My Report = Row Structure
Revenue ROW STRUCTURE PROPERTIES
Revenue Line 1 . Row Structure Name (required) MyStructure
Revenue Line 2 Dimension Table (required) ACCT v
Revenue Line 3 @) use Dimension Mapping

Revenue Total

— Data Row Properties
Expenses

Expenses Line 1 Row Text Revenue Line 1

Expenses Line 2
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6. If Use Dimension Mapping is enabled for the row structure, click the Dimension Mapping tab to
map dimension elements to each row. This mapping determines the data to be shown on each
row, instead of defining a filter. For more information on mapping dimension elements, see Using
the Dimension Mapping editor.

7. Click Save to save the row structure.

The new row structure can now be used when creating or editing web reports.

» Copying fixed row structures
You can copy existing fixed row structures as needed to create additional fixed row structures.
In order to copy a fixed row structure, you must be an administrator or have the Create Web Reports

security permission. If you do not have permission to create web reports, then the Copy action is
disabled.

To copy a fixed row structure:
1. Inthe Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to copy, then hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Copy from the menu.

Name Y.

= RevExp E]

= RevExp1 @ Info
([ Copy
7 Edit
ft Delete

3. Inthe Copy Fixed Row Structure dialog, enter a Name for the new fixed row structure, then click
OK. By default, the name is Copy of OriginalName.

The fixed row structure is copied with the specified name. You can now open this fixed row structure for
editing.

» Editing fixed row structures

Any user can edit a fixed row structure. The Create Web Reports permission is not required.

Keep in mind that when a row structure is assigned to a report, that report always uses the most current
version of the row structure. Any edits that you make to a row structure are immediately available in
any reports that use the row structure.
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To edit a fixed row structure:
1. Inthe Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to edit, then click on the row structure name to

open it.

TIP: You can also select Edit from the actions menu (using the three dots icon) to edit the
fixed row structure.

The row structure opens in the row structure editor, in the current browser tab.
3. Using the row structure editor, make changes to the row structure as needed.

4. Click Save to save your changes.

» Changing fixed row structure names and descriptions
You can rename a fixed row structure or change its description. If existing reports use the fixed row

structure, those reports will continue to reference the renamed structure.

To change a fixed row structure name and/or description:
1. Inthe Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to edit, then hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Info from the menu.

Name Y’

= RevExp B

= RevExp1 @ (b
O Copy
# Edit
ft Delete

The Information panel opens along the right-hand side of the page.
3. Inthe Information panel, edit the fixed row structure Name or Description as needed, then click
Apply.

The name can be up to 250 characters, and the description can be up to 2000 characters.

» Deleting fixed row structures

Any user can delete a fixed row structure. The Create Web Reports permission is not required. If the
fixed row structure was used by any web reports, those reports will no longer function correctly until
they are edited to use a different fixed row structure.
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IMPORTANT: If the deleted fixed row structure was used by a web report built from a template, that
report will no longer work. Currently, there is no way to edit the row structure assignment for
template-based reports. If the report is still needed, it must be re-created from template with a
different fixed row structure.

To delete a fixed row structure:

1. Inthe Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to delete, then hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Delete from the menu.

Name Y'

= RevExp [:]

= RevExp1 @ Info
O Copy
/ Edit
M Delete

3. When you are prompted to confirm that you want to delete the structure, click OK.

The structure is deleted from the system and no longer displays in the Intelligence Center.

Using the Row Editor
Using the Row Editor, you can define fixed row structures for use in web reports. Fixed row structures
define the following:

e The sections to be displayed in the report, including section titles and subtotal rows

e The data rows to be displayed within each section

When you use the Intelligence Center to create a new fixed row structure or to edit an existing fixed row
structure, it opens in the fixed row structure editor.

» Overview
By default, the Row Editor consists of two primary areas:

e The section editor on the left-hand side, where you can add, reorder, and remove sections and
data rows

e The property editor on the right-hand side, where you can define properties for the overall row
structure, the selected section, or the selected row
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ACCT.ACCT = 4000

If the row structure is configured to Use Dimension Mapping to define the row data, then another area
is available via the Dimension Mapping tab. You can use the Dimension Mapping area to map dimension
items to individual data rows. For more information on using dimension mapping, see Using the

Dimension Mapping editor.
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Row structure editor with Dimension Mapping tab

To save the row structure after making changes, use the Save button located at the top right of the
editor.

Certain parts of the row structure can be configured as hidden, such as section header rows or total
rows. By default, these hidden items no longer display in the editor. If you need to view these items so
that you can work with them and configure them, you can toggle the option Show Hidden items at the
top right of the editor.

» Using dimension mapping versus row filters in a fixed row structure
When you build a fixed row structure, there are two different ways to define the data to be shown each
in row:

¢ Filters: Each row can have a filter criteria statement that defines the data for that row. For
example, Acct.Acct=4100 or Acct.Category="Revenue'.

e Dimension mapping: Each row can be assigned one or more items in a specified dimension. For
example, if Acct is the specified row dimension, then you can view the list of accounts and map
them to specific rows in the report as needed.

The filter option is the most flexible way to build a fixed row structure, because:

e You can use any valid filter criteria statement to define the data in each row, including compound
statements using AND or OR, and referencing any table (not just the specified dimension table).

¢ You can define filters at the section level, which then combine with all row-level filters in the
section.

e You can repeat dimension elements within the row structure—for example, to create multiple
sections that show revenue for different regions or lines of business.
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However, because the filter option is more flexible, it also requires a more advanced level of knowledge
about your data structures. You must take care not to create invalid or conflicting filters, and make sure
that your filters result in the data that you want to display in the report.

In contrast, the dimension mapping option is the easiest to set up, because:

¢ You are presented with a full list of all items in the specified dimension, which you can search and
filter as needed.

e To assign an item to a row in the report, you simply select the item and then click the arrow
button to move it over to the row. Each row can be assigned as many items in the dimension as
needed.

* |tis very easy to see exactly which dimension items will display on each row, and to see which
items have not yet been assigned to rows.

However, the dimension mapping option is less flexible. Rows can only display data from the specified
row dimension, and each item in the dimension can only be assigned to a single row.

» Row structure properties

The following required properties at the top of the right-hand pane apply to the entire row structure.

Row Editor Show Hidden Items
My Report :
My Rep Row Structure
Revenue + @0 ROW STRUCTURE PROPERTIES
Revenue Line 1 Row Structure Name (required) MyStructure2
Revenue Line 2 Dimension Table (required) ACCT v

Revenue Line 3 Use Dimension Mapping

Revenue Total

= Section Properties

Expenses
SECTION HEADER PROPERTIES

Expenses Line 1 @ show Section Header

Example Row Structure properties area

Item Description

Row Structure The name of the row structure. The name identifies the row structure so that it
Name can be selected when creating or editing a web report.
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Item Description

Dimension Table The primary dimension table to be used on the data rows. You can select any
reference table in your system.

This selection is used as follows:

e By default, it determines the table available to the Filter Wizard when
defining filters for sections and data rows. For example, if the dimension
table is Acct, then you can use the Filter Wizard to build filters based on
Acct.

NOTE: When using filters to define the data in sections and rows, the
dimension table is simply a default table. If you want to define a filter using
a different dimension, then you can manually enter a filter criteria
statement using that dimension.

e |f Use Dimension Mapping is enabled, then it determines the dimension
table for the row mappings. For example, if the dimension table is Acct,
then you can map one or more accounts to each data row. In this case, data
rows can only use the dimension table.

Use Dimension Specifies whether the data in data rows is defined by using filters or by using

Mapping dimension mapping. By default, this is disabled, so data is defined using filters.
If instead you want to use dimension mapping for the rows, click the toggle
switch to enable this option. The toggle switch shows as green when enabled
and as gray when disabled.

If Use Dimension Mapping is enabled, the row structure editor updates as
follows:

¢ A new tab named Dimension Mapping becomes available next to the Row
Editor tab. You can use this tab to define dimension mappings for the rows.
Typically, you should define the sections and rows in the structure first, then
go to the Dimension Mapping tab to assign mappings to each row.

e The Filter fields in the Section Properties and the Row Properties become
hidden, because they do not apply when using dimension mapping. If a filter
is defined for a section or a row before dimension mapping is enabled, the
filter is retained in the properties (assuming it was saved) but it will be
ignored in reports.

For more information on the differences between using filters or dimension
mapping to define data rows, see Using dimension mapping versus row filters
in a fixed row structure.
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» Adding, removing, and reordering sections

Using the Row Editor tab, you can build your row structure by adding, removing, or reordering sections.

Each row structure starts with a top-level root section that includes an optional header and an optional
grand total.

Click to add
. sections
Row Editor —

Root Section

Grand Total

Root section header
and total row

Row editor with starting root section

To add new sections to the row structure, select the section header row—the Root Section row—and
then click the plus sign and select Add New Section.

Row Editor
Grand Total

_ | = Add Data Row

= Add New Section

Option to add a new section

The new section is added within the root section.

You can continue to add as many sections as needed
at this level.
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Row Editor

Root Section

Section 1 + 0
New Data Row 1
New Data Row 2
New Data Row 3
Section Total
Section 2
New Data Row 1
New Data Row 2
New Data Row 3
Section Total

Grand Total
Row editor with two newly added sections

To add subsections within a section, select the section header row for any section, and then click the
plus sign and select Add New Section. The new subsection is added to the current section. You can nest
as many section levels as you need by adding subsections to sections.
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Section Total

Section Total

Section 2
Row editor with newly added subsection

Newly added sections use default text and styling, which can be configured for each section. Each newly
added section consists of the following by default:

e A header row to display optional header text for the section. If you do not want a header row to
display for a particular section (including the root section), you can hide it by disabling Show
Section Header when configuring the section properties.

e Three data rows to display queried data in the section. You can add or remove data rows as
needed.

e A total row to display the totaled data for the section. If you do not want a total row for this
section (including the root section), you can hide it by disabling Show Section Total Row when
configuring the section properties.

Once you have added sections, you can make further section changes as follows:

* To reorder sections: Select the header row of a section and then drag and drop it to a new
location within the same level of the structure. For example, if you have three sections at the
same level, you can drag and drop these three sections to change their order. But you cannot
drag and drop one of these three sections to a lower level or a higher level.
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¢ To delete a section: Select the header row of the section and then click the delete icon (trash
can). The section and all of its subsections are deleted. Note that the root section is required and
cannot be deleted.

IMPORTANT: Make sure you no longer need the section before clicking the delete icon. The
section will be deleted immediately with no confirmation prompt. If you deleted a section by
accident, then you can exit the row structure editor without saving, but you will also lose any
other unsaved changes that you have made during the current session.

» Section properties
To configure the properties for a section, select the section header and then complete the Section
Properties in the right-hand pane.

Row Editor ~ Dimension Mapping Show Hidden ltems

My Report Row Structure

Revenue ROW STRUCTURE PROPERTIES
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Section Header Properties

Item Description

Show Section Specifies whether the section header row is visible when the row structure is

Header used in a report. By default, this option is enabled, so the section header row is
visible. If you do not want this section to have a header row, disable this
option. The toggle switch shows as green when enabled and as gray when
disabled.

If this option is disabled, then the remaining section header properties become
hidden because they do not apply. Note that you may want to define header
text before disabling the option, to make it easier to identify the section when
working within the row structure editor.

NOTE: If you hide the section header, then you will no longer be able to select
the header row in the editor for purposes of adding rows or subsections,
configuring the section, reordering the section, or removing the section. If you
need to work with the section header row, you can enable the option Show
Hidden Items, located at the top right of the editor. This will cause all hidden
items to show in the row structure, so that they can be selected and
configured.

Header Text The text to display on the section header row. By default, this is set to "Root
Section" for the root section header and "Section" for all other newly added
sections. The header text should be edited to reflect the data shown in this
section.

Header Category  The style to use on the section header row. The style determines display
attributes such as font size and font weight. Select one of the following:

¢ Headerl through Header6: These styles apply specific formatting to the
header row. Although Header1 is designed to be used as the top-level
section header, followed by Header2, and so on, you can assign these styles
to any section header row as needed.

e Default: Axiom Strategy Management automatically applies the appropriate
header style depending on the section's placement in the row structure
hierarchy. The header row for the root section uses Header1, sections in the
next level use Header2, and so on.

By default, the header category is set to Header1 for the root section header,
and Default for all newly added sections.
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Section Total Properties

Item Description

Show Section Specifies whether the section total row is visible when the row structure is used

Total Row in a report. By default, this option is enabled, so the section total row is visible.
If you do not want this section to have a total row, disable this option. The
toggle switch shows as green when enabled and as gray when disabled.

If this option is disabled, then the remaining section total properties become
hidden because they do not apply.

Total Row The location of the total row in the section, either Below the data rows or

Placement Above the data rows. The total row is located below the data rows by default.

Total Row Text The text to display on the section total row. By default, this is set to "Grand
Total" for the root section total and "Section Total" for all other newly added
sections.

Total Row The style to use on the section total row. The style determines display

Category attributes such as font size, font weight, shading, and borders. Select one of the
following:

¢ Grand Total or Total: These styles are intended to be used for "final" total
rows. Both styles use shading and top and bottom borders. The bottom
border of the Grand Total is a double border.

e SubTotall through SubTotal4: These styles are intended to be used for
subtotal rows. These options provide varying combinations of bold and
regular text, shading or no shading, and border or no border.

By default, the total row category is set to Grand Total for the root section total
row, and Subtotal3 for all newly added sections.

Section Properties

Iltem Description

Indent Child Specifies whether the rows in this section are aligned with the section header

Rows row or indented. By default, this is enabled, so the rows are indented. If instead
you want the rows to be aligned with the section header row, disable this
option. The toggle switch shows as green when enabled and as gray when
disabled.
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Item Description

Parent Total Specifies how the data in this section is treated when computing the total row
Row Behavior of the parent section. Select one of the following:

e Add: The data in this section is added when computing the parent total. This
is the default behavior.

e Subtract: The data in this section is subtracted when computing the parent
total.

¢ Ignored: The data in this section is ignored when computing the parent
total. You might do this if the rows in this section contain supporting detail
that should not impact the overall totals.

Although this option displays on the root section, it does not apply because the
root section does not have a parent section.

For example, imagine that you have a parent section with two subsections.
Subsection A totals 5000, and Subsection B totals 1000.

¢ |f both subsections are set to add, then the total of the parent section is
6000.

¢ If Subsection A is set to add but Subsection B is set to subtract, then the
total of the parent section is 4000.

¢ [f Subsection A is set to add but Subsection B is set to ignore, then the total
of the parent section is 5000.

Section Data Optional. A data filter to apply to all of the data rows in this section, including

Filter any subsections. This is intended to be used when all rows in the section need
to be filtered by a particular dimension or grouping, so that you do not need to
repeat that dimension grouping on each individual data row. Only applies when
Use Dimension Mapping is disabled.

Enter the filter criteria statement to apply to the data rows in this section.
Section data filters use normal filter syntax for Axiom Strategy Management.
Although you can use the Filter Wizard to create the filter criteria statement, it
is limited to creating filters based on the specified dimension table for the row
structure. In many cases the section data filter needs to use a different
dimension, so you must manually create the filter criteria statement.

For example, imagine that you want to show revenue accounts in the rows of
your report, but you want to split the data into two sections reflecting two
different sales regions. You can create two sections and define section filters
for each, such as Dept.Region="East' and Dept.Region="West"'. All of
the data rows in those sections will be filtered by the specified region in
addition to the specific account filters listed on each row.
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» Adding, removing, and reordering data rows

Using the Row Editor area, you can add data rows to a section, remove unneeded rows, and reorder
rows. Each data row represents a record of data that you want to query from the database and display
within the report.

To add new data rows to a section:

¢ Select the section header row, then click the plus sign and select Add Data Row.

Row Editor

My Report

Revenue Line 1 = Add Data Row

Revenue Line 2 = Add New Section

Revenue Line 3

Revenue Total

Option to add a new data row

The new row is added to the bottom of the section. You can continue to add as many new rows to the
section as needed.

Row Editor

My Report
| Revenue
Revenue Line 1
Revenue Line 2
Revenue Line 3

New Data Row i

Revenue Total

Section with a newly added data row

Administrator's Guide Axiom Strategy Management | 300



Once you have added data rows, you can make further row changes as follows:

* To reorder rows: Select the data row that you want to move, and then drag and drop it to a new
location within the same section. For example, if you want a newly added row to be at the top of
the section instead of the bottom, then you can drag and drop it to that location. But you cannot
drag and drop the row to a different section, not even to subsections of the current section.

* To delete a row: Select the data row that you want to delete and then click the delete icon (trash
can). The row is deleted.

IMPORTANT: Make sure you no longer need the row before clicking the delete icon. The row
will be deleted immediately with no confirmation prompt. If you deleted a row by accident,
then you can exit the row structure editor without saving, but you will also lose any other
unsaved changes that you have made during the current session.

Only data rows can be individually added, deleted, and reordered. Section header rows and section total
rows are not considered to be data rows and are managed as part of the section. Note the following:

¢ The delete icon on section header rows does not delete the header row; it deletes the entire
section. If you do not want a particular section to have a header row, you can configure the
section to hide the header row.

e Section total rows do not have delete icons. If you do not want a particular section to have a total
row, you can configure the section to hide the total row.

e Section header rows are always located at the top of the section. When you drag and drop a
section header row you are moving the entire section, not just the header row. It is not possible
to move just the header row.

e Section total rows can be located at either the top or bottom of the section, but not by dragging
and dropping. When you configure the section, you can specify the location of the total row.

» Row properties

To configure the properties for a data row, select the row and then complete the Row Properties in the
right-hand pane.

Row Editor ~ Dimension Mapping Show Hidden ltems

My Report =l Row Structure

Revenue ROW STRUCTURE PROPERTIES

Revenue Line 1 o Row Structure Name (required) MyStructure

Revenue Line 2 Dimension Table (required) ACCT ¥

Revenue Line 3 @) Use Dimension Mapping

Revenue Total % .
{aa= Data Row Properties
Expenses

Expenses Line 1 Row Text Revenue Line 1

Expenses Line 2

Example Row Properties area
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Item Description

Row Text The text to display on the data row. By default, this is set to "New Data Row".
The row text should be edited to reflect the data shown on this row.

For example, if this row is going to display data for the Travel account, the row
text should be something like "Travel" or "Account 5000 - Travel".

Data Filter A filter criteria statement to define the data to query into this row. Only applies
when Use Dimension Mapping is disabled. If dimension mapping is enabled,
then use the Dimension Mapping tab to map the data for this row.

Row filters use normal filter syntax for Axiom Strategy Management. You can
type the filter, or you can use the Filter Wizard to create a filter based on the
specified Dimension Table for the row structure.

For example, if the data filter is Acct.Category="Revenue', then this row
will display data for all revenue accounts when this row structure is used in a
report. The specific data returned will depend on the data columns used in the
report, and any other filters applied to the report.

Each row's data filter is independent from any other row, and does not need to
use the same grouping level or even the same dimension as other rows. For
example, one row can be Acct .Acct=4000, while another row is
Acct.Category='Marketing', and a third row is Fcst .Acct=670.
However, keep in mind the following:

e If you use the Filter Wizard to make the filter, it is limited to the table
selected as the Dimension Table for the row structure. If you want to use a
different table for a particular row, you must manually write the filter.

¢ Although there are no restrictions on the individual row filters, all of the
filters used must be compatible with the eventual primary table selected for
the report, when the fixed row structure is used in a report.

If the row uses a data filter, then the row's data filter will be combined with any upstream section data
filters (using AND). For example, imagine the row structure has sections and rows configured as follows:

Parent Section Filter Dept.Company='Company A'
Current Section Filter =~ Dept.Region='US West'

Row Filter Acct.Acct=4000

Then the data for this row is determined as follows:

Dept.Company="'Company A' AND Dept.Region='US West' AND Acct.Acct=4000
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Using the Dimension Mapping editor

Using the Dimension Mapping editor, you can assign dimension items to specific rows of a fixed row
structure. When the row structure is used in a web report, the rows will display data for the assigned
dimension items.

For example, if the row dimension is Acct, you can assign one or more accounts to each row in the row
structure. If a row is assigned Acct 4000, then that row will display data for Acct 4000, for each of the
columns used in the report.

» Dimension Mapping editor overview

The Dimension Mapping editor is only accessible when creating or editing a row structure. If Use
Dimension Mapping is enabled for the row structure, then a Dimension Mapping tab displays next to
the Row Editor tab. You can click this tab to open the Dimension Mapping editor and assign dimension
items to each row.

. .
AXIOM| Intelligence Center R Ja @ EJI
w @
Row Editor Dimension Mapping () show Hidden Items
My Report 2] Row Structure
Revenue + o ROW STRUCTURE PROPERTIES
Revenue Line 1 Row Structure Name (required) MyStructure2
Revenue Line 2
Dimension Table (required) ACCT v
Revenue Line 3
@D us< pimension Mapping

Revenue Total

i= Section Properties
Expenses
SECTION HEADER PROPERTIES

@D snow section Header

Header Text Revenue

Expenses Line 1
Expenses Line 2
Expenses Line 3

Header Category Default v

Expenses Total

Dimension Mapping tab available in row structure when Use Dimension Mapping is enabled
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AXIOM| Intelligence Center o a @ EE

w @

Row Editor Dimension Mapping
Dimension Table as |
specified in Row
Editor tab

MyStructure2 Selected Row: Revenue Line 1

Select All | Select Al []Show Mapped Dimension ltems
My Report =
Yy Rep Select a data row

to map that row

Revenue

Revenue Line 1

4000  Revenue 0 Defauit

Revenue Line 2 0

1000  Cash

Revenue Line 3 0 Dimension items mapped 1100 Short Term Investment
1300  Accounts Receivable
Expenses to selected data row
1400 Notes Receivable

1600 Inventory

Expenses Line 1 2
1700  Other Inventory

Erpenses Line 2 0 1800 Empoyeerec  List of dimension items |
1900 prepais Exper @vailable to be mapped to
2000 Other Current data rows

Simplified view of row 2100 Laboratory and EqUpment
structure as defined 2200 Accumulated Depreciation
in Row Editor tab 2300  Long Term Note Receivable

2400  Investment in Affiliates

Expenses Line 3 0

2500  Capital
3000  Accounts Payable <

Example Dimension Mapping editor

e The left side of the Dimension Mapping editor displays a simplified view of the row structure
defined on the Row Editor tab. You can select a data row in the row structure in order to map
dimension items to that row.

° Each data row must be assigned at least one dimension item when using dimension
mapping. It is not possible to mix use of data filters and dimension mappings.

° The number to the left of the row label shows how many dimension items have been
assigned to that row.

e The two columns on the right side of the Dimension Mapping editor are used to map dimension
items.

° The Current Mappings column in the middle of the page shows the dimension items
mapped to the currently selected data row.

° The dimension column on the right side of the page shows the remaining unmapped
dimension items. The dimension used for the mappings is determined by the specified
Dimension Table in the Row Editor tab. In this example, the dimension table is Acct and
the column shows the list of accounts defined in that table.

° You can use the arrow buttons between the columns to move dimension items from the
dimension column to the Current Mappings column and vice versa.

Each dimension item can only be assigned to a single row in the row structure. Once a dimension item is
moved to the Current Mappings column, it is removed from the list of unmapped dimension items and
cannot be assigned to another row.
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NOTE: When building a fixed row structure with large tables (such as the EDS Encounter table)
dimension mapping is disabled, as it can cause performance issues. Instead, you can use the filter
wizard to define that row in a report. See Specifying the row dimension for a web report for more
information.

» Assigning dimension items to data rows

Each data row in the row structure must be assigned at least one dimension item. When the row
structure is used in a report, the dimension mappings determine what data displays in each row.

To assign one or more dimension items to a data row:
1. Inthe row structure on the left side of the page, select the data row that you want to map. If any
dimension items are already mapped to this row, those dimension items display in the Current
Mappings column.

2. Inthe dimension column on the right side of the page, select the dimension item or items that
you want to map to the data row.

¢ Click a dimension item once to select it. If you select a dimension item by accident, click it
again to de-select it.

e Note that using the Shift key or the CTRL key to select multiple dimension items at once
does not work here. You must individually click on each dimension item that you want to
assign.

You can search and filter the dimension list to help find the desired dimension items.

3. Once all of the dimension items that you want to assign are highlighted, click the left arrow to
move the selected dimension items to the Current Mappings column.

If you want to remove a mapped dimension item from a data row, you can select the item in the Current
Mappings column and then click the right arrow to move it back to the dimension column.

In the following example, two accounts have been mapped to the Expenses Line 1 data row. When this
row structure is used in a report, this row will display summed data for the Software Expense and
Computer Expense accounts. (In a real report, the label text for this data row would likely be defined as
"Software and Computer Expenses" or something similar.)
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Row Editor Dimension Mapping

MyStructure Selected Row: Expenses Line 1
My Report Select All | Select All | () Show Mapped Dimension Items
Current Mappings 2 v ACCT 96
Revenue
Revenue Line 1 1
5200  Software Expense o 0 Default =
Revenue Line 2 0 5400  Computer Expense 1000  Cash
Revenue Line 3 0 1100  Short Term Investment
1300 Accounts Receivable
Expenses 1400  Notes Receivable
Expenses Line 1 2 1600 Inventory
1700 Other Inventory
Expenses Line 2 0 1800  Employee Receivable

Expenses Line 3 0 1900  Prepaid Expenses

2000  Other Current Assets

2100  Laboratory and Equipment
2200  Accumulated Depreciation
2300  Long Term Note Receivable
2400  Investment in Affiliates

Example data row with mapped dimension items

The two accounts that are mapped to this data row no longer display in the dimension column and
cannot be mapped to any other row. You can optionally enable Show Mapped Dimension Items to see
all items in the dimension column, but mapped items will display as grayed out and cannot be selected.

» Searching and filtering the dimension column
You can search and filter the dimension column to more easily find the dimension items that you want
to map.

e You can type into the search box at the top of the column to find items by dimension value. The
search matches any dimension value that contains the search text. Currently, the description text
is not included in the search.

e You can select a grouping column so that the dimension column is filtered to only show values for
a particular grouping. For example, you may have a grouping column of Category, which you can
use to show accounts within a particular category—such as Revenue, Capital, or Marketing.

If you use Select All when the list is filtered by a search or by a grouping value, then only the currently
visible items are selected. This can be a convenient way to find, select, and map multiple dimension
items at a time.

To filter the dimension column by a grouping value:

1. Click the down arrow icon in the column header, and then click Choose Grouping Column.
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Select All | Clear All

v ACCT

Choose Grouping Column

(] Show Mapped Dimension Items

99

2. Inthe Choose a Grouping Column dialog, select the grouping column that you want to use, and

then click OK.

The dimension column becomes filtered by the first value in the selected grouping column. This

value displays in the column header.

3. To filter the dimension column by a different value in the grouping column, click the down arrow

icon in the column header, and select the desired value.

In the following example, "Balance Sheet" was the automatically-selected value from the
grouping column, and we are now going to select "Marketing" instead.

Select All | Clear All

v Category : Balance Sheet

Choose Grouping Column

Clear Grouping Column
« Balance Sheet

Capital

COGS

Marketing

Other Expenses

Other Income/Expense

Overhead

Payroll

[ ]Show Mapped Dimension ltems

21

The dimension column is now filtered to only show accounts that belong to the Marketing

category.
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Select All | Clear All (] show Mapped Dimension ltems

v Category : Marketing 3

Type to Search

5700  Advertising =
5800 Marketing

5000 Sales Commissions

If you want to clear the grouping column filter, click the down arrow icon in the column header, and
select Clear Grouping Column.

Using the Filter Wizard in the Fixed Row Structure editor

The Filter Wizard is available in the Fixed Row Structure editor to assist you in building a valid filter
criteria statement.
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A | Filter Wizard *
Define criteria for the filter, based on table GL2018
4 45 DEPT - = France .
- India
g Dept
v Italy
[m] Description Singapore
* E WorldRegion K
[m] Country | US Central
Sl i Region | US East
; o | US West
E Lu. rency -
Ereview DEFT.Region IM ('US West', 'US East', 'US Central’) Y
Tapply
Filter A
m Cancel
Example Filter Wizard

The tables available in the wizard depend on the table specified as the dimension table for the fixed row
structure.

To create a filter:
1. Inthe left-hand side of the dialog, select the table column on which you want to base the filter.

For example, if you want to create a filter such as DEPT . DEPT>=5000, then you must select the
DEPT column from the DEPT table.

To find the desired table and column, you can filter the list by typing into the Search box. The
filter matches based on table and column names.

Once you select a table column, the values in that column display in the right-hand side of the
dialog.
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TIP: Alternatively, you can use the folder icon to the right of the Preview box to load a
previously saved filter from the Filters Library. If you do this, your selected filter is placed in
the Preview box, overwriting any current content in the preview. Skip to step 4.

2. Inthe right-hand side of the dialog, select the value(s) on which you want to base the filter. You
can type into the filter box above the list of values to filter the list.

3. Inthe space between the two selection boxes, select the operator to use for the filter criteria
statement, such as equals, not equals, greater than, or less than. By default, the filter statement
uses equals (=).

Note the following about filter operators:

e Greater than / less than options are only available if the column data type holds numbers
or dates.

e [f multiple items are selected, then IN and NOT IN syntax is automatically used for equals
and not equals respectively.

e If the column is a string column and the value contains an apostrophe (such as O'Connor),
the wizard automatically converts this value to double apostrophes so that it is valid for
use in the filter (0''Connor). Apostrophes in string values must be escaped this way so that
they are not interpreted as the closing apostrophe for the filter criteria statement.

e The LIKE operator is supported, but is not available for selection in the Filter Wizard. You
must manually edit the filter criteria statement if you want to use it. Only advanced users
with knowledge of valid SQL LIKE syntax should do this.

4. Review the filter criteria statement in the Preview box to ensure that it is as intended. If you need
to make changes, you can manually edit the statement, or you can start again with a new
statement. If you want to clear the statement, click the X icon to the right of the Preview box.

5. If nofilter is currently present in the Filter box, click Apply to move the filter down to the Filter
box. If a filter is currently present in the Filter box, you can do one of the following:
e Click Replace to overwrite the current filter with the preview filter.
e Click AND or OR to add the preview filter to the current filter. This creates a compound
criteria statement.
You can repeat the filter creation process as many times as necessary to create the desired

statement. You can also manually modify the filter in the Filter box as needed, such as to add
parentheses to group statements.

6. When the filter in the Filter box is complete, click OK.
TIP: If you want to save the filter you have created for future use, click the save icon to the
right of the Filter box. You can select a folder location in the Filters Library (or My Documents

if applicable), and specify a name for the filter. This option is only available if you have
read/write access to at least one location where filters can be stored.
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Opening web reports

In order to open an existing web report, you must have at least read-only access to the report, as
defined in Axiom Strategy Management security. Web reports can be opened from either the Web
Client or the Desktop Client.

This topic discusses the default ways to access and view web reports. Your system may be designed so
that you can open web reports in other ways, such as:

¢ Using the Navigation menu in the Web Client

e Using links within your home page or product pages

¢ Using links within a task pane or ribbon tab in the Desktop Client

» Opening web reports from the Intelligence Center

The Intelligence Center in the Web Client is a hub where you can access all of your available reports,
regardless of the report type. The Intelligence Center is automatically filtered to show only the reports
that you have access to.

To open a web report from the Intelligence Center:
L X ]

1. Click the Syntellis icon E.:I in the Navigation bar. From the Area menu, select Intelligence Center.
N @ &
- L o

PRODUCT AREAS
Home
Intelligence Center

System Administration

2. Inthe left-hand panel, select the Reports tab if it is not already selected.
3. Do one of the following to locate the report that you want to open:

e Use the folder tree in the left-hand panel to navigate to the folder where the report is
located.

OR

e Use the Search box to search for the report by name.
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For more information on how to search, filter, and sort the Intelligence Center, see Intelligence
Center overview.

4. Once the report displays in the Intelligence Center grid, click on the report name to open it.

The report opens in the current browser tab. You can now view and explore the data using various
features. For more information, see Viewing and exploring data in web reports.

» Opening web reports from the Desktop Client

You can open a web report from the Reports Library in the Desktop Client (Excel Client or Windows
Client). You can differentiate web reports from other types of Axiom Strategy Management reports
using the following icons:

Web report

@ Visualization report
= Axiom form

B: Spreadsheet Axiom file

To open a web report from the Desktop Client:
1. Onthe Axiom tab, in the Reports group, click Reports to bring up the Reports menu.

NOTE: In systems with installed products, this feature may be present on a different ribbon
tab, such as the Main tab.

TIP: You can also open reports from the Explorer task pane or Axiom Explorer.

2. Use the Reports Library folders at the bottom of the menu to navigate to the specific web report
that you want to open, and then click on it.

The web report opens in the Web Client using your default browser. You can now view and explore the
data using various features. For more information, see Viewing and exploring data in web reports.

Viewing and exploring data in web reports

Once a web report is opened, you may have access to a variety of features to view and explore the data
in the report, including filtering, sorting, and drilling. Additionally, web reports may be configured with
report parameters, which can be used to dynamically change the data shown in the report.
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NOTE: The features described in this topic apply to web reports created in the Report Builder. Web

reports created from template may have similar features, but do not work in exactly the same way.

For more information on viewing and exploring data in a web report created from template, consult
the product documentation for the product that provided the template.

» Drilling data

If the web report has been configured to enable drilling, you can drill any data row in the report. Total
rows, subtotal rows, and section header rows are not drillable.

To drill a data row:
1. Hover your cursor over the far left column in the report so that a magnifying glass icon appears
on the row.

The tooltip for the magnifying glass will be either "Drill" (if multiple drill paths are available) or
"Drill to <path>" (if a single drill path is available). For example, the tooltip will say "Drill to Acct" if
the Acct drill path is the only available drill path.

2. Click the icon to drill the row.
e |If multiple drill paths are available, these paths display in a menu when you click the icon.
Click the drilling path that you want to view.

e [f a single drill path is available, that path is automatically used when you click the icon to

drill.
Q12020
WorldRegion t
Q1 Actuals Q1 Budget
Qﬂn,?sia $6,989,316 55,416,397
\—E Drill to Country
TO} $473,158 $340,531
North America $32,766,656 $35,609,235

Hover and click to drill

The drill results are presented within the current tab, replacing the original report. The current row
being drilled and the current drill level display at the top of the drill results.
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AXIOM| Intelligence Center

Budget to Actuals | Corporate
Through June 2022

. WorldRegion = Europe Country = UK
Drill Path x _ )

By Country By Region
a1 Q2
Region ¢
Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference
United Kingdom Sales Region (UK) $161,771 $5247,830 -34.73% $237,089 5244075 -2.86%

Example drill results with drilling path displayed at the top

You can continue drilling the drill results if additional drill paths are available. You can return to a
previous path by clicking on that path name in the header. When you are finished viewing the drill
results, you can click the X icon in the drill path to clear the drill and return to the original report.

» Using report parameters

If the web report is configured with report parameters, you can use the Report Parameters panel along
the left-hand side of the report to dynamically change the data shown in the report.

AXIOM)| Intelligence Center o a @ EE

@

Report Parameters Edit| | Export | | Share
Grouping for analysis

Vice President v

Budget to Actuals

Account category to analyze Through June 2022

Revenue v
Q12022 Q22022
Vice President ¢

Q1 Actuals Q1 Budget Difference Q2 Actuals Q2 Budget Difference
Bree Sigman $6,015,031 $6,954,348 -13.51% $6,437,818 $6,848,978 -6.00%
Evan Simpson $12,810,352 $13,195,690 -2.92% $5,208,342 $12,995,756 -59.23%
Frank Martinez $161,693 $331,567 -51.23% $262,089 $326,543 -19.74%
Javier Grant $5,018,848 $4,165,304 20.49% $4,119,925 $4,102,194 0.43%

Example report with report parameters

The Report Parameters panel contains one or more parameters that you can set as needed. If the report
requires you to select a parameter value in order to refresh data in the report, then when you open the
report the message "Waiting for input" displays in the report grid. Otherwise, the report opens and
refreshes data using default values defined for report parameters as needed.
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You can interact with report parameters as follows:

e You can select one or multiple values for each parameter, depending on the parameter type and
configuration. If a parameter allows multiple values to be selected, the parameter box shows text
such as "3 items selected". You can hover your cursor over this text to view the selected values in
a tooltip.

Report Parameters

Selected values:
Departments

22000 - Information Technologies
23000 - Purchasing & Materials Mgmt ||

24000 - Business Development

3 items selected

\

—r—

If the parameter allows selection of multiple values, and some values are already selected, then
using the drop-down list to select more items will add to the current list of items. If instead you
want to clear the list of items and start over, click the X icon in the selection text.

e A parameter may start out blank (unset), or it may start with a default value, depending on the
parameter type and configuration.

e Some parameters may be dependent on other parameters. In this case, the dependent parameter
will not become available for use until its parent parameter has a selected value.

e Parameters may be required or optional:

° If a parameter is optional, then you can leave it unset, or you can clear its value using the X
icon to the right of it.

° If a parameter is required, then it cannot be cleared. You can select a different value, but
you cannot fully clear the parameter. Exception: If the parameter allows selection of
multiple values, then you can click the X icon in the selection text to clear the current
selections.

Once you have made selections for the parameters, you can apply and clear them as follows:

e Click Apply to refresh the report using your parameter selections. The Apply button is not active
until all required parameters have selected values.

¢ Click Clear to clear all optional parameters. You can then click Apply to refresh the report with the
optional parameters unset.
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NOTES:
¢ When you share or export a report, it does not honor the report parameter selections, with
one exception. If the report parameter determines the row dimensions of the report, and the
parameter has a default value, the exported report will use that default value.

¢ The specific parameters available and how they impact the report depends on the report
configuration. Contact your system administrator or the report designer if you have any
guestions about how the parameters affect the report data.

» Adjusting column width and order

You can make minor adjustments to the column display as follows:

¢ To change the column width, hover your cursor along the right edge of the column header, then
drag to make the column thinner or wider.

e To reorder columns, click on a column header and then drag it to a new location. Note that
columns cannot be moved in or out of a column group (meaning a set of columns grouped under
header text). If a column belongs to a column group, you can change its order within the group
but you cannot drag it out of the group.

» Sorting data

If the web report uses a data grid with dynamic rows, then you can sort the data by any column in the
grid. To sort the grid by a column, click on the column header. Each click toggles between ascending
sort, descending sort, and no sort. If the grid is currently sorted by a column, the sort direction is
indicated by an arrow on the column header (up for ascending, down for descending).

The web report may only allow sorting by a single column, or it may allow sorting by multiple columns.
This is configured by the report designer. If the grid uses single-column sorting, then it is not possible to
clear the sort on a column. Instead you must click on a different column to change the sort to use that
column.

If the web report uses a fixed row structure, then the row values are fixed in position and cannot be
sorted.

» Filtering by column data

If the web report uses a data grid with dynamic rows, you may be able to filter the report by the column
data. For example, you might want to filter a column to hide zero-value records, or to show all records
above or below a certain value. You might want to filter a dimension column to hide or show certain
dimensions (such as departments, accounts, and so on). The report designer determines whether a
column is enabled for filtering.

If a column allows filtering, the filter icon displays in the column header when you hover your cursor
over the column header.
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Jan
ﬁ Filter
$5,050

$43,558
Filter icon for a column with filtering enabled

To filter the report based on a column:

1. Click the filter icon in the column header to show the filter options.

2. Set the filter options as desired. The options vary depending on the column type.

Jan Y. Feb

$5.0-' Is greater than {

$43,5! 5,000.00

a»
e

And

$103,7:

$59,0! Is equal to ol
$136,1° “ i
$9,749,1L . ./

Example filtering options

3. Click Filter.

The report updates to only show records that meet the filter. Additionally, the filter icon in the column
header remains visible to indicate that the grid is filtered by this column.

The filter is retained until you clear it, or until the report is refreshed with new data.

To clear a filter:
1. Click the filter icon in the column header to show the filter options.

2. Click Clear.

The grid updates to clear the filter. The filter icon is now only visible when hovering over the column
header.
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» Viewing paged data

If the web report uses dynamic rows, the data is paged to show a specified number of records per page.
If the data in the grid exceeds the page limit, you can move between pages using the page controls at
the bottom left of the grid.

$24,470,195.79 $17,723,313.38 $24,470,195.79

1 2 3 L 25 v items per page 1-250of 51 items
Page controls for data grids

¢ Click a page number to move directly to that page.
e Click the single arrow buttons to move one page back or forward.

e Click the double arrow buttons to move to the first page or the last page.

By default, the data grid shows 25 records per page. You can use the drop-down list next to the page
controls to change this to 50, 100, or 500 as needed.

Web report sharing, export, and distribution

The information in web reports can be distributed throughout the organization using a variety of
features:
e You can export a web report as a PDF, Excel, or delimited file, and save it locally or to the Axiom
Strategy Management repository.
e You can share a web report via email to other users, by sending a link to the live file in the
system, or by attaching a PDF or Excel file.
* You can process web reports iteratively over a dimension, and then automatically save and/or
email the report to designated recipients.

Exporting a PDF copy of a web report

You can export a web report as a PDF file, and save the file locally or to the Axiom Strategy Management
repository. The export can be performed while viewing the report, or from the Reports Library in the
Intelligence Center.

e When exporting the report from the Intelligence Center, it is exported using default settings. If
the report requires user input to return data, you should instead open the report and export from
the report viewer.

e When exporting the report from the report viewer, the export honors the current report state
such as sorting, filtering, and drilling.

Any user who can view the report can export to PDF and save it to a local folder location. In order to
save a PDF copy to the Axiom Strategy Management repository, you must have read/write access to at
least one folder in the Reports Library.

Administrator's Guide Axiom Strategy Management | 318



To export a web report as a PDF file:
1. Inthe Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

e Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon then select Export > PDF from the menu.

Name Y Modified on 7

B Acct Analysis E] 9/16/2021 11:09 AN

B Budget Analysis @ Info 3/2/2021 12:27 PN
/ Edit

[@ Budget to Actuals Comparison < Share  » 7/2/2021 7:36 AM
+

B Corporate Dashboard == Export g [ Delimited PN
D Copy [{) Excel

B Quarterly Performance PM

[

M Delete @ POF

¢ Click the report name to open the report. In the top right corner of the report, click Export
> PDF.

Edit Export  Share

Delimited
Excel

PDF

3. Inthe Export Report dialog, enter a file name into the File name field. By default, the file name is
the same as the web report file name.
4. Select the export destination from the Export to drop-down:
e My computer: Save the PDF to your computer.

e Axiom repository: Save the PDF to a folder in the Axiom Strategy Management Reports
Library, or to your My Documents folder.
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NOTES:

¢ |f you save the PDF to a folder in the Reports Library, any user with at least read-only
access to that folder will be able to view the PDF. You should be sure that it is
acceptable for users with permission to the target folder to view the data in the PDF.

 If you do not have read/write access to any folders in the Axiom repository, then the
Export to option is not available and does not display in the dialog. The PDF will be
automatically saved to your computer.

¢ |f you save the PDF to your computer, keep in mind that Axiom Strategy Management
does not enforce any security on the exported file.

5. If you are saving to the Axiom repository, select an Output folder:
¢ Click the folder icon = to the right of the field.

e In the Choose output folder dialog, select a folder in the Reports Library. The dialog only
shows folders where you have read/write access to that folder or a child folder.

NOTE: If you have access to the My Documents folder, then you can also save reports
to that location for your personal use.

¢ Click OK to choose the folder and return to the Export to PDF dialog.
The path to your selected folder now displays in the Output folder field.

6. Inthe Configuration Settings section, select the following:
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Item Description

Pages If you are exporting from the report viewer and the report has paged
data, select one of the following:

e Current Page: The export will contain the current page of data only.
For example, if you are currently viewing page 2 of the data in the
report, the export will contain that data only.

¢ All Pages: The export will contain all pages of data, up to 10 pages
maximum.

A "page" refers to a page of data as displayed in the report, not PDF
pages. Report pages can be configured to show 25 (default), 50, or 100
rows. For example, if you select to export the current page and the page
size is 100, the PDF will contain those 100 rows which may span several
PDF pages.

NOTES:
e |f you are exporting from the Intelligence Center, this option does not
display and the PDF will contain all data pages (up to the maximum).

» |f the report uses a fixed row structure, data is not paged and this
option does not apply. The PDF will contain the full contents of the

report.

Layout Select the page size for the PDF. You can choose from the following
standard page sizes: A3, A4, A5, Legal, Letter, or Tabloid. Letter is the
default size.

Orientation Select the orientation for the PDF, either Portrait or Landscape. Portrait is

the default orientation.

Margin Specifies the PDF page margins. Select one of the following:
¢ None: No margin
e Narrow: 0.5 inch margins all around
¢ Normal: 1 inch margins all around (default)

Header Specify optional header and footer text. The variables {page number}

and {total pages} can be used in the header or footer.
Footer -

You can select from several predefined header and footer options using
variables, or you can type text into the Header or Footer box.

NOTE: If the margin is set to None, then the Header, Footer, and
Alignment options are not available because there is no room to display a
header or footer.

Alignment Specify the alignment of the header and footer text, if defined: Left,
Center (default), or Right.
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7. Click Export to create the PDF.

¢ [f you are saving to the Axiom repository, and you used a file name that already exists in
the target folder, you are prompted to choose whether or not to overwrite the existing file.
If you choose not to overwrite, you are returned to the Export to PDF dialog so that you
can use a different name and/or output folder.

e If you are saving to your computer, the exact behavior is determined by your browser
settings. The default behavior for most browsers is to save the file to the Downloads folder
on your computer.

* |n either case, a notification message displays at the top of the page to indicate whether
the PDF creation succeeded or failed.

» Export behavior
When you create the PDF, the web report contents are handled as follows:
e If the grid in the web report has paged data, the PDF will contain either all rows shown on the
current page, or all rows in the report up to 10 pages of data. The number of rows in a page of
data depends on the paging selection in the report (25, 50, or 100).
© Column headers are present on the first PDF page only; headers do not repeat on PDF
pages.
° |f the report has a total row, that row is always included in the PDF and always displays the
full total, even if the PDF only contains a partial set of data.

° If exporting from the Intelligence Center, the PDF contains all data pages up to the
maximum, using the default of 25 rows per page.

e If you have sorted, filtered, or drilled the data displayed in the report, these changes are reflected
in the PDF. The exception is if you have reordered columns—columns display in their original
order.

NOTE: Drill results can only be saved as a PDF if the report was created in the Report Builder.
Web reports created from template display drill results slightly differently, and these results
cannot be saved to PDF.

e If the report uses report parameters, those parameter selections are not reflected in the export.
Exception: If the report uses a dynamic column tied to a Column List report parameter, the
default value for that parameter will be used for the export.

NOTE: For reports created from template, refresh variable selections are applied to the
export.

e If the report contains a column with links, the column displays the link text without an active
hyperlink.
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Exporting grid data in a web report to Excel

You can export grid data in a web report to a spreadsheet, so that you can further examine the data
using spreadsheet features. You can save the spreadsheet locally, or save it to the Axiom Strategy
Management repository.

The export can be performed while viewing the report, or from the Reports Library in the Intelligence
Center.

e When exporting the report from the Intelligence Center, it is exported using default settings. If
the report requires user input to return data, you should instead open the report and export from
the report viewer.

¢ When exporting the report from the report viewer, the export honors the current report state
such as sorting, filtering, and drilling.

Any user who can view the report can save the spreadsheet export locally. In order to save the
spreadsheet export to the Axiom Strategy Management repository, you must have read/write access to
at least one folder in the Reports Library.

To export grid data to an Excel spreadsheet:
1. Inthe Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

e Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon then select Export > Excel from the menu.

Name Y Modi

B Acct Analysis B 9/16/2021 1

B Budget Analysis @ Info 3/2/2021 1
# Edit

[@ Budget to Actuals Comparison & Share > 7/2/2021

3 Export »

B Corporate Dashboard [ Delimited 1
0 C
@ Copy [ Excel

B Quarterly Performance & Delete 1
= @ PDF

e Click the report name to open the report. In the top right corner of the report, click Export
> Excel.
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Delimited
Excel

PDF

3. Inthe Export to Excel dialog, enter a file name into the File name field. By default, the file name
is the same as the web report file name.

4. Select the export destination from the Export to drop-down:
e My computer: Save the spreadsheet to your computer.

e Axiom repository: Save the spreadsheet to a folder in the Axiom Strategy Management
Reports Library, or to your My Documents folder.

NOTES:

¢ |f you save the spreadsheet to a folder in the Reports Library, then any user with at
least read-only access to that folder will be able to view the spreadsheet. You should
be sure that it is acceptable for users with permission to the target folder to view the
data in the spreadsheet.

 If you do not have read/write access to any folders in the Axiom repository, then the
Export to option is not available and does not display in the dialog. The spreadsheet
will be automatically saved to your computer.

¢ If you save the spreadsheet to your computer, keep in mind that Axiom Strategy
Management does not enforce any security on the exported file.

5. If you are saving to the Axiom repository, select an Output folder:
e Click the folder icon = to the right of the field.

¢ |nthe Choose output folder dialog, select a folder in the Reports Library. The dialog only
shows folders where you have read/write access to that folder or a child folder.

NOTE: If you have access to the My Documents folder, then you can also save reports
to that location for your personal use.

e Click OK to choose the folder and return to the Export to Excel dialog.

The path to your selected folder now displays in the Output folder field.
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6. If the current report is enabled for directed drilling, you can optionally choose to Export all drill
levels. If this option is enabled, then the report data is "flattened" using all drill levels. For
example, if the report is currently showing rows by Acct, and the report has configured drilling
levels of Region and Dept, then the exported report contains data rows by unique combination of

Acct/Region/Dept.

NOTES:
¢ [f this option is enabled, the export ignores any sorting, filtering, or drilling in the
report. The directed drilling columns are added to the report as row dimensions, and
all data is exported at this level.
e This option is not available if the report uses a fixed row structure, or if the report is
built from template.

7. Click Export to create the spreadsheet.

e [f you are saving to the Axiom repository, and you used a file name that already exists in
the target folder, you are prompted to choose whether or not to overwrite the existing file.
If you choose not to overwrite, you are returned to the Export to Excel dialog so that you
can use a different name and/or output folder.

e |f you are saving to your computer, the exact behavior is determined by your browser
settings. The default behavior for most browsers is to save the file to the Downloads folder
on your computer.

e In either case, a notification message displays at the top of the page to indicate whether
the spreadsheet creation succeeded or failed.

» Export behavior
When the grid data is exported, the behavior is as follows:
¢ [f the data is paged in the report, the export contains all pages of data.
e By default, the basic number format applied to the column is preserved in the export. The
exception is negative numbers, which will always be shown using a minus sign regardless of the

configured format. Other formats such as background colors and borders are not applied to the
exported data.

e Date and DateTime columns are exported as follows:

° Columns configured to display the full date part are exported using the default date or
date-time format, regardless of the format configured to display in the report.

° Columns configured to display other date parts display the numeric value of the date part
only. For example, if the column is configured to display the Quarter part as Q1 format, the
value is exported as only the number (1 for Q1).
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e If you have sorted, filtered, or drilled the data displayed in the report, these changes are reflected
in the export. The following exceptions apply:

© Reordered columns are ignored. Columns are exported in their original order.

° Drill results can only be exported to Excel if the report was created in the Report Builder.
Web reports created from template display drill results slightly differently, and these
results cannot be exported.

o If Export all drill levels is enabled, the export ignores any sorting, filtering, or drilling in the
report. The directed drilling columns are added to the report as row dimensions, and all
data is exported at this level.

e [f the report uses report parameters, those parameter selections are not reflected in the export.
Exception: If the report uses a dynamic column tied to a Column List report parameter, the
default value for that parameter will be used for the export.

NOTE: For reports created from template, refresh variable selections are applied to the
export.

e Column group headers are omitted from the export. Additionally, if a column has a 2-row header,
only the first row of that header is exported.

e If the report contains a column with links, the link configuration is ignored, and the regular
column value is exported (as if the column were not enabled to show links).

e Export to Excel is capped at 150,000 rows. If a report contains over 150,000 rows, only partial
data is exported, and the total row is omitted.

Exporting grid data in a web report to a delimited file

You can export grid data in a web report to a delimited file such as comma-separated (CSV). You can
save the delimited file locally, or save it to the Axiom Strategy Management repository.

The export can be performed while viewing the report, or from the Reports Library in the Intelligence
Center.
¢ When exporting the report from the Intelligence Center, it is exported using default settings. If
the report requires user input to return data, you should instead open the report and export from
the report viewer.
e When exporting the report from the report viewer, the export honors the current report state
such as sorting, filtering, and drilling.

Any user who can view the report can save the delimited file locally. In order to save the delimited file to
the Axiom Strategy Management repository, you must have read/write access to at least one folder in
the Reports Library.
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To export grid data to a delimited file:
1. Inthe Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

e Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon then select Export > Excel from the menu.

Name Y Modi
B Acct Analysis E] 9/16/2021 1
udget Analysis ' 1
B Budget Analysi © Info 3/2/2021
/ Edit
Budget to Actuals Comparison 7/2/2021
@ g p «% Share »
+
B Corporate Dashboard = Export > [ Delimited
D Copy ) Excel
B Quarterly Performance
 Delete @ POF

e Click the report name to open the report. In the top right corner of the report, click Export
> Excel.

Edit  Export  Share

Delimited
Excel

PDF

3. Inthe Export Report dialog, enter a file name into the File name box. By default, the file name is
the same as the web report file name.

4. For Export to, select the export destination:
e My computer: Save the delimited file to your computer.

e Axiom repository: Save the delimited file to a folder in the Axiom Strategy Management
Reports Library, or to your My Documents folder.
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NOTES:

¢ |f you save the delimited file to a folder in the Reports Library, then any user with at
least read-only access to that folder will be able to view the file. You should be sure
that it is acceptable for users with permission to the target folder to view the data in
the file.

 If you do not have read/write access to any folders in the Axiom repository, then the
Export to option is not available and does not display in the dialog. The file will be
automatically saved to your computer.

¢ |f you save the file to your computer, keep in mind that Axiom Strategy Management
does not enforce any security on the exported file.

5. If you are saving to the Axiom repository, select an Output folder:
e Click the folder icon = to the right of the field.

e In the Choose output folder dialog, select a folder in the Reports Library. The dialog only
shows folders where you have read/write access to that folder or a child folder.

NOTE: If you have access to the My Documents folder, then you can also save reports
to that location for your personal use.

¢ Click OK to choose the folder and return to the Export to Excel dialog.
The path to your selected folder now displays in the Output folder field.

6. Inthe Configuration options section, select the desired Delimiter. You can select any of the
following: Comma (default), Space, Period, Pipe, Tab, Semi-Colon, Colon.

If the delimiter is a comma, the file format for the exported file is CSV. For any other delimiter,
the file format is TXT.

7. If the current report is enabled for directed drilling, you can optionally choose to Export all drill
levels. If this option is enabled, then the report data is "flattened" using all drill levels. For
example, if the report is currently showing rows by Acct, and the report has configured drilling
levels of Region and Dept, then the exported report contains data rows by unique combination of
Acct/Region/Dept.

NOTES:

¢ |f this option is enabled, the export ignores any sorting, filtering, or drilling in the
report. The directed drilling columns are added to the report as row dimensions, and
all data is exported at this level.

e This option is not available if the report uses a fixed row structure, or if the report is
built from template.
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8. Click Export to create the delimited file.

¢ [f you are saving to the Axiom repository, and you used a file name that already exists in
the target folder, you are prompted to choose whether or not to overwrite the existing file.
If you choose not to overwrite, you are returned to the Export Report dialog so that you
can use a different name and/or output folder.

e If you are saving to your computer, the exact behavior is determined by your browser
settings. The default behavior for most browsers is to save the file to the Downloads folder
on your computer.

* |n either case, a notification message displays at the top of the page to indicate whether
the file creation succeeded or failed.

» Export behavior

When the grid data is exported, the behavior is as follows:

¢ [f the data is paged in the report, the export contains all pages of data.

e |f the report uses row dimensions, then the first row of data in the file contains the column
headers. Group headers are omitted from the export. Additionally, if a column has a 2-row
header, only the first row of that header is exported. The total row is excluded from the export.

¢ [f the report uses a fixed row structure, all rows are included in the delimited file, including
header rows and subtotal rows.

e The raw data is exported to the delimited file. No formatting is applied. For example, this means
number formats are not applied, date formats are not applied, and the Show Description option
is not applied. The Description will only display if you click the Show description toggle in the
Formatting Properties area of your report's column configuration settings.

e |f a data value in the export contains the delimiter, that value is escaped in double quotation
marks. For example, if the delimiter is a space character, then values with spaces are wrapped in
double quotation marks (such as "Finance Department").

e If the report contains a column with links, the link configuration is ignored, and the regular
column value is exported (as if the column were not enabled to show links).
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e If you have sorted, filtered, or drilled the data displayed in the report, these changes are reflected
in the export. The following exceptions apply:

© Reordered columns are ignored. Columns are exported in their original order.

° Drill results can only be exported to file if the report was created in the Report Builder.
Web reports created from template display drill results slightly differently, and these
results cannot be exported.

o If Export all drill levels is enabled, the export ignores any sorting, filtering, or drilling in the
report. The directed drilling columns are added to the report as row dimensions, and all
data is exported at this level.

e [f the report uses report parameters, those parameter selections are not reflected in the export.
Exception: If the report uses a dynamic column tied to a Column List report parameter, the
default value for that parameter will be used for the export.

NOTE: For reports created from template, refresh variable selections are applied to the
export.

Sharing a web report via email

You can share a web report with other Axiom Strategy Management users via email. The report can be
shared as a link to the live report, or as a PDF or Excel attachment. Sharing can be done while viewing
the report, or from the Reports Library in the Intelligence Center.

e When sharing the report from the Intelligence Center as a PDF or Excel attachment, the
attachment is generated using default settings. If the report requires user input to return data,
you should instead open the report and share from the report viewer.

e When sharing the report from the report viewer as a PDF or Excel attachment, the attachment
honors the current report state such as sorting, filtering, and drilling. Exception: report parameter
selections are not honored unless the report is built from template.

e When sharing the report as a link, the email recipient can click the link to log in to Axiom Strategy
Management and view the report within the application. The recipient must have at least read-
only security permission to the report in order to view it. When using the link, the report is
opened in its default state, and the user can explore the report as needed.

Any user who can view the report can share it. The report can be shared with any user in Axiom Strategy
Management, or any email address that the Axiom Strategy Management system can send email to.

NOTE: When sharing a web report as a PDF or Excel attachment, keep in mind that Axiom Strategy

Management does not enforce any security on these attachments. Any user who receives the email
can view the attachment.

To share a web report via email:
1. Inthe Intelligence Center, locate the report in the folder tree, or search to find it.
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2. Do one of the following:

e Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon and select Share from the menu, then select either Excel, Link, or PDF.

Name h g M

B Acct Analysis B 9/16/20]

B Budget Analysis @ Info 3/2/201
J Edit

[ Budget to Actuals Comparison & share > 2

[ Excel

+

B Corporate Dashboard = Export ¥ & Link 0]
D Copy A PDF

B Quarterly Performance f Delete 0]

e Click the report name to open the report. In the top right corner of the report, click Share,
then select either Excel, Link, or PDF.

Edit  Export = Share

Excel
Link

PDF

3. If you selected to share as either Excel or PDF, then complete the settings in the Share Report
dialog, and then click Share. The settings are the same as when exporting to Excel or PDF, except
that you do not specify a location to save the exported file—the file will be attached to the
sharing email. For example:

e For PDF, you can specify the file name, layout, orientation, margin size, and header/footer
content.

e For Excel, you can specify the file name and whether to export all drilling levels.
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NOTES:
¢ The Share Report dialog for Excel only displays if you are sharing from within the report
viewer, and only if the report is configured for directed drilling. Otherwise, the dialog
does not display and the file name of the Excel attachment will always be the report
file name.

e The PDF or Excel attachment is generated using the same behavior as when exporting
the file to PDF or Excel. For more information, see Exporting grid data in a web report
to Excel or Exporting a PDF copy of a web report.

¢ If you selected to share as a link, this dialog does not display and you are taken directly
to the E-mail dialog.

4. Inthe E-Mail dialog, select the recipients of the email. You can type email addresses into the To,
CC, and BCC boxes, or you can click the plus icon next to the recipient box to look up email
addresses for Axiom Strategy Management users:

* In the Select Users dialog, select the check boxes next to the users that you want to share
the report with.

¢ You can search on the user first or last name to find users.

* Once you have selected one or more users, click OK. The recipient box is populated with
the email addresses for the selected users. If the box already contained one or more email
addresses, the newly selected addresses will be added to the existing list.

If you are manually typing email addresses, separate multiple addresses with semicolons.
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E-mail X

To: jdoe@company.com

Cc:

EDE

Bce:

Subject: Sharing Expense Analysis

[A Expense Analysis.pdf

Attached is a copy of the expense analysis that we talked about]

Cancel

Example E-mail dialog

5. In the E-Mail dialog, complete the Subject and body text as needed.
e By default, the subject is set to "Sharing FileName".
e If you are sharing a link, the link is pre-populated into the body text.

6. Click Share to share the report and send the email.

e If you are sharing the report as a PDF or Excel file, the attachment is generated at this
point. If the report is large, there may be a delay while the attachment is generated.

e A notification message displays at the top of the page to indicate whether the email and its
attachment (if applicable) was generated successfully. Once the email is generated, it will
sent by the Axiom Strategy Management server using the standard
System.SMTPMessageDelivery job.
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Production reporting for web reports

Using production reporting features with web reports, you can generate and deliver report "snapshots"
to various audiences as needed.

e You can perform multipass processing on a web report over a specified dimension, such as by
department, region, or entity. The report is iteratively refreshed—one "pass" for each value of
the dimension—and during each pass a filter is automatically applied to limit the data to the
current dimension value.

e The output of each pass is a filtered PDF or Excel "snapshot" of the report. This static snapshot is
then saved to a target folder location—either a local folder in your network or the Axiom
repository—and/or emailed to a specified recipient. Folder locations and email recipients can be
determined dynamically so that the location and recipient changes as needed for each pass.

e Multiple PDF or Excel snapshots can be optionally collected into larger "report books" and then
dynamically saved and/or emailed as needed. For example, you might process three different
web reports by entity, and then collect the three resulting entity snapshots into a single file per
entity.

To perform multipass processing on a web report, use the Scheduler task Web Report Processing. This
task will process a target report by a specified dimension, and then save and/or email the output files as
configured in the task.

To collect output files into report books, use the File Collect option of File Processing. To do this, you
must create a spreadsheet report, enable it for file processing, and then configure file collect options.
Once it is configured, file collect processing can be run manually in the Desktop Client, or can be run
using the Scheduler task File Processing.

IMPORTANT: In phase one of production reporting for web reports, processing is only supported for
web reports created from product-delivered templates. Ad hoc web reports created in the Report
Builder cannot be processed yet. Support for ad hoc report processing may be added in a future
release.

Setting up web report processing

You can perform production reporting for web reports using multipass processing. The report can be
processed multiple times over a dimension, generating a filtered PDF or Excel copy of the report for
each value of the dimension. The report copies can be saved to a designated location and/or emailed to
designated recipients.

To perform multipass processing on a web report, use the Scheduler task Web Report Processing. When
you set up this task, you configure the following:

e The web report to process. You can process any web report created from a product-delivered
template.
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e The output format of the processing. Each pass will generate a filtered PDF or Excel output file.
The name of the file can be set dynamically using processing variables and job variables.

e The delivery option for the processing. Each output file can be saved to a folder location, emailed
to a recipient, or both.
o If the output is saved, you specify the location of the target folder (local or Axiom
repository) and the folder path. The folder path can be set dynamically using processing
variables and job variables.

° |f the output is emailed, you specify the recipients of the email, and the email subject and
body text. The recipients can be manually entered into the task settings (and can
optionally use job variables), or you can specify a table column to dynamically look up the
recipients. Recipients can be email addresses, or you can list user and role names to look
up email addresses from Axiom security. The email subject and body text can be set
dynamically using processing variables and job variables.

e The dimension to process. You can specify any dimension that will be compatible against the data
queried in the target web report. The web report will be processed once for each value in the
dimension. If desired, you can define a filter to limit the dimension values to process.

» Configuring a web report processing task

In order to create a Scheduler job with a Web Report Processing task, you must be an administrator or a
user with the Scheduled Jobs User permission. You must also have read/write access to at least one
folder in the Scheduler Jobs Library to save the job. Scheduler jobs can only be created in the Desktop

Client.

To create a Scheduler job with a web report processing task:
1. Onthe Axiom tab, in the Administration group, click Manage > Scheduler.

NOTE: In systems with installed products, this feature may be located on the Admin tab. In
the System Management group, click Scheduler.

2. Inthe Scheduler dialog, on the Job tab, click New.
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ID User
4575512 System.ProcessMotification System
4575500  Systemn.SystemDataPurge Systern
4575502 System.ndexMaintenance System

Status
Pending
Pending
Pending

3. Select the Tasks section of the job, then on the Job tab, click Add > Web Report Processing.
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4. Select the Web Report to Process. This is the report that will be processed by the task.
¢ Click the Browse button to open the Axiom Explorer dialog.

¢ Navigate to the web report that you want to process, then select the report and then click
Open.

The selected report is listed in the Web Report to Process box.

IMPORTANT: Remember, only web reports that are created from a product-delivered
template can be processed. The Axiom Explorer dialog is filtered to only show reports that
were created from template.
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i Scheduled Jobs | [7] New Job

General > Task Control
Variables v Task Details
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Event Handlers Web Report to Process: My Report.axwc Browse...
Notification
4 Tasks
Web Report Processing @ Advanced Options
Results

Example task with report selected for processing

5. Complete the general processing properties that determine the processing type and the output:

Iltem Description

Processing Select one of the following to determine the output format of each pass:

Type e Export to Excel (default): The contents of the report are exported to a
spreadsheet (XLSX) file. The output uses the same behavior as when
you export to spreadsheet while viewing the web report.

e Export to PDF: The report is saved as a PDF file. The output uses the
same behavior as when you save to PDF while viewing the web report.
Save or Email Select one of the following to determine the delivery method for the
Files output:

e Save Files (default): The output files are saved to the specified output
folder.

e Email Files: The output files are emailed to the specified recipients.
The output files are not saved anywhere on the file system.

e Save and Email Files: The output files are both saved and emailed.

Administrator's Guide Axiom Strategy Management | 338



Item Description

File Generation Select one of the following to determine whether the output is saved as a
single file or multiple files:

e Multiple Output files (default): The results of each pass are saved as
individual output files. For example, if the multipass settings result in
10 passes, then 10 output files are created (one file for each pass).

¢ Single Output File: The results of each pass are collected into a single
output file. For example, if the multipass settings result in 10 passes,
then the results of all 10 passes are placed in a single output file.

If the output type is Excel, then each pass is a separate sheet in the
Excel file. If the output type is PDF, then the PDF for each pass is
combined into one large PDF file.

File Name Specify how the output file (or files) should be named. You can do the
following:

e You can use processing variables and/or Scheduler job variables to
generate dynamic file names.

¢ You can type a "hard-coded" file name.

If the task will generate multiple output files, then the file name (or the
output folder path) must use a processing variable so that the output of
each pass is unique. If the task will generate a single output file, then
variables are not required.

To use a processing variable, you can type the variable or you can click the
pencil icon s to open a text editor. From the Insert Variable list, select
the variable that you want to use.

For example, you could set the file name to Income Statement
[Current Value]. If the report is being processed by region to multiple
output files, this will generate file names such as Income Statement
West, Income Statement East, and so on (where "East" and "West"
are region names).

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job
variables are enclosed in curly brackets.
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Item Description

Sheet Name

Specify how the sheet for each pass should be named. This property only

applies when the processing type is Export to Excel. You can do the
following:

e You can use processing variables and/or Scheduler job variables to

generate dynamic sheet names.

¢ You can type a "hard-coded" sheet name.

If the task will collect all of the output into a single spreadsheet file, then
the sheet name must use a processing variable so that the output of each
pass is unique. If the task will generate multiple output files, then
variables are not required.

To use a processing variable, you can type the variable or you can click the
pencil icon s# to open a text editor. From the Insert Variable list, select
the variable that you want to use.

For example, you could set the sheet name to [Current Value]. If the
report is being processed by region, this will generate sheet names such
as West, East, and so on (where "East" and "West" are region names).

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job
variables are enclosed in curly brackets.

i Scheduled Jobs

General
Variables
Scheduling Rules
Event Handlers
Motification
4 Tasks
Web Report Processing
Results

[ New Job

» Task Control

v Task Details

Browse...

Web Report to Process: My Report.axwc

@ Advanced Options

Processing Type: Export to PDF
Save or Email Files: | Save and Email Files
File Generation: Multiple Qutput Files

File Name: [CURRENT_VALUE]

Example task with general processing properties configured

6. Depending on the selected processing type (PDF or Excel), complete the properties specific to

that processing type:
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Export to PDF Settings

Item Description

PDF Select the orientation for the PDF, either Portrait or Landscape. Portrait is

Orientation the default orientation.

Page Size Select the page size for the PDF. You can choose from the following
standard page sizes: A3, A4, A5, Legal, Letter, or Tabloid. Letter is the
default size.

Export to Excel Settings

Item Description

Include Column Specifies whether column headers are included in the file output. By

Headers default this is set to On, which means column header text is included in
the first row of the spreadsheet. Column grouping headers and multi-row
headers are not included.

If this option is set to Off, then column headers are omitted from the file
output and the data starts in the first row of the spreadsheet.

Include total Specifies whether the total row is included in the file output. By default
row this is set to On, which means that the total row is included in the
spreadsheet.

If this option is set to Off, then the total row is omitted from the file
output.

NOTE: This option only applies when the web report being processed is a
dynamic row report with the total row enabled. If the web report being
processed uses a fixed row structure, then the total and subtotal rows
defined in the fixed row structure are always included in the spreadsheet.
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& Scheduled Jobs | [] New Job

General > Task Control

Variables v Task Details
Scheduling Rules

Event Handlers Web Report to Process: | My Report.axwc Browse...
Notification

4 Tasks
Web Report Processing @ Advanced Options
Results

Processing Type: Export to PDF
Save or Email Files: | Save and Email Files
File Generation: Multiple Output Files

File Name: [CURRENT_VALUE]

v Export to PDF Settings

PDF QOrientation: Portrait

Page Size: Letter

Example task with PDF-specific settings

7. If the processing is set to Save Files or Save and Email Files, complete the Output File Settings:

Item Description

Output To Select one of the following:

e Local File System (default): The output location is outside of Axiom
Strategy Management, to a location on your local network share. The
specific path is detailed in the Output Folder setting. Access to output
files is not controlled by Axiom Strategy Management.

e Axiom Repository: The output location is the Axiom Strategy
Management file system, within the Reports Library. The specific path
is detailed in the Output Folder setting. Access to output files is
controlled by security access to the designated folder within Axiom
Strategy Management.
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Item Description

Output Folder Specify the folder location for the file output. You can type a folder path,
or you can click the folder icon to browse to the folder location. The
browse dialog will display either your local file system or the Axiom file
system, depending on what you selected for Output To.

The output folder can be made dynamic as follows:

¢ [f File Generation is set to Multiple Output Files, then processing
variables can be used in the output folder path. For example, you can
include [Current Value] in the output folder path, and this will be
replaced with the current multipass value. Processing variables are not
valid in the output folder path if the task is configured to generate a
single output file.

e Scheduler job variables can be used in the output folder path.

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job
variables are enclosed in curly brackets.

Local file system

The output folder location must be entered as a UNC path, and must be
accessible by the Scheduler service user account (for on-premise systems)
or the Axiom Cloud Integration Service (for cloud systems).

The ability to save files to the specified location and access them after
saving is controlled by local network security.

Axiom repository

The specified location in the Axiom file system must be within the Reports
Library, and the location must use the full path (meaning:
\Axiom\Reports Library\...). The ability to save files to the
specified location and to create new folders (if necessary) depends on the
Axiom Strategy Management security permissions for the user processing
the file. Users can only create new folders if they have read/write
permissions to the parent folder, and they can only create new files if they
have read/write permissions to the target folder.

Once the files are created within the Axiom file system, access to those
files is dependent on the user's permissions to the output folder. Typically
you should create the output folder in advance (or if you want to create
output folders on-the-fly, create a parent folder to hold the output
folders), and then set permissions for that folder as appropriate in Axiom
Strategy Management security, so that the appropriate users will be able
to access the files after they are created.
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Item Description

Remote Data This option only applies when the file output is being saved to your local
Connection file system, and only for Axiom Cloud systems that are using remote data
connections.

Select the name of the remote data connection to use for the file
processing operation. The designated remote data connection will be
used to access the local file system and save output file(s) to the
designated location.

A remote data connection is required to save files locally from an Axiom
Cloud system. For more information, see the section on remote data
connections in the Scheduler Guide.

Purge Setting This option only applies when the file output is being saved to the Axiom
Repository.

If you want the file output to be automatically deleted after a specified
period of time, then click the pencil icon +* to open the Choose Date
dialog.

e No purge date (default): File output is not automatically deleted.

e Static purge date: Select a specific date, after which the output will be
deleted.

¢ Relative purge date: Specify a number of days to keep the output after
it has been generated. The output will be deleted after the specified
number of days have passed.
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4 Scheduled Jobs

General
Variables
Scheduling Rules
Event Handlers
Notification
4 Tasks
Web Report Processing
Results

[ New Job

> Task Control

v Task Details
Web Report to Process: My Report.axwc
@ Advanced Options
Processing Type: Export to PDF

Save or Email Files: | Save and Email Files

File Generation: Multiple Output Files

File Name: [CURRENT_WALUE]

> Export to PDF Settings

v QOutput File Settings
Output To: Axiom Repository

Output Folder: | \Axiom\Reports Library\File Processing

Purge Setting: Delete after 7 days

Example task saving output to the Axiom Repository

8. If the processing is set to Email Files or Save and Email Files, complete the Email Settings:

Administrator's Guide

Axiom Strategy Management | 345



Item Description

Recipient Optional. Specify a table column that holds the desired email recipients
column for each pass. This option only applies if File Generation is set to Multiple
Output Files, so that each pass will be sent a separate email.

You can type the name of a table column, or click the column button Ff to
select a column from the multipass table or a lookup table. (You must
select a multipass column first before you can use the column button to
select a column.) For example, if the multipass column is Dept.VP, the
recipient column might be Dept.VP.Email.

The specified column can contain any of the following: email addresses,
user login names, and/or role names. The column can contain multiple
values separated by a semicolon. The recipients listed in the column will
be used as the To address for the email (in addition to any recipients
listed directly in the To field). If the column contains a user login name,
that user's email address as defined in security will be used. If the column
contains a role name, the email will be sent to all users in the role.

To verify that the recipient column will resolve as you expect for each
pass, you can click the Preview Multipass List button in the Multipass
Data Settings section. The specified recipient column displays in this
preview so that you can see the recipient column values associated with
the multipass column values.

NOTE: The recipient column must have a one-to-one relationship with the
values in the specified multipass column.

To Specify the To recipient(s) for the email. This is required if a recipient
column is not specified. If a recipient column is specified, the recipients
listed here will be added to the recipients listed in the column for each
pass.

You can type one or more email addresses, user login names, and/or role
names. Separate multiple recipients with semicolons. If a user login name
is listed, that user's email address as defined in security will be used. If a
role name is listed, the email will be sent to all users in the role.

NOTE: If File Generation is set to Multiple Output Files, the recipients in
the To field will receive a separate email for each pass. The only way to
dynamically send the emails to different recipients per pass is to use the
Recipient Column option.

cC Optional. Specify the CC recipient(s) for the email. This field follows the
same rules as the To field.
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Item Description

BCC Optional. Specify the BCC recipient(s) for the email. This field follows the
same rules as the To field.

From Select one of the following to specify the From address for the email:

e Current User: The email will be sent from the user who executes the
Scheduler job.

e System User: The email will be sent from the designated From user for
Scheduler. This is the same value returned by the
{Scheduler.FromEmailAddress} job variable.

Subject Line Enter the subject line for the email. Processing variables can be used in
the subject line when File Generation is set to Multiple Output Files.

To use a processing variable, you can type the variable or you can click the
pencil icon # to open a text editor. From the Insert Variable list, select
the variable that you want to use.

For example, you could set the subject line to Monthly report for
[Current Value] in order to include the current pass value in the
subject line.

Body Text Enter the body text for the email. Processing variables can be used in the
body text when File Generation is set to Multiple Output Files.

To use a processing variable, you can type the variable or you can click the
pencil icon +# to open a text editor. From the Insert Variable list, select
the variable that you want to use.

Scheduler job variables can be used in any of the email settings except the From setting.
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i Scheduled Jobs | [] New Job

General > Task Control
Variables
Scheduling Rules
Event Handlers
Notification
4 Tasks
@ Advanced Options

Results

v Task Details

Web Report to Process: = My Report.axwe

Processing Type: Export to PDF
Save or Email Files: | Save and Email Files
File Generation: Multiple Output Files

File Name: [CURRENT_VALUE]

> Export to PDF Settings
> Output File Settings
~ Email Settings

Recipient Column: | Dept.VP.Email

To:

(G Finance

Bec

From: Current User

Subject Line: Monthly Report for [CURRENT_VALUE]

Body Text: Attached is the montly report for [CURRENT_VALUE]. Please contact Jane Doe in Finance with any questions.

Example task looking up email addresses from a recipient column

9. Complete the multipass settings for processing:
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Item Description

Multipass Specify the column to use for multipass processing. You can type a

Column Table.Column name, or click the column icon £ to select the column from
a dialog. You can select any column on a data or reference table, though
typically processing is performed by a dimension such as Dept.Dept, or a
grouping such as Dept.Region.

The report will be processed once for each unique value in the specified
column (except for any values excluded by the Source Filter). A filter is
applied to the data query in the report so that the data is limited to the
current pass value. For example, if you are processing by Dept.Dept, then
the report will be processed once for each department, and the report
data will be limited to only the data for that department.

Keep in mind the difference between processing by a data table column
such as GL2022.Dept, versus a dimension table column such as Dept.Dept.
When processing by GL2022.Dept, the report will be processed by each
department with data in the GL2022 table. When processing by
Dept.Dept, the report will be processed by each department in the Dept
table.

To verify the list of values for processing, click the Preview Multipass List
button to view the list of items. The first 100 values are shown, in the
order they will be processed. If the task configuration includes a Recipient
Column (in the email settings) or a Sort By column, these columns are
also shown in the preview.
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Item Description

Current Pass Optional. Define a header to display in the report output file. This option
Header only applies if the processing type is Export to PDF.

The current pass header should use processing variables to display
information about the current pass. To use a processing variable, you can
type the variable or you can click the pencil icon +# to open a text editor.
From the Insert Variable list, select the variable that you want to use.

For example, you can define a header such as:

Processed by [MULTIPASS COLUMN] [CURRENT VALUE]

When processing by Dept.Dept, this would resolve such as
Processed by Dept 22000

By default, if the current pass header is left blank, then the PDF output
will not include a header to indicate the current pass information.
However, it is possible that the template used to create the report may
have been designed with a dynamic header that will display this
information.

Sort By Optional. Specify one or more sort columns for the list of multipass
values. You can type a Table.Column name, or click the column icon £ to
select the column from a dialog. You can also optionally specify Asc or
Desc after the column name (ascending order is used if not specified). For
example: Dept.Dept Desc. Separate multiple values with semicolons.

By default, the values are sorted by the multipass column in ascending
order. The Sort By field only needs to be used if you want the values to be
sorted in descending order instead, or if you want the values sorted by a
different column in the same table.

The processing order is only relevant when File Generation is set to Single
Output File, since it determines the order of each individual pass within
the single file. When outputting to Multiple Output Files, the order is still
used during processing but it has no useful impact on the outcome.

Source Filter Optional. Specify a filter to limit the multipass list of items. You can type a
filter, or you can click the filter icon Y- to use the Filter Wizard.

When the multipass list of values is generated, any value that does not
meet the source filter will be excluded from processing.

By default, all values in the specified multipass column are processed if
the source filter is left blank.

Scheduler job variables can be used in any of the multipass settings.
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& Scheduled Jobs | [] New Job

General > Task Control

Variables v Task Details
Scheduling Rules
Event Handlers Web Report to Process: My Report.axwc Browse...
Notification - .
4 Tasks
Web Report Processing ® Advanced Options
Results

Processing Type: Export to PDF

Save or Email Files: | Save and Email Files
File Generation: Multiple Output Files
File Name: [CURRENT_VALUE]

> Export to PDF Settings

> Output File Settings

> Email Settings

v MultiPass Data Settings

Multipass Column: Dept.VP
Current Pass Header: | Processed by [MULTIPASS_COLUMN] [CURRENT_VALUE]
Sort By:

Source Filter:

10. Complete the remaining task and job settings as desired. For more information, see the Scheduler
documentation. Note the following:

e Generally speaking, the Advanced Options displayed at the top of the Web Report
Processing task should only be modified as advised by Axiom Support.

» If you want to schedule the job for execution at a later date and/or time, including setting
up recurring execution, use the Scheduling Rules section of the job.

e If you want to use Scheduler job variables in any task settings, these variables should be
defined in the Variables section of the job.

e |tis recommended to review the Notification settings for the job and adjust them as
needed. By default, Scheduler jobs are configured to send an email to the user who
executed the job when the job completes, regardless of the job status.

11. On the Job tab, click Save to save the job.

12. Inthe Axiom Explorer dialog, select a folder location in the Scheduler Jobs Library and define a
name for the job, then click Save.

If the job settings included an active scheduling rule, this rule is evaluated when the job is saved and the
next scheduled execution is added to the Scheduler job queue.
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» Executing web report processing

Once you have set up a Scheduler job with a Web Report Processing task, you can execute the web
report processing by executing the Scheduler job. Scheduler jobs can be executed on demand by using
the Run Once feature within Scheduler, or you can schedule the job for future execution by defining and
saving a scheduling rule in the job. Scheduler jobs can also be executed on demand using RunEvent,
such as to kick off the Scheduler job from a custom task pane, Axiom form, or spreadsheet Axiom
report.

When web report processing is executed, the following occurs:
e The list of multipass values to process is obtained using the Multipass Column limited by the
Source Filter, sorted in the default or specified sort order.
e The specified report is processed once for each value in the multipass list.
° The report data query is filtered by the current pass value and the report data is refreshed.
° A PDF or Excel copy of the report is generated, depending on the specified Processing
Type.
 If the File Generation is Multiple Output Files, then the output file for each pass is saved and/or
emailed according to the task configuration.

¢ |[f the File Generation is Single Output File, then the result of each pass is saved in temporary
storage and then merged into a single file once all passes are complete. This single file is then
saved and/or emailed according to the task configuration.

Each pass of multipass processing can succeed or fail independently without affecting the other passes.
For example, imagine the multipass list has 10 items. Pass 1 fails because the specified recipient column
does not contain a valid email address, user name, or role for the pass 1 value. This pass-level failure
does not stop passes 2-10 from being processed. The job status will report partial success in this case.

A Scheduler job can contain multiple Web Report Processing tasks, followed by a File Processing task to
collect the various output files into "report books", and then save and/or deliver the collected books.
For more information, see Setting up file collect with web report processing.

» Using processing variables

The following processing variables can be used in various settings within the Web Report Processing
task, in order to dynamically change the setting using information for the current pass.
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Item Description

[CURRENT_VALUE] This variable returns the current multipass processing value. For
example, if you are processing by Dept.Dept, and the current pass is
for department 20000, the variable will be replaced by the value
20000" for this pass.

This variable is typically used in settings such the file name, sheet
name (when generating Excel output), and folder path.

[CURRENT_PASSNUMBER] This variable returns the current pass number. For example, if the
current pass is number 20 of 35 passes, the variable will be replaced
by the value "20" for this pass.

[MULTIPASS_COLUMN] This variable returns the name of the multipass column. For example,
if you are processing by Dept.Dept, the variable will be replaced by
the value "Dept" for all passes.

This variable could be used whenever you want to reference the
name of the dimension processed. For example, instead of just
referencing the current value in the file name, you might want to
reference the column name and the value. A variable construction
like [MULTIPASS COLUMN] [CURRENT VALUE] would resolve to
"Dept 20000" when processing by Dept.Dept and the current pass is
for department 20000.

Processing variables can only be used in certain settings, and sometimes only when the output is
multiple files (versus a single file). See the documentation for each individual setting to see if processing
variables are supported in that setting.

NOTE: Processing variables and Scheduler variables use different syntax. Processing variables are
enclosed in square brackets. Scheduler job variables are enclosed in curly brackets.

» Using Scheduler job variables in task settings

Scheduler job variables can be used in any Web Report Processing task setting that you can directly type
into, such as the file name, sheet name, folder path, and various email settings. To use a Scheduler job
variable, you first define the variable on the Variables tab of the job, then you enter the variable in the
desired setting using curly brackets. For example, if the variable name as defined on the Variables tab is
columnname, then enter {columnname} in the task setting. When the job is executed, the variable in
curly brackets will be replaced by the current value of the variable.

Scheduler job variables are useful when you want a task setting to change dynamically based on a
variable value that gets passed to the Scheduler job. Various processes in Axiom Strategy Management
can trigger a Scheduler job for execution and pass variable values to the job. Additionally, previous tasks
in the job can set a variable value that is then passed to subsequent tasks in the job.

Administrator's Guide Axiom Strategy Management | 353



NOTE: Processing variables and Scheduler variables use different syntax. Processing variables are
enclosed in square brackets. Scheduler job variables are enclosed in curly brackets.

» Using Scheduler job variables to pass refresh variable values

If the web report uses refresh variables, Scheduler job variables can be used to pass variables to these
variables. For example, in some cases the report may require certain refresh variables to be set before
data can be queried. In this case, the Scheduler job must pass values for these required refresh
variables. The refresh variables will be used to refresh data for each pass, in addition to the multipass
filter for the current pass.

In order to pass a Scheduler job variable value to the report as a refresh variable value, special syntax is
used for the job variable:

ReportVariable.VariablelID
Where ReportVariable is a dedicated keyword that tells processing to apply the variable as a
report parameter, and VariablelD is the name of the specific report parameter.

For example, the report may contain a refresh variable that specifies the grouping level (row dimension)
of the report. This refresh variable takes values such as Dept, WorldRegion, Country, and so on.

Choose Grouping Column

( Dep v

Dept
Description
WorldRegion
Country
Region
Currency

VP

Example refresh variable

In this example, the ID of this refresh variable is groupingColumnvar. Therefore to pass a value to this
refresh variable, a Scheduler job variable named Reportvariable.groupingColumnVar can be
used. This variable must be assigned a value that exactly corresponds to a value that can be selected for
the refresh variable within the Refresh Variables panel.

Administrator's Guide Axiom Strategy Management | 354



4 Scheduled Jobs [] New Job

General Job values

:i:::ii_s Rules Variable Name Default Value
uling Ru i

Event Han?ilers i ReportVariable.groupingColumnVar Region

Notification
4 Tasks
Web Report Processing
Results

When this report is processed, the value for this refresh variable will be set to Region.

NOTES:

* The processing variable [Current Value] can be used as the variable value, if it will resolve
to a valid value for the refresh variable. In this case, the value of the variable will change
dynamically for each pass.

e Because the variable IDs are not exposed on the report, this feature is primarily useful for
product developers to deliver a pre-configured Scheduler job with a product.

Setting up file collect with web report processing

You can combine web report processing with the File Collect feature to create and deliver "report
books". For example, you may have three different reports that you want to process by region, then you
want to collect the output into region-specific report books to deliver to each regional manager.

This process works as follows:
e You set up multiple Web Report Processing tasks in Scheduler to process the web reports and
save the output to a designated location. The output can be PDF or Excel.

e You set up File Collect in a separate spreadsheet utility to collect the output from the Web Report
Processing tasks. This configuration specifies:

° The type of files to collect, PDF or Excel.

° The source folder(s) from which to gather the files to collect.

° The file filter to specify the files to collect.

° The file name of the output file, and the file type if applicable—PDF files can only be
collected as PDF, but Excel files can be collected as either PDF or Excel.

° The delivery method of the output file—save only, email only, or save and email—as well
as the output folder and email settings (as applicable).

° Qptional common files to include in each output file, such as a cover page.

° QOptional multipass column to perform the file collect operation iteratively over a
dimension

e You set up a File Processing task in Scheduler and configure it to run the File Collect report utility.
Typically all of the tasks would be in a single Scheduler job, so that the Web Report Processing
tasks are run first, then the File Processing task runs afterward to perform the final collect
operation.
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File Collect is an option of File Processing. It can be used to collect any PDF or Excel files, regardless of
how they are generated. For more information on how to configure file collect, see the File Collect
documentation.

The following example shows a Scheduler job with three Web Report Processing tasks and one File
Processing task. The three Web Report Processing tasks are used to process three different web reports
by region and then save the output files to a designated folder in the Axiom Strategy Management
repository.

A | Axiom Scheduler - Web Report Collect Example ? X

Job Service

T, re/ ; > 4

L 4 H D [=ar ¥ = =
New Open Save Close Run Add Move Remove Clear
Once - Down Selected All

i Scheduled Jobs | [7] Web Report Collect Example

General |['> Task Control

Variables v Task Details
Scheduling Rules

Event Handlers Web Report to Process:  Report1.axwc Browse...
Notification
4 Tasks
Web Report Processing - Report 1 @ Advanced Options
Web Report Processing - Report 2
Web Report Processing - Report 3

File Processing - File collect Processing Type: Export to PDF Y
Results

Save or Email Files: | Save Files e

File Generation: Multiple Qutput Files ¥

File Name: [CURRENT_VALUE]_Report1 7

> Export to PDF Settings

> Qutput File Settings

v MultiPass Data Settings

Multipass Column: DEPT.Region 20|
Current Pass Header: = Processed by [MULTIPASS_COLUMN] [CURRENT_VALUE] s
Sort By: il
Source Filter: Y

Example Scheduler job with multiple Web Report Processing tasks

The File Processing task is used to run the File Collect report utility once all of the Web Report
Processing tasks are completed. Note that the File Processing task simply points to the spreadsheet
report that contains the File Collect configuration; the settings are not defined within the Scheduler job.
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Job Service
s, 2
L} o | b
New Open Save Close Run
Once

u Scheduled Jobs

General

Variables

Scheduling Rules

Event Handlers

Notification

4 Tasks

Web Report Processing - Report 1
Web Report Processing - Report 2
Web Report Processing - Report 3

File Processing - File collect

Results

A | Axiom Scheduler - Web Report Collect Example

=r W T
Add Move Remove Clear
S Up Selected  All

[ Web Report Collect Example

» Task Control
~ Task Details

File to Process: PDF File Collect Multipass.xlsx

[ Process File Multipass
|| Enable iterative calculation while processing

File Processing Settings
Processing Type:  File Collect

Sheets to Process: FileCollect

MultiPass Settings
» MultiPass Data Settings

> MultiPass Filter Settings

Batch Variables:

Browse...

[] Override

[] Override

Preview Multipass List

Example Scheduler job with File Processing task to run the File Collect operation

The following screenshot shows an example of how the File Collect settings could be configured within
the spreadsheet report. The File Collect operation will be performed using multipass processing by
region. The file filter will collect all files in the source folder location based on the current pass region
name, then save and email the output file. The email address and file name settings use a formula with
a GetCurrentValue function in order to dynamically set the email address and file name for each pass.
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< Axiom Assistant

File Processing Settings Q
2| Processing Type: | File Collect v
g
= Sheets to Process: [FileCollect Q
£ MultiPass Settings Show Advanced View
£

Source Column: | DEPT.Region m
§
= Actions
% [B Refresh file lists in selected column(s
| [ Refreshallfile lists
2 (3 Add additional package columns
<
o 3 Addnew source folder section
g
2| [ Addnewfile collect sheet
s
8| B Processfile

A Process file multipass

Notifications

cessing

AlHome [2) test_drill [2) POF File Collect Multipass Screenshot x
LE =
u1 2(3 B JI © DE F G H |
1 FILE COLLECT CONFIGURATION
8 | Package name (Optional) [Common Files | [Report Book
9 Active On
}(2 Source File Type (Excel or PDF) PDF
13 Email Settings
14 | Email to list Commean Files are added at the beginning | jdoe@mycompany.com
15 | Email CC list of a package if 'Include common files in
16 Email from package' is set to 'On’ noreply@mycompany.com
17 | Subject text Monthly Report Book
Body text Attached is your regional monthly report book
18 for June.
19 Message priority Normal
20 Attach file to email On
21 Attach each file separately (don't combine them into one) Off <-
= 22
23 Source Folder Settings
24 File source (Axiom or Local) [Axiom Repository | [Axiom Repository
26 | Source folder path \Axiom\Reports Library\File Processing\Axiom\Reports Library\File Processing
27| Filefilter list Wgy—|
28 (Multipass only) Filter template (e.g. {Dept.Dept}_*.xIsx) I *{Dept.Region}*.pdf <
30 Source folder path
31| Filefilter list
32| (Multipass only) Filter template (e.g. {Dept.Dept}_*.xlsx)
= 33
34 Output File Settings
35 | Output location (local file or Axiom) Axiom F itory
36| Outputfile purge setting (Axiom files only) - can be a static purge date or number of days
37 Output folder path \Axiom\Reports Library\Monthly Reports
38 Remote Data Connection Name
39 | Output file name (no extension) Region_West_MonthlyReportPackage
40 Output file type pdf
41 | Saveoremail generated files Save File and Send Email
= 42
43 | File List Settings
= 44| Auto-generate file list [on | [on
45| Continue On Error lon | [on
46 | Include commen files in package On
47
48 List File List
49
50 \Axiom\Reports Library\File Processing\Axiom\Reports Library\File Processing
51 cover.pdf West_Report1.pdf
52 West Report2.pdf
53 West_Report3.pdf
54
55

Example File Collect configuration to collect the PDF output into a PDF report book
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Administering Security

The Axiom Strategy Management system administrator manages security in the Axiom Strategy
Management subsystem. To manage security, the system administrator needs to have the Security
Admin role.

NOTE: Currently, system administrators need to add users and assign user roles by accessing the
Security Management window from the Desktop Client.

Security is integrated at all levels of Axiom Strategy Management, meaning that no matter where you
are in the system, you can only view data and use features for which you have the appropriate access.

Security in the Axiom Strategy Management is based on the following:

e Logon — Allows users to log on to the system.

e Subsystem — Gives users access to one or more Axiom Healthcare Suite products licensed by your
organization.

* Role — Determines which assets you have access to. Assets include icons, tools, report, utilities,
task panes, and so on. Users may have multiple roles. For example, a user might be an
administrator for Axiom Strategy Management but an end-user for another Axiom product.

» Filter — Restricts the data that you can view for each asset. For example, you may have access to a
specific report, but the report may only display specific information based on department.
Typically, you are restricted to your specific department or entity while administrators have
broader access.

About user roles

All user roles in Axiom Strategy Management, except the Strategy Management Administrator role, are
additive, which means you can assign a user multiple roles as needed, with each assigned role adding
rights. You can assign users as many roles as necessary to do their work, but the best practice is to add
no more rights than the user needs. The starting role for everyone but administrators is the Strategy
Management User role, which you assign to each new user as you add them to the Axiom Strategy
Management subsystem.
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» Axiom Everyone

This role provides access to the Axiom platform functions with which Axiom Strategy Management is
integrated. All Axiom Strategy Management users are given this role by default when you add them to
Axiom Strategy Management if they do not already have this role from having access to another Axiom
product. This role cannot be configured by the Axiom Strategy Management Admin.

» Strategy Management User

This is the baseline role in Axiom Strategy Management. All users except Strategy Management
administrators are assigned this role; it provides access to general navigation and core functionality
within the Web Client. This role is preconfigured and should not require additional configuration after
the initial system is set up. The following tabs refer to those in the Security Management dialog
accessible from the Excel or Windows Client. Baseline access includes:

Tab Access to

Permissions None

File Groups Can query Strategy Management — Requests

Tables SMReference — Full Read access on all tables except Initiative, unless the user is

the designated owner or sponsor for an Initiative; in which case, the user has
access to only those Initiatives for which they are owner or sponsor.
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Tab Access to
Files Reports Library > Strategy Management Utilities > Home Pages

¢ Dashboard — Read only

© Can drill down to view details on Perspectives and Perspective measures,
including measure data and KPI icons

© Can view list of Objectives but not view performance data or KPI icons,
unless the user owns the Objective
e Perspectives — Read only
° (Can see all enabled Perspectives

© Can drill down to view Perspective measure details but not related
Objective measures

° Cannot see Baseline, Prior, Current, or Target information for related
Objective measures unless the user owns the related Objective
¢ Objectives — Read only

° Cannot view Objective measure data or KPI icons unless the user owns
the Objective

° Cannot drill down to details unless the user owns the Objective

© Cannot view associated Initiatives unless the user is the owner or
sponsor for the Initiative

* |nitiatives — Read only

° Additional Initiative role required to see Initiative names and Initiative
data, except for Initiatives the user owns or sponsors

e Admin pages — No access

» Strategy Management Executive

This role adds the following access rights to the Strategy Management User role:

e Provides full read access to Objectives, Initiatives, and measures information.
* File Groups tab — Adds Read Only access to all plan files

e Tables tab > SMReference

© Adds full Read access to the Initiative table

» Strategy Management Initiative Creator

This role adds the ability to create Initiatives and submit them for review and approval using the
Initiative Approval Process Management workflow. Only users with this role can create Initiatives in the
Web Client. System administrators cannot create Initiatives in the Web Client without the Initiative
Creator role. System administrators can add Initiatives in the Excel or Windows clients using the import
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Initiatives utility.

NOTE: This role requires the user to have either the Strategy Management User role or the Strategy
Management Admin role.

» Strategy Management Initiative Owner

This is not strictly a “user role” because it is not managed in the system security settings, it is assigned
by the Initiative creator when they create the Initiative. This adjunct role enables the user to review and
modify an Initiative when it is in the Owner Review stage of the Initiative creation approval process, to
update an Initiative’s measure data and milestone status when the Initiative is in the Active Tracking
stage of the Initiative update approval process, and to approve an Initiative as Complete in the Pending
Reset stage of the Initiative completion process. An Initiative owner can also abort an Initiative at the
Active Tracking step in the Initiative creation approval process and the Initiative update approval
process.

NOTE: Users can only be assigned this role if they already have the Strategy Management User role.

» Strategy Management Initiative Sponsor

This is not strictly a “user role” because it is not managed in the system security settings, it is assigned
by the Initiative creator when they create the Initiative. This adjunct role enables the user to review and
modify an Initiative when it is in the Sponsor Review stage of the Initiative creation approval process.
This role also enables the user to review and approve Initiative measure data in the Active Review stage
of the Initiative update approval process.

NOTE: Users can only be assigned this role if they already have the Strategy Management User role.

» Strategy Management Initiative Approver

This role enables the user to approve Initiatives into the Active Tracking stage of the Initiative Approval
Process Management workflow, or to reject or abort Initiatives. This role also enables the user to view
comments and submission history for Initiatives.

NOTE: Users can only be assigned this role if they already have the Strategy Management User role.

This user role adds the following rights:
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Tab Access to

File e Dashboard — Read only
© Can see Subscribed Initiatives in list
© Can access Initiatives approval process task page

e Perspectives — Read only
© Can see all Initiatives related to each Objective and can click to access
Initiative-related pages
e Objectives — Read only

© Can see all Initiative information and click to access Initiative-related
pages (but still cannot see Objective measure data unless user is
Objective owner)
* |nitiatives — Read only
° Can see all Initiative names and Initiative summary data
© Cannot create an Initiative

° (Can click to go to Initiative plan file page, approval process routing page

» Strategy Management Admin

This role grants the user system administrator access, including access to all Axiom Strategy
Management tools and tables from the Excel or Windows Client. This role does not require the Strategy
Management User role be assigned in addition. This role does not provide the ability to assign roles to
users.

Tab Access to

Permissions e Administer announcements
e Administer Axiom Explorer
¢ Administer tables

¢ Scheduled jobs user (can use Scheduler in Desktop Client for the following
jobs: SM_CreatePlanFiles, UpdateMeasureData-SQL, and
UpdateMeasureTarget-SQL)

File Groups Can query Strategy Management — Requests

e Create Plan Files (in the Excel and Windows clients)
e Create new records

¢ Run Axiom Queries

Tables SMReference — Full access

Data — Full access
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Tab Access to

Files Reports Library > Strategy Management Utilities > Home Pages

¢ Objectives — Full Read access
e |nitiatives — Full Read access

e Admin pages — Full access

» Security Admin

This role grants the user the ability to add users to the Axiom Axiom subsystem and to assign other
Strategy Management roles.

e Permissions tab

° Administer Security — Security Management utility for managing users, user roles, and
access to the Axiom Strategy Management subsystem

Add a user

Use these instructions to add a user to Axiom Strategy Management. Every user is first assigned the
Strategy Management User role unless that user is assigned the Strategy Management Administrator
role.

NOTE: You must have the Security Admin role to be able to access the Security Manager and assign
roles to users.

To add a user to Axiom Strategy Management:
1. Launch the Desktop Client.

In the Ribbon, click the MAIN tab.

In the Security section, click Security Manager.

2

3

4. Inthe top left corner of the Security Management dialog, click Users.

5. At the bottom left of the dialog below the list of users, click the Create user plus () icon.
6

In the User Details section of the General tab, add the user’s information. For information, go to
the Axiom Desktop Client help and search on “defining user properties.”

7. At the bottom right of the Security Management dialog, click Apply.

NOTE: You cannot assign roles or a subsystem to the user until you click Apply.

8. Inthe Assigned Roles section, click the Add plus (4) icon.

9. Inthe Assign Roles dialog:
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a. Scroll to the bottom of the Available Roles column and click Strategy Management User.
b. Click Add to move the role to the Assigned Roles column.
c. Click OK.

10. Inthe Assigned Subsystems section, click the Add plus () icon.

11. Inthe Available Subsystems column of the Assign Subsystems dialog:
a. Click Strategy Management.

b. Click Add to move it to the Assigned Subsystems column.

c. Click OK.
12. Click Apply.
13. Click OK.

Assign roles to users

You can assign roles to a user at any time after adding the user to the Axiom Strategy Management
subsystem and giving them the Strategy Management User Role in the Security Management utility.

These instructions assume that the user already has the Security Management User role and has been
added to the subsystem.

NOTE: You must have the Security Admin role to be able to assign roles to users.

To assign roles to a user:
1. Launch the Desktop Client.

2. Inthe Ribbon, click the MAIN tab.
3. Inthe Security section, click Security Manager.
4. Inthe top left corner of the Security Management dialog, click Users.

5. Locate and select the user in the list of names.

NOTE: If the list is long, you can clear the Disabled check box to view only active users, or you
can type the user’s name in the search field above the list.

6. Inthe Assigned Roles section of the General tab, click the Add plus (&) icon.

7. In the Assign Roles dialog:

a. Scroll to the bottom of the Available Roles column and select the desired role.

b. Click Add to move the role to the Assigned Roles column.
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c. Repeat until you have added all the desired roles for the user.

d. Click OK
8. Click Apply.
9. Click OK.
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A

Reference

This appendix contains reference information for administrators configuring and maintaining Axiom
Axiom.

Launch the Desktop (Excel or Windows) Client

Use the following instructions to launch either the Windows Client or the Excel Client from Axiom
Strategy Management.

To launch one of the spreadsheet clients:

1. In the Global Navigation bar (blue bar at top of page), click the Quick Launch icon m).

2. Inthe Quick Launch menu, click the desired Desktop Client (Windows or Excel).

E L es AXIOM

Launch
Am A
Windows Excel
Client Client
Add-Ins
MS Word MS PowerPoint
Add-In Add-In

The application launches.
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Get Perspective icons

Axiom Strategy Management uses free icons from Font Awesome. Only icon names from Font Awesome

will work.
1. Go to Font Awesome and search for the icon you want or review the available lists.
2. Locate the desired icon in the list and click it. A new page opens for that icon. The code for the
icon displays below a picture of the icon.
3. Use your cursor to highlight just the code, as shown in the following example.
h Font Awesome Home WhatsNew GetStarted Icons * Examples ¥  Accessibility Community
* { i "I" + .
* +}+ - Unicode: f047 - Created: v1.0 - Categories: Web Application Icons, Directional lcons
4. Right-click the highlighted name, and select Copy.
5. In Axiom Strategy Management, navigate to the desired Icon field, place your cursor in the field,
right-click and select Paste.
6. Click Save.
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About measures

Axiom Strategy Management uses data collectors called measures to determine how the items in the
strategy hierarchy—Perspectives, Objectives, and Initiatives—are performing currently and over time.

Each measure captures specific data. For example, if an Objective is to improve patient access to care,
you could assign a measure that records the average time it takes for a patient to schedule a primary
care visit.

Measure data is updated on a regular schedule according to the measure’s frequency; the default is
monthly. The system administrator updates Perspective and Objective measure data. Initiative measure
data is typically updated by the Initiative owner, or an administrator can also update them if needed.

Each measure has some or all of the following attributes:

Description — Measure name
GL Acct — General Ledger account in which the measure belongs

Precision — The number of decimal values that display for units when the system displays
measure data in Measure Detail windows

Class — Category in which the measure belongs
Type — Method used for updating the measure

Unit — Format type of the data the measure produces (i.e., amount for currencies, percent for
percentages, number for other numeric data)

Frequency — How often the measure data is updated and reported
Formula Description — Optional. How the measure data is derived, if applicable
User Drill — Optional. Indicates the measure has an associated drill document

Enabled / Disabled — Whether or not the measure is available to be selected for hierarchy items
(Perspectives, Objectives, and Initiatives)

MeetsTargetDirection — Direction of the measured data (higher or lower) that is favorable when
the data is compared to the set target

When measures are assigned to Perspectives, Objectives, or Initiatives, they receive the following
additional attributes:

Baseline — Starting point at which data measurements begin. This can be from the current year or
a historical average for the past 12 months.

e Target — The number used as a comparison point against which measure data is compared to

determine if the data is favorable or unfavorable. The person assigning the measure to a
Perspective, Objective, or Initiative, sets the target. The target typically comes from either a
benchmarked or budgeted number.

Period Begin — (Called Start Date in Initiative measures) The starting date for which measure data
is collected and recorded. This date typically coincides with the start date of the Initiative.
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e Period End — (Called End Date in Initiative measures) The date measurement data stops being
collected and recorded.

e Department — Optional. The department from which the measure data is taken

e Entity — Optional. If a department is selected, then the entity is the higher-level section of the
organization (e.g., location, building), or the organization itself, that the department belongs to. If
no department is specified, then the entity is the part of the organization or the entire
organization from which the measure data is taken.

About Key Performance Indicator icons

Axiom Strategy Management displays Key Performance Indicator (KPI) icons to represent current status
as compared with set targets and to show period-over-period trends. KPls use measurements of active
data to reflect whether the hierarchy item they apply to is performing favorably, unfavorably, or a mix
of both, as compared to the target set in the item’s measure.

How the system determines KPI icon use

The system displays KPI icons to provide at-a-glance performance status for Perspectives, Objectives,
and Initiatives. Perspective and Objective KPIs reflect their measure data. Initiatives are different in that
their KPl icons represent the status of their milestones. For more information, see About Initiative
milestones.

KPI icons represent a value judgment of whether the data measured is favorable or unfavorable
compared to the target set in the measure when the measure is applied to a Perspective or Objective.

Measured data can be higher than, lower than, or right on the target. Whether data above the target or
below the target is favorable or unfavorable depends on what is being measured. For example, when
measuring profitability, data above the target is favorable. However, if the measure tracks the number
of patient falls, then your target would be the maximum number of falls considered acceptable in a
period, and a number at or below the target would be favorable. The direction of the data—above or
below the target—that is favorable, is called the MeetsTargetDirection attribute. The
MeetsTargetDirection attribute is defined when the measure is created.

In the following example, a Perspective measure tracks the AHRQ Patient Safety Indicator Composite for
serious complications. For this measure, the MeetsTargetDirection is set to Lower. The target is set to
the number 50. The current measurement is 47, which is lower than the set target, so the current
measurement is favorable. The icon used to represent the measure’s current performance is called a
performance icon. In this case, because the performance is favorable, the icon used is a check mark in a
green circle.
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Notice that the current measurement is lower than the prior measurement, which indicates improved
performance over time. In Axiom Strategy Management, performance over time is called trend. When
data is moving in a favorable direction from the previous measurement, the trend is favorable, which is
represented by a green, up arrow icon.

B Clinical Performance

Measure 1 Measure Description Entity Dept Unit Baseline Prior Current Target

dicator Composite (Serious

sl 837 0 0 Number 75.00 48.81 47.00 50.00

Performance . Prior Current
K Trend icon Target
icon measurement measurement

Icons and icon colors indicate status: a check mark indicates favorable, an exclamation mark indicates
unfavorable. Green represents favorable data, and red represents unfavorable data. Orange indicates
the status is a mixture of favorable and unfavorable data if the icon is a performance icon. For a trend
icon, orange indicates the trend is flat, meaning it is moving neither favorably nor unfavorably as
compared to the previous frequency period measurement.

The following example of the list of Objectives from the Dashboard page displays each Objective’s KPI
and trend icons.

Objective Performance

Accelerate resource optimization - clinic space, scne du d, sla

o Attract and Retain Top Talent
Earn Highest Patient Satisfaction and Experience Scores
Earn Industry Leading Patient Satisfaction & Experience Scores
ED Wait Time Reduction, Improve Patient Fle
Effectively Manage Controllable Supplies Expense related High-Cost | ants &
Effectively Manage Labor Cost and Product n-line with Industry Best Pract
srow Primary Care Market Share 10

For detailed descriptions of each icon used in the system, see the following tables.
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Key Performance Indicator icons

Axiom Strategy Management uses two kinds of KPI icons: performance and trend. Performance icons
come in two types: single-measure and roll-up measure. Single-measure icons reflect the status of a
single measure, whereas roll-up measure icons reflect a combination of two or more measures.

» Performance icons for hierarchy measures

This table lists the performance icons used for Perspective, Objective, and Initiative measures.
Performance icons represent the status of measurements for a single frequency period.

Icon Meaning

This icon indicates the hierarchy item’s measure is performing favorably compared
to the set target. The system displays this icon to represent the performance of a
single measurement or multiple measurements that are performing favorably.

This roll-up icon indicates that the hierarchy item’s measure performance is a mix of
favorable and unfavorable measurements compared to the set target.

This icon always represents a roll-up measurement. This icon also always represents
a mix of favorable and unfavorable measurements for the item being measured,
regardless of how many of the measurements are favorable or unfavorable. For
example, if a Perspective has four measures and three of them are favorable and one
is unfavorable, this performance icon is used; likewise, if three of the measures are
unfavorable and one is favorable.

This icon indicates that the item is performing unfavorably compared to the target.
The system displays this icon to represent the performance of a single measurement
or multiple measurements that are all performing unfavorably.

- This icon indicates that either no data is available for the item or that you do not
b
— have permissions to view that data.

» Trend icons for hierarchy measures

Trending is determined by comparing the measure value of the current frequency period to the previous
frequency period. In the case of roll-up measures, this is evaluated by comparing the previous period
performance (i.e. green, red, orange) to the current period performance. Trend icons apply only to
measure data performance, not Initiative milestone performance.

Icon Meaning

The item is trending favorably. This means the performance is headed in a favorable
direction compared to the previous measurement.
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Icon Meaning

The item is trending flat. This means the performance is trending neither favorably nor
unfavorably compared to the previous measurement.

v The item is trending unfavorably. This means the performance is headed in an
unfavorable direction compared to the previous measurement.

The item contains no data, or you do not have permissions to view the data.

Icon combinations

The following table lists the possible performance-trend icon combinations and their meaning.

Icon set Meaning

0 - Performance is favorable compared to the target, and trending favorably
compared to the previous measurement.

0 Performance is favorable compared to the target, and trending flat, neither up
nor down, compared to the previous measurement.

o v Performance is currently favorable compared to the target, but trending
unfavorably.

Performance is a mixture of favorable and unfavorable measurements
compared to the target, and is trending favorably compared to the previous
measurement.

F

Performance is a mixture of favorable and unfavorable measurements
compared to the target, and is trending flat compared to the previous
measurement.

Performance is a mixture of favorable and unfavorable measurements
compared to the target, and is trending unfavorably compared to the previous
measurement.

v

Performance is unfavorable compared to the target, and trending favorably
- compared to the previous measurement.

Performance is unfavorable compared to the target, and trending flat compared
to the previous measurement.

Performance is unfavorable compared to the target, and trending unfavorably
v compared to the previous measurement.

There is no performance or trend data available for the item, or you do not
have permissions to view the data.
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About Initiative milestones

When creating an Initiative, users can set milestones to track the life cycle of the Initiative. Milestones
provide a way to ensure that the Initiative project gets launched on time, that work gets done according
to schedule, and that Initiatives are completed on time. Milestones are tracked monthly.

Unlike Perspectives and Objectives, Initiatives do not have begin and end dates; instead, an Initiative’s
life cycle begins at creation and ends when all of its milestones are complete and the Initiative no longer
needs to collect measure data. However, since an Initiative supports an Objective, the Initiative’s
milestone time frames need to fall within the associated Objective’s Period Begin and Period End dates.
To ensure this happens, each newly-created Initiative comes with two built-in milestones:

¢ I|nitiative Kickoff — Uses the current date as the milestone’s start date.

¢ Initiative Completion — Uses the last day of the month of the Period End date of the associated
Objective as the milestone’s start and end dates. For example, if the Objective Period End date is
June 2021, the Initiative Completion milestone dates will be June 30, 2021.

NOTE: The system only displays Objective dates on the Admin Maintenance page to system
administrators.

Before submitting the Initiative for approval, if you delete both of these Initiatives without adding any
others, save the file and then go back to the plan file page, the default Initiatives will be restored.
(However, if the milestones are deleted during the owner or sponsor review stages, the Initiatives are
not restored.) This is a safeguard to prevent creating Initiatives with no milestones. While you can save
an Initiative without milestones, the best practice recommendation is to have at least one Milestone per
Initiative. This is especially important because Initiative status is derived from milestone status. You do
not have to add all the milestones before submitting the Initiative for approval; the Initiative owner or
sponsor can add milestones before the Initiative is approved to active tracking.

After the Initiative has been approved to the Active Tracking stage, Initiative owners and sponsors can
update the status of milestones.

» Milestone status

When the system displays an overall Status for an Initiative on the Initiatives page, it uses the most
recent status of the Initiative’s milestones. However, the milestone status displayed in the Status
column on the Initiatives page is not an aggregation of the Initiative’s milestones; rather, the system
checks the status of all the Initiative’s milestones and if there is a problem with any of them, the system
displays the status that is the most urgent.

For example, if any milestones have the status of Needs Attention, then this is the status that displays in
the Status column, even if the other milestones are On Track or Completed. However, if another one of
the Initiative’s milestones has the status At Risk, then this is the status that displays because At Risk is a
higher level of urgency than Needs Attention. This feature allows you to see immediately which
Initiatives need help to get back on track.
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Milestone status icons

Initiative milestone status is represented using KPI icons but no trend icons. When the dash icon () is
used to represent milestone status, it indicates that there is no milestone data. No milestone data
usually indicates that the Initiative has not reached the Active Tracking stage in the Initiative creation

approval process.

> 1

> 26
> 27
> 28
» 29
> 31

> 40

1D

Status

Needs
Attention

On Track

On Track

On Track

On Track

On Track

No Status

Initiative Name

w

Digital Engagement

w

New Initiative

v

Admit Goal Written to Bed Occupied -

& Admit Order Written to Bed Occupied-

& Bed Assigned to Occupied
& Testing the Workflow

&= Reduce WTH voluntary turnover for rolling
2 month period ending June 30, 2020 to

Owner
Rick Grayson

Dr Johnson

Rick Grayson

Tom Mckinlay

Rick Grayson

Orlando Ramos

Jeff Goldstein

Sponsor Stage
Dr Johnson Active Tracking
Darryl Fleck Initiative Creatior
Dr Johnson Active Tracking
Jay Spence Initiative Creatior
Dr Johnson Initiative Creatior
Orlando Ramos Pending Reset
Daniel Ziegler Initiative Creatior
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